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I Introducing DeskProto

1.1 Disclaimer

All milling devices (whether or not Numerically Controlled) are dangerous
devices: when working with a milling machine it is possible to damage either
the workpiece or the machine, or even to injure yourself. So do take care, and
always check your milling paths before sending them to the machine - in case
you are a novice user have an experienced colleague check them.

Delft Spline Systems, the software distributor, the dealer and any other
intermediate parties are in no way responsible for any damage or injury,
direct or consequential, relating to the use of this software.

Copyright © 1995-2021  Delft Spline Systems
This computer program is protected by copyright law. Unauthorized
reproduction or distribution of this program is prohibited.

DeskProto ® is a registered trademark of Delft Spline Systems.
Windows ® is a registered trademark of Microsoft Corporation.
MacOS ® is a registered trademark of Apple Inc.
Linux ® is a registered trademark of Linus Torvalds.
All other trademarks are owned by their respective owners.
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1.2 Licenses and Copyrights

DeskProto is protected by copyright law. Unauthorized reproduction or
distribution of this program is prohibited.
Copyright © 1995-2021, Delft Spline Systems

DeskProto uses the following external libraries (installed during Setup as DLL
files):

The Boost C++ libraries.
Copyright © 1998-2005, Beman Dawes, David Abrahams, 
Copyright © 2004-2007, Rene Rivera.
Used and distributed under the Boost Software License V1.0.
www.boost.org

The Clipper library for clipping and offsetting lines and polygons
Copyright © 1995-2013, Angus Johnson
Used and distributed under the Boost Software License V1.0.
http://www.angusj.com/delphi/clipper.php

The Crypto++ library of cryptographic algorithms 
Copyright © 1995-2013, Wei Dai
Used and distributed under the Boost Software License V1.0.
www.cryptopp.com

The HIDAPI library for communication with HID devices.
Copyright © 2009, Alan Ott, Signal 11 Software,
used and distributed under the HIDAPI license.
github.com/signal11/hidapi  

The Minizip library for reading and writing ZIP archives.
Copyright © 2017, Nathan Moinvaziri
used and distributed under the Minizip license.
github.com/nmoinvaz/minizip

The QT cross-platform application framework.
Copyright © 2016, The QT Company Ltd. and other contributors
used and distributed under the GNU Lesser General Public License
(LGPLv3).
www.qt.io

http://www.boost.org
http://www.angusj.com/delphi/clipper.php
https://www.cryptopp.com
https://github.com/signal11/hidapi
https://github.com/nmoinvaz/minizip
http://www.qt.io
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The complete license texts for all these libraries can be found in the
DeskProto About box.
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1.3 Essentials

What does DeskProto offer
DeskProto is a CAM program (Computer Aided Manufacturing) for 3-axis,
4-axis and 5-axis CNC milling machines, offering Desktop Prototyping.
DeskProto allows you to to create CNC toolpaths for 2D vector drawings,
for 3D geometries, as well as for 3D reliefs based on photos. It can be used
for product design, jewelry, woodworking, medical applications, arts,
education, hobby, etc. DeskProto can be combined with any CAD program,
and with any CNC milling machine.

Four Editions of DeskProto are available: Free, Entry, Expert and Multi-
Axis, offering different (sub)sets of DeskProto’s functionality. An edition
comparison table can be found on www.deskproto.com 

How does it work
Starting point for DeskProto is a CAD file (it is not possible to design in
DeskProto: CAM is about calculating toolpaths). Three types of CAD data
are supported, each with a slightly different work-flow: 
Vector-data: 2D drawing containing lines and arcs, stored as DXF, AI, EPS
or SVG file.
Geometry-data: 3D geometry defined as a collection of triangles (facets) that
describe its outer surface (polygon data), stored as STL or DXF file.
Bitmap-data: 2D image containing colored pixels, stored as BMP, JPG, GIF,
PNG or TIF file.
So in fact DeskProto offers three CAM programs for the price of one !

DeskProto will load the CAD file and display its contents. It is possible to
load more than one file. At this point you can scale, translate, rotate etc.
After entering some milling parameters (cutting tool, required accuracy, etc)
DeskProto will calculate the toolpaths and save them in an NC file. Send this
NC file to your CNC milling machine and you will have your part ready
within a short time.

What hardware/software is needed
DeskProto is available for Microsoft Windows, for Apple MacOS and for
Linux.

For Windows it needs Win7, Win8, Win10 or newer. On 64 bits Windows
versions a 64 bits DeskProto will be installed, otherwise a 32 bits version.
Minimum required hardware is a Pentium PC with 1 GB RAM and 100 GB
free disk space: faster/more is better. The graphics card needs to support

https://www.deskproto.com/products/comptable.php
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OpenGL V2.1 or newer. A special build for Win XP (SP3, 32 bits) is
available on request.

For MacOS  it needs Sierra (10.12), High Sierra (10.13), Mojave (10.14),
Catalina (10.15), Big Sur (11) or newer. DeskProto for MacOS always is 64
bits. Here as well minimum hardware requirement is 1 GB RAM and 100 GB
free disk space: faster/more is better.
The MacOS version does not include the "Custom Wizards" nor the option
"Send Toolpaths directly to machine" (each of these a rarely used feature). As
Apple's implementation of OpenGL is incomplete the commands "Print
Image" (File menu) and "Generate Contour" (in the dialog to graphically set
the Operation Area) do not work in the MacOS version,

For Linux it has been developed and tested using Ubuntu 18.04 (64 bits),
still it should also work on most other popular Linux distributions. Only 64
bits versions are supported. Here as well minimum hardware requirement is 1
GB RAM and 100 GB free disk space: faster/more is better.
The Linux version does not include the "Custom Wizards" nor the option
"Send Toolpaths directly to machine" (each of these a rarely used feature).

The screenshots in this Manual / Help file have been made using Windows,
still for MacOS users and for Linux users these images will be completely
clear as all screens are very similar when using one of these operating
systems.
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1.4 Specifications

Required operating system (Microsoft Windows):
Windows 7 / 8 / 10 or newer.
The Setup will install the 64 bits build of DeskProto (called x64), except
when it detects that a 32 bits Windows is running, then it will install the 32
bits build of DeskProto. Both builds behave identically, you can only find
out which version by looking in the About box. The 32 bits version of
Windows calculates a bit slower, and limits the memory use to max 2 GB per
application, which may be a problem if your are working with large datasets.
A special build for Win XP (SP3, 32 bits) is available on request.

Required operating system (Apple MacOS)
MacOS Sierra (10.12), High Sierra (10.13), Mojave (10.14), Catalina (10.15),
Big Sur (11) or newer.
DeskProto for MacOS always is 64 bits.

Required operating system (Linux)
Tested on Ubuntu. It should also work on most other popular Linux
distributions. 
Only 64 bits versions are supported

Required hard disk space:
Minimum 1 GB: about 100 MB for program only, plus at least 900 MB for
projects

Required internal memory:
As much as possible, recommended at least 1 GB

Required graphics:
A 3D graphics card (or on-board graphics) that supports OpenGL V2.1 or
newer,

Supported Project files:
DPJ, version 2.0
DPJ, version 3.0 / 3.1
DPJ, version 4.0 / 4.1
DPJ, version 5.0
DPJ, version 6.0 / 6.1
DPJ, version 7.0 / 7.1
Version 1  DPJ files (Windows 3.11) are no longer supported.
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Project files exist in two versions: with and without calculated toolpaths.

Supported Vector file types:
DXF AutoCAD Drawing Interchange File
limited to points, lines, polylines, arcs, circles and ellipses (2D)
EPS Encapsulated PostScript and
AI Adobe Illustrator
SVG Scalable Vector Graphics
limited to points, lines, polylines, arcs, circles and ellipses (2D)
Entities in these files that are not supported will be simply ignored by
DeskProto.

Supported Geometry file types:
STL STereoLithography
ASCII & binary
DXF AutoCAD Drawing Interchange File
limited to triangles and rectangles (3D)
VRML Virtual Reality Modeling Language
limited to triangles and rectangles

Supported Bitmap file types:
BMP Windows BitMaP
Used by the bitmap operation to load a bitmap
GIF Compuserve Graphic Interchange File
Used by the bitmap operation to load a bitmap
JPG Joint Photographic Experts Group
Used by the bitmap operation to load a bitmap
PNG Portable Network Graphics File
Used by the bitmap operation to load a bitmap
TIFF Tagged Image File Format
Used by the bitmap operation to load a bitmap

Supported NC program files (toolpath data):
NC-program Numeric Controlled
only ASCII, machine-dependent format and file extension

Other supported file-types:
DPW DeskProto Wizard
defines one custom wizard
DPS DeskProto Script
contains a DeskProto script.
DPT DeskProto Toolpath
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contains all toolpaths for one DPJ file

Maximum File size
The DeskProto code does not have a maximum for any file. In practice the
maximum is limited by the computer's resources. For the standard 64 bits
version the maximum STL filesize mainly depends on how much RAM
memory is present: when the Operating System needs to swap the
calculations will become too slow for most users.
For the 32 bits version (Windows only, see above) the maximum amount of
RAM is limited to 4 GB, part of which is used for other aims. As the
memory needs to contain both the geometry and the toolpaths these are
related: for a very large STL file (say 1 GB) only simple toolpaths will be
possible. Roughly speaking the STL file size maximum for 32 bits DeskProto
will be about 800 MB (binary STL).
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1.5 Wizard

For novice users it may be difficult to complete the DeskProto process of
generating an NC program file based on your own CAD-data. And for
experienced users some complicated models that DeskProto can produce
remain difficult to prepare. For these reasons DeskProto features Wizards: a
series of dialog screens that guide you step-by-step through the complete
process. The DeskProto wizards also tell you where each setting can be
found in the ‘normal’ user interface, to enable you to do it without wizard the
next time (if desired). The wizard can be started from the File menu (File >>
Start Wizard) and from the Start Screen.

So the DeskProto Wizard is meant to let you execute a task by guiding you
through the steps needed.  The first wizard screen (see Choosing the type of
Wizard) presents a list of the tasks for which a Wizard has been created.
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The illustration above shows a typical wizard screen.
On top six icons that indicate the sequence of pages in this wizard. These
function as tabs: when colored these icons can be used to navigate to a
different page of the wizard by clicking on the icon.
The number of pages of each wizard (and options on each page) depends on
which Edition you are running.
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Along the bottom the standard Wizard buttons: Back, Next, Cancel, Help
and (not on the illustration) Finish.
The button Apply (on the left) will refresh your screen and apply the
currently selected settings.
This leftmost button may also show Calculate, which will calculate the
toolpath with the currently selected settings.

Important are the yellow question marks in front of each question: position
the cursor over one of these, and DeskProto will show a Wizard Tooltip
with Help information for this question. Including information where to find
this setting in the dialog based user interface.

All functionality offered by the wizards is also available in the normal user
interface: the wizards are only meant to make things easier for you, they do
not add new options. After finishing any wizard you can fine-tune the
settings that the wizard made.
When you open an existing project that was made by the wizard, DeskProto
will again use the wizard interface. However after fine-tuning in the dialog
based interface that is no longer possible.

In addition a very powerful feature is present called the Custom Wizard: a
wizard written in a Script language and later added to DeskProto. This makes
it possible for any user and reseller to create a custom wizard for a specific
application and/or a specific fixture.
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1.6 Support

If you encounter problems while working with DeskProto, please try the
following:

1. Search for a solution in the on-line Help system. The help is very detailed:
every option in every dialog is explained.

2. Look in the FAQ (Frequently Asked Questions) on the DeskProto
website.

3. Look in the Forum on the same website

4. Carefully read the appropriate sections in the Manuals (printed or pDF
download).

5. In case no solution found: ask the Dealer who supplied DeskProto to
you.

In case of any other problem: contact Delft Spline Systems.
When you send us a project please do so using the ZIP file that you can
generate via Create Problem Report (Help menu). Sending the DPJ file is
insufficient as that file does not contain the CAD-data nor your
cutter/machine/postprocessor definitions.

https://www.deskproto.com/support/faq.php
https://www.deskproto.com/forum/forum.php


DeskProto Reference

Page 18

1.7 Delft Spline Systems

Delft Spline Systems is a Dutch software house, founded in 1984, specialized
in the development and the use of CAD/CAM software. The first product of
the company, the SIPSURF CAD/CAM package, was released in 1986, ran
in MS-Dos, and was specialized in designing freeform surfaces. As for
products containing freeform surfaces it is absolutely necessary to create
physical models in order to really evaluate the design, a module to easily
calculate CNC toolpaths has been present from the start. 

Since that time Rapid Prototyping has been recognized as vital for product
development, has even become a buzz word. Based on a long experience of
Rapid Prototyping and NC milling, Delft Spline Systems was able to develop
this unique DeskProto package, meant for product designers. 

Since that time we have found that DeskProto is very well suited for many
other applications as well. Key feature is the ease of use: DeskProto does not
aim at CNC specialists (like most other CAM software), but instead at
professionals in a different application. Like in jewelry, arts, design,
education, prostheses,  woodworking, food and sweets, and so on. This is
worded in our motto

"CNC machining for non-machinists"

We hope you will enjoy using it, and we expect it will help you in producing
high quality parts within a short time.

When you want to stay informed about new DeskProto Developments you
can subscribe to our Newsletter emails by checking that option when
downloading a DeskProto trial version from our website. 
The news will reach you even more quickly when you follow the DeskProto
page on Facebook and/or Instagram.

Delft Spline Systems
Utrecht, The Netherlands

Tel: +31 30 296 5957

Website: www.deskproto.com

Email info@deskproto.com

The DeskProto software © is owned by Delft Spline Systems.
DeskProto ® is a registered trademark of Delft Spline Systems.

https://www.facebook.com/DeskProto
https://www.instagram.com/deskproto/
https://www.deskproto.com
mailto:info@deskproto.com
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II Screen layout

The computer screen presented by DeskProto looks like the screenshot
shown above. In this chapter a short explanation will be given of each element
on the screen. The image shows a Windows screen. Using MacOS or Linux
the screen looks a bit different, still the same elements are present and can
clearly be recognized. From top to bottom, the following elements are
present:

· The top line is called the Title bar. It contains the name of the current
project, the word DeskProto, information  about your license, and a few
operating system icons.

· The Menu bar is the next horizontal line. It contains in black characters
the names of the available pull-down menus. In MacOS the menu bar has a
different location and an extra menu (left of File) called DeskProto. That
will all look familiar for Apple users.

· The button bar or Toolbar is the horizontal line below, containing a
number of buttons for commands that need to be at hand. DeskProto can
show these buttons in two sizes (setting in the View menu), the
illustration shows the large buttons.
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· The View window. The large screen-area below the button bar (right part
of the screen) is used to display the 3D data in one or more views. The
border of this window contains the Thumb-wheels.

· The Project Tree window at the left of the view window displays the
Project Tree, showing the structure of the current project.

· The NC Files window at the bottom left shows the NC Program files that
have been saved for this project.

· Finally the bottom line or Status bar displays extra information on the
DeskProto commands, and some standard Windows messages.

You can resize two areas of the DeskProto screen: of both the Project Tree
window and the NC Files window the size can be changed. You can do so
exactly as for the complete window: move your cursor over the border of this
screen area, see the cursor change, press the left mouse button and move.
This only works on one side of this screen area, called the splitter.

In Windows you can Resize the complete DeskProto screen, just as most
Windows dialog screens. Two standard sizes and Custom are available (the
exact shape and color of these buttons differs per Windows version):

·   The minimize button on the title bar will minimize: no window
visible, only a button on the Taskbar.

·   The maximize button on the title bar will maximize: full screen
window.

·   The custom size button restores the latest custom size. In
custom size mode you can change the size by positioning the cursor on
one of the borders or corners of the dialog window (note that the cursor
changes to an arrow), pressing the left mouse button and then moving the
cursor.

In MacOS  you can use the  three colored buttons on the left
side of the title bar (red, yellow and green), for closing, minimizing, and
zooming (expanding to full-screen) the window. After zooming to full screen
the title bar with the colored buttons will have disappeared, you can again see
it by moving your cursor to the upper border of the screen.

In Linux the three buttons on the title bar look like this: .
Functionality is the same as in Windows.
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2.1 Title Bar

The Title bar is located along the top of a window.
It's exact appearance depends on your version of Linux/MacOS/Windows,
and on the Theme that you have selected. In Windows this bar will be semi-
transparent, which is a feature of the Aero interface.

To move the window, drag the title bar.  You can also move other dialogs in
DeskProto by dragging their title bars.

A title bar may contain the following elements:
· Name of the current DeskProto project, or "Untitled" if the project has not

yet been saved (here "Teapot.dpj")
· Name of the application (here "DeskProto 7.1")
· License type: commercial, educational, hobby, etc. (here "Dealer license:

Not For Resale").

In Windows these buttons are present (the exact shape and color of these
buttons differs per Windows version):
· Application Control-menu button (the orange icon "DP")

· The Minimize button  to reduce the DeskProto application
window to a taskbar button

· The Maximize button  to enlarge the DeskProto application
window to fill all available screen space.

· The Restore button  to return the DeskProto application window
to its size and position before you chose the Maximize or Minimize
command.

· The Close button  to exit DeskProto and close it's window.

In MacOS  the buttons are different:

·  These three buttons are for closing (red), minimizing
(yellow), and zooming (expanding to full-screen mode, green) the window.
The icons on these buttons are visible only when the cursor moves over
them.
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In Linux the buttons on the Title bar look like this:

·  Functionality of these three buttons is the same as in
Windows, see above.

The Windows images were made in Win10, the MacOS buttons in Catalina,
the Linux buttons in Ubuntu 18.04
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2.2 Menu Bar

The menu-bar is the main route to all the commands that are available in
DeskProto. This is why the command reference in the next chapter of this
manual is structured following these pull down menus. Each item in the
menu-bar represents a pull down menu, which can be made visible by clicking
the left mouse button with the cursor on the item. The menu shown above is
present both in Windows and in Linux. The following menus are present:

File File management and Print options.

Edit Standard Windows options Edit and Properties.

View Display and View control options.

Parameters Options to change the parameters for project, part and
operations

Create Toolpath calculation and saving options.

Options Customization of libraries, defaults and other settings.

Help Online Help options

Note that in the illustration above one character is underlined for each menu-
item. This is a feature in Windows: the underlined character can be used to
control the program without a mouse. Pressing Alt + F (at the same time) will
open the File menu for instance. 
In most versions of Windows the underlining will be invisible: you can press
the Alt button to make it visible.

The menu bar in MacOS  (Apple) contains one extra menu: the DeskProto
menu. This is the first menu, before File: in MacOS for each application the
first menu has the name of the application.

DeskProto About / Activate / Upgrade / Check f Upd / Preferences

These commands are present in Windows as well: in the Help menu and the
Options menu.
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2.3 Toolbar

The toolbar is the series of buttons displayed across the top of the
application window, below the menu bar.  The toolbar provides quick access
to many tools used in DeskProto. All these functions can also be accessed via
the menus.

To hide or display the Toolbar, choose Toolbar from the View menu. A
check mark appears next to this menu item when the Toolbar is displayed. 

The next command in the View menu is "Large Toolbar Buttons", with which
you can choose between two sizes of buttons. Again with a check mark if
large buttons have been selected (which is the default status). The best choice
will depend on the resolution of your screen: on a high-res screen the small
buttons will become too small. The size of the buttons can also be changed in
the Preferences: on the Advanced tab you can set a scaling factor for the
complete user-interface.

Below a list of all buttons with for each button an explanation of its
functions.

Open a New project. Same command as New in the File
menu

Open an existing project.  DeskProto displays the Open
dialog, in which you can locate and open the desired DPJ-
file.

Save the open project with its current name as DPJ file.  If
you have not yet named the project, DeskProto displays
the Save As dialog.

Load or Add a Vector file into the project.

 

Load or Add a Geometry file into the project.
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Load a Bitmap file into the project (adding is not possible:
max 1 bitmap file loaded).

Calculate the toolpaths for all visible operations of the
current part.

Show a Simulation of the result that you can expect after
machining the part.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), and show's its current
state.

Write the NC program for all visible operations of the
current part.

Send toolpaths to machine for all visible operations of the
current part.
This button is visible ONLY when this option has been
configured (in the Preferences); for some configurations the
button will show a different icon.

Print the image as present in the current view.

Preview how the image would be printed.

Show or hide the Part information dialog.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), and show's its current
state.

Change the Layout out of the views.

Change which Items should be shown in the active view
(the Scene).

Change the Viewpoint (camera position) of the active view.

Set the viewpoint of the active view to Top view (XYZ  0 /
0 / 0 ).
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Set the viewpoint of the active view to Front view ( -90 /
0 / 0).

Set the viewpoint of the active view to Left side view ( -
90 / 90 / 0).

Set the viewpoint of the active view to Bottom view ( 0 /
180 / 0).

Set the viewpoint of the active view to Back view ( -90 /
180 / 0).

Set the viewpoint of the active view to Right side view ( -
90 / -90 / 0).

Set the viewpoint of the active view to Isometric view.

Set the viewpoint of the active view to Default view.

Restore the previous viewpoint settings.

Restore the next viewpoint settings (enabled only after
Restore previous view, to undo that restore).

Change mouse-function to rotation.
The four mouse-buttons are "toggle buttons", showing
depressed in case selected. De-selecting can be done by
pressing one of the other mouse-buttons. Always one of
these four buttons is selected.

Change mouse-function to panning.

Change mouse-function to zooming.

Change mouse-function to zoom window: zooming in by
selecting a specific area in the active view.

Note that one of these four mouse-functions is active at
any moment, so choosing one means deselecting the
previous one. DeskProto also offers other tools: the red
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thumb-wheels on the screen are for rotations, the yellow for
pan and the blue wheel is for zoom. A handy alternative is
using the middle mouse button (the mouse-wheel): rotating
this wheel zooms, and moving the mouse with the wheel
pressed pans.

Set the Zoom percentage to 100% to show the complete
geometry.

Display the Help Topics dialog.
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2.4 View Window

The view window shows the CAD-data that you are working with, the
toolpaths that you create, and much more. In the screenshot above the most
important items to be displayed are indicated:

The wireframe block in orange is the Material block that you start with for
this Part.
The wireframe block in green is the Area to be machined for one Operation
Both blocks can be shown shaded by making them Translucent in the Items
Visible dialog
Drawn in metallic blue is the Geometry that you loaded (the STL file).
Vector data and bitmaps are displayed in gray.
The lines in red are the Toolpaths: the path that the tip of the cutter will
follow to create your part.
Start and end of the toolpath are shown as small red arrows.
Some of the toolpaths are in purple: these are done at reduced speed because
of a High chipload. 
And the dashed lines in gray are positioning movements in Rapid.
The green View orientator at the bottom left helps to orient by showing the
directions of the axes.
The dark blue orientator shows the position of the WorkPiece zero point.
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The six Thumb-Wheels in the window border can be used to change the
camera position.

The list above includes the most used items in the View Window. Many
more items can be displayed though: this can be defined using the Items
Visible dialog. This dialog contains a large number of checkboxes to switch
the various items on and off.

Mind the two different orientators: the green Orientator does not indicate the
WorkPiece zero point: that is shown by the blue Orientator.

Double-clicking in the View window will open the Items visible dialog.
Right-clicking in the View window will make a small menu pop up, called the
context menu, offering you a few relevant commands 
(right-clicking on a Mac with a one-button mouse can be emulated by
pressing the Ctrl (Control) key while clicking the mouse button).
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2.5 Project Tree

In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left of the screen. In the above example the project 'Torso'

contains two Parts (icon  ), one with five Operations and one with
two. 
Three different Operation types can be present: Vector operation (icon

 ),  Geometry Operation (icon  ), and Bitmap operation (icon

 ).
When one of these Operations or Parts is in an error status this is shown by

the  error icon.

The lamp icon  indicates if a line in the Tree is visible (yellow) or

 not (gray). Only one Part can be current (visible) at a time. Of the
Operations in that part none, several or all can be visible. Click on a lamp
icon to change the status of that line. The Project line has no lamp icon as
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that line cannot be turned off. For Operation lamp icons two keyboard
shortcuts are present: Ctrl+Click means "Make Visible and Hide Others",
Ctrl+Shift+Click means "Make All (in)visible".

If you do not see a Project tree window, activate the option Project tree in
the View menu by selecting it.  The Project tree icon in the menu will become
active (drawn in a frame) and the Project Tree will be displayed. De-
activating this option (by again selecting it) will make the Tree window
disappear. The size of the Window can be changed by dragging it's borders
with the mouse.

Shortcuts:
The black arrow button in the border of the View Window opens and closes
this Tree Window.

The project tree offers you a number of functions:

Editing parameters
Double-clicking on a line in the tree will open the dialog to edit the
parameters of the Project, Part or Operation.

Making a part current
To see a particular part (in case you have defined more than one part) you
should make it current. To make a part current just click with the left mouse-
button on the gray lamp icon of that part. You can also use the Context menu
(see below). When a part is not current, its icon is grayed.
There is always exactly one part that’s current. No more, no less.
You cannot make a Part "un-current" by clicking on a yellow lamp icon: you
can only make a different part current.

Making an operation (in)visible
To be able to see how the toolpaths look for a particular operation, this
operation should be visible. To make an operation visible just click with the
left mouse-button in the tree on the gray lamp icon of that operation to make
it yellow (turn the light on). Clicking on the yellow lamp icon of a visible
project will make it invisible. When an operation is not visible, its icon is
grayed.
Of the operations in a Part none, one, several or all can be visible.

Displaying parameters in the status bar
When you single-click on one of the items in the project-tree, that particular
item is highlighted (shown with a blue background), meaning that it is
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selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus
When you right-click on an item in the tree a small menu pops up called the
context menu, offering you a number of functions (right-clicking on a Mac
with a one-button mouse can be emulated by pressing the Ctrl (Control) key
while clicking the mouse button).
The available functions will be different for each line of the tree, and will
include the following options:

Edit the parameters of that tree-item.

Add a Part to the project. The settings of the default part are used.
Add an Operation to that part. The settings of the first default operation are
used. There are Add options for a Vector Operation, a Geometry Operation
and a Bitmap Operation.
Copy an operation or a part will add an item that is identical to the current
one.

Remove a Part from the project. This is only possible when there will be at
least one part left after it has been removed.
Remove an Operation from that part. This is only possible when there will be
at least one operation left in the part where it belongs to after it has been
removed.

Move Parts and Operations in the Tree can be used when the sequence is
important (for instance first roughing, then finishing).

The other options in the context menu will be self explaining.
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2.6 NC Files

The NC files window shows a list of NC program files that have been saved
for this project. For each file its Name and Date are listed. This may be easy
for you to manage NC files for this project.

Hoovering over the filename (positioning the cursor there without clicking)
will make DeskProto show the complete file specification of the NC file in a
tooltip: see the screenshot above.

Double-clicking a file will open the file using the default program that has
been set for that file-type in File Explorer. For instance double-clicking a
.TXT file will open it in Notepad. You can configure your machine's control
software to open your NC files, or a text editor in case you want to check the
file's contents.

By right-clicking on any line in this window you can open a Context menu,
offering the following options:
· Remove the file-name from the list
· Delete the file
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· Open the file - same effect as the double-click just described
· Open the file location - which will show the NC program in File Explorer
· Send the file to your machine (only in case that option has been

configured)
· Add a file - for instance to add a TXT file with your own project

documentation.

The NC Files window can made visible or invisible by checking or unchecking
the option NC Files list in the View menu. This same effect can be achieved
by pressing the  black arrow button in the title bar of this window. Note that
the NC Files window can only be visible when the Project Tree Window is
visible too.
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2.7 Status Bar

The status bar is displayed at the bottom of the DeskProto window, and
gives status information about various relevant items. To display or hide the
status bar, use the Status Bar command in the View menu. A check mark
appears next to the menu item when the Status Bar is displayed.

The left side of the status bar describes the commands of toolbar buttons as
you point to them  (a sort of extra Help information). Menu commands are
also described when you use the arrow keys to navigate through the menus.

In the middle area the most important parameters of the selected tree-item are
displayed: CAD filename and machine for the Project, dimensions for a Part,
cutter and precision for an Operation.

At the right side of the status bar the coordinates of the current mouse
position are displayed, however only when the geometry is displayed in one
of the six main views. These coordinate values shown are in “Translated”
coordinates: the coordinates as used in the NC file. This is a very handy
option that enables you to quickly check dimensions and positions on the
screen.
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III Menu commands

3.1 DeskProto Menu (MacOS only)

In any MacOS application the first menu has the same name as the
application, containing some standard options for the application. The image
above shows the DeskProto menu. 
In Windows and in Linux these commands are all present as well, however
you can find them in other menus (see below).

In this document the commands are listed conform the menu structure in
Linux and Windows,
MacOS users can find more information about the DeskProto commands via
the links below: 
About DeskProto
Activate License
Upgrade information
Check for Update
Preferences
Quit DeskProto
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3.2 File Menu

The File menu contains all options for File management and for Printing,
conform Windows conventions.
On the right side of the menu you can see "shortcuts" for a number of
commands: for instance "Ctrl+O" means to keep the Ctrl key pressed and
then press the O key: DeskProto will perform the Open Project command.
No need to use your mouse !

Note that not all options are present in the DeskProto Free edition and Entry
edition.

3.2.1 New Project

This File menu command creates a new project in DeskProto. 
This project will be called "Untitled" until it has been saved.
You can select one of three project types:  Vector project,  Geometry project,
 Bitmap project,
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by selecting one in a sub-menu.

The difference is the type of operation that will be present:
· a Vector project features a Vector operation, and is meant to process

Vector Data (like a 2D DXF file)
· a Geometry project features a Geometry operation, and is meant to

process Geometry Data (like a 3D STL file)
· a Bitmap project features a Bitmap operation, and is meant to process

Bitmap Data (like a JPG file)
Combined projects are possible by adding operations once the project has
been opened.

One of these three project types is the default, shown in bold characters.
You have selected this default when you first started DeskProto, in the Initial
Settings dialog.
It can be changed later by editing the default Part (Options menu) and
changing the type of operation that is present.

When starting DeskProto automatically opens a new default project, so no
need to again use "New Project" at program start.
As a next step you can then load the CAD file(s) you want to use: Vector
data, Geometry data and/or Bitmap data.

You can open an existing project with the Open Project command.

Shortcuts:

Toolbar:

Keys: CTRL+N  (Windows, Linux)  +N  (MacOS).
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3.2.2 Open Project

This File menu command opens an existing project. The currently open
project will be closed, and the standard Windows Open File dialog will be
displayed, showing all DeskProto project files (.DPJ).

You can’t open more than one project at a time.
You can create a new project with the New command.
A 'Close' option is not present: you can close your current project using
either 'New', 'Open' or 'Exit'.

Important to know is that you can not load a CAD Data file using the Open
command: it can only open DeskProto projects. In order to load a vector file,
geometry or bitmap file you need to use the command Load Vector File, Load
Geometry File or Load Bitmap File. Even easier is to use one of the Wizards.

Shortcuts:

Toolbar:

Keys: Ctrl+O  (Windows, Linux)  +O  (MacOS).

When opening a project file, the CAD file(s) that were used will be read
again: the DPJ files does not store the CAD-data but only links to the
external CAD files. The CAD file must thus be found at the same place as
where it was when the project file was saved. So when sending out a project
file make sure to also send all CAD files.

If the CAD file cannot be found (for instance when the DPJ file was copied
from a different computer system) then DeskProto will check if a CAD file
with the correct name can be found in the current directory (same as the DPJ
file) or in the default Data directory. If yes, DeskProto will ask you if it can
use that file instead, see the File Not Found dialog.

3.2.3 Open Recent Project

This File menu command will show a list containing the latest projects that
you have opened (maximum 20).
Click on any project in the list to again open it. 
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This list is called the Recent File List, and also MRU which stands for
Most Recently Used.
It is a convenient standard option in current software.

3.2.4 Save Project

This File menu command saves the open project to its current name and
directory, in a DeskProto project file (.DPJ).  When you save a project for
the first time, DeskProto will display the Save As dialog so you can name
your project.  

If you want to change the name and directory of the open project before you
save it, choose the Save As command.
Also if you want to save the DPJ file with toolpaths you need to use that
command.

Note that the project file does not contain the CAD-data, only a link to the
CAD-file. For saving the geometry after it has been changed use the Save
Geometry As command.

Shortcuts:

Toolbar:

Keys: Ctrl+S  (Windows, Linux)  +S  (MacOS).

3.2.5 Save Project as

This File menu command saves and names (or renames) the open project,
using the Save As dialog. 

In this dialog you can:
· Name your project. 
· Select a new location for the project file.
· Select the type of DPJ file to be written: standard or with Toolpaths.

To save a project with its existing name and directory, use the Save
command.
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3.2.6 Load/Add Vector File

The File menu command Load Vector File displays the standard Windows
Open File dialog in which you can select the vector file you want to load. It
will be showing all Vector file types that DeskProto can read: DXF, AI, EPS
and SVG.
After browsing the file it's contents will be loaded, at project level (so
accessible for all parts and for all operations).

Shortcuts:

Toolbar:

When you already have loaded vector data, this command will change to Add
Vector File and the new vector curves will be Added. For an overview of all
Vector files that you loaded, or when you want to replace your current
Vector file with a new, go to the Parameters menu, choose the option Project
Parameters and go to tab Vector.

Only when Adding a second vector file an extra dialog will pop up: the
Vector Data Transformation dialog. This dialog enables you to position the
new vector  curves relative to the current CAD data.

3.2.7 Save Vector Data as

This File menu command displays the standard Windows Save File dialog in
which you can define the vector file you want to write. 
This command makes it possible to:
1- save vector data in a CAD file with one or more Transformations applied
2- merge several vector files to one combined new CAD file. 

Of course this is only possible in case you have previously loaded Vector
data.

About 1: 
Before the standard Save dialog an extra dialog will pop up: the Save Vector
Data Options dialog, which enables you to apply Transformations that you
have set in the Part Parameters.
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About 3:
For importing Vector files DeskProto supports three file formats: DXF, EPS,
AI and SVG.
However, for exporting Vector files only DXF and SVG are supported.

3.2.8 Load/Add Geometry File

The File menu command Load Geometry File displays the standard
Windows Open File dialog in which you can select the geometry file you
want to load. It will be showing all Geometry file types that DeskProto can
read: STL, DXF and WRL.
After browsing the file it's contents will be loaded, at project level (so
accessible for all parts and for all operations).

Shortcuts:

Toolbar:

When you already have loaded a geometry, this command will change to Add
Geometry and the new geometry will be Added, to form one combined new
geometry. For an overview of all Geometry files that you loaded, or when
you want to replace your current geometry with a new, then go to the
Parameters menu choose the option Project Parameters and go to tab
Geometry.

Only when Adding a second geometry file an extra dialog will pop up: the
Geometry Transformation dialog. This dialog enables you to position the
new geometry relative to the current CAD data.

3.2.9 Save Geometry Data as

This File menu command displays the standard Windows Save File dialog in
which you can define the geometry file you want to write. 
This command makes it possible to:
1- save geometry data with one or more Transformations applied
2- merge several geometry files to one combined new file. 
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3- save geometry data in a different format (so use DeskProto as a converter
for geometry files).

Of course this is only possible in case you have previously loaded Geometry
data.

About 1: 
Before the standard Save dialog an extra dialog will pop up: the Save
Geometry Data Options dialog, which enables you to apply Transformations
that you have set in the Part Parameters.

About 3:
DeskProto supports six file formats for geometry files, you can select one in
the Save as Type box.
STL STereoLithography File ASCII
STL Binary
DXF AutoCAD Drawing eXchange File Polyface Meshes
DXF 3D Faces
VRML Virtual Reality Modeling Language Version 1.0
VRML Version 2.0

STL is preferred as being most standard, and the binary version results in a
much smaller file size than ASCII. So Binary STL is the default file type here

3.2.10 Load Bitmap File

The File menu command Load Bitmap File displays the standard Windows
Open File dialog in which you can select the bitmap file you want to load. It
will be showing all Bitmap file types that DeskProto can read: BMP, JPG,
GIF, PNG and TIF.
After browsing the file it's contents will be loaded, at project level (so
accessible for all parts and for all operations).

Shortcuts:

Toolbar:

DeskProto supports only one open bitmap file per project. So adding a
second bitmap file (like for geometry files and vector files) is not possible.
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Reason is that geometry data and vector data comes with a position in 3D
space, so combining several files can make sense.
Bitmap files do not have such position in space.

If needed you can combine several bitmap files to one large image (using any
graphics program) and import that new image file in DeskProto.

3.2.11 Save Bitmap Data as

This File menu command displays the standard Windows Save File dialog in
which you can define the bitmap file you want to write. 
This command makes it possible to save bitmap data in a different format (so
use DeskProto as a converter for bitmap files).

Of course this is only possible in case you have previously loaded Bitmap
data.

DeskProto supports four file formats for exporting bitmap files: BMP, JPG,
PNG and TIFF. You can select one in the Save as Type box.

3.2.12 Print Image

This File menu command prints an image of the DeskProto View Window.

This command presents a Print dialog, where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.

Shortcuts:

Toolbar:

Keys: CTRL+P  (Windows, Linux)  +P  (MacOS).

3.2.12.1 Print Preview

This File menu command displays the image of the page to be printed.
Two versions of this command are present in DeskProto:
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· Print Image Preview, which shows the View Window as it would appear
when printed.

· Print Project Data Preview, which shows the Project Data as it would
appear when printed.

When you choose this command, a print preview window will pop up in
which the page will be displayed in their printed format.  The print preview
toolbar offers you options to view either one or two pages at a time; move
back and forth through the document; zoom in and out of pages; and initiate a
print job.

On most MacOS versions this command cannot be used as Apple does not
offer the full OpenGL functionality.

Shortcuts:

Toolbar:   (for Print Image Preview)

3.2.12.2 Print Page Setup

This File menu command selects a printer and a printer connection.
Two versions of this command are present in DeskProto:
· Print Image Page Setup, for printing the View Window.
· Print Project Data Page Setup, for printing the Project Data.

This command presents the standard Windows Print Setup dialog, where you
specify the printer and its connection. The available options will depend on
the Printer driver that you have selected.

Note that some CNC milling machines also use a Windows Printer Driver and
thus a Print Setup Dialog. Do NOT select such milling machine here, instead
use the DeskProto Preferences. This command is only for printing on paper.

3.2.13 Print Project Data

This File menu command prints all the data in the project, that means all the
project parameters, the parameters of all of its parts, and the parameters of
all of their operations. See the example image below.
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The printed pages can be used for backup and documentation purposes.

This command presents a Print dialog, where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.

3.2.13.1 Print Preview

This File menu command displays the image of the page to be printed.
Two versions of this command are present in DeskProto:
· Print Image Preview, which shows the View Window as it would appear

when printed.
· Print Project Data Preview, which shows the Project Data as it would

appear when printed.

When you choose this command, a print preview window will pop up in
which the page will be displayed in their printed format.  The print preview
toolbar offers you options to view either one or two pages at a time; move
back and forth through the document; zoom in and out of pages; and initiate a
print job.

On most MacOS versions this command cannot be used as Apple does not
offer the full OpenGL functionality.

Shortcuts:

Toolbar:   (for Print Image Preview)
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3.2.13.2 Print Page Setup

This File menu command selects a printer and a printer connection.
Two versions of this command are present in DeskProto:
· Print Image Page Setup, for printing the View Window.
· Print Project Data Page Setup, for printing the Project Data.

This command presents the standard Windows Print Setup dialog, where you
specify the printer and its connection. The available options will depend on
the Printer driver that you have selected.

Note that some CNC milling machines also use a Windows Printer Driver and
thus a Print Setup Dialog. Do NOT select such milling machine here, instead
use the DeskProto Preferences. This command is only for printing on paper.

3.2.14 Show Start Screen
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The DeskProto Start Screen shown above is a help to quickly start the task
that you need.
You can open the Start Screen via the File menu  (File >> Show Start Screen).

Shortcut:

Keys: Ctrl+B  (Windows, Linux)  +B  (MacOS).  
B stands for "Begin", as the S already is being used.
 
It will first show the Edition that your are running, 
next your Name and Location (as owner of the license),
and the type of License, with the restrictions that apply (of any).

Three groups of tasks are presented:
· Start a new project
· Open an existing project 
· Other tasks
Each line in these three lists is a link that will directly start that task.

Starting a New project can be done either using the Wizard interface or the
Dialog based interface. 
Default choice for this dialog is to start a New project using the Wizard: that
is what will happen when you simply press the Enter key (indicated by the
icon at this line). This is the most convenient option for novice users.
The difference between Vector/Geometry/Bitmap projects is explained on
page New project. 

The DeskProto Setup has installed a number of Sample projects and
Sample geometries on your PC. Including some great geometries like the
DeskProto picture frame: see the lessons in the DeskProto Tutorial book.
Conform Microsoft's specifications the Samples have been installed in the
\ProgramData\ folder, which may not be easy to find as it is a hidden folder
and its location is different per Windows version. Sorry about that,
unfortunately for standard users other locations are not permitted by
Microsoft. Also when using MacOS or Linux the Samples folder may not be
easy to find for you.
Using the checkbox Use samples folder you will always be able to find the
sample geometries.

Recent projects will be available only when you have used DeskProto V7
before. In this dialog only the latest 5 projects will be shown.  Command
Open project will allow you to open any project file by browsing one.
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In the Other tasks section, Open sample project makes it easy to find the
sample projects.
The other three 'other tasks' require an Internet connection, as they will start
your browser and open a web page.

The checkbox Show this start screen on startup makes this screen
automatically appear at each start of DeskProto. After having de-selected this
option, you can still access the Start Screen using the command Show Start
screen in the File menu.

3.2.15 Start Wizard
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The Wizard-based user interface is an important feature of DeskProto. It
makes it possible for users without much CAM know-how to easily create
the toolpaths that they need for their projects. Each wizard is a series of
dialog screens (forms) that need to be filled in: the wizard in a way 'takes
your hand' and guides you through the process of creating toolpaths.

When you create a project using a wizard and you save the project without
making any changes after finishing the wizard, on re-opening DeskProto will
show the project using the same wizard. So it is possible to use DeskProto
seeing only the wizard interface. This is new in DeskProto V7, and will be a
great help for inexperienced users.

Navigating the Wizard is done using the Wizard buttons, on the bottom of the
screen:

  Back and    Next let you navigate the wizard
pages,

  Cancel and    Help are standard buttons.
Every wizard page has its own Help information page.

  Finish will replace Next on the final page of the Wizard,

  Apply will apply the currently selected settings and refresh
your screen.

  Calculate will calculate the toolpath with the currently
selected settings.

Navigation icons: The DeskProto wizards start with the page shown above,
called "Which Wizard?". On the top of the page you can see one icon, after
selecting one of the wizards a series of icons will be shown: one for each
wizard page. At this point these extra icons are all gray, when progressing
they will be colored: then they can be used as tab-pages to navigate (click on
a colored icon to jump to that page of the wizard).

Help information: Important are the  yellow question marks in front of
each question. When you position the cursor over such mark a Tooltip will
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pop up, giving extra information about that question. It will also tell you
where to find that setting in the Dialog based interface.

The first question, "Machine to be used", in most cases needs not be changed
as your default machine will already have been selected here.

The second question, "Type of milling", presents the six wizards that you can
choose from: you need to select one before continuing.  
Not all wizards will be available for all users (some may have been grayed
out): some wizards are not available in all DeskProto Editions, and some
wizards are only available in case you selected a machine with a rotation axis. 
Also: in the Free edition and the Entry edition the available wizards do not
include all described options.

Basic Vector Machining
This wizard creates 2D toolpaths for just one Vector file (DXF, EPS, AI,
SVG). It is meant for novice DeskProto users, and explains this procedure
step-by-step. You can choose to use either Profiling or Pocketing toolpaths.

Basic Geometry Machining
This wizard creates 3D toolpaths for just one Geometry file (STL, DXF). It
is meant for novice DeskProto users, and explains step-by-step the
procedure to create an NC toolpath file (NC program) based on your
geometry. The model will be machined from one side, using three operations:
Roughing, Finishing and a smoothing contour.

Basic Bitmap Machining
This wizard creates 3D toolpaths for a relief based on a Bitmap file (BMP,
GIF, JPG, PNG, TIFF file). It is meant for novice DeskProto users, and
explains this procedure step-by-step. 

Advanced Geometry  (the three advanced wizards are all for geometry
machining):

Two sides, manual flip, also called Two-sided Wizard  (not available in the
Free Edition and the Entry edition)
This advanced wizard is a unique feature of DeskProto, and makes it very
easy for you to create a compete 3D part by machining it from two sides, on
any three axis milling machine. DeskProto assists you by taking care of the
repositioning needed to machine the second half: no need to change the
workpiece zero point (starting position of the cutter).
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Two or more sides, automatic rotation, also called N-Sided Wizard
 (available only in the Multi-Axis edition)
N-sided milling is meant for machines with a rotation axis (A-axis), and
allows indexed machining: this wizard generates toolpaths to machine the
part from several (N) sides, with a rotation in-between. The number of sides
can be freely chosen: for two sides the result is the same as for the previous
wizard, though now with automatic rotation.

Rotary Machining   (available only in the Multi-Axis edition)
If your machine is equipped with a rotation-axis (A-axis) you can use this
wizard to create toolpaths for a model that is machined from all sides:
rotation axis machining. In contrast to the previous wizard, now the material
rotates during machining. 
A rotation axis is an extra piece of equipment that lets your model rotate
during machining (just like a roast rotating on a spit above a barbecue).

Note that all functionality offered by the wizards is also available in the
dialog-based user interface: the wizards are only meant to make things easier
for you, they do not add new options. After finishing any wizard you can
still use the dialogs to fine-tune the settings that the wizard made.

You can find the Wizard in the File menu  (File >> Start wizard)  or in the
Start Screen.

Shortcut:

Keys: Ctrl+W  (Windows, Linux)  +W  (MacOS).

3.2.16 Start Custom Wizard

The Custom Wizard (also called Script wizard) is a wizard written in a Script
language and is stored as a separate file (so not in the file DeskProto.exe).
This is a very powerful option, as it makes it possible for any user and
reseller to create a custom wizard for a specific application and/or a specific
fixture.

Custom wizards are not available in MacOS and Linux, only in Windows,
sorry about that.

Using a Custom Wizard.
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Script Wizards can be accessed via the File menu. 
A keyboard shortcut is available as well:  Ctrl + Shift + W.

After selecting command Start Custom Wizard the dialog shown above will
pop up, allowing you to select which Custom wizard to use. This list is filled
when DeskProto starts, and contains all valid Wizards found in the
subdirectory \Wizards\ of the DeskProto directory, for instance in C:
\Program Files\DeskProto 7.1\Wizards\
As most of the wizards shown in the illustration above require a rotation axis,
the list of wizards will be much shorter for users of a Free edition, Entry
edition and/or an Expert edition of DeskProto.

A Custom wizard can also be started by:
· calling its DPW-file as a  command line parameter.
· double-clicking it's DPW-file in Windows explorer.

When you are a user of a DeskProto Custom Wizard and need any Help
information, please refer to the documentation that came with that  Wizard.
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More information about Custom wizards can be found on the Custom
Wizard page.

3.2.17 Run Script

Normally when you use DeskProto you will load a CAD-file, set a number of
parameters, calculate toolpaths and save an NC program file. So you
manually perform a number of actions, in a specific sequence. In some
applications the actions to be done and the parameter settings to be used are
always the same, which makes it possible to automate this task. Such
automation can be achieved by Scripting.

A Script is a list of actions to be done, saved in a file. These actions of course
need to be described in a language that the computer will understand: in a
DeskProto script you need to use the JavaScript scripting languages. For
more information also see the Scripts page.

You can start a script via the "Run Script..." command the File menu.

Shortcut:

Keys: Ctrl+R  (Windows, Linux)  +R  (MacOS).

This command will open the Run Script dialog as shown above. Here you can
browse the Script file (files are seen with extension .dps for DeskProto Script
file) and then press the Run button to start it.
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Complete automation can be achieved by starting DeskProto with the name
of the Script file as command line parameter. Then this complete dialog will
be skipped: the script will be started and executed automatically. More
information about this in Command line parameters.

Note that also a special type of Script does exist, called the Script Wizard,
which does exactly as the name suggests. These script wizards can not be
started using this Run Script command.

Above you see the very simple script file ExampleScript.dps  that was
present in the dialog just shown. It contains (and calls) two functions, one to
load a 3D geometry file, and one to add and rotate a part. Line starting with
"//" in JavaScript are comment lines. This is just a very simple example: you
can add any DeskProto functionality here, which makes scripting a very
powerful tool for automation.

The second example script file that has been installed is called
ScriptedBottle.dps
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This script will load the bottle sample geometry, rotated and segment it (Part
Segment is the old name for the Material block, still used in the Scripts),
calculate toolpaths and save an NC file. No path for the NC Program file is
specified, so it will be saved in the default location for Write NC which is in
most cases is the (My) Documents folder.
When using such script as command line parameter you can even add an Exit
command: then the actual user does not need to perform any user-interaction
with DeskProto.

For more information on scripting see the DeskProto Script Reference. You
can find that on the DeskProto distribution CD, or without such CD email us
to obtain a copy.

3.2.18 Exit

This command ends your DeskProto session. DeskProto prompts you to
save projects with unsaved changes. In Windows and in Linux it can be found
in the Help menu, in MacOS in the DeskProto menu (as "Quit DeskProto").

Windows shortcuts:

Mouse: Click the application's Close button  (top right button of
the title bar).

Keys: ALT+F4

MacOS shortcuts:

Mouse: Click the red application's Close button  (top left
button of the title bar).

Keys: +Q

Linux shortcuts:

Mouse: Click the red application's Close button  (top
left button of the title bar).

Keys: Ctrl+Q
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3.3 Edit Menu

The Edit menu contains all options for Clipboard actions and a Properties
command, conform Windows conventions. The number of commands is very
limited though as DeskProto does not include an Undo function, and as Cut,
Paste, Select and Search actions are not applicable for DeskProto.

3.3.1 Copy

This Edit menu command is applied to the currently active item in
DeskProto.
That can either be one of the lines in the Project Tree or the image in the View
Window.

In the Tree the Project cannot be copied, so when that line is active an error
will pop up.
In case a Part or an Operation is active it will simply be copied: a copy of the
Part or Operation will be added to the Tree.

The image in the DeskProto View Window will be copied to the Windows
Clipboard.
The clipboard is used to cut and paste data between windows applications:
you can for instance Paste this image into a Word document. Copying data to
the clipboard replaces the contents previously stored there. This command
has no visible effect in DeskProto.

Shortcuts:

Keys: CTRL+C  (Windows, Linux)  +C  (MacOS).
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3.3.2 Properties

This Edit menu command can be used to edit the highlighted tree-item or the
active view. Depending on what is selected last this command will open one
of the following five dialogs:
Project Parameters , Part Parameters , Geometry Operation Parameters ,
Vector Operation Parameters , Bitmap Operation Parameters , Viewpoint .
This is conform Microsoft's specifications for Windows: Edit -> Properties
should open the Properties dialog for the selected item.

Shortcuts:
Keys: Alt+Enter (Windows, Linux)  Option+Enter  (MacOS: this is what
these weird icons mean).
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3.4 View Menu

The functions in the View menu let you control what is visible on your
screen.

3.4.1 Toolbar

The toolbar is the series of buttons displayed across the top of the
application window, below the menu bar.  The toolbar provides quick access
to many tools used in DeskProto. All these functions can also be accessed via
the menus.

To hide or display the Toolbar, choose Toolbar from the View menu. A
check mark appears next to this menu item when the Toolbar is displayed. 

The next command in the View menu is "Large Toolbar Buttons", with which
you can choose between two sizes of buttons. Again with a check mark if
large buttons have been selected (which is the default status). The best choice
will depend on the resolution of your screen: on a high-res screen the small
buttons will become too small. The size of the buttons can also be changed in
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the Preferences: on the Advanced tab you can set a scaling factor for the
complete user-interface.

Below a list of all buttons with for each button an explanation of its
functions.

Open a New project. Same command as New in the File
menu

Open an existing project.  DeskProto displays the Open
dialog, in which you can locate and open the desired DPJ-
file.

Save the open project with its current name as DPJ file.  If
you have not yet named the project, DeskProto displays
the Save As dialog.

Load or Add a Vector file into the project.

 

Load or Add a Geometry file into the project.

Load a Bitmap file into the project (adding is not possible:
max 1 bitmap file loaded).

Calculate the toolpaths for all visible operations of the
current part.

Show a Simulation of the result that you can expect after
machining the part.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), and show's its current
state.

Write the NC program for all visible operations of the
current part.

Send toolpaths to machine for all visible operations of the
current part.
This button is visible ONLY when this option has been
configured (in the Preferences); for some configurations the
button will show a different icon.
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Print the image as present in the current view.

Preview how the image would be printed.

Show or hide the Part information dialog.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), and show's its current
state.

Change the Layout out of the views.

Change which Items should be shown in the active view
(the Scene).

Change the Viewpoint (camera position) of the active view.

Set the viewpoint of the active view to Top view (XYZ  0 /
0 / 0 ).

Set the viewpoint of the active view to Front view ( -90 /
0 / 0).

Set the viewpoint of the active view to Left side view ( -
90 / 90 / 0).

Set the viewpoint of the active view to Bottom view ( 0 /
180 / 0).

Set the viewpoint of the active view to Back view ( -90 /
180 / 0).

Set the viewpoint of the active view to Right side view ( -
90 / -90 / 0).

Set the viewpoint of the active view to Isometric view.

Set the viewpoint of the active view to Default view.
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Restore the previous viewpoint settings.

Restore the next viewpoint settings (enabled only after
Restore previous view, to undo that restore).

Change mouse-function to rotation.
The four mouse-buttons are "toggle buttons", showing
depressed in case selected. De-selecting can be done by
pressing one of the other mouse-buttons. Always one of
these four buttons is selected.

Change mouse-function to panning.

Change mouse-function to zooming.

Change mouse-function to zoom window: zooming in by
selecting a specific area in the active view.

Note that one of these four mouse-functions is active at
any moment, so choosing one means deselecting the
previous one. DeskProto also offers other tools: the red
thumb-wheels on the screen are for rotations, the yellow for
pan and the blue wheel is for zoom. A handy alternative is
using the middle mouse button (the mouse-wheel): rotating
this wheel zooms, and moving the mouse with the wheel
pressed pans.

Set the Zoom percentage to 100% to show the complete
geometry.

Display the Help Topics dialog.

3.4.2 Large Toolbar Buttons

The Toolbar is the series of buttons displayed across the top of the
application window, below the menu bar.
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In case your have a high resolution monitor - or if you do not have clear eye-
sight - these buttons might be too small for you to clearly recognize them. To
solve that problem you can ask DeskProto to display large size buttons.
Note that in the Windows Display properties you can select a larger font for
all text.

To select or deselect this option, choose "Large toolbar buttons" from the
View menu. A check mark appears next to the menu item when the large
buttons are displayed.  Small toolbar buttons are 24 x 24 pixels, large buttons
are 32x32 pixels.

The illustration shows the difference between large size and small size.

In addition to these two sizes for the buttons DeskProto offers an option to
scale the complete user interface, on the Advanced tab of the Preferences
(select "User Interface"). 

3.4.3 Status Bar

The status bar is displayed at the bottom of the DeskProto window, and
gives status information about various relevant items. To display or hide the
status bar, use the Status Bar command in the View menu. A check mark
appears next to the menu item when the Status Bar is displayed.

The left side of the status bar describes the commands of toolbar buttons as
you point to them  (a sort of extra Help information). Menu commands are
also described when you use the arrow keys to navigate through the menus.
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In the middle area the most important parameters of the selected tree-item are
displayed: CAD filename and machine for the Project, dimensions for a Part,
cutter and precision for an Operation.

At the right side of the status bar the coordinates of the current mouse
position are displayed, however only when the geometry is displayed in one
of the six main views. These coordinate values shown are in “Translated”
coordinates: the coordinates as used in the NC file. This is a very handy
option that enables you to quickly check dimensions and positions on the
screen.

3.4.4 Part Information

The View menu command Geometry Information displays or hides the Part
Information dialog, which shows information about the geometry and the
current part.  A check mark appears next to the menu item when the dialog is
displayed.

Shortcuts

Toolbar:



Menu commands

Page 65

DeskProto Reference

3.4.5 Project Tree

In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left of the screen. In the above example the project 'Torso'

contains two Parts (icon  ), one with five Operations and one with
two. 
Three different Operation types can be present: Vector operation (icon

 ),  Geometry Operation (icon  ), and Bitmap operation (icon

 ).
When one of these Operations or Parts is in an error status this is shown by

the  error icon.

The lamp icon  indicates if a line in the Tree is visible (yellow) or

 not (gray). Only one Part can be current (visible) at a time. Of the
Operations in that part none, several or all can be visible. Click on a lamp
icon to change the status of that line. The Project line has no lamp icon as
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that line cannot be turned off. For Operation lamp icons two keyboard
shortcuts are present: Ctrl+Click means "Make Visible and Hide Others",
Ctrl+Shift+Click means "Make All (in)visible".

If you do not see a Project tree window, activate the option Project tree in
the View menu by selecting it.  The Project tree icon in the menu will become
active (drawn in a frame) and the Project Tree will be displayed. De-
activating this option (by again selecting it) will make the Tree window
disappear. The size of the Window can be changed by dragging it's borders
with the mouse.

Shortcuts:
The black arrow button in the border of the View Window opens and closes
this Tree Window.

The project tree offers you a number of functions:

Editing parameters
Double-clicking on a line in the tree will open the dialog to edit the
parameters of the Project, Part or Operation.

Making a part current
To see a particular part (in case you have defined more than one part) you
should make it current. To make a part current just click with the left mouse-
button on the gray lamp icon of that part. You can also use the Context menu
(see below). When a part is not current, its icon is grayed.
There is always exactly one part that’s current. No more, no less.
You cannot make a Part "un-current" by clicking on a yellow lamp icon: you
can only make a different part current.

Making an operation (in)visible
To be able to see how the toolpaths look for a particular operation, this
operation should be visible. To make an operation visible just click with the
left mouse-button in the tree on the gray lamp icon of that operation to make
it yellow (turn the light on). Clicking on the yellow lamp icon of a visible
project will make it invisible. When an operation is not visible, its icon is
grayed.
Of the operations in a Part none, one, several or all can be visible.

Displaying parameters in the status bar
When you single-click on one of the items in the project-tree, that particular
item is highlighted (shown with a blue background), meaning that it is
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selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus
When you right-click on an item in the tree a small menu pops up called the
context menu, offering you a number of functions (right-clicking on a Mac
with a one-button mouse can be emulated by pressing the Ctrl (Control) key
while clicking the mouse button).
The available functions will be different for each line of the tree, and will
include the following options:

Edit the parameters of that tree-item.

Add a Part to the project. The settings of the default part are used.
Add an Operation to that part. The settings of the first default operation are
used. There are Add options for a Vector Operation, a Geometry Operation
and a Bitmap Operation.
Copy an operation or a part will add an item that is identical to the current
one.

Remove a Part from the project. This is only possible when there will be at
least one part left after it has been removed.
Remove an Operation from that part. This is only possible when there will be
at least one operation left in the part where it belongs to after it has been
removed.

Move Parts and Operations in the Tree can be used when the sequence is
important (for instance first roughing, then finishing).

The other options in the context menu will be self explaining.
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3.4.6 NC File List

The NC files window shows a list of NC program files that have been saved
for this project. For each file its Name and Date are listed. This may be easy
for you to manage NC files for this project.

Hoovering over the filename (positioning the cursor there without clicking)
will make DeskProto show the complete file specification of the NC file in a
tooltip: see the screenshot above.

Double-clicking a file will open the file using the default program that has
been set for that file-type in File Explorer. For instance double-clicking a
.TXT file will open it in Notepad. You can configure your machine's control
software to open your NC files, or a text editor in case you want to check the
file's contents.

By right-clicking on any line in this window you can open a Context menu,
offering the following options:
· Remove the file-name from the list
· Delete the file
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· Open the file - same effect as the double-click just described
· Open the file location - which will show the NC program in File Explorer
· Send the file to your machine (only in case that option has been

configured)
· Add a file - for instance to add a TXT file with your own project

documentation.

The NC Files window can made visible or invisible by checking or unchecking
the option NC Files list in the View menu. This same effect can be achieved
by pressing the  black arrow button in the title bar of this window. Note that
the NC Files window can only be visible when the Project Tree Window is
visible too.

3.4.7 Thumbwheels

The Thumb-wheels that are drawn in the border of the View window offer
an easy way to change the camera position. You can use them by pressing the
left mouse button with the cursor on the wheel and then moving the mouse,
keeping the left button pressed. The cursor will become arrow-shaped to
guide you. You can look at the small green axis cube (the Orientator) in the
left-bottom corner  of the view to help you when rotating. The three red
thumb-wheels control the rotation (three axes), the two yellow wheels
control the pan (horizontal and vertical movement), and the blue one controls
the zoom.
The Thumb-wheels can be switched on and off in the View menu.

A trick that may be handy: when you keep the shift key pressed while
rotating the rotation will be done in steps of 15 degrees.
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Note that these rotations only change the viewing angle (camera position),
not the orientation of the part in space.
You can make the thumb-wheels visible and invisible using the Thumb-
wheels command in the View menu.

3.4.8 Layout

The View menu command Layout... displays the Views Layout dialog in
which you can change the layout of the views in which the geometry is
drawn. You can view either 1, 2, 3 or 4 views at the same time.

Shortcuts:

Toolbar:

3.4.9 Items Visible

The View menu command Items Visible... displays the Items Visible dialog,
in which you can change what is and what is not shown in the active view
(the Scene). In case none of the boxes is checked the View Window will be
blank. You can also select which operations should be visible.

Shortcuts

Toolbar:
Mouse: Right-click in a View, and select Items Visible in the shown
context-menu.

It is even quicker to just double-click inside a View.
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3.4.10 Viewpoint

The View -> Viewpoint submenu offers the following commands to set the
Viewpoint:

Top / Front / Left / Bottom / Back / Right  to set one of the six main views.
Isometric / Use default  to set the Isometric or the Default view.
Previous to return to the previous View settings.
Next (enabled only after Restore previous view) to undo that restore.
Custom will open the Viewpoint dialog.

The same functions can be accessed more easily using the Toolbar buttons.
Note that the Viewpoint can also be set using the Thumb-wheels or the
Mouse functions.
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3.4.11 Zoom

The View -> Zoom submenu offers the following commands:

Zoom In and Zoom out both change the zooming factor with 15 %.
Zoom All sets the zooming factor to 100 % to completely show all items.
Custom... will open the Viewpoint dialog, as the zooming factor is one of the
Viewpoint settings.

The latter two functions can be accessed more easily using the Toolbar
buttons.
Note that the Zoom can also be set using the Thumb-wheels or the Mouse
functions.

3.4.12 Mouse Function

This command determines the functionality offered by the left mouse button
inside the View Window. Four different functions are possible, of which
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always exactly one is active (the four functions are toggled). In the Toolbar
you can quickly see which function is active as that button is drawn
depressed.

Rotation: use the mouse (move it inside the graphics view with the left
mouse button pressed) to rotate your geometry.  Imagine that the geometry is
inside a large hollow glass sphere: with your mouse you can grab the sphere
anywhere, and rotate it round its center point, including the geometry. This
means that grabbing and moving (say) left in the upper part of the screen has
a different result than grabbing and moving left in the lower part of the screen.
Note that in fact the geometry is not rotated, but the camera position
(viewpoint) instead. You can see this, as during rotation the Orientator (the
small axis cube at the bottom left of your screen) rotates with the geometry.
If you want to rotate the geometry you should use the rotation option in the
Part Parameters.

Pan: use the mouse to pan your geometry (move it on the screen, left-right,
up-down, etc). When zoomed in you can use panning to determine which
part of the geometry to look at.

Zoom: use the mouse to zoom in and out: move the mouse up is zoom out
(push away), move down is zoom in (pull in). The center of the screen
remains directed to the same position.

Zoom Window: use the mouse to zoom into any part of the screen. Click the
left mouse button to define one corner of a bounding box, move the mouse
keeping the button pressed, and release it as you have reached the opposite
corner. The part of the screen inside the bounding box will now be displayed
as large as possible.

Using the first three functions the geometry is continuously redrawn during
the mouse movement. Depending on the size of your file and the speed of
both your computer and graphics card, this redrawing will take more or less
time. In case the redrawing is too slow, you can influence the number of
entities to be continuously redrawn: see Options - Preferences - Advanced.

An alternative for Zoom is rotating the Mouse wheel. This works no matter
which of the above buttons is active. In the Preferences you can reverse the
effect of the rotation direction.
An alternative for Pan is moving the mouse with the middle button (the
wheel) depressed. 



DeskProto Reference

Page 74

So when the mouse-function button “Rotation” on the screen is active for the
left mouse button, using these alternatives you have  Rotate, Pan as well as
Zoom easily available without having to press any Toolbar button.

Note that you can also use the red, yellow and blue Thumb-wheels on the
border of the graphics screen.
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3.5 Parameters Menu

The parameters menu offers access to all milling parameters. The three main
levels Project, Part and Operation follow the structure of the Project Tree:
one Project can contain one or more Parts (for instance a left half and a right
half), and each Part can contain one or more Operations (for instance for
roughing, finishing and detailing). Operations can be one of three types:
Vector Operation, Geometry Operation and Bitmap Operation.

3.5.1 Project Parameters

This Parameters menu command displays the Project parameters in which
you can edit the parameters of your current Project.

This dialog can be reached via the Parameters menu, first option.

Shortcuts:
You can double-click on the project-item in the project tree (the base level
item).
Or right-click on the project-item and select Project Parameters in the
context-menu.

This same dialog is used for the Default Project parameters.

3.5.2 Part Parameters

This Parameters menu command displays the Part Parameters dialog in which
you can edit the parameters of a Part.
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In case a Project has more than one Part, first a dialog will be shown in which
you can select the part you want to edit.

The part you select here will also become the current Part, and thus will be
displayed when you have finished editing.

Shortcuts
Double-click on a part-item in the project tree (one of the second level items).
Or right-click on a part-item and select Part Parameters in the context-menu.

3.5.3 Operation Parameters

This Parameters menu command displays the Operation Parameters dialog in
which you can edit the parameters of an Operation.
Operations can be either Geometry Operations , Vector Operations or
Bitmap Operations.

In case a Part has more than one Operation, first a dialog will be shown in
which you can select the operation you want to edit. 
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Shortcuts
Double-click on an operation-item in the project tree (one of the third level
items).
Or right-click on a operation-item and select Operation Parameters in the
context-menu.
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3.6 Create Menu

These options control all actions for calculating and saving NC toolpaths.
Note the submenu called Extra which offers some extra options. As these
extra commands are very specific and not important for most users these
commands have been "hidden" in a submenu.

3.6.1 Calculate Toolpaths

With this option you can create the toolpaths for the current part.

In case all operations of the current part are visible (see Visible Operations),
all the toolpaths for the current part will be calculated and drawn. When at
least one operation of the current part is invisible, you will be asked if you
only want to use only the visible operations for calculations or if you want to
use all operations.

In case you choose No for in order to calculate all operations, they all will be
made visible after calculations.
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It may be that you grow tired of this warning popping up all the time. Then
you can disable "Always show this message" by removing the mark from
the checkbox: the warning then will no longer be displayed. You can reset it
on the Advanced tab of the Preferences.

 

While calculating, DeskProto will show a progress bar like shown above.
You can select either the small dialog left or the detailed view right using the
black arrow (triangle) button in the lower right corner.  DeskProto is a multi-
threaded application, so it can split up the calculations over multiple cores
(in case you have a multi-core PC).

Each operation is assigned it's own core (so when you project has just one
operation the calculation will not be multi-threaded). Of course no more
threads can be running at the same time than the number of cores that is
available. The detailed view of the progress bar will show maximum 8 threads
(even on a 16 core PC) as otherwise the dialog would become too large.

Shortcut:

Toolbar:

In case you want to calculate all toolpaths for ALL Parts, then you can use
the command Calculate All Toolpaths in submenu Extra.
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3.6.2 Write NC-program File

With this option you can create an NC-program-file for the current part,
which can be sent to the machine to mill a part.

First you will be asked to give a Name for the NC-program file, in a standard
Save-As dialog, in which the correct file-extension for your machine has been
already entered. The only thing you have to do are make sure the file is being
saved in the right place and choose a filename.

The name for the NC file that you enter here may be automatically changed.
When you have more than one Operation and different cutters are used in
these Operations, a tool change will be needed. In case your postprocessor
specifies to start a new NC file at each tool change, two or more NC files will
be written. Names for these subsequent files will be automatically generated.
In case you chose the name Test.nc and the two operations were called
Roughing and Finishing, then the first file will be called Test#1_Roughing.nc
and the second file Test#2_Finishing.nc 

In case all operations of the current part are visible (see Visible Operations),
the NC file(s) will be written for all the toolpaths of the current part. When
at least one operation of the current part is not visible, you are asked if you
only want to use the visible operations for the NC file or if you want to use
all operations.

In case you choose No (so choose ‘all operations’), they will also all be made
visible afterwards. 

A next message box will pop-up in case one of the Operations is part of a
Chain:
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Normally the answer will be Yes, meaning that you want to write the
complete toolpath, including all Operations that belong to this chain of
Operations.

After that, the NC-program(s) will be created, using the post-processor that
is configured for the machine you have selected in the current part.

Shortcut:

Toolbar:

3.6.3 Send Current Toolpaths to Machine

For some CNC milling machines this option can be used to directly send the
toolpaths to the machine (or to the machine's control software) from
DeskProto. As this is not possible on all machines, by default this option is
not available (disabled: 'grayed out'). The option will become available after
configuring an output destination to be used, in the DeskProto Preferences.
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This feature is not available in MacOS and Linux, only in Windows, sorry
about that.

In the Preferences (Options menu) the following destinations can be
configured for this option:
· a Windows Printer driver (this is possible for a few machines only, like the

machines made by Roland)
· a port like COM1: or LPT1:
· an external program
· none, which is the default.
DeskProto will write a temporary NC program file (TempNC.ext, conform
the machine that you selected and its postprocessor) and will open the
external program with this file TempNC.ext as command line parameter. For
the other options DeskProto will simply write all information to the selected
port or driver (instead of to an NC file).

As external program you can configure the control software of your CNC
milling machine. However in fact you can select any program, also for
instance a milling simulation software, or (for the diehards) a plain text  editor
like Notepad to change the NC-program that DeskProto has just created.

After giving this command, the Machine Check dialog (shown above) will be
displayed to ask you if the machine is ready. After pressing 'Send' DeskProto
will start sending. 
In order to send an existing NC file you can use the command Send NC
Program File to machine.

If your machine does not support this: the standard route to get the NC
program file to the machine is to exit DeskProto and transfer the NC file
using the machine’s own communication software. If this software  runs on a
different computer you will first have to transfer the file to that PC, via a
network or by USB stick or CD.
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How to prepare the machine will be different for every machine. Still some
general guidelines can be given. Basically the following steps have to be taken:
1. Fixture a fitting block of material on the machine (look in the Geometry

Information dialog for the correct dimensions).
2. Mount the correct tool. Note: in case you use a different cutter than

entered in DeskProto an incorrect part will be produced.
3. Tell the machine where to find the material. In other words: set the

workpiece zero-point. By default DeskProto uses the left-front-top
corner of the material block as zero-point, you can change this at tab
'Zero-point' of the Part Parameters.

4. Send the NC-program file to the controller and start machining.

3.6.4 Estimate Machining Time

This command calls the Estimated Machining time dialog, in which
DeskProto gives a rough estimation for the machining time that it will take to
create your part. Be aware that this is a rough estimation: the actual time will
be influenced by many factors. The information for this dialog explains why. 

3.6.5 Show Simulation

With this option you can create a Simulation for the current part.
The command will immediately show the block of material, so before any
operation has been machined.
In the Simulated operations dialog that pop up you can select which
operations you want to be processed and press Calculate to start.

When the simulation is shown DeskProto will automatically make many
other items on screen invisible: Material block, Operation areas, toolpaths, Z-
grids. You can override that via the Items Visible dialog.

This is a toggled command: again giving the same command will make the
Simulation invisible.
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3.6.6 Extra

These Extra commands also are options for calculating and saving NC
toolpaths. As these Extra commands are very specific and not important for
most users these commands have been "hidden" in a submenu.

3.6.6.1 Calculate Z-grids

With this option you can create the Z-grids (an intermediate calculation
result) for the current part.

In case all operations of the current part are visible (see Visible Operations)
in the active view, all the Z-grids for the current part will be calculated. When
at least one operation of the current part is not visible you are asked if you
only want to use only the visible operations for calculations or if you want to
use all operations.

In case you choose No for ‘all operations’, they all will be made visible after
calculations.
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3.6.6.2 Calculate All Toolpaths

With this option you can create all Toolpaths for all Parts.

Where the other commands in the Create menu only concern the current part,
this one command influences all parts in the current project. 

All operations for all parts will be calculated, so also the invisible operations
(see Visible Operations).

3.6.6.3 Send NC-program File to Machine

For many CNC milling machines this option can be used to directly send an
NC program to the machine (or to the machine's control software) from
DeskProto. As this is not possible on all machines, by default this option is
not available (disabled: 'grayed out'). The option will become available after
configuring an output destination to be used, in the DeskProto Preferences.

This feature is not available in MacOS and Linux, only in Windows, sorry
about that.

In the Preferences (Options menu) the following destinations can be
configured for this option:
· a Windows Printer driver (this is possible for a few machines only, like the

machines made by Roland)
· a port like COM1: or LPT1:
· an external program
· none, which is the default.
DeskProto will open the NC program file, and will simply copy its contents
to the selected port or driver, or will open the external program with this file
as command line parameter.

As external program you can configure the control software of your CNC
milling machine. However in fact you can select any program, also for
instance a milling simulation software, or (for the diehards) a plain text  editor
like Notepad to change the NC-program that DeskProto has just created.
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In DeskProto the NC program file must have been saved first, in the correct
format for your machine. A standard File Open dialog will be displayed to
ask you for the file you want to transfer. After selecting the correct NC
program file the Machine Check dialog (shown above) will pop up: after
pressing Send DeskProto will start sending. 
In order to send the current toolpaths without first saving an NC file you can
use the command Send current toolpaths to machine.

If your machine does not support this: the standard route to get the NC
program file to the machine is to exit DeskProto and transfer the NC file
using the machine’s own communication software. If this software  runs on a
different computer you will first have to transfer the file to that PC, via a
network or by USB stick or CD.

How to prepare the machine will be different for every machine. Still some
general guidelines can be given. Basically the following steps have to be taken:
1. Fixture a fitting block of material on the machine (look in the Geometry

Information dialog for the correct dimensions).
2. Mount the correct tool. Note: in case you use a different cutter than

defined in DeskProto an incorrect part will be produced.
3. Tell the machine where to find the material. In other words: set the

workpiece zero-point. By default DeskProto uses the left-front-top
corner of the material block as zero-point, you can change this at
Translation tab of the Part Parameters.

4. Send the NC-program file to the controller and start machining.
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3.6.6.4 Export Z-grid / Simulation as

The Z-grid is a temporary representation of the geometry, used by
DeskProto to calculate the toolpaths.
The Simulation has of course a completely different aim, still the internal
representation in DeskProto is the same as for the rendered Z-grid. Both
items are represented by a large number of triangle on the outer surface:
polygon data.

As for geometry files in DeskProto the same polygon data representation is
used, it is possible to export the Z-grid and/or the Simulation as a geometry
file. For standard DeskProto use this is absolutely not needed, however it
might be useful for instance to use external software to compare original
geometry and simulation.

In the dialog box shown above you can choose how to export the Simulation.
For exporting the Z-grid exactly the same dialog is used. The following
options can be set:

The File type is either Geometry file, Bitmap file or XYZ file.
The use of a geometry file was described above.
For export as Bitmap file DeskProto will convert the 3D information to 2D
by translating Z-height to gray-value. For each point in the Z-grid one pixel
will be made. The highest Z-value will be given a white pixel, the lowest level
a black pixel, and all in-between values an according in-between gray value.
This is in fact the reverse procedure as used for the Bitmap Operation.
An XYZ file is a point cloud file: a number of points in 3D space, each point
represented by its 3 coordinates.

The Subtype sets the file format that has to be used.
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For Bitmap files you can choose one of four well known bitmap file types:
BMP. GIF, JPG, PNG and TIFF.
For Geometry files you can choose any of the formats that DeskProto
supports for 3D, as described in 3D Geometry.
For XYZ files only one format is supported: ASCII text file, one point with
three coordinates per line.

The function of  File name will be clear, you need to use the Browse to fill
this field or edit it's contents.

For rotation axis parts not all options are available.
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3.7 Options Menu

The Options menu gives access to all configuration options of DeskProto.
For normal use you will not need these options, they are present in case the
defaults set by the installation program should not match your wishes. The
option used most will be the Cutter library to create new cutter definitions,
as in many cases the default cutters will not match your real cutters.
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3.7.1 Library of Machines

For every NC program to be created DeskProto will apply a machine-
definition, which should of course match the NC milling machine that you are
going to use. A large number of predefined machine-definitions have been
included with DeskProto. This is the Library of machines, which has been
copied to your computer during Setup. 

When you first start DeskProto in most cases  you can simply select one of
these predefined machines, visible in DeskProto's Welcome screen (only
visible the first time that your start DeskProto). After that you still can
change this setting in the (default) Project parameters. 
In case you have a special machine that is not present in the list, in this
Machine library you can edit an existing machine definition or even make a
new definition for your own machine. 

You can find the Library of machines in the Options menu. When you open
this library first a warning message will be displayed that this option is meant
for advanced users only. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).



Menu commands

Page 91

DeskProto Reference

After this warning the dialog shown above will pop up. Here you can choose
the machine you want to Edit or Copy, and also Add and Remove machines.
After pressing Add, Copy or Edit the Machine dialog will be shown,
containing all parameters to define a machine in DeskProto.

Before you start defining a new machine, be sure a postprocessor for the
machine is already available. If not, configure one first in the Library of
Postprocessors (see the next paragraph). 

A machine definition is stored as a file name .mch in the DeskProto drivers
folder (See Preferences). These files can be copied, for instance to a different
PC to make the machine available on that PC as well. You can easily find each
driver file via button "Open location", which will open the Drivers folder in
MS Explorer, MacOS Finder or Linux File Manager.

The files are in Windows .ini format, and can be changed using a plain editor
like Notepad (changing in DeskProto is safer though). A line that starts with
a semicolon (;) is a comment.

Note:
Selecting a machine here does NOT change which machine is selected for the
current part. To select a machine for your current part open the Part
Parameters dialog.
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3.7.2 Library of Postprocessors

Every NC program created by DeskProto is made using a postprocessor.
This is the part of the DeskProto software that is machine-dependent: it
creates an NC program file that is in the format required by your NC milling
machine. In Windows terminology this piece of software should be called the
device driver for a particular output device, however, in milling terminology it
is called a Postprocessor and we will use that name. DeskProto makes it
possible to define your own postprocessor (which is not possible for
Windows drivers !). CNC machinists call this a ' Configurable Postprocessor'.

Note that you can not explicitly select the postprocessor that you want to
use as one of the milling parameters. It will be implicitly selected when you
select the milling machine. Each milling machine’s definition includes a setting
for the postprocessor to be used.

You can find the Library of postprocessors in the Options menu. When you
open this library a warning message will be displayed that this option is
meant for advanced users only. The warning is optional: when you remove
the mark from checkbox "Always show this message" it will no longer be
given. You can restore all warning messages on the Advanced tab of the
Preferences (in group Settings).
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After this warning the dialog shown above will pop up. In this Library you
can choose the postprocessor you want to Edit or Copy, and also Add and
Remove a postprocessor. After pressing Add, Copy or Edit the
Postprocessor dialog will be shown, containing all parameters to define a
postprocessor in DeskProto.
Note: as many parameters must be entered for a postprocessor definition, we
recommend not to use Add to create a new postprocessor, but to Copy one
that resembles the new one, and then Edit any changes needed. In most cases
the postprocessor “ISO plain G-codes” is a good one to use as a start.  Make
sure to save it using a proper new name.

A postprocessor definition is stored as a file name .ppr in the DeskProto
drivers folder (see Preferences). These files can be copied, for instance to a
different PC to make the machine available on that PC as well. You can easily
find each driver file via button "Open location", which will open the Drivers
folder in MS Explorer, MacOS Finder or Linux File Manager.

The files are in Windows .ini format, and can be changed using a plain editor
like Notepad (changing in DeskProto is safer though). A line that starts with
a semicolon (;) is a comment.

Note:
Selecting a postprocessor here does NOT change which postprocessor is
used to make an NC-program of the current part. A postprocessor
automatically will be selected by selecting a machine. To use a particular
machine in your project open the Part Parameters dialog. 
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3.7.3 Library of Cutters

For every NC program to be created (more accurately for every operation)
you will need to select a cutter. Obviously the cutter that you select for
DeskProto’s calculations must be available for your actual milling process. A
number of predefined cutter-definitions have been included with DeskProto.
This is the Library of cutters, which has been copied to your computer
during Setup. In many cases you can simply select one of the existing cutters
when editing the operation-parameters. However in case you need a special
cutter,  in this 'Cutter Library' you can change an existing cutter or define
your own.

You can find the Library of cutters in the Options menu. When you open this
library a warning message will be displayed that this option is meant for
advanced users only. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

After this warning the dialog shown above will pop up. Here you can choose
the cutting tool you want to Edit or Copy, and also Add and Remove cutters.
After pressing Add, Copy or Edit the Cutter dialog will be shown, containing
all parameters to define a cutter in DeskProto.
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A cutter definition is stored as a file name .ctr in the DeskProto drivers folder
(see Preferences). These files can be copied, for instance to a different PC to
make the machine available on that PC as well. You can easily find each driver
file via button "Open location", which will open the Drivers folder in MS
Explorer, MacOS Finder or Linux File Manager.

The files are in Windows .ini format, and can be changed using a plain editor
like Notepad (changing in DeskProto is safer though). A line that starts with
a semicolon (;) is a comment.

Note:
Selecting a cutter here does NOT change which cutter is selected for the
operations. To select which cutter to use: open the Operation Parameters
dialog.

3.7.4 Default Project

After choosing this option, first you will be warned that whatever you
change here will influence all new projects that you create later.  The warning
is optional: when you remove the mark from checkbox "Always show this
message" it will no longer be given. You can restore all warning messages on
the Advanced tab of the Preferences (in group Settings).

The dialog that pops up is equal to the Project Parameters dialog, it will thus
not be explained here. The difference is that this function adjusts the default
project settings, that will be used for every new Project that is created.

The default project is either a Vector project, a Geometry project or a Bitmap
project. You cannot define this project type in this dialog: the default project
type is defined by setting an Operation of the preferred type as first
operation in the Default Part.

Most important setting in this dialog is the default Machine. You can select
any machine in the list to be used as default; if needed you can add and/or edit
machines in the Library of Machines.

The functionality offered in this dialog is very limited: it is not possible to
define a default geometry, nor more than one part. Only the options Use Z-
values, Preserve Direction (Vector), Skip backfaces and Flip normals
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(Geometry) are allowed. The DeskProto default for these four checkboxes is
off.

Creating two or more Parts as default is not possible as that would make
things way too complicated (for instance which of the operations then would
be the actual default one...).
A default project file is not possible as that would conflict with the default
Part and the default Operations.
Note that for repeating jobs can also achieve much using Command line
parameters, by Scripting, and by auto-loading a template project file which
may have more Parts. For instance for automation of two sided machining.

Note:
The default project parameters are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button is supplied here to Restore the DeskProto
defaults for all parameters.

3.7.5 Default Part

After choosing this option, first you will be warned that whatever you
change here will influence all new parts that you create later. The warning is
optional: when you remove the mark from checkbox "Always show this
message" it will no longer be given. You can restore all warning messages on
the Advanced tab of the Preferences (in group Settings).

The dialog that then pops up is equal to the Part Parameters dialog, it will
thus not be explained here. The difference is that this function adjusts the
default part settings, that will be used for every new Part. You can use this
for instance when you want to use more than one operation for all your
parts, always apply a specific transformation or translation method, etc, etc.

An important setting for the default part is the first operation, as that defines
the project type. When the first operation is a vector operation the default
project is a Vector project, for a geometry operation it is a Geometry project
and for a bitmap operation it is a Bitmap project.

For the default part all three groups of settings can be accessed:
· Vector settings
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· Geometry settings
· Bitmap settings
even though no CAD data of that type is present here.

These default parameters will be stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux), and will be
different for every user. As it is possible to completely mess up these
settings, making it very hard to use DeskProto, an extra button is supplied
here to Restore the DeskProto defaults for all parameters. After using this
button you will have to again choose your machine as the default machine.

3.7.6 Default Vector Operation

After choosing this option, first you will be warned that whatever you
change here will influence all new Vector operations that you create later. The
warning is optional: when you remove the mark from checkbox "Always
show this message" it will no longer be given. You can restore all warning
messages on the Advanced tab of the Preferences (in group Settings).

The dialog that then pops up is almost equal to the Vector Operation
Parameters dialog, it will thus not be explained here. The difference is that
this function adjusts the default Vector operation settings, that will be used
for every new Vector Operation. This is the option to use for instance in case
you want a specific cutter automatically selected, need a specific feedrate or
spindle speed, etc, etc. These default parameters will be stored in the registry
(Windows) / file DeskProto.plist (MacOS) / file DeskProto.conf (Linux), and
will be different for every user. 

In case more than one default Vector Operation have been defined in the
default part, first a dialog is displayed in which you can select one of the
default operations:
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In this case the dialog will of course show Vector operations to choose from.

Two extra buttons are present, that are not available in the normal Vector
Operation parameters:

As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button Restore Defaults is present here to Restore
the DeskProto defaults for all parameters.
The DeskProto defaults are the built in values that were also present when
you first installed DeskProto.
The default cutter might be different though: for a Vector operation
DeskProto will select the first flat end cutter in the Cutter library with a
diameter of 6 mm (metric users) or 1/4" (inch users). It such cutter is not
present the first cutter in the library will be used.

And on tab page Profiling and extra Set... button is present, in section
Support tabs, to define the Default profiling support tab settings.

3.7.7 Default Geometry Operation

After choosing this option, first you will be warned that whatever you
change here will influence all new operations that you create later. The
warning is optional: when you remove the mark from checkbox "Always
show this message" it will no longer be given. You can restore all warning
messages on the Advanced tab of the Preferences (in group Settings).
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The dialog that then pops up is equal to the Operation Parameters dialog, it
will thus not be explained here. The difference is that this function adjusts the
default operation settings, that will be used for every new Operation. This is
the option to use for instance in case you want a specific cutter automatically
selected, need a specific feedrate or spindle speed, etc, etc. These default
parameters will be stored in the registry (Windows) / file DeskProto.plist
(MacOS) / file DeskProto.conf (Linux), and will be different for every user.

In case more than one default operation has been defined in the default part,
first a dialog is displayed in which you can select one of the default
operations:

As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button is supplied here to Restore the DeskProto
defaults for all parameters.

The DeskProto defaults are the built in values that were also present when
you first installed DeskProto.
The default cutter might be different though: for a Geometry operation
DeskProto will select the first ballnose cutter in the Cutter library with a
diameter of 6 mm (metric users) or 1/4" (inch users). It such cutter is not
present the first cutter in the library will be used.
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3.7.8 Default Bitmap Operation

After choosing this option, first you will be warned that whatever you
change here will influence all new Bitmap operations that you create later.
The warning is optional: when you remove the mark from checkbox "Always
show this message" it will no longer be given. You can restore all warning
messages on the Advanced tab of the Preferences (in group Settings).

The dialog that then pops up is equal to the Bitmap Operation Parameters
dialog, it will thus not be explained here. The difference is that this function
adjusts the default bitmap operation parameters, that will be used for every
new Bitmap Operation. This is the option to use for instance in case you
want a specific cutter automatically selected, need a specific feedrate or
spindle speed, etc, etc. These default parameters will be stored in the registry
(Windows) / file DeskProto.plist (MacOS) / file DeskProto.conf (Linux), and
will be different for every user. 

In case more than one default Bitmap Operation has been defined in the
default part, first a dialog is displayed in which you can select one of the
default operations:

In this case the dialog will of course show Bitmap operations to choose from.

As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button is supplied here to Restore the DeskProto
defaults for all parameters.
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The DeskProto defaults are the built in values that were also present when
you first installed DeskProto.
The default cutter might be different though: for a Bitmap operation
DeskProto will select the first ballnose cutter in the Cutter library with a
diameter of 6 mm (metric users) or 1/4" (inch users). It such cutter is not
present the first cutter in the library will be used.

3.7.9 Default View

The default view settings are used for any new project and any new part. 
They are also used for the command and button Use Default View.
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After choosing this option, first you will be warned that this option will only
influence the defaults. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

To edit the parameters of the default view a special dialog is used, as both the
dialogs to change the Items and the Viewpoint contain parameters that are not
suitable as default parameters. 

Items
Here it’s possible to set what will be shown initially. For an explanation of
the Items see Items visible dialog. Displaying Z-grids, toolpaths or
simulations is not possible in the default view, as these items have to be
calculated first.

Viewpoint
Only the rotation can be set here. Zooming of the default view will always be
100%, panning will be set to zero. 
After changing the default rotation you can restore the original DeskProto
defaults (which are stored internally in DeskProto and which can not be
changed) by pressing the appropriate button. 
Finally: instead of typing three values for X, Y and Z rotation, you can
manually adjust the rotation in your current view until you like it, and then
copy the settings, by pressing the button Copy from Active View.

Note:
The default view settings are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.

3.7.10 Preferences

This is open the Preferences dialog, in which you can edit DeskProto's
preferences. The dialog consists of 5 Tab pages.

In Windows and in Linux this command can be found in the Options menu, in
MacOS in the DeskProto menu.

In Windows these preferences are stored in the Registry



Menu commands

Page 103

DeskProto Reference

in MacOS  in file ~/Library/Preferences/com.delft-spline-
systems.DeskProto.plist 
in Linux in file ~/.config/Delft Spline Systems/DeskProto.conf 
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3.8 Help Menu

Finally the Help menu which gives access to the Help system and to the
About box. 
For the DeskProto Editions Entry and Expert  an extra option is present:
Upgrading...  (to a higher edition).

3.8.1 DeskProto Help

The Contents page of the DeskProto Help System, shown at the Contents
tab on the left of the Help Window, offers an overview of all available Help
topics, organized in 'books'. Each book can be opened by double-clicking its
line or by clicking on the arrow icon in front of the line. Five books are
available:
· Introducing DeskProto
· Screen Layout
· Menu commands
· Dialogs
· Concepts

The same five books can be found as Chapters in the DeskProto Reference
Manual (available as PDF for download), which contains almost exactly the
same information as the Help file.

In addition to the Contents tab page three more tabs are available in the Help
dialog: 
the Index page can be used to find help on a specific subject
the Bookmarks tab to mark pages that you want to remember
the Search page to locate any word or phrase in the Help system.
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While reading the Help text, additional related information can easily be
accessed by clicking on the active items (Hyperlinks) in the text. Active
words are shown in blue and underlined, while the cursor will turn to a hand
when moved over an active item.

The online Help system that has been installed with DeskProto can be
started from the Help menu. In addition some other methods to open Help
are available as well:

· The Help button on the Toolbar: 
· Pressing the F1 Function key on the keyboard (for MacOS this is Fn+F1).
· All dialogs have a Help button, providing Help information about the

use of that particular dialog.

3.8.2 Quick Start

Instructions about how to use DeskProto are available in a Tutorial book
(either printed or as PDF download), meant to step by step introduce you to
the functions that DeskProto offers. It is recommended to read and execute at
least lessons number one and two of this Tutorial before starting to make
parts with your own CAD-data. As an alternative you can find many
instruction videos, both on the DeskProto website and on YouTube.

However, if you are not a great manual reader and want to start at once
exploring DeskProto, at least read this Quick Start first. It is meant to explain
the basic ideas of DeskProto: you will need this information to be able to
understand what is happening. After that, novel users are advised to first use
the Wizards, that will guide them through all steps needed to generate an NC
program file. In all cases do not forget to use the Help file, which will explain
every DeskProto screen in detail.
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The DeskProto screen contains standard items like the title bar (top line),
menu bar, toolbar (the row of buttons below the menu) and status bar
(bottom line). The center area is divided into three tiles: the large View
window on the right, and the windows Project Tree and NC files on the left.
Follow the links for more information on any item.

The above screenshot shows the Windows version of DeskProto. The
MacOS  version has an extra menu choice: the DeskProto menu, on the left
side of File. It is visible on the top of the screen, so not in the DeskProto
window. This is conform the MacOS standard and won’t confuse any Apple
user.

The DeskProto menu in Linux is identical to the menu in Windows, and in
most cases part of the DeskProto window. Though some Linux versions
allow the menu to be shown at the top of the screen (instead of at the top of
the dialog).

For now it is important to know within this screen two different user-
interfaces exist: the wizard-based interface and the dialog-based interface.
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[1] Wizard-based interface.
New users are advised to use the DeskProto Wizards, that will guide them
through all the steps needed to generate an NC toolpath file using their own
CAD-data. The illustration above shows a typical wizard page. A wizard will
set the same parameters as are available in the dialogs, only now they are
presented in a sequential series of screens, and only the most important
parameters are shown. You can find the wizards via the Start Screen or via
the File menu.

[2] Dialog-based interface.
When using the Dialog-based interface you need to know where to find the
parameters. 
In this interface you can define parameters on three levels:
1. Project parameters include the name of the CAD-data file(s), the machine
and the number of Parts that you want to use in this project.
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2. Part parameters define What will be machined. These set size,
orientation, position and alike.
Within each Part you can use one or more milling Operations.
3. Operation parameters define How it will be machined.
These are in fact the only real 'milling parameters'.  Three different types of
operation are available: Vector Operation, Geometry Operation and Bitmap
Operation as for these three types of data different settings are needed.

The Project is the central concept of DeskProto. All information about a
project is stored in a Project-file (name.dpj), which is the file to be opened
when starting and to be saved when finishing. The project file contains all
milling parameters and viewing parameters, and also contains references to
the CAD-files (so the CAD-data is not included). 

You can imagine the tree-like structure of a project, which is displayed in the
Project Tree at the left side of the DeskProto screen: see the illustration
above. This sample Project “Bottle” consists of one Part called “Half bottle”
and three Operations called “Roughing”, “Finishing” and “Contour”. Each
operation line includes a lamp icon that you can switch on and off to make
the operation (in)visible. The project will be named when saving it for the
first time, until then the tree displays the name “untitled”.

Note 1: four different Editions of DeskProto are available: Free, Entry,
Expert and Multi-axis. The Free edition only offers basic CAM
functionality, Entry and Expert contain subsets of the available parameters,
Multi-Axis includes all functionality. For the rest all editions are equal.

Note 2: to open a CAD-file in DeskProto you have to use "Load Vector
file..." "Load Geometry file..." or "Load Bitmap file..." in the File menu (if
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needed start a New project first). You cannot use File>Open, as you do not
yet have a DeskProto project file for this new project. The CAD-data that
you load will be available for all Parts and for all Operations.

The functions of DeskProto can be reached using the pull-down menus or
using the buttons on the toolbar. The most important menus are described
below:

* The View Menu offers the opportunity to change what data should be
displayed on your screen and how that should be done. Also try changing
your view by rotating the six colored thumbwheels on the screen, and by
using your mouse inside the view window. In fact most of the functions in
the View menu can be activated most easily by using the button bar.

* In the Parameters Menu you can edit all vector/geometry/bitmap
parameters and all milling parameters. For simple parts it is sufficient to edit
only the front Tab page for both Part and Operation parameters: the other
Tabs can come later (as all parameters have suitable default values).

* The Create Menu is the most important; this is where you can start the
milling calculations and write the NC program file. 

The most important buttons for the DeskProto process are:

 

The first step is to Load CAD data:
Vector or Geometry or Bitmap (or a combination).

After setting some parameters you can then
Calculate the toolpaths and view them on the
screen.

Optionally you can show a Simulation of the
result, 
to check your toolpaths for correctness.

Finally you Write the NC file
and send it to your  CNC milling machine.
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We do hope you will enjoy using this software, it certainly can help you to
make your prototyping really rapid.

3.8.3 Create Problem Report

When asking for support, DeskProto users often send us the DeskProto
project file (DPJ file), intended to make us see what they are doing.
Unfortunately this is not sufficient: this DPJ file only contains the
parameters that you have set. And in order to reproduce the problem also the
CAD file(s) are needed. Plus the driver files for cutters, machines and/or
postprocessors. The Create Problem Report option automatically bundles all
these files in one ZIP file, that you then can send to us.
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Creating a problem report is done in four steps:

Step 1 asks you to enter your Contact details: information about how we
can reach you (we ask only the bare minimum).

In Step 2 you are asked to describe the problem, in plain text. The more
clear you describe the problem, the more chance that we can indeed reproduce
it. And that is absolutely needed in order to start looking for a fix.
Note that you cannot actually use DeskProto while this Problem Report
dialog is opened, so you cannot walk through all steps and type them during
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the process. If that is what you want you need to open Notepad, and after
finishing copy the text from Notepad to this dialog.

In Step 3 DeskProto will collect all information needed to reproduce the
problem: all files as just mentioned, and in addition some basic information
about the Windows version and the graphics card that you are using.
Step 3 can only be started after you have entered the information asked for in
steps 1 and 2.
As one of the files to be collected is the DPJ file, DeskProto will ask you to
first save this file (in case needed). It is also possible to create a Problem
Report ZIP file when no project is loaded: the ZIP file then will not contain
DPJ file and CAD-data.

Step for finally saves the report file: a ZIP file that you can email to us.
Default name for this file is DpReport_Name.ZIP  in which Name is the
Name that you just entered.
Default location is your current directory, so the folder where you just loaded
or saved your geometry and/or project.
You are however free to change file name and file location.

This same ZIP file can of course be used for other purposes as well, like
sending a complete project to some other DeskProto user, or for archiving
purposes.

3.8.4 Activate license

In Windows and in Linux this dialog can be found in the Help menu, in
MacOS in the DeskProto menu.
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The Free Edition of DeskProto can and may be used without buying a
license.
Users who need more functionality can buy a license to activate (unlock) one
of the higher Editions: Entry, Expert or Multi-Axis. One of the options in
the Free edition is to evaluate (trial) these higher Editions - when trialling a
watermark (the "Trial cross") will be visible in all machined parts.

In all cases you need to first download the DeskProto Setup file from our
website www.deskproto.com and instal DeskProto on your computer. This
Setup file is the same for all Editions of DeskProto.

A free DeskProto license is given to any user: you are welcome to use the
Free Edition of DeskProto free of charge.

A paid DeskProto license can be bought either via a reseller or via our
webshop. After buying you will receive the license (a PDF file) containing
two strings: a Name and a Key.
The Name contains the name of the buyer (either a person or a company)
and his/her/its location (city, village): information that will be clearly shown
at each program start.

http://www.deskproto.com
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The Key is a code of 340 characters, containing information all license
information. Each Key is valid only for the Name on that same license.

The Activate dialog is meant to activate a DeskProto license and unlock the
extra functionality for the Edition that you have bought. Both the complete
Name-string and the 340 character Key have to be entered exactly as given,
including case (upper or lower), spaces, commas, points, etc. Any small
difference will make DeskProto refuse to activate. So use Copy/Paste to enter
this information in this dialog.
After filling both fields you can use the Activate button to make DeskProto
activate the license.

Make sure to carefully save and backup the license: you will
again need Name and Key when (for instance) you buy a new
computer.

A registered version of DeskProto will clearly show the Name of it's owner:
in case that is not you then you are running an illegal copy!

After Activating it is also possible to Deactivate, allowing you to again
convert the program from paid license to free license. Needed for instance
when you sell your computer.
You may Activate and Deactivate as many times as you like: information
about the previous licenses will simply be deleted. 
Activating a new license is also possible without Deactivation first.

Both for Activating and for Deactivating administrative privileges are
required (Windows).

In Windows the license activation affects all users of that PC, in MacOS  and
in Linux the activation information can be accessed only by the current user:
every next user will also need to activate the license on that same computer.

3.8.5 Upgrade information

In Windows and Linux this dialog can be found in the Help menu, in MacOS
in the DeskProto menu.
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Displays a dialog screen that lists the advantages of the higher DeskProto
Editions 
(only shown in the Free Edition, the Entry Edition and the Expert Edition).

DeskProto is available in four different Editions:
1. Free
2. Entry
3. Expert
4. Multi-Axis

The difference between the editions is the number of parameters that you can
set (both Part parameters and Operation parameters), and (for the Free
edition) the number of Parts and Operations.

The difference between the Expert Edition and the Multi-Axis edition is that
(of course) more axes are available in the latter: the A-axis and B-axes rotation
axes.

Of course for registered users of DeskProto such upgrade is available at a
special upgrade price.



Menu commands

Page 117

DeskProto Reference

3.8.6 Check for Update

This command will make your DeskProto contact the website
www.deskproto.com (an internet connection is required) to see if a newer
Service Release (bugfix build) is available for download. In Windows and
Linux this dialog can be found in the Help menu, in MacOS in the DeskProto
menu.

Once every few months a newer build of the program is released, containing a
number of bugfixes.
You can find the Revision number of your DeskProto in the About box.
And you can find information about the Revisions that have been released on
www.deskproto.com/support/buildhistory.htm

The command Check for Updates will automatically compare the Revision
number of your DeskProto with the Revision number of the latest release, it
will tell you when a newer release is available for download, and it will ask if
you ant to download it. When you answer Yes DeskProto will open the page
on the DeskProto website where you can download the Updater Setup.

Running the Updater Setup will recognize your DeskProto license and keep
that active.
Only the program will be updated: drivers, scripts, language files etc will
remain as they were.

When no internet connection is available DeskProto will tell you that it
"Could not perform the Update check".

http://www.deskproto.com
http://www.deskproto.com/support/buildhistory.htm
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3.8.7 About DeskProto

In Windows and Linux this About box can be found in the Help menu, in
MacOS in the DeskProto menu.

The DeskProto About Box will display information about the DeskProto
version that you are running:

Version number, like 7.1

Edition - so either Free, Entry, Expert or Multi-Axis, and if the program is
32 bits or 64 bits.

Build date - the format of the build date is “yyyy-mm-dd”, and it shows
that date on which your file DeskProto.exe has been built.
Revision number - each build of the file DeskProto.exe receives a new
revision number.

Serial number - Each new (paid) license gets a new number, so the Serial Nr
of your license is unique (empty for the Free edition).

Licensed to - the Name on which this license has been registered (empty for
the Free edition)

Copyright notice - all rights reserved. You do not own the software: you own
a license to use the software

Contact information - DeskProto is made by Delft Spline Systems in the
Netherlands

Short program description.

At the bottom of this dialog, next to the OK button you can find the button
Show Copyrights.
Pressing that button will show the license texts for all external libraries that
are used in DeskProto.
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IV Dialogs

4.1 File

4.1.1 Vector Data Transformation

DeskProto allows loading more than one Vector data file and more than one
Geometry file. For each file DeskProto simply reads the coordinates in the
file (as defined by the CAD systems that wrote each file) and draws the
CAD data using these coordinates. 

This may result in unwanted collisions and/or overlaps. Such unwanted
situation can be corrected as you can give each file it's own set of
transformations. For instance a translation to position two identical curve
sets next to one another. 
In the Vector Transformation dialog these Transformations can be set for a
Vector Data file.
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For Vector files that also contain Z-values a third entry (Z) is present for
Scaling, Mirroring and Translating.

This dialog can be opened on the Vector page of the Project parameters, using
button Transform....
It will also pop up when loading an extra Vector file, and enables you to
position the new vector data relative to CAD data that is already present. It
offers basically the same transformations as also present in the Part
Parameters (see there for more help), however these will be applied only to
this one vector file.

A handy tool in this dialog is the Preview button, as it will draw the new
vector curves according to the transformations that you entered in the dialog.
If this new position is not what you need, you can enter new transformation
values and again press Preview for a new drawing. When all is OK you can
acknowledge with OK.

You need to realize that in the drawing that you see the Part Transformations
will be applied as well, after the transformations that you enter here. This
means that (for instance) when in the Part Parameters a rotation of 90 degr.
round Z is applied, a translation along Y that you enter here will result in a
translation along X on your screen..
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4.1.2 Geometry Transformation

DeskProto V7 allows loading more than one Vector data file and more than
one Geometry file. For each file DeskProto simply reads the coordinates in
the file (as defined by the CAD systems that wrote each file) and draws the
CAD data using these coordinates. 

This may result in unwanted collisions and/or overlaps. Such unwanted
situation can be corrected as you can give each file it's own set of
transformations. For instance a translation to position two identical
geometries next to one another. 
In the Geometry Transformation dialog these Transformations can be set
for a Geometry file.

This dialog can be opened on the Geometry page of the Project parameters,
using button Transform....
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It will also pop up when loading an extra Geometry file, and enables you to
position the new geometry relative to CAD data that is already present. It
offers basically the same transformations as also present in the Part
Parameters (see there for more help), however these  will be applied only to
this one geometry file.

A handy tool in this dialog is the Preview button, as it will draw the new
geometry according to the transformations that you entered in the dialog.  If
this new position is not what you need, you can enter new transformation
values and again press Preview for a new drawing. When all is OK you can
acknowledge with OK.

You need to realize that in the drawing that you see the Part Transformations
will be applied as well, after the transformations that you enter here. This
means that (for instance) when in the Part Parameters a rotation of 90 degr.
round X is applied, a translation along Y that you enter here will result in a
translation along Z on your screen..

4.1.3 Save Vector Data Options
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The Save Vector Options dialog enables you to apply Transformations that
you have set in the Part Parameters. It will pop up after pressing command
Save Vector Data As... in the File menu, and after pressing the Save as...
button on tab Vector of the Project parameters.

It offers the five Vector transformations that can be set in the Part Parameters
(see there for more help). Note that only those transformations can be
checked that indeed have been applied.  When you check a transformation,
DeskProto will save the Vector data including that transformation. So the
new file will then contain rotated curves, scaled curves, etc. This is ideal for
instance for saving a scaled or rotated version of your CAD file.

In case multiple vector data files have been loaded: when calling this
command from the file menu the total of all vector curves will be exported.
All Vector Data Transformations that have been set for each file on Project
level will also be applied when exporting a Vector data file.

4.1.4 Save Geometry Data Options
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The Save Geometry Options dialog enables you to apply Transformations
that you have set in the Part Parameters. It will pop up after pressing
command Save Geometry Data As... in the File menu, and after pressing the
Save as... button on tab Geometry of the Project parameters.

It offers the six transformations that can be set in the Part Parameters (see
there for more help). Note that only those transformations can be checked
that indeed have been applied.  When you check a transformation, DeskProto
will save the 3D geometry including that transformation. So new file will then
contain rotated geometry, scaled geometry, with support tabs, etc. This is
ideal for instance for saving a scaled or rotated version of your geometry file.
This feature also can be used to create more than 4 support tabs (save with 4
tabs, load again and again add tabs).

In case multiple geometry files have been loaded: when calling this command
from the file menu the total of all geometries will be exported.
All Geometry Transformations that have been set for each file on Project
level will also be applied when exporting a Geometry file.
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4.2 Wizards

The Wizard-based user interface is an important feature of DeskProto. It
makes it possible for users without much CAM know-how to easily create
the toolpaths that they need for their projects. Each wizard is a series of
dialog screens (forms) that need to be filled in: the wizard in a way 'takes
your hand' and guides you through the process of creating toolpaths.

When you create a project using a wizard and you save the project without
making any changes after finishing the wizard, on re-opening DeskProto will
show the project using the same wizard. So it is possible to use DeskProto
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seeing only the wizard interface. This is new in DeskProto V7, and will be a
great help for inexperienced users.

Navigating the Wizard is done using the Wizard buttons, on the bottom of the
screen:

  Back and    Next let you navigate the wizard
pages,

  Cancel and    Help are standard buttons.
Every wizard page has its own Help information page.

  Finish will replace Next on the final page of the Wizard,

  Apply will apply the currently selected settings and refresh
your screen.

  Calculate will calculate the toolpath with the currently
selected settings.

Navigation icons: The DeskProto wizards start with the page shown above,
called "Which Wizard?". On the top of the page you can see one icon, after
selecting one of the wizards a series of icons will be shown: one for each
wizard page. At this point these extra icons are all gray, when progressing
they will be colored: then they can be used as tab-pages to navigate (click on
a colored icon to jump to that page of the wizard).

Help information: Important are the  yellow question marks in front of
each question. When you position the cursor over such mark a Tooltip will
pop up, giving extra information about that question. It will also tell you
where to find that setting in the Dialog based interface.

The first question, "Machine to be used", in most cases needs not be changed
as your default machine will already have been selected here.

The second question, "Type of milling", presents the six wizards that you can
choose from: you need to select one before continuing.  
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Not all wizards will be available for all users (some may have been grayed
out): some wizards are not available in all DeskProto Editions, and some
wizards are only available in case you selected a machine with a rotation axis. 
Also: in the Free edition and the Entry edition the available wizards do not
include all described options.

Basic Vector Machining
This wizard creates 2D toolpaths for just one Vector file (DXF, EPS, AI,
SVG). It is meant for novice DeskProto users, and explains this procedure
step-by-step. You can choose to use either Profiling or Pocketing toolpaths.

Basic Geometry Machining
This wizard creates 3D toolpaths for just one Geometry file (STL, DXF). It
is meant for novice DeskProto users, and explains step-by-step the
procedure to create an NC toolpath file (NC program) based on your
geometry. The model will be machined from one side, using three operations:
Roughing, Finishing and a smoothing contour.

Basic Bitmap Machining
This wizard creates 3D toolpaths for a relief based on a Bitmap file (BMP,
GIF, JPG, PNG, TIFF file). It is meant for novice DeskProto users, and
explains this procedure step-by-step. 

Advanced Geometry  (the three advanced wizards are all for geometry
machining):

Two sides, manual flip, also called Two-sided Wizard  (not available in the
Free Edition and the Entry edition)
This advanced wizard is a unique feature of DeskProto, and makes it very
easy for you to create a compete 3D part by machining it from two sides, on
any three axis milling machine. DeskProto assists you by taking care of the
repositioning needed to machine the second half: no need to change the
workpiece zero point (starting position of the cutter).

Two or more sides, automatic rotation, also called N-Sided Wizard
 (available only in the Multi-Axis edition)
N-sided milling is meant for machines with a rotation axis (A-axis), and
allows indexed machining: this wizard generates toolpaths to machine the
part from several (N) sides, with a rotation in-between. The number of sides
can be freely chosen: for two sides the result is the same as for the previous
wizard, though now with automatic rotation.
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Rotary Machining   (available only in the Multi-Axis edition)
If your machine is equipped with a rotation-axis (A-axis) you can use this
wizard to create toolpaths for a model that is machined from all sides:
rotation axis machining. In contrast to the previous wizard, now the material
rotates during machining. 
A rotation axis is an extra piece of equipment that lets your model rotate
during machining (just like a roast rotating on a spit above a barbecue).

Note that all functionality offered by the wizards is also available in the
dialog-based user interface: the wizards are only meant to make things easier
for you, they do not add new options. After finishing any wizard you can
still use the dialogs to fine-tune the settings that the wizard made.

You can find the Wizard in the File menu  (File >> Start wizard)  or in the
Start Screen.

Shortcut:

Keys: Ctrl+W  (Windows, Linux)  +W  (MacOS).
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4.2.1 Custom Wizard Page

Custom wizards can be added by any user, as explained on the Custom
Wizards page.
Because of that in the Help file no Help pages are available for these wizards:
on all custom wizard pages the Help button will  show this same help page.

For all pages the four buttons at the bottom of the page will be the same:
Cancel, Help, Back and Next. The meaning of each button will be clear.

The rest of the dialog has been filled by whoever made this custom wizard.
So in case of any question read the wizard's documentation, or contact the
supplier of the wizards.

Custom wizards are not supported in MacOS and in Linux.
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4.3 Parameters

4.3.1 Project Parameters

The Project parameters dialog offers all settings that are available on project
level. Most important are the CNC milling machine to be used and the CAD
data files. Each of the five tab pages will be described in detail below.

Note that the Project Parameters dialog has an extra button: Apply. Using
this button you can apply any new setting immediately, without having to
first close the dialog. Any changes will be immediately reflected in the
drawing on screen and in the Geometry information dialog.

This dialog can be reached via the Parameters menu, or by double-clicking the
Project line in the Tree
The same dialog is used for the Default Project parameters.

General parameters

Filepath
This filed shows the path and name of the currently loaded Project file. This
information cannot be changed in this dialog. To start a new project or to save
the project using a different name, see the File menu.
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Machine
Here you can select the machine you want to use. DeskProto will use the
machine information to check if the part is not too large for the machine, if
the speeds that you enter are possible for this machine, if the number of axes
is available. The selected machine also defines the format of the NC Program
file, because the machine information states which postprocessor (driver) to
use. You can have a look at the machine-definition using the option Library of
machines in the Options menu.

Normally you do not have to bother with this parameter as your machine will
be the default machine (as set the first time that DeskProto was started, in
the Initial Settings). If not, you can change the default machine using the
option Default Project Parameters in the Options menu.
Note: when you change the selected machine DeskProto will automatically
change values for Feedrate and Spindle speed for all operations in the project,
as the new machine may not be capable of outputting the old values.

Parts
The number of Parts present in the project can be controlled here, using the
buttons Add, Remove and Copy. Multiple parts can be used in a project to
create different models, for instance a scale model and a full size, or a front
part and a back part. 
You can also influence the sequence of the parts, using the two Move
buttons. The part that is selected (it’s line made blue) will be moved in the
direction of the arrow.  This does not have any effect an the resulting
toolpaths, it can be handy though in order to neatly arrange your parts in case
you have many.

Vector parameters
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Vector files
This tab page shows all Vector files (if any) being used in this project. When
more than one file is present only one file is selected in this dialog (blue
background color): the buttons on the right will influence that file (except the
Add button of course).
You can change the set of files using the Add button and the Remove button
on the right, to add and remove files. 
When a vector file has been changed (for instance it is again exported from
CAD) you can Reload it.
Very powerful is the Transform option: for each file you can define a set of
transformations, for instance in order to position two vector drawings next to
one another in 3D space.
Save As offers the option to save one vector file. The Save Vector data
options dialog will op up, allowing you to select which transformations to
use for the new file.
The File Info button finally shows information of the selected vector file:
type, size, number of curves, dimensions.

Use Z-values
Vector machining in most cases will be done using two-dimensional CAD
data: a drawing that does not contain any Z-values (only X and Y, to be
shown at Z=0.0).  Nevertheless DeskProto will also accept vector files that
contain Z-coordinates. When opening such file DeskProto will ask you
whether or not you want to use these Z-coordinates.  With this checkbox you
can later change this setting.
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When you use the Z-coordinates, the machining depth that you set in the
Vector operation parameters will be taken relative to the Z-level of the curve
(or point) as it has been defined in CAD.
When using Z-values, not all options in the Vector operation will be available.
This option can also be checked for vector files that do not contain Z-values:
DeskProto then will use Z=0 for all points on the vector curves. This will
influence the result when both vector files and geometry files are loaded: the
CAD-data zero level of the geometry file is used for the curves, where
normally the curves will be drawn at the top of the block.

Preserve curve direction when loading
When loading a DXF file DeskProto checks if it can combine separate curves
(polylines) to one curve: in case the endpoint of curve 1 is the same as the
startpoint of curve 2 then for machining it is best to process them as one
combined curve. This is especially important for recognizing closed curves. 
When checking if two points are equal DeskProto applies a small tolerance
(0.001 mm), in order to correctly process 'sloppy' drawings.
This option tells DeskProto what to do if two curves share either both
endpoints or both startpoints: the curves then can be combined only if the
curve-direction of one curve is reversed. As default setting DeskProto will
indeed reverse curve direction in order to combine as many curves as
possible; checking this option forbids DeskProto to do so. This may be
handy in case you want to use the curve direction as defined in CAD for your
toolpaths.

Geometry parameters
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Geometry files
This tab page shows all Geometry files (if any) being used in this project.
When more than one file is present only one file is selected in this dialog (blue
background color): the buttons on the right will influence that file (except the
Add button of course).
You can change the set of files using the Add button and the Remove button
on the right, to add and remove files. 
When a geometry file has been changed (for instance again exported from
CAD) you can Reload it.
Very powerful is the Transform option: for each file you can define a set of
transformations, for instance in order to position two geometries next to one
another in 3D space.
Save As offers the option to save one geometry file. The Save Geometry data
options dialog will op up, allowing you to select which transformations to
use for the new file.
The File Info button finally shows information of the selected geometry file:
type, size, number of facets, dimensions.

Skip Backfaces
For heavy calculations you may want to check the option Skip Backfaces in
order to save calculation time. This option will skip all facets (triangles) of
which the invisible inside (the backface) is on top as seen from the positive
Z-direction. This means that half of the triangles can be skipped, which
results in shorter calculation time. The resulting toolpath will be the same (for
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a valid geometry). As on current computers the difference in calculation time
is not very large the option is no longer checked by default.
For corrupt geometries you may need to disable this function.

Flip Normals
In DeskProto for each facet (triangle) a  normal vector is stored, indicating
which side of the facet is on the outside of the geometry (also see the
previous paragraph, on Backfaces). This information is stored in the STL file.
When using a corrupt STL file this information can be wrong. In case ALL
normal-vectors point to the inside of the geometry you can use this option
Flip normals to correct the normal information. This option is available only
when Skip Backfaces has been checked, as otherwise the normal direction is
not used anyway.

Bitmap parameters

Bitmap file
This tab page shows the Bitmap file (if any) being used in this project (for
bitmap data only one file can be loaded in a DeskProto project).
You can change this file using the Browse button, on the right, and you can
remove it with the Remove button. 
When a bitmap file has been changed (for instance again exported from CAD)
you can Reload it.
Save As offers the option to save the bitmap file.
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The File Info button finally shows information of the selected bitmap file:
type, size, number of pixels, DPI, dimensions.

For bitmap files no extra options are available.

Chaining parameters

Chaining is an option meant to combine Operations in various Parts into
one large NC Program file. Normally only Operations in the same Part will be
combined into one NC Program file. This option is used when more than one
part is involved, for instance by the N-sided milling wizard, for indexed
machining. 
Note that chaining is of course only available in case more than one Part is
present in the current project.
Also note that Chaining is an option for advanced users: only apply this
feature this when you know how to use it.

The button Create adds an empty new chain to the list of chains.

The button Remove deletes the currently selected chain.

The combo box Chain shows the currently selected chain (if any), and makes
it possible to select other chains. Chain names are automatically generated:
Chain 1, Chain 2, etc.
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The field Chained Operations shows all operations in the currently selected
chain. You can use the up and down buttons to change the sequence of the
operations in the chain.

The field Unchained Operations shows all operations in the project that are
not (yet) part of a chain. You can use the left and right arrow buttons to
move unchained operations to a chain and to remove operations from the
selected chain.

In the Operation Start/End commands you can add extra commands to be
executed in-between the two chained operations: either after the first
Operation or before the subsequent operation. For instance to rotate the
rotation axis to the correct angle before starting that operation (needed for
indexed machining).

4.3.2 Part Parameters

The Part parameters dialog offers all settings that are available on part level.
The parameters are applied to the CAD-data in the sequence as presented by
the Tab pages, from left to right. The further to the right, the more advanced
the parameters in the tab. Each of the tab pages will be described in detail
below.

The number of tabs that is present is different for each type of CAD-data, as
each data type comes with different settings:
Vector Settings
Geometry Settings
Bitmap Settings
When more than one type of CAD-data has been loaded you can therefore
select the set of settings that you want to edit, when no CAD-data is present
only the tab General will be visible. Some of the tabs pages are identical for
all data types, some are present for just one of the three types. Every tab
page description below mentions for which type of data it is present.

The number of tabs that is present also is different for each Edition.
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For instance in the Free Edition and in the Entry Edition only the first two
Tab pages are available, as these editions offers less parameters than the other
editions. 

The Part Parameters dialog has an extra button: Apply. Using this button you
can apply any new setting immediately, without having to first close the
dialog. Any changes will be immediately reflected in the drawing on screen
and in the Part information dialog.

This dialog can be reached via the Parameters menu.
Shortcuts: 
You can double-click on a part-item in the project tree (one of the second
level items).
Or right-click on a part-item and select Part Parameters in the context-menu.

This same dialog is used for the Default Part parameters, only with an extra
button Restore DeskProto defaults to reset the original default parameters.

General parameters
(Vector, Geometry and Bitmap Settings)

Name
The name of the  part can be changed here. Use a meaningful name to easily
remember the purpose of each specific part: the Project Tree then will be
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easy to interpret in case of more than one part. This name is for your
convenience only: it is not used in the resulting NC program file.

Machine settings
These are visible and/or enabled only in the Multi-Axis edition of DeskProto,
and only if the machine with a Rotation axis and/or with a Tilt option has
been selected in the project parameters. The tilt-option is very rare: only a
few machines support this.

Use rotation-axis
A rotation axis is a device on the machine that rotates the part during
machining. Like a roast on a spit above the barbecue. Note the difference
between an A-axis and a lathe: on a lathe the spinning of the part causes the
cutting, on a rotation axis the spinning of the tool.

By default DeskProto generates standard XYZ toolpaths, and thus ignores
the rotation axis. 
If "Use rotation axis" is checked, DeskProto will generate XZA toolpaths
instead, with A-value in degrees. In the View Window the difference will be
immediately visible, as the operation area no longer is a rectangular block, but
a cylinder instead. 
The part will rotate when machining: continuous rotation. This in contrast to
the indexed machining that some CAM programs offer (which is possible
using DeskProto too, in the N-sided wizard).

For geometry-data DeskProto will rotate the 3D part when calculating the
toolpaths, vector data and bitmap data will be wrapped around a cylinder.

When you check “Use Rotation axis”,DeskProto will automatically (when
applicable):
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· set the Zero-point Z Translation to "None" for the Z-axis (resulting in a
Workpiece zero point exactly on the rotation axis)

· disable Inverse milling as that does not work for rotary machining.
· set the Material block to “Use upper half of geometry”, in order not to let

the tool sink below the rotation axis.
· change the default setting for the Support Tabs.
· set the Borders to "No extra" for all operations in that part (as the part

must not be cut loose of the rotation axis)

You are free to change these settings later in case needed.
The message box shown above will remind you of these changes, you can
switch it off when no longer needed (it can be restored in the Preferences, tab
Advanced, subset Settings).

By default DeskProto calculates for a rotation axis parallel to the X-axis,
which is officially known as an A-axis.  A rotation axis parallel to Y is
supported as well: you can configure that in the Advanced machine settings.

Use rotation axis tilt option
This option concerns a special type of fifth axis: a mechanism that tilts the
complete rotation axis unit. Such fifth axis is present on some machines
offered by Roland (JWX-10, MDX-40), and is meant to machine the inside
of a ring. In fact this is a B-axis. DeskProto does not control the movement of
this axis: it has to be manually set. For more information and a picture see the
Tilt option tab of the Operation Parameters. This tab page is present only if
this tilt option is checked.

This option is only available in case a machine has been selected that
supports this "Rotation axis tilt option" (so in case the machine-definition in
the Library of machines supports this). This option also is available only in
the DeskProto Multi-Axis edition. If this box is not checked DeskProto will
ignore the tilt option and generate standard toolpaths. 

Operations
The number of operations within the part can be changed by adding,
removing or copying operations, using the buttons Add, Copy and Remove.
As three different types of Operation can be added: Vector, Geometry and
Bitmap, as the Add button comes in three flavors.
When more than one operation is needed to create a part (for instance first
roughing with a large cutter and then finishing with a smaller one) the
sequence of the operations is important. Using the Move arrow buttons you
can change the sequence of the operations.
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Transform parameters
(Vector and Geometry Settings)

The availability and the contents of options 4 and 0 on this tab page will
differ per edition of DeskProto (Free, Entry, Expert, Multi-Axis).
The options will also be different for Vector data and for Geometry data
The order in which the transformations are applied will affect the result,
which is why they are numbered in the dialog. For instance scaling is done
before rotation, so when you rotate you may need to scale a different axis
than visible on the screen.

1. Scale
Scaling is the first transformation that is applied to the original geometry /
vector data. It is possible to scale differently for X, Y and Z, by un-checking
the Uniform option. The imported CAD file does not contain information
about the units used, DeskProto assumes the units used in the CAD file to be
the same as set in the Preferences dialog. If this is not true it can be corrected
using the scale factor: 
Enter a scale factor of 25.4 to use a CAD file created in inches in a DeskProto
that is configured to use metric units.
Enter a scale factor of 0.03937 to use a CAD file created in mm in a
DeskProto that is configured to use inches.
You can scale either by using scale factors or by entering the desired new
dimensions.
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For Vector-data without Z-coordinates only X and Y can be scaled.

2. Mirror
The mirror option is the second transformation applied. It is only useful to
mirror in one direction, as mirroring in two directions is identical to one
rotation, and mirroring in three directions can be achieved by mirroring in one
direction plus a rotation. The mirror option can be useful when you have a
geometry that is one half of a symmetrical prototype. By mirroring the
geometry for the second part you can produce two parts that will exactly fit
together.
For Vector-data without Z-coordinates only X and Y can be inverted.

3. Rotation
The rotate option is the third transformation applied. Note the difference
between this rotation (which changes the geometry) and the view rotation
(which only changes the viewpoint / the camera position). Both rotations use
identical process, so you can use the Viewpoint to find the rotation you need,
and then use these X, Y, Z rotation values to enter here.
When a custom Material block and/or Area is present (rectangular) the block
or area can remain correct only for rotations over (multiples of) 90 degrees.
For other angles the boundaries would be changed. For Freeform areas only
rotations over (multiples of) 180 degrees are possible, other rotations are not
permitted.
For Vector-data without Z-coordinates only rotations round Z are possible.

4. Inverse milling (Geometry settings)
The inverse milling option useful for producing a mold: a cavity in a solid
block of material that exactly fits your geometry. In many cases it will be
easier to create an inverse geometry using the original CAD system.
However, this option comes in useful in case you only have the STL file, not
the original CAD data.

Inverse milling is not the same as mirroring the Z-axis. A mold that is created
by mirroring would produce mirror images of the original geometry. Instead
DeskProto uses a 180 degree rotation to create the inverse. As this inverting
is applied during toolpath calculations, the STL geometry on the DeskProto
screen is not inverted. To get an idea of what you are machining you can
display the rendered Z-grid or a simulation instead.

Note 1: when selecting this option, in most cases it is necessary also to
change the Ambient and set it to 'Top level'.
Note 2: when this option is checked, setting the Z-values for the Material
block and the Area to be machined still is done in un-inverted coordinates.
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Inverse milling is not available in the DeskProto Free edition and Entry
edition.

4. Panning (Vector settings)
Panning can be used to correctly position the Vector curves over a geometry
and/or a bitmap. For instance when you want to engrave a logo on a 3D part.
When you only have vector data loaded this option in most cases will not be
used: for the NC file DeskProto will by default apply a Translation that will
make the corner of the block the Workpiece Zero point (0.0, 0.0, 0.0)
The button Align to... leads to the Align dialog: a handy help to set a few
useful locations.

The vector panning option will be disabled ("grayed out") when it does not
make sense: in case only vector data is loaded AND the XY translation (tab
Zero-point) is automatically calculated ("to positive XY" or "Make center").
The latter condition is always true in the Free edition and the Entry edition.

0. Center geometry (Geometry settings)
In DeskProto all Translations are applied at the end of the calculation
pipeline, after calculating the actual toolpaths. For rotation axis machining
this is not sufficient, as the position of the geometry during calculation
influences the toolpaths that will result. 
By default (when you do not check this option) during rotation axis
machining DeskProto will rotate the geometry around the X-axis as defined in
the CAD system.
When you check this option, DeskProto will rotate around a line parallel to
the X-axis through the exact center of the part. You can immediately see the
difference as this influences the size of the Material block: when checked a
cylinder that exactly fits the geometry, when not checked a cylinder that is
far too large if not. 
The Center Geometry option is performed before the other transformation,
hence it has been give sequence number 0.
When you need any other position of the rotation axis you have to go back to
the CAD system and translate the geometry there.

In addition to this option you can still use the Translation options for a
translation to be applied just before saving the toolpaths. For rotation axis
machining you then can choose between a workpiece zero point on the
rotation axis or on the top of the cylinder block (Z=0 level).
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XY Transform parameters
(Bitmap Settings)

Bitmap dimensions
The dimensions on this tab page define the size of the Relief in XY, the size
in Z is determined by the Z-settings for Black and for White.

· Use DPI from bitmap file. Most bitmap files contain a DPI value, which
stands for Dots Per Inch. So for a 300 DPI image the size of one dot
(pixel) will be set to 1/300 inch. As the number of pixels is known this
value sets the exact size of the image, and thus for this choice it sets the
size of the relief. For files without a DPI value (for instance GIF files)
DeskProto will use 96 as default.

· Use custom DPI. This options allows you to enter any DPI value. As
explained above this value will set the exact size of the image, and thus also
of the relief.

· Calculate from precision.... As explained in paragraph Bitmap Data
DeskProto uses a Z-Grid to create the Relief. For options 1, 2 and 4 the
ratio between Pixel size and Grid cell size (the path distance) is not
necessarily a whole number. So it might be that some Grid cells 'contain'
more pixels than others. This may lead to a Moire pattern like a small
ridge every few mm. Which can be fixed by choosing this option
(approximate the requested dimension as close as possible). One pixel will
be converted to exactly ... , 1/4 , 1/3 , 1/2 , 1 , 2 , 3 , 4 , ... grid cells, as set
by the ratio Pixel size / Path distance. As the path-distance is one of the
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Precision values in the Operation parameters, when more than one bitmap
operation is present you need to select the operation the you want to use.
Important: when you later change the Precision, the size of the relief will
change as well !

· Custom. Here you can enter any dimension as required.

The option Keep aspect ratio takes care that the ratio between X size and Y
size is not changed: same ratio for both image and relief. So when you change
the X size with this option checked, you will see that the Y size
automatically changes too.

Panning
The position of the bitmap relief relative to the workpiece zero point can be
changed here. By default the relief is located with it's lower left corner exactly
at XY (0,0), so at the zero point (the Z depends on the settings of the second
tab page). If this is not the correct location you can change it by entering
Translation values for X and Y here. Panning can for instance be used to
correctly position the bitmap relief over a geometry.
The button Align to... leads to the Align dialog: a handy help to set a few
useful locations.

The bitmap panning option will be disabled ("grayed out") when it does not
make sense: in case only bitmap data is loaded AND the XY translation (tab
Zero-point) is automatically calculated ("to positive XY" or "Make center").
The latter condition is always true in the Free edition and the Entry edition.
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Z Settings parameters
(Bitmap Settings)

In order to use a Bitmap image in DeskProto it needs to be transformed to a
3D Relief. As explained in paragraph Bitmap Geometry, this is done by
created by calculating a Z-height for every pixel in the bitmap image, based on
its gray value..

Z calculation
In these two edit boxes you can enter the Min and Max Z-values, to be used
for black and white. DeskProto calculates this depth starting at the top of the
block. So positive values do not make sense here (unless the option 'Project
bitmap relief on 3D part geometry' has been checked).
In the image above the minimum Z for white pixels is -2.0 and the maximum
Z for black is 0.0, which for gray values will result in the lighter the color the
lower the relief (the other way round is also possible: black lowest and white
highest). This is called gray-value to Z-height conversion.

Project bitmap relief on 3D part geometry  (not in the Free edition and the
Entry Edition)
When this option is checked, the Z-value that is calculated for the color of
that pixel is added to the Z-value of the geometry at that location. So the 3D
relief is projected onto the underlying geometry, using a vertical projection.
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See the illustration below (where the relief depth for black has been set on 0.0
and for white on a positive value).

Here a shell relief is created from a bitmap image, and projected on the
perfume bottle that you have seen more often as example part. This is of
course a great design tool to create embossed products. The picture shows a
positive relief: on top of the geometry.
Important for such positive relief is that of course material is needed to create
this relief, so the previous operations used to machine the bottle may not
machine the original bottle shape there. This can be achieved by making each
operation a bitmap operation.
The relief to be projected can also be negative: when the Z-values range from
0.0 to a negative value, the relief will be subtracted from the part geometry.
This option is activated only when a geometry has been loaded in the project,
as of course otherwise projection is not possible.
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Material parameters
(Vector, Geometry and Bitmap Settings)

The block of material to be used (the stock) is a rectangular volume, bounded
by Minimum and Maximum values for each of the three axes. Only the
CAD-data inside this block will be processed during the milling calculations,
the rest will be discarded. As you can see in the icon pictures, the bounding
box of the block will be drawn in orange lines (the green lines that you may
see are for the Area to be machined).

A cylindrical block and the Min and Max R-values are available for rotation
axis machining.
The options that mention the Geometry are available only when a geometry
file has been loaded.

Four options are available:
· Use all CAD data is the default: the block will be the bounding box that

exactly fits all CAD data. For 2D vector files a block thickness of 10 mm
will be used (minimum Z -10.0, for inch users -0.5"), unless the Machining
depth as set in the Vector Operation parameters is more. 

· Use whole geometry uses a bounding box that exactly fits the total
geometry. In case you have only loaded one or more geometry files the
result will be the same as for Use all CAD data.

· Use upper half of geometry is meant for  symmetrical geometries that
can be machined in two halves, for instance the right side and the left side
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of a power drill. Separately machine both halves and then glue them
together to become one model. This option is not present for rotation axis
machining.

· Custom is the option to define any other block size. In that case you can
enter the block dimensions either by typing the appropriate minimum and
maximum values, or using your mouse after pressing button Set
Graphically. You can always reset the values by again selecting 'Use all
CAD data. As said the Min and Max R-values are available for rotation
axis machining. Setting min and max values for the A-axis (in degrees) is
not possible (in previous DeskProto versions this was possible, though as
far as we know it was not used).

If you want you can enter the values for the block in Translated
coordinates. When you have checked this checkbox the minimum and
maximum values of the block (the boundaries) are displayed in the
coordinates as used on the machine. These are the coordinates after
Translation has been applied. A translation is also applied in the Free edition
and the Entry edition (where no Translation tab is present): making the
front/left/top corner of the block the zero point. Checking or unchecking this
checkbox does not influence the toolpaths. It’s just a temporary conversion
in this dialog to make setting the boundaries easier.

The option Use cylindrical material block as said is available only for
rotation axis machining. As you will see for a Custom block this option
makes a difference in which edit fields can be edited. For a cylinder block a
minimum R lower than 0.0 is not permitted. When you enter a minimum
above 0.0 the result will be a tube--shaped block.

A custom material block size can be used when the block that you have is
larger than the bounding box of the CAD data. For instance when your
actual block is higher than the CAD geometry: the roughing layers will start
counting from the top of the block, so the block thickness in DeskProto
needs to match the real block. This can be done here by entering custom block
dimensions.

You can also use a custom block that is smaller than the CAD data. For
instance when the part is too large for your machine. Say it is 500 mm long,
while your machine can do max 300 mm (along X). Then in your DeskProto
project define two parts. For the first part set a custom block with X-min 0.0
and X-max 250, and for the second part set a block with X ranging from 250
to 500. The two parts that you machine will exactly fit together to form the
complete model. It will be needed to use the option Protect Vertical surfaces
to make the splitting surfaces vertical.
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The same trick can be used when your part is too high for your machine:
build the model from separately machined slabs of material. For instance
produce a model of 140 mm high, milling three separate slabs of standard
tooling board blocks of 50 mm thick, using three parts with these material
blocks: part1 Z 0-50 mm, part2 Z 50-100 and part3 Z 100-140 mm.

Note: 
In case Inverse milling (male to female) is applied, then the block boundaries
entered here are applied on the original geometry, before the male to female
conversion.

Support parameters
(Geometry Settings)

Support tabs can be added to the geometry to keep the part connected to the
rest of the block. These are small blocks of material (cylinder or  rectangular),
acting as connection bridges to hold the part on its place. Say your block is a
slab that is much larger than the part: you then can clamp the slab on its
corners and machine several parts, each on a different position, without the
need to clamp each separate part.
Tabs are also needed for two-sided machining (see the Two Sided Milling
Wizard), and for fixturing your model on a rotation axis device.
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This tab page is about Geometry support tabs, made by adding small blocks
to the geometry. Not to be confused with Vector tabs, made by changing the
machining depth in a 2D toolpath.

Each support tab is created by loading an STL file from folder C:\Program
Files\DeskProto 7.1\Supports\
The contents of this STL file will be scaled and rotated as needed, and will
then be added to the geometry and be handled by DeskProto just like any
other geometry detail.

Four options are available:
· Don't use support tabs, which is the default and will be OK for most

parts.
· Use Default support tabs: DeskProto will locate these tabs at the extreme

points of the geometry (min and max X, min and max Y, applied after the
rotation). For normal XYZ machining four rectangular tabs are generated,
for rotation axis machining two cylinder shape tabs. Tab width and
thickness depend on the size of the geometry, tab length is (at least) 1.5
times the cutter diameter (10% of this length sticks into the geometry), to
make sure that the cutter can machine it.

· Custom tabs can be used when the default tabs do not satisfy, you can
choose to create one to four custom tabs. For each of the four tabs you can
then check whether or not to use them, and for each checked tab you can
specify location and dimensions graphically, using the Edit button. This
will open the Set support tab dialog, where you can also set the shape of
the tab.

· Use tabs of first part is very convenient when several parts use the same
support tabs. Define these support tabs only once (for the first part), and
use that same definition in all other parts. In that case also any changes
need to be made only once. This option is very handy for two-sided
machining. For the first part obviously this option will be disabled.

In order to keep  support tab connected to the surrounding material the end
of the tab needs to stick outside the area to be machined, as otherwise the end
of the tab will be cut loose.
When the end of the support tab is on the edge of this area you need to
switch off the borders in each of the operations used for this part
(Operation parameters, Tab page Borders). If not DeskProto will cut the
outside surface of each tab as well, cutting it loose from the surrounding
material.
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Ambient parameters
(Geometry and Bitmap Settings)

DeskProto toolpaths for Geometry and Bitmap by default will completely
cover a rectangular area. Most geometries do not have a rectangular geometry
though, so in many cases some area will be present without geometry. This is
called the ambient area. Or in other words, the area where no geometry is
present, seen from the top. On this tab page you can specify the level
(height) at which this ambient area should be milled.

· The default choice is Equal to bottom level of material, so at the
minimum Z-level of the block. This will do for most cases, as then all
material around the part will be removed. Note: when using this option,
for ballnose cutters the actual Z-level will be R (radius of the cutter)
lower than the bottom of the block, to make vertical walls possible. So take
care not to damage your machine's working table.

· Equal to top level of material will be useful when you want to make a
mold by using inverse milling: then you do not want the material around
the cavity to be removed.

· Custom, allows to specify any ambient level, by entering a Z-value edit
box. Hidden feature: When you select this option, a ballnose cutter will
not go R mm lower than the level in the Z edit box (as just explained for
'Equal to bottom'). So switching from "Equal to bottom" to "Custom" will
not change the value in the Z edit box, however may nevertheless produce
different toolpaths.
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If you want you can enter the ambient level in Translated coordinates.
When you have checked this checkbox the Z-level is displayed in the
coordinates as used on the machine (after Translation has been applied).
Checking or unchecking this checkbox does not influence the toolpaths. It’s
just a temporary conversion in this dialog to make setting the ambient level
easier.

Zero-point parameters
(Vector, Geometry and Bitmap Settings)

Setting the WorkPiece zero point for your NC programs means applying a
Translation to your CAD data: converting from CAD coordinates to
machine coordinates. Although you can see translation as a form of
transformation, it’s not placed on the Transform tab page of these Part
parameters. In DeskProto the translation is applied after all actual
calculations, just before saving the toolpaths to an NC-program. So in the
Part parameters it is shown as last tab that influences the toolpath data. On
screen the position of the WorkPiece zero point is shown by the blue
Orientator cube (if not then you can switch it on in the Items Visible
dialog).

Default translation is option 1 for  X, Y and Z, making the front-left-top
corner of the block the Workpiece zero point. This is customary for CNC
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milling and very handy: the zero position will now be with the tip of the tool
touching the top of the material, at the front-left corner of the block. So all X
and Y positions to be machined will be positive (starting at 0), and all Z
positions will be negative (starting at 0 as well).  Cutter positions may still
have a negative X and/or Y value, as the cutter needs to move outside the
block to machine the outer surfaces.

It is possible to use different settings for X, for Y and for Z. For each axis
five predefined translation options are available. For each option DeskProto
will calculate the actual translation values and show it in the edit box. 

XY:
- Translate To positive X&Y for material block has just been explained:
X=0.0 rep Y=0.0 will be on the edge of the block. This option is the most
convenient one because it will be easy to set the zero-position on the
machine.
- Translate To positive X&Y for cutter positions will make all cutter
positions (or toolpath coordinates) have a positive X or Y coordinate. This
option is useful in case the machine can handle only positive X & Y
coordinates (for example the small Roland Modela MDX 15 and 20).
- Make center of material block zero is preferred by some users as their
default option. It is a convenient option for two-sided machining using
reference pins on the working table to keep the block in position after turning
it upside-down: on the machine the zero point then needs to be positioned
exactly in the middle of these pins.
- None means that no translation is applied. The zero-position of the CAD
data will correspond with the work-piece zero-point on the machine.
- Custom makes it possible to use any own defined translation, to be entered
in the edit boxes. The value that you enter is the translation between CAD
coordinates and workpiece coordinates. The edit boxes also show the actual
translation for any of the other options.

Z:
- Make top of block zero has just been explained: Z=0.0 will be on the top
surface of the block. So the CAD data will be translated in a way that all
points have negative Z-values. This option is the most convenient one
because it will be easy to set the zero-position on the machine.
- Make center of block zero: the workpiece  zero point will then be exactly
in the middle of the block for Z.
- Make bottom of block zero will put Z=0.0 at the bottom of the block. So
the CAD data will be translated in a way that all points have positive Z-
values. Advantage of this option is that the workpiece zero point can be the
same for any block thickness. Note that in case of ballnose cutter the tip of
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the cutter can still travel below Z=0, see the explanation on the Ambient
page.
- None means that no translation is applied. The zero-position of the CAD-
geometry will correspond with the workpiece  zero point on the machine.
- Custom makes it possible to use any own defined translation, to be entered
in the edit box. The value that you enter is again the translation between
CAD coordinates and workpiece coordinates.

For Rotation axis machining only the X and Z coordinates can be translated.
The Y coordinate value can not be translated as the tool does not move along
the Y axis during rotation axis machining. In this case also some of the Z-
options are not available either as they would not make sense.

When you have checked the option Use rotation axis tilt option on the
General tab of the Part parameters,  a different set of Translation options will
be available. See the illustration above.

As explained for the Tilt option settings (rotation axis tilt option) of the
Operation parameters, the X-translation will determine the location of the
part when the tilt angle has been applied. The workpiece zero point (X=0.0)
needs to be exactly on this 5th axis (so on the tilting rotation point). The
small illustration on the dialog shows that a larger distance between the axis
and the part will result in a larger Z-displacement when rotating. So the
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Distance to material block must be carefully set in order to have the
toolpaths aligned for operations with and without a tilt angle.

The Resulting Translation will be different from the Distance to material
block, as the zero point of the STL file (CAD zero) in most cases is not
located on the left edge of the block.

A Y-axis translation is not possible here: this tilt option is combined with
rotation axis (4th axis) toolpaths, where Y-translation is not applicable.

Simulation parameters
(Vector, Geometry and Bitmap Settings)

A Simulation is a drawing on screen that shows you what the resulting
machined part will look like. This can be used to check things like the
resulting surface smoothness, error movements that would damage the part,
rest-material where the cutter cannot reach, etc. In this dialog you can set the
simulation parameters. You can read how to display the simulation on the
Simulated Operations dialog page.

The Resolution sets the accuracy of the simulation to be calculated. 
The 3-axis simulation (XYZ) applies a Z-grid, similar to many other
DeskProto calculations: the level of detail sets the number of grid cells used.
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The higher the level of detail, the longer it will take to calculate the simulation
and to draw it.
The rotary simulation uses a completely different algorithm, based on voxels
(very small 3D cubes). Here  the level of detail sets the number of voxels that
are used. The more voxels the more accurate the result (smaller cubes), and
the longer the calculation time.

Five preset options are available to set the number of cells in the simulation
grid:

Grid-cells Voxels
Low 200 200

500 400
Medium 1000 700

2000 1200
High 5000 2000

This number of grid-cells (voxels) is used for the longest side of the block to
be simulated. The number of cells along the short side of the block is
calculated proportionally.
In most cases the default setting (Medium) will be a good choice. A higher
level of detail will be needed only when you want to zoom in onto some
detail. This will make both calculation and display of the simulation much
slower though. In addition, calculating a high level of detail will also need
much memory.

You can enter a Custom resolution in case one of these five presets does not
match your needs.

Compare with Geometry offers the possibility to check the difference
between the resulting part and the original STL file geometry. DeskProto will
calculate the distance between the simulation and the STL geometry, and will
apply a color on the simulation when this distance is above a certain tolerance
value.
This option is of course only active for a Geometry project. It is also not
possible for a rotary simulation.

Check if removed too much (RED) will show a red color in case DeskProto
has removed too much material. Note that the red will only be visible when
you have turned off the rendered geometry in the Items visible dialog,
otherwise the geometry will hide the red.
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Check if  rest material left (GREEN) will show a green color in case too
little material has been removed because the cutter could not reach a certain
position. This may happen on many occasions, like:
- toolpath distance too large (and a ballnose cutter)
- small hole where the cutter does not fit inside
- sharp inner corner, which will be machined with the Radius of the cutter

A Tolerance value decides whether or not to apply such color red or green.
As a default this tolerance has been set to 0.1% of the material block size, so
the largest dimension of the block divided by 1000. When you set it to
Custom you can enter any value that you need in the edit box.

4.3.3 Set Support Tab

The Set support tab dialog makes it possible to set the size and position of
one geometry support tab. You can reach this dialog by using an Edit button
on the Support tab of the Part parameter dialog, or on the Material and
Supports page of one of the Geometry wizards..

The dialog shows a new drawing of your part, with a rectangle that indicates
the support tab that you are editing. You can edit the tab by 'picking' one of
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the sides of this rectangle with your mouse and then moving it (as default the
button 'Adjust boundary' now is active).

Using the buttons on the right you can change the drawing. Twelve of these
are standard DeskProto buttons to set the viewpoint, of which the use is
known and needs no explanation here. Note that mouse rotation is not
present: this dialog only uses the six main views.

The first button on the first row shows the Items visible icon that
is also used in the main window. This icon however opens a special version:
the 'Items visible for Set Graphically' dialog. It will be clear that here you can
select the items to be shown in the drawing.

The first two buttons on the second row are about the main function of this
dialog: graphically set the support tab. Note that these are “mouse buttons”
as well: of the five mouse buttons only one is active at any time.

This button sets the mouse function to Resize the current tab by
dragging each of the four sides to a new position.

This button sets the mouse function to drag a complete new
rectangle to define a New support tab.

Below the buttons you can use the combo-box to select the Shape of the
support tab. 
By default five shapes are available: Block, Cone, Cylinder, Pyramid and
Wedge.
For the Cone, Pyramid and Wedge the orientation of the support is
determined by which support tab you are editing: left, right, front or back.

You can also set the new support tab by entering minimum and/or maximum
values for X, Y and Z in the six edit boxes. The dimensions of the current
material block are shown to assist you, so are the coordinate values of the
current mouse position.

As a support tab is aligned with the main axes,  this resizing only makes
sense in the six main views (looking along X, Y or Z): other viewpoint
positions are not possible in this dialog. For each of the main views of course
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only two coordinates can be changed: to change the third as well you have to
select a different main view using one of the six view buttons.

Note:
It is possible to add your own support shape.
The base support tabs are present as STL files in files in C:\Program
Files\DeskProto 7.1\Supports\
You can add any STL file here, and use this geometry as a support tab. For
instance a special shape that matches a fixture that you have made.
Important is that the geometry in this STL file must be sized to exactly fit
inside a cube of 1 by 1 by 1 mm: only then the dimensions that you will set
in this dialog will be set correctly (internally DeskProto creates the support
by copying, scaling and rotating the base support tab as defined in this file).

For software specialists: 
you can set the location of this supports directory as follows:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\7.1\Preferences\File Locations\SupportsLocation
For MacOS change line "7·1.Preferences.File Locations.SupportsLocation" in
file DeskProto.plist 
For Linux change line "Preferences\File%20Locations\SupportsLocation" in
file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !
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4.3.4 Items Visible for Set Graphically

In DeskProto a number of dialogs are present that show a drawing of the part
in order to graphically set a parameter:
Set Material block (Part parameters)
Set Support tab (Part parameters)
Set Center (Operation parameters, for strategies Circular and Radial)
Set Area (Operation parameters)
Set Freeform area (Operation parameters).

When graphically setting this parameter it may be handy change which items
are visible in the drawing. This dialog allows you to switch each of the
available items on and off.

For more information on any of the options in this dialog see the Help page
of the Items Visible dialog for the main screen.
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4.3.5 Set Material Block / Area

This dialog is used for two settings in DeskProto, each with a different name.
The contents of the dialog is identical though.
The dialog Set Material Block makes it possible to graphically set the size
and position of the material block. You can reach this dialog by using button
'Set Graphically' on the Material tab of the Part parameters dialog, or button
'Detail settings' on the Material page of one of the wizards.
The dialog Set Area makes it possible to graphically set the size and
position of the area to be machined. You can reach this dialog by using button
Set Graphically on the Area tab of the Operation Parameters dialog.

The dialog shows a new drawing of your part, with a rectangle that indicates
the block or area that you are editing. You can edit the tab by 'picking' one of
the sides of this rectangle with your mouse and then moving it (as default the
button 'Adjust boundary' now is active).

Using the buttons on the right you can change the drawing. Twelve of these
are standard DeskProto buttons to set the viewpoint and the mouse function,
of which the use is known and needs no explanation here. Note that mouse
rotation is not present: this dialog only uses the six main views.
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The first button on the first row shows the Items visible icon that
is also used in the main window. This icon however opens a special version:
the 'Items visible for Set Graphically' dialog. It will be clear that here you can
select the items to be shown in the drawing.

The first two buttons on the second row call the main function of this dialog:
graphically set the block or area. Note that these are “mouse buttons” as well:
of the five mouse buttons only one is active at any time.

This button sets the mouse function to Resize the current block or
area by dragging each of the four sides to a new position.

This button sets the mouse function to drag a complete new
rectangle to define a New block or area.

You can also set the new block or area by entering minimum and/or maximum
values for X, Y and Z in the six edit boxes. The boundaries of the current part
are shown to assist you, as are the coordinate values of the current mouse
position.

When you change the block or area, you will see that both the old and the
new block remain visible: the changes will become effective after pressing the
OK button.

As a block/area is rectangular and aligned with the main axes, this resizing
only makes sense in the six main views (looking along X, Y or Z): other
viewpoint positions are not possible in this dialog. For each of the main
views of course only two coordinates can be changed: to change the third as
well you have to select a different main view using one of the six view
buttons.
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4.3.6 Panning Alignment

This dialog is used both for the Vector settings (Align Vector Data) and for
the Bitmap Settings (Align Bitmap Data), and can be reached using the "Align
to..." button in the Part parameters: for Vector tab Transform, for Bitmap tab
XY Transform. 

When you use more than one type of CAD data for one part, it may be
needed to align these data types with one another. This dialog makes such
alignment easier.
Only alignment by panning along X and Y is supported, panning Z and
rotation are not possible here.

The thing that will be aligned is the Bounding box of the Vector curves
respectively of the Bitmap image.

This bounding box can be aligned with one of five entities:
· CAD zero point. Always possible.
· Vector data. The bounding box of all vector curves. Only available for

bitmap data, in case one or more vector files have been loaded as well.
· Geometry data. The bounding box of all geometry. Only available in case

one or more geometry files have been loaded.
· Bitmap data. The sides of the bitmap image. Only available for vector

data, in case a bitmap has been loaded as well.



Dialogs

Page 165

DeskProto Reference

· Material block. Only available in case a custom block has been defined.

For X-Alignment three options are present:
· Left means that the Left side of the Bounding box will be aligned with the

left side of the entity.
· Center means that the Center of the Bounding box will be aligned with the

center of the entity.
· Right means that the Right side of the Bounding box will be aligned with

the right side of the entity.
The CAD zero-point does not have a side, so here the Bounding box will be
aligned with the point.

For Y-Alignment the options are called Back, Center and Front, but are in
fact the same as for X.

4.3.7 Vector Operation Parameters

DeskProto features three different types of Operations: this dialog is for the
Vector Operation -- in addition also dialogs for a Geometry Operation and for
a Bitmap Operation are available.

The Vector Operation parameters are divided into 7 sections by tab pages.  In
the Free edition of DeskProto only the first three tab page are available,
offering less parameters than the Expert and Multi-Axis editions. In the
Entry edition only the Advanced tab is missing.

This dialog can be reached via the Parameters menu, third option.
Or you can double-click on a vector operation line in the project tree (one of
the third level items).
Or right-click on a vector operation line and select Operation Parameters in
the context-menu.

This same dialog is used for the Default Vector Operation parameters, only
with an extra button Restore DeskProto defaults to reset the original
default parameters.
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General parameters

Name
The name of the  operation can be changed; use a meaningful name to easily
remember the purpose of each specific operation. The name is meant for your
convenience only, it is not used in the NC program file. It will be used for the
file name though in case the NC output is in more than one file, for instance
due to a cutter change.
  
Cutter
You can select a cutter from the cutting tool library using the small arrow
button at the right. Adding new cutters to the library, changing an existing
cutter or just retrieving information on a cutter can be done using Library of
cutters (Options menu).

Curve info
The Vector data that has been loaded consist of a number of vector curves. In
order to use curves for toolpath calculation they need to be selected first: for
Profiling, for Pocketing and/or for Drilling. It is possible to combine two or
three toolpaths types in one Operation. In case no curves have been selected
the Vector operation is invalid as then no toolpaths can be calculated.
Selecting curves cannot be done on this tab page, only on the three tab pages
just mentioned.



Dialogs

Page 167

DeskProto Reference

The Speed settings are identical to the settings offered in the Geometry
Operation Parameters: see the explanation on Feedrate and Spindle Speed
there.

Z settings parameters

The Machining depth is the Z-coordinate for the actual toolpath. You can
describe this as the pen-down level when plotting a 2D vector file. The depth
is measured from the top of the block. This means that a positive value does
not make sense here.
In case of a 3D polyline the machining depth is taken relative to the Z-value
of the curve.

The option Project vector curves on 3D part geometry (not available in the
Free and the Entry edition of DeskProto) is ideal for instance to engrave a
logo or text onto a 3D design: the 2D vector curves will be converted into 3D
toolpaths. When you check this option, the Machining depth is no longer
interpreted as a standard Z-level, however is taken relatively to the Z-level of
the geometry at that point. So a level of –1 mm results in a groove of that
depth over the 3D part.
The projection is vertical, meaning that on curved surfaces the 2D drawing
will be distorted: a circle that is projected on a sloped surface will be changed
into a ellipse. 
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For this projection DeskProto will take into account the shape of the cutter
in 3D.
This option is only available when geometry has been loaded, and when at
least one Geometry Operation is present before this Vector operation. This
Geometry Operation is needed to make sure that all material above the
geometry has been removed. 
When the vector data contains Z-values and in the Project parameters the
option "Use Z-values" has been checked, the use of this option "Project
vector curves on 3D part geometry" will make DeskProto ignore the Z-values
in the CAD-data.

In order to calculate such projected vector toolpath DeskProto needs to make
a Z-grid. The option Calculation Precision in XY allows you to set the
precision (the cell-size) of this Z-grid. The smaller the value entered, the more
accurate the Z-values of the toolpath will be, and the more calculation time
needed. This Z-grid will be calculated only for the area covered by the vector
file.

The Free movement height specifies the height at which the cutter can
freely move over the block, so without touching material. This is also called
the Safe height. As in the analogy with a pen plotter the machining level is the
pen-down level, the free movement height can be seen as the pen-up level.
This height is used to move the cutter from one position to another without
machining (positioning movements). It is set as the height above the top of
the block, so negative values are permitted here. The positioning movements
will be done in Rapid mode (so at the maximum speed of the machine).
More information on positioning movements on the Movement tab of the
Geometry operation.

A special option is present to allow the use of DeskProto toolpaths on a
laser cutter. While laser cutting the laser of course has to be switched off
during positioning movements. Many laser cutters make their laser respond
to the Spindle command: in the DeskProto postprocessor an option is
present to switch off the spindle during rapid movements.

When the option Always stay low is checked, the positioning moves are done
at normal feedrate. When only Vector data is present the Z-level of these
positioning movements will not change: the specified height above the top of
the block. When a Geometry has been loaded as well the positioning
movement may be done below the top of the block: each movement then is
done at the Free movement height above the highest point of the geometry
over which the cutter moves. 
Always stay low can not be checked when Roughing layers are used.
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For very small positioning movements DeskProto will not let the cutter rise
to Free Movement level, see the explanation on the Geometry Operation
page.

Profiling parameters

Three different toolpath types can be generated based on the vector curves:
Profiling, Pocketing and Drilling. This tab page contains the settings for
Profiling: the cutter will exactly follow each curve that is selected.

Select curves allows you to specify which of the available vector curves
need to be used to generate profiling toolpaths.  
The options None and All will be clear. 
The option Layer refers to the layers in the DXF drawing (or rather the
CAD file), and provides an easy way to select all curves in a certain layer.
Which is convenient as in many design files all curves to be done by the same
cutter are combined in one layer. In case no layer information is present in the
CAD-file DeskProto will use a layer called "(DP-default)".
To make a Custom selection it is needed to open dialog Edit curve selection
using button Select.... 
The fifth option, to use the Selection of 1st Vector Operation, of course is
available only in case a first vector operation with such selection is present.
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For Profiling it is not possible to select single point 'curves'. The drawing
above contains 8 vector curves: one single point (on the left side), five open
curves (the + consist of two lines) and two closed curves (on the right side).
Selecting All for this drawing will result in 7 curves being selected here: all
except for the single point.

Three Strategy options are present to follow the curve:

Outside/left is meant to produce parts that exactly match the shape of each
curve: the profile of the part. So the cutter will move along a path that
follows the curve at exactly R mm distance (where R is the radius of the
cutter), on the outside of the curve. Outside of course can be defined only for
closed curves, for an open curve the cutter will travel on the left side of the
curve (as defined by the curve direction in the vector CAD file).
For closed curves inside this curve (so nested curves) the cutter will travel on
the inside of the curve (holes in the part). The next nesting level again will be
with toolpath on the outside, and so on. DeskProto will start machining the
innermost curves and than work it's way to the outside, in order to keep the
part clamped when machining.

Inside/right is meant to produce holes that exactly match the shape of each
curve: the profile of the hole. So the cutter will move along a path that
follows the curve at exactly R mm distance (where R is the radius of the
cutter), on the inside of the curve. Inside of course can be defined only for
closed curves, for an open curve the cutter will travel on the right side of the
curve (as defined by the curve direction in the vector CAD file).
For closed curves inside this curve (so nested curves) the cutter will travel on
the outside of the curve (islands within the hole). The next nesting level again
will be with toolpath on the inside, and so on. DeskProto will start machining
the innermost curves and than work it's way to the outside, in order to keep
the part clamped when machining.

Strategy On curve means that the center of the cutter will exactly follow
each curve that was selected. The resulting shape(s) then will depend on the
diameter of the cutter that is used. Now DeskProto really acts like a plotter.
The cutter will exactly follow the lines as defined in the 2D vector file, at a
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certain machining depth (pen-down level). For positioning moves in-between
the cutter rises to Z-free height (pen-up level).

All three strategies can also be used for vector curves that contain Z-values!
That is ideal for instance for cutting holes in thermoformed parts. The curve
then will copy the Z-value of the point in the curve. 
For strategies Outside/left and Inside/right the Z-value of the closest point in
the curve will be used. Note that when toolpaths at different heights share the
same XY position the algorithm may copy an incorrect Z-value, so please
check your toolpaths when using this option.

Cutting direction
For strategies Outside/left and Inside/right it is possible to choose between
Conventional, Climb and Shortest route. The  small drawings explain the
difference between these three options: it is about the relation between the
direction of milling and the rotation direction of the tool (normally
clockwise). The choice made here will affect the surface quality of the
machined profile, the best choice is different for each material. The option
Shortest route will use the direction that makes the positioning movements
from curve to curve as short as possible.
For strategy On Curve it is not possible to define Conventional or Climb, for
that strategy you can select either Original (as defined in the CAD file),
Reversed or Shortest route. In the latter case DeskProto again will optimize
to reduce the total distance for the positioning movements.

Support tabs
Support tabs can be used to keep the part connected to the rest of the block.
When cutting a closed profile at full depth in sheet material a separated part
will result: the material inside the profile is no longer is connected to the rest
of the sheet. Support tabs are interruptions in the toolpath, acting as
connection bridges to hold the part on its place. this allows you to clamp the
material on its corners and machine your parts, each on a different position,
without the need to clamp each separate part.

This tab page is about Vector support tabs, made by changing the machining
depth in a 2D toolpath. Not to be confused with Geometry support tabs,
made by adding small blocks to the geometry. 

Three options are present:
None will be clear: no support tabs
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Default will automatically generate supports conform the Default profiling
tabs settings.
Custom allows you to exactly define the location and size of each tab, using
the Set Profiling tabs dialog.

Vector support tabs are available only for vector curves without Z-values
(2D curves). So they also cannot be used when a 2D curves is projected on a
3D geometry, or when for a 2D vector file the option "Use Z-values" has
been checked in the project parameters.

Pocketing parameters

Three different toolpath types can be generated based on the vector curves:
Profiling, Pocketing and Drilling. This tab page contains the settings for
Pocketing: the cutter will remove all material within a closed curve. The
resulting hole in the block of material is called a pocket: hence the name
pocketing.

Select curves allows you to specify which of the available vector curves
need to be used to generate pocketing toolpaths.  
The options None and All will be clear. 
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The option Layer refers to the layers in the DXF drawing (or rather the
CAD file), and provides an easy way to select all curves in a certain layer.
Which is convenient as in many design files all curves to be done by the same
cutter are combined in one layer. In case no layer information is present in the
CAD-file DeskProto will use a layer called "(DP-default)".
To make a Custom selection it is needed to open dialog Edit curve selection
using button Select.... 
The fifth option, to use the Selection of 1st Vector Operation, of course is
available only in case a first vector operation with such selection is present.

For Pocketing only closed curves can be selected, as an open curve does
not define a pocket. The drawing above contains 8 vector curves: one single
point (on the left side), five open curves (the + consist of two lines) and two
closed curves (on the right side). Selecting All for this drawing will result in 2
curves being selected here: only the two closed curves.

Two Strategy options are present to create a pocket:
The Parallel strategy fills the pocket with toolpaths parallel to the X-axis.
The Offset strategy fills the pocket with toolpaths that follow the shape of
the outside curve (the contour that defines the pocket).
Each strategy is clearly illustrated by the small icon drawing in the dialog.

Each of these two strategies has its own set of Strategy detail settings.

For Parallel:
The parallel toolpaths normally start minimum Y and continue to maximum
Y, Reversed will reverse that direction.
Stepover is the distance between two parallel toolpaths. It is set as
percentage of the cutter diameter. So for a cutter of 10 mm diameter, a
Stepover of 50% will mean a toolpath distance of 5 mm, and 80% will mean 8
mm.
By default the pocketing toolpaths as said are parallel to the X-axis, the
option Angle with X-axis allows you to change this.

For Offset only two detail settings are present as the Angle does not apply: 
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Offset toolpaths normally start with the outmost path and then progress to
the middle. Reversed means to start in the middle and progress to the
outmost path.
The Stepover setting is the same for both strategies, set as percentage of the
cutter diameter.

The Cutting direction applies to the toolpaths when emptying the pocket.
So for Offset toolpaths outside-in (that start with the outmost path and
proceed to the center of the pocket) the milling direction along the outer
profile of the pocket will be the reverse.

For both strategies it is possible to add a toolpath that follows the contour of
the pocket. This can be done on the Roughing tab: after setting an Allowance
such Profile path can be added in order to remove the allowance and make the
pocket smooth. 

Drilling parameters

Three different toolpath types can be generated based on the vector curves:
Profiling, Pocketing and Drilling. This tab page contains the settings for
Drilling: the cutter will move along the Z-axis and drill a hole in the block, at
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the XY location as defined in the drawing, and a depth as defined on tab Z
Settings.

Select curves allows you to specify which of the available vector curves
need to be used to generate drilling toolpaths.  
The options None and All will be clear. 
The option Layer refers to the layers in the DXF drawing (or rather the
CAD file), and provides an easy way to select all curves in a certain layer.
Which is convenient as in many design files all curves to be done by the same
cutter are combined in one layer. In case no layer information is present in the
CAD-file DeskProto will use a layer called "(DP-default)".
To make a Custom selection it is needed to open dialog Edit curve selection
using button Select.... 

For Drilling three types of curves can be selected: 
· single points (defining the XY position of the center of the hole)
· + signs (so two single lines that together form a + sign), where the length

of each line equals the cutter diameter.
· circles with a diameter that equals the cutter diameter
The drawing above contains 8 vector curves: one single point (on the left side
left), five open curves (the + consist of two lines) and two closed curves (on
the right side). Selecting All for this drawing will result in 3 curves being
selected here - only in case the diameter of the cutter is correct for both the +
and for the circle. For a cutter with any other diameter only one curve will
then be selected: the single point.

Setting a Diameter tolerance may be needed to make the above selection
process work correctly. For instance a circle of 4.0 mm diameter in an inch
drawing may have been rounded to 0.1575 inch. When DeskProto uses the
exact diameter (0.1574803 inch) it will not find that circle. Clearly you
intended to use it, which is solved by applying this tolerance.

For most toolpaths the chips that are cut off the block can freely fly away.
Not so for drilling, as then the cutter or drill is surrounded by solid material
on all sides. This means that the grooves in the cutter at some point will be
completely filled with chips, which will soon be compressed to one almost
solid mass that will make cutting impossible. The solution is to regularly
retract the cutter to a position above the block, thus freeing the chips. This
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process is called Peck drilling, as it resembles what a woodpecker does.
This parameter offers two sub-settings:
Peck depth is the Z-distance after which a (next) retraction movement needs
to be done
The Retraction Z-value sets the height (above the top of the block) that will
be reached in the retraction movement.

Roughing parameters

Roughing is applied when the cutter cannot reach the required Machining
depth in one cutting movement, either because the cutter's cutting length is
not sufficient or because the material is too hard to machine all at once. The
total depth then will be reached in a number of cutting passes (layers), each
on a lower Z-level.
Roughing can also be used to achieve a high quality result: when the roughing
toolpaths have removed most of the material, the load for the finishing
toolpaths will be low which will reflect on the resulting quality (less
vibrations in the cutter).

When you un-check Use Layers the cutter will immediately go down to full
depth. This choice is not allowed for the first Vector operation of a part:
DeskProto does not allow the cutter to remove more material (dive deeper)
than is possible for the cutter: its maximum layering height, as explained
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on the Geometry roughing page. In case you are sure that sufficient material
has already been removed to allow skipping the layers (for instance by a
Geometry Operation) you can add an extra Vector operation to the part,
before the current operation, and make it invisible (an unused dummy
operation).

The Layer height that is specified determines how deep the cutter may go
into the full material. You can set this Layer height to the Cutting length of
the cutter or to a Custom value. The custom value may not be higher than
this cutting length though. The default layer height equals the whole Cutting
length of the cutter. In most cases it is preferable to use a smaller Custom
 layer height, as with a tough material you do not want the cutter to use its
total cutting length. As a rule of thumb: set the Layer height equal to the
cutter's (flute) thickness.

For Geometry toolpaths and Bitmap toolpaths the roughing layers are
completely machined, one by one, from top to bottom.
For Vector toolpaths the Roughing Layers are machined in a different way:
the layers are machined per separate curve, of course again from top to
bottom. Only "nested curves" are treated as one group: the complete "nest" is
done layer by layer. Like in the image above, where this sequence is being
followed: layer 1 for the D nest, layer 2 for the D, layer 1 for the E nest,
layer 2 for the E, currently machining layer 1 for the S nest (the red dot
shows the current cutter position), and so on.

The Ramping angle is used when starting to machine. The cutter will first
move to the correct XY position: exactly above the first point to be
machined, on the Free movement height Z-level. Then the cutter will move
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down to that first point to be machined, which is normally done in one
vertical downward movement (plunge).
Such vertical downward movement is not ideal: many cutters do not like that,
and the chips cannot escape from the deep round hole that is created.
Entering a Ramping angle makes DeskProto replace this vertical movement
by a series of ramping movements: go down along a sloping line. See the small
picture in the dialog for this option. You can set how steep this sloping line
needs to be by entering an angle value in degrees: this is the angle between the
sloping line and a horizontal line.
The ramping angle and the length of the vertical movement determine the
length of the horizontal component of the ramp. When this horizontal
component is less than 10% of the cutter radius DeskProto will not apply
ramping.

Setting an Allowance keeps a cutter at that distance of the actual curve when
roughing. The allowance prevents that the cutter takes away too much
material (this can happen as the cutter will vibrate and may bend when
roughing). The allowance also improves the resulting surface quality, as
during finishing the tool will remove the same small amount of material all the
time. It is the equivalent of the Skin in a Geometry operation, however
applied only to X and Y.

When an Allowance is set it is possible to Add a finishing profile path to
the operation. This path will follow the exact curve and remove the
allowance, using the same cutter.  In order to finish with a different cutter (for
instance smaller in case of small details) you need to use separate operations
for rouging and finishing.

For this finishing profile path you can finally define the Direction of milling:
Shortest route, Conventional or Climb, see the explanation above (tabs
Profiling and Pocketing).
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Advanced parameters

Start / End offers the option to add extra commands to the NC program
before the operation toolpath starts and/or after it has ended. These
commands can be movement commands and/or user defined commands. They
can be used for instance to make the cutter move to a safe position before
rotating the 4th axis. Button Settings... will open the Operation Start/End
settings dialog.

Using the Feedrate for plunge-movements it is possible to decrease the
feedrate when the cutter moves downwards. This may be needed when
machining in metals, as fast plunge movements may damage the cutter (many
cutters have problems with drilling). It is expressed as a percentage of the
normal feedrate for this operation. 
The rate you enter here will be used for movements that go down along an
angle that is more than (steeper than) 30 degrees. 
For downward movements along an angle less than 30 degrees the reduction
will be smaller: DeskProto will apply the rate as specified + 20.  So when
you have set the plunge rate to 40 %, these movements will be reduced to 60
% of the normal feedrate.
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4.3.8 Geometry Operation Parameters

DeskProto features three different types of Operations: this dialog is for the
Geometry Operation -- in addition also dialogs for a  Vector Operation and
for a Bitmap Operation are available.

The Geometry Operation parameters are divided into 7 sections by tab
pages. The further to the right, the more advanced the parameters in the tab.
In the Free edition of DeskProto only the first tab page is available and In the
Entry edition only the first and the third tab page, offering less parameters
than the Expert and Multi-Axis editions.

This dialog can be reached via the Parameters menu, third option.
Or you can double-click on a geometry operation line in the project tree (one
of the third level items).
Or right-click on a geometry operation line and select Operation Parameters
in the context-menu.

When a geometry operation is part of a Chain with more than one geometry
operation, an extra button will be present: Apply to chain. After changing
one of the operation's parameters, for instance the Strategy, you can press
that button in order to apply this change to all geometry operations in the
chain.
Note: this button is present only in geometry operations, and it will not
affect any bitmap operations and/or vector operations in the chain.

This same dialog is used for the Default Geometry Operation parameters,
only with an extra button Restore DeskProto defaults to reset the original
default parameters.

The Geometry Operation parameters are identical to the Bitmap Operation
parameters. The Geometry Operation applies them on the Geometry, the
Bitmap Operation applies them on the Bitmap relief.
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General parameters

Name
The name of the  operation can be changed; use a meaningful name to easily
remember the purpose of each specific operation. The name is meant for your
convenience only, it is not used in the NC program file. It may be used for
the file name though, in case the NC output is in more than one file (for
instance because of a cutter change)

Cutter
You can select the Cutter to be used from the a list (that will open when you
click on the currently selected cutter). Which cutter is best depends on how
the geometry is shaped. Generally speaking:
- For freeform surfaces use ballnose cutters to reduce the staircase effect.
- For ‘straight/square’ geometries use a flat cutter to get flat horizontal
surfaces and sharp inner corners.
The larger the cutter, the smoother the resulting surface and the faster the
machining. Use small cutters only in case of small details. You can also use a
large cutter for the complete part and a small one later for some detailed areas.
Adding or removing cutters to/from the list can be done in the Cutter library
(Options menu), where you can also view and edit existing cutter definitions.

Precision
Here you can enter the accuracy to be applied. Two parameters are present: 
Distance between toolpaths (also called the Stepover)  and  Stepsize along
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toolpath (each path is built as a large series of movements, each step being a
very small straight line). Normally both distances are set equal. The smaller
these two distances, the more accurate the model, however also
proportionally more time will be needed for both calculation and milling.  
In case you have selected to use the rotation axis, one of both precision
values should of course be an Angle in degrees. Still, as this is easier to
imagine, a distance in mm or inch is used. DeskProto will convert this value
to degrees at the outside of the (cylindrical) area to be machined.

An example will illustrate why this is called Precision: in case the distance
between the toolpaths is set to 1 mm and a cube of 10.5 mm has to be
machined, then this is not possible: the resulting cube model will be either 10
or 11 mm (DeskProto will in fact make it 11). This inaccuracy is a drawback
of the algorithm that DeskProto uses, and is compensated for by its
advantages such as calculation speed and robustness.

The precision values used will be rounded to a value that is calculated by
dividing the diameter of the cutter by an odd number. The 8 predefined values
offered by DeskProto match this formula. You may enter a custom value as
well, which in case it does not match will be rounded to the first smaller value
that does match the formula. The reason to use this rounding is that the
resulting (physical) part will be more accurate, due to the grid-based
algorithm used by DeskProto for its calculations. When the cutter diameter
exactly matches an odd number of grid-cells the results will be most accurate.

For example: When the diameter of the cutter (d) is 4.0, and you enter a
precision value of 1.0, it will be changed to 0.8 (d/5 = 0.8). The value of 1.0
that you have entered will nevertheless be saved in the project. So when you
later change the cutter, the precision will still be (close to) 1.0. For advanced
users some detail precision settings ("subsampling") are available on the
Strategy tab page. These will enable you to use a precision that is higher than
the toolpath distance.

Note 1: 
In this calculation the flute diameter of the cutter is used (so not the shaft
and not the tip). 
Note 2: 
Be careful with a large Stepsize. The cutter will move in a straight line to the
next calculated position, so a large step might damage some in-between
geometry. This is most likely to happen in case of vertical walls, and can be
corrected by the option Protect vertical surfaces.
Note 3:
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When a Skin is applied in the Roughing parameters, the diameter of the
resulting virtual cutter is used. Say you use a ballnose cutter with a 6 mm
diameter, and a skin of 0.5 mm.  Then DeskProto will do the calculations
with a virtual cutter of 7 mm diameter (radius 3.0 + skin 0.5 = 3.5). This
means that the first option in the combo-boxes (drop down menu) for
Precision now will be "7.0 (d/1)" As this is larger than the diameter of the
actual cutter, this first option will be deactivated (grayed out).
Same for other cutter types, though then the geometry of the virtual cutter
will be different (sharp corners will be rounded).
For negative skin value DeskProto allows precision values that are larger than
the virtual cutter.

Speed
The Feedrate is the speed with which the cutter moves through your
material. The value you enter here must be between the minimum and
maximum feedrate values permitted for the machine you selected for the
project. 
Distinguish the feedrate from the actual cutting speed of the tool’s cutting
edge, which is determined by the rotation speed (spindle speed) and the
diameter of the cutter. 
The units used for the Feedrate are set in the postprocessor of the machine
that you selected for your part. DeskProto does not check or even
understand these units: it just copies the number that you enter here to the
NC file. Whether or not you can use decimal values for the Feedrate also
depends on the postprocessor settings: on the Feedrate page you can define
whether or not decimals are used.

Generally speaking a tougher material will require a lower feedrate. Same for a
smaller cutter. A very handy option is to let DeskProto automatically reduce
the Feedrate in high Chipload conditions, on Tab page Movement of this
dialog.

The Spindle speed is the rotation speed of the cutter. The unit is rpm,
which stands for rotations per minute. The value you enter here must be
between the minimum and maximum spindle speed values permitted for the
machine you selected for the project. The smaller the diameter of the tool, the
higher the spindle speed needed in order to get the same actual cutting speed.

Note: 
It is possible to check Automatic Speed setting for a cutter in the Cutter
definition. In that case when the cutter is chosen the Feedrate and Spindle
Speed will be set automatically. That is quite useful for very thin cutters that
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need a low feedrate and a high spindle speed as otherwise you could forget to
set the correct speeds and break your cutter.
Note:
Each Speed option is only available in case your machine supports it, if not
the option will be grayed out in this dialog. For instance on many machines
the Spindle speed cannot be set from the computer but only using a knob on
the machine. This setting (so whether or not this is possible on your
machine) can be made in the Postprocessor dialog (Options menu).

Strategy parameters

The eight available Main strategies should be clear from the pictures drawn in
the dialog. Each main strategy (at the left) has its own Detail settings at the
right.

Parallel toolpaths is the default strategy: DeskProto will project a series of
parallel toolpaths on the geometry. This is the only strategy that is available
in the Free and in the Entry edition of DeskProto.
Detail settings for parallel are the following:  Along X-axis means toolpaths
parallel to the X-axis (so on constant Y), and Along Y-axis means toolpaths
parallel to the Y-axis. For each of these, two starting points are available:
start at the front side versus at the back side (reversed), and start left versus
start right (reversed). 
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In addition an Angle with X-axis can be entered to create toolpaths that are
not parallel to X and Y, but still parallel to one another. The angle value may
not be negative: instead the desired result can be achieved by selecting Along
Y-axis with a different A-value. The Angle option is not available for rotation
axis machining.

A very powerful detail setting for strategy Parallel is the Helix option. This
will only be shown for Rotation axis machining (so when in the Part
parameters "Use rotation axis" has been checked), replacing option "Angle
with X-Axis".  It will only be active (enabled) when:
· in the Advance Machine parameters option "A-values may exceed 360"

has been checked
· on tab page Movement either Conventional or Climb has been set as

Cutting direction
· the Parallel toolpath detail settings are either Around A or Around A

reversed
· The Area to be machined includes the complete cylinder (so range from 0.0

to 360.0 for A)
· you have a Geometry operation: the Helix is not supported in Bitmap

operations.

Without this option checked, each toolpath around A will be at one constant
X-value. After one complete 360 degree rotation the cutter will move along X
to the next X-value and start the next toolpath. So two 90 degree corners for
each rotation will result, which will slow down the milling process. The
Helix option will change that and produce one long toolpath without
sharp corners: both X and A will show a continuous movement, with the Z-
value following the geometry. Perfect for shoe lasts, fishing lures and many
more rotary parts.
Using the Helix option combined with Roughing layers (and sorting) will not
give optimal results:  the Helix path will be interrupted when skipping what
is done in previous layers. Best is to use Helix only for finishing.
The last detail setting for Parallel is the Surface sampling refinement: see
below.

Second strategy is Crosswise. This is the same as creating two operations
where one of them uses parallel to X and the other one uses parallel to Y.
When you would use two operations there would be redundant calculations
though, resulting in longer calculation time: hence this strategy. This option is
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useful in case the model you want to produce must have a very high surface
quality: the staircase effect resulting from the parallel X toolpaths will be
removed by the parallel Y toolpaths and vice-versa. 
As Detail setting you can choose which of the two directions has to be done
First, and here as well you can enter an Angle with X-axis.
The last detail setting for Crosswise is the Surface sampling refinement:
see below.

The Block strategy combines toolpaths parallel to X and Y to a sort of
rectangular 'spiral'. These are probably the most efficient toolpaths, very
suited for roughing. So the wizard will as a default select this strategy for its
roughing operations.
The Detail settings for block offer two options: inside out versus outside
in, sufficiently explained by the name and the small drawings, and Angle
with X-axis as just described.
The milling direction can be set on the page Movement tab of this dialog.
When machining Outside-in: Conventional will start left to right along X
(Counter-Clockwise), Climb will start front to back along Y (Clockwise).
The last detail setting for Block is the Surface sampling refinement: see
below.

Circular is a completely different strategy: the rectangular base pattern
(grid) as applied in the first strategies is not used. In top view the toolpath
shows true circles, projected onto the 3D geometry. For each XY toolpath
position the Z-value is calculated using a special radial Z-grid. Of course that
strategy is very well be suited for round geometries, like rings or cups.
Detail settings are:
Inside out versus outside in (same as for block strategy)
Yes or no machine the corners: this concerns the area inside the rectangular
area to be machined but outside the largest circle that touches all four sides of
this area. This option is available only in case the Center has been set inside
the operation area: if not it will be "grayed out".
Yes or no make it a Spiral toolpath (in top view). This is a great strategy for
high speed machines as no sharp angles are present in the toolpath.
Set the Center point of the Circle/spiral toolpaths. Standard this point is set
in the center of your Operation area, however you can also choose the Center
of the Part's material block, or any Custom XY values. These custom values
then can be either typed or graphically set using the Set button. The center
point may even be outside the block.
Here as well the milling direction can be set on the page Movement tab of this
dialog: Conventional result in a counter-clockwise direction, Climb clockwise
(for outside-in).
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If you want you can display and enter the values for the center in
Translated coordinates. When you have checked this checkbox the
coordinate values are displayed in the coordinates as used on the machine
(after Translation has been applied). Checking or unchecking this checkbox
does not influence the toolpaths. It’s just a temporary conversion in this
dialog to make setting the centerpoint easier.
Strategy Circular is not available for rotation axis machining.

Radial is the complement of circular: same Z-grid, however now radial
toolpaths (so perpendicular to circular). The same Detail settings apply here
as well, except for the Spiral. And the sequence of the toolpaths now is called
Clockwise versus Counterclockwise.
Strategy Radial is not available for rotation axis machining.

Offset machining generates toolpaths as offset lines to the border of the area
to be machined.
This area can be defined either using option Skip Ambient, using a (freeform)
Area to be machined, or using a combination of both. For a complete
rectangular area the paths will be similar to the Block strategy, for a round
area the paths will be similar to the Circular strategy; the power of the Offset
strategy is that this will work for any freeform area to create toolpaths that
follow the shape of the geometry.
You can for instance apply the automatically generated freeform area that
follows the outer contour of the geometry. The result will be the same as
when using Skip Ambient, however now the Border settings can be used.
Typical application example is machining corrective insoles (to be worn
inside shoes), which can be done very efficiently with toolpaths parallel to
the sole's outer contour.
Detail settings for Offset are: 
Inside-Out versus Outside-In will be clear, and Surface sampling
refinement will be explained below. 
This strategy produces a number of "parallel" toolpaths, and Smooth
toolpath transitions concerns the transition to each next toolpath. Normally
the last point of the finished path will be connected to the first point of the
next path, resulting in two 90 degree angles in the toolpath. On fast machines
this will cause the machine to reduce the feedrate at these points. This can be
prevented by checking the option Smooth toolpath transitions: DeskProto
then will ignore these last points and first points, and instead will connect the
last-but-one point of the finished path to the second point of the next path.
The result will indeed be a smoother transition. Be careful though: ignoring
two points for each transition may cause DeskProto to remove too much
material.
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Fill Gaps: the Offset toolpaths follow the outer contour of the area to be
machined, each next toolpath at the prescribed distance from the previous
one. In the center of the area the paths from opposite sides will meet, and
there the distance between the last toolpaths may be larger then the
prescribed distance, creating gaps in the toolpath pattern. See the small
drawing in the dialog. For flat cutters this will not be a problem, for ballnose
cutters at these gaps the cusp (ridge of remaining material) will be higher than
for the rest of the geometry. To prevent this unwanted situation you can use
the option Fill Gaps: then DeskProto will add extra toolpaths to also fill
these gaps.

Waterline machining produces toolpaths on a constant Z-level (just like the
waterlines over a ship’s hull). Such strategy is also called contour machining
or Z-plane machining. While the difference with toolpaths on constant X or
on constant Y seems small, in reality the difference is huge as completely
different calculation algorithms are needed. In the Detail settings an extra
parameter is needed: the Waterline distance (so the distance between two
toolpaths in Z-direction). The XY toolpath distance parameter as set on the
General tab page is also used: when horizontal surfaces have to be filled. 
Important is to realize that only on each prescribed height level a toolpath
will be present. Imagine for instance a geometry with a horizontal top surface
and a hole in that surface (pocket) of 9.5 mm deep. Z=0 is at the top of the
part. When you set the Waterline distance at 2 mm, toolpaths inside the
pocket will be generated at Z=-2.0 , Z=-4.0 , Z=-6.0 and Z=-8.0  So the
depth of the resulting pocket will be 8 mm, not 9.5 as in the Geometry.  You
can of course calculate a Waterline distance that will give a better result: 9.5/5
= 1.9 mm instead of 2.0 will result in a hole of exactly 9.5 mm deep.
A second waterline parameter is the choice between Top to bottom: start at
the highest point and work down, and Bottom to top: start at lowest Z-level
on the outside of the block, and work towards the top.
Finally the Detail parameter Fill horizontal planes is offered. This option
needs some explanation. As waterline toolpaths have a fixed Z-distance in-
between each two toolpaths, at (almost) horizontal surfaces there might be a
large distance between two toolpaths. This (horizontal) distance may be
larger than the diameter of the cutter: resulting in islands of material remaining
after completing that operation. The option Fill horizontal planes checks
where the horizontal distance is too large, and fills the space with toolpaths
at a distance as specified on the General Tab. All these in-between toolpaths
have the same Z-value, so a visible staircase effect will be the result. You can
un-check this option when you use a waterline operation for finishing, as in
that case all material has been already removed by previous operations. This
will save you much time, both for calculating and for milling.
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The last strategy Contour only is in fact an additional strategy as it does not
machine the complete part: only the outline of the geometry (outer contour)
at ambient level is machined. This can be used after some other strategy: to
smoothen the model (when DeskProto creates toolpaths that are parallel to
the X- or Y-axis, at places where the outside surfaces are almost vertical the
contour can show a staircase effect). You can also use it for "Pre-roughing"
the material: Give your block the correct outside shape before you start
roughing, which will reduce the amount of chips.
You can use detail setting Offset to have the Contour line toolpath keep a
certain distance to the geometry: add a skin, however then only for X and Y.
Just as for a Roughing skin defining an offset will change the pre-set Precision
values, as the offset is achieved by using a different cutter diameter for the
calculations.
Detail setting Ignore enclosed contours does exactly what its name
suggests: when a hole is present in the geometry the normal result for this
strategy will include a contour path within this hole (nested contours).
Checking this box will make DeskProto create a toolpath only for the outer
contour.

The Surface sampling refinement parameter that is offered for some
strategies is meant for advanced users, as normally the default values are
appropriate. After checking the box you can use the Settings button. As a
result the Surface Sampling refinement dialog will be shown that allows you
to fine-tune the cell-size of the Z-grid, which will influence the calculation
precision.
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Roughing parameters

Roughing stands for quickly getting rid of most of the material without
milling very precisely. So after an roughing operation you will need a second
operation which machines the same area more accurately: the finishing
operation. In DeskProto you can use an operation either for roughing or for
finishing, so if you need both you will have to Add an operation in the
General Part parameters.

When roughing you want to make sure that the cutter does not cut too deep
into the material: deeper than the cutting length of the cutter is not permitted
(though for hard materials that will still be way too deep).
The roughing option Layer Height maximizes the cutting depth: instead of
trying to remove all material at once, this will be done layer by layer. The
default layer height equals the complete maximum layering height of the
cutter, see the image below. In most cases it is preferable to use a smaller
Custom  layer height, as with a tough material you do not want the cutter to
use its total cutting length. As a rule of thumb: set the Layer height equal to
the cutter's (flute) thickness.
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The image above shows why for ballnose cutters the Cutting length of the
cutter cannot be used as maximum for the layer height. When machining layer
1 rest-material will remain at the ballnose top of the cutter, which then in
layer 2 would collide with the shaft of the cutter. Shown in red in the image.
As the shaft of the cutter cannot cut this is not permitted. So DeskProto uses
a maximum layering height that is smaller than the cutting length of this
cutter. When this max layer height is smaller than the radius of the cutter (and
when roughing layers are applied) DeskProto will show a warning that "the
selected cutter may not be suitable for roughing layers".

For conical cutters the situation may be worse, as for such cutter the
complete cutting edge may be conical (so no vertical edge as in the above
image). For such cutters DeskProto will show the above warning when
applied in a roughing operation: the user then can decide whether or not this
is acceptable. Many jewelers for instance use only conical cutters ("V-bits"),
however for machining wax models this bit of rest material is no problem at
all. The warning is optional, so a jeweler can simply uncheck the "Always
show" checkbox for this warning.

The first Geometry operation of each part always uses layers.  This is done
automatically and cannot be overruled: DeskProto does not allow the cutter
to remove more material than possible for the cutting length of the cutter. For
subsequent operations you can un-check Use Layers: the cutter will then
machine at full depth all the time. 
When you absolutely need a first operation without layers, and you are very
sure that sufficient material has already been removed to do this, you can add
an extra Geometry Operation to the part, before the current operation, and
make it invisible (an unused "dummy" operation).
Note:
The first layer starts at the top of the material block. When your block is
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higher than the part you can use a custom Material block having a higher
Maximum Z value.

Entering a Skin Thickness results in a model which is thicker: a skin is
added everywhere around the model, as an extra allowance. In this way the
chance that the cutter takes away too much material is reduced (this can
happen as roughing typically will be done using a low precision, and as the
cutter will vibrate and may bend during roughing). Using a skin also improves
the resulting  surface quality, as then during finishing the tool will remove the
same (small) amount of material all the time. Internally DeskProto processes
the skin by applying a different size (and shape) cutter.
It is possible to set the Skin on a negative value, making the resulting part too
small. This is interesting in some special cases, like for creating electrodes for
EDM machining (spark erosion), or for machining a foam core to apply
modeling paste on for the final cut to size.
Of course entering a value of 0.0 means that no skin will be applied.
Warning on skin use: 
The skin is also applied on vertical surfaces, which in case of high vertical
walls may lead to a problem during finishing. When finishing the cutter
machines on full depth, so it will try to take off the skin of the complete
vertical wall in one go. In case the wall is higher than the cutting length of the
tool this is a problem for which no automatic solution is available yet. An
easy workaround to solve it is to add an operation using the waterline
strategy, milling from top to bottom, and machine these waterline toolpaths
first.

The Ramping angle is used when starting to machine. The cutter will first
move to the correct XY position: exactly above the first point to be
machined, on the Free movement height Z-level. Then the cutter will move
down to that first point to be machined, which is normally done in one
vertical downward movement (plunge).
Such vertical downward movement is not ideal: many cutters do not like that,
and the chips cannot escape from the deep round hole that is created.
Entering a Ramping angle makes DeskProto replace this vertical movement
by a series of ramping movements: go down along a sloping line. See the small
picture in the dialog for this option. You can set how steep this sloping line
needs to be by entering an angle value in degrees: this is the angle between the
sloping line and a horizontal line.
The ramping angle and the length of the vertical movement determine the
length of the horizontal component of the ramp. When this horizontal
component is less than 10% of the cutter radius DeskProto will not apply
ramping.
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Ramping is applied only when moving down to the first point of an
Operation (in case of multiple layers: for every layer). It is not applied on
other downward vertical movements.

The option to Protect Vertical Surfaces is useful when roughing with a
large value for the Stepsize along toolpath. In case the steps are large they
may not “see” all geometry in-between and remove too much material. This
may happen in case of vertical or steep surfaces in the geometry. Checking
this option will replace any tool-movement steeper than 45 degrees by
separate horizontal and vertical component movements. Take care: on many
machines this may cause unwanted vibrations as smooth paths are replace by
staircases, so only check this option in case needed.
This resembles the algorithm as used in Vertical surfaces in the Advanced
Operation parameters with a height/step ratio of 1, however this latter
advanced option is more intelligent.

Area parameters

This tab page offers almost the same options as the Material tab page of the
Part parameters. 
Note that the functionality that is offered is different though !  The Material
block defines the size of the complete Part: any geometry outside the
boundaries of the Part will be removed. The Operation area only defines the
area to be machined. So it limits the toolpaths for this Operation, to be
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used for instance when there is a small area of the part that is very detailed
and needs to be machined with a smaller tool in an extra operation. Any
geometry outside this area (and within the part) will not be damaged.
As you can see in the icon pictures, the bounding box of the area is be drawn
in green lines.
The area definition also applies to the Z-axis, allowing you to set a maximum
machining depth and height for the area.

The image above shows six edit boxes. This is how the page looks in a part
that uses three-axis machining. For a part that uses rotation axis machining
(4th axis) the page will show 10 edit boxes, of which only six can be edited.
Min and max Y and Z then cannot be edited (only viewed), and extra edit
boxes are present for min and max Radius and Angle of the Operation area.

The default option here is Use material block (Part). This means that the
cutter will machine the whole part you want to create. 

When your material block is smaller or larger than the CAD data that you
loaded it may be handy to use the bounding box of the relevant data type as
area:
In a Geometry Operation this can be done by choosing option Use geometry
area.
In a Bitmap Operation this can be done by choosing option Use bitmap area.

A next extra option is available for rotary projects: Use material block
above rotation axis.

Two types of custom area are available:

Custom rectangular sets a rectangular block (or a cylinder) as area, just as
for the material block. This block can be defined by entering the min and max
Boundaries in the edit boxes at the right, or graphically. 
Checking the option Display translated coordinates changes the numbers
that are shown for the area boundaries: these will now be in workpiece
coordinates as used on the machine, so after Translation. Only the numbers
shown here for input are changed, not the actual coordinate values in the
toolpath: it is just a temporary conversion on screen for setting the
boundaries more easily.
The button Set graphically pops up the Set Area dialog that makes it very
easy to set any area using the mouse.

The second type is the Freeform area. This option allows the use of areas
that are not rectangular, for instance a circle or any freeform contour
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(freeformed in top view). Button Set freeform pops up the Set freeform
area dialog.
For a freeform area the Min and Max X and Y values shown as Boundaries
relate to its bounding box. The min and max Z can be set as for a rectangular
area. A freeform area is not possible for a part that uses the rotation axis, in
that case the option is not shown.

Final option is Use area of 1st geometry operation, of course active only
for second and further geometry operations in the part. This is a handy
option for instance when a complex Freeform area needs to be used both for
Roughing and for Finishing.

The area may not be larger than the block of material that has been defined for
the part, for any of the axes.

Borders parameters

In order to machine all geometry in the area to be machined, the cutter needs
to move a bit outside this area. This is needed as otherwise the cutter cannot
reach the (almost) vertical surfaces an the outside edge of the part. The small
images in the dialog show why this is needed. In DeskProto this extra area
called the Border area, and on this tab-page you can influence the size of the
border area. 
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The Z-level used for the border area is set at the Ambient tab of the Part
Parameters. 
Note that you can also make the material block or the area larger to add extra
area to be machined.

The default option is Extra for cutter, which sets the border area size
exactly to what is needed to let the cutter go around the model, in order to
machine all outside surfaces of the part. 
In the four edit boxes you can see that this value matches the Radius of your
cutter. The cutter will of course cut at its full diameter, however here we
consider the position of the center of the cutter. And for this center the max
distance to the geometry is the Radius of the cutter.
The size of the Extra for cutter area is different when you have set an Angle
in the Strategy sub-settings (toolpaths at an angle with the X-axis or Y-axis).
We have found that the border area then needs to be larger, as otherwise the
cutter cannot completely move down on all sides of the part. How much
larger depends on the Angle that has been set.

The second option, No extra, keeps the cutter positions (for the centerpoint
of the cutter) exactly inside the area to be machined. Using this option it is
still possible that the tool cuts away material that lies just outside the area, as
half of the cutter reaches outside. DeskProto will anyway check that any
geometry that belongs to the Part is not damaged. 

The option Cutter stays within area means that the whole cutter will stay
inside the area to be machined. This option is used by the Two Sided Milling
Wizard, to make sure that the area that is machined is exactly the same for all
operations, no matter which diameter cutter is used.

The last option, Custom, makes it possible to define the border sizes
yourself, using the four edit boxes. The values may  be positive values as well
as negative. For negative values there is a limit though, as obviously some
area that can be machined has to remain.  Four boxes are available only if the
area to be machined is a rectangle: for a freeform area only one border size can
be set. And for rotary machining only the two X-borders can be set.

The use of the checkbox Uniform will be clear: it forces all four edit boxes to
have identical values.
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Movement parameters

The Cutting direction is important for the surface quality of the prototype.
The default direction is Meander, which means that (for parallel toolpaths)
the first movement is from left to right, the second from right to left, etc. The
tool keeps cutting all the time, so meander is the fastest option. 

However, on the surface of the model you may see a difference between the
movements going from left to right (L-R) and the movements in the opposite
direction. The  surface will be smoother when all movements go in the same
direction. Obviously there are two possibilities here: L-R and R-L. The
words Climb and Conventional refer to the relation between the direction
of milling and the rotation direction of the tool (normally clockwise): see the
small drawings in the dialog.
Note that choosing the option Climb or Conventional in fact does not
guarantee it to be used all the time: when machining a downward sloping
surface it is possible that in fact the back of the tool cuts, thus reversing the
actual cutting direction.

Meander is not possible for all strategies: for strategies Block, Spiral, Offset,
Waterline and Contour meandering cannot be selected: for these strategies it
would not make sense. That is, unless the option Sort is active. When sorting,
also for these strategies some areas may be present where the toolpaths can
be optimized by making them meander. In these cases DeskProto offers the
Meander direction with the remark "only optimizes sorting".
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You will have to test though whether or not this works for your project: in
some special cases selecting Meander will lead to extra positioning
movements, so to a longer toolpath.

The Free movement height is the Z-level at which all ‘non-cutting’ tool
movements will be executed, also called the "Safe height". This is for rapid
positioning movements over the part, for instance from the home position to
a position above the first point to be milled. The Z level you enter here is the
number of units (mm or inches) above the top of the material block. Only
positive values are allowed: in case of a negative free movement height the
model and/or the cutter might be damaged.
When a Skin has been set (Roughing) the free movement level will be the
Skin-thickness higher

This Free movement height (ZFree) value will be used in three ways:
· The first point and the last point of the toolpath for each operation are

located ZFree mm/inch above the top of the Material Block. This is needed
to make sure that the cutter is high enough when moving to and from these
points, so instance to a next operation. These movements are done in
Rapid mode, which is permitted only above the block. 

· The positioning moves during an operation are performed at ZFree
mm/inch above the max Z of the Operation Area, or (in case that is higher)
above the max Z of the geometry within the XY limits of the Operation
area. This is done in order to speed up the process when machining some
detail area at a low Z level.

· When the option Always stay low is checked, the positioning moves are
performed at ZFree mm/inch above the highest point of the geometry
and/or bitmap relief over which the cutter moves. For machines with a
slow Z-axis this will save a lot of time. Also when on your machine
switching between Rapid and Normal movement is slow this will save
time, as these movements below the top of the block are done at normal
Feedrate. Always stay low is not possible when Roughing layers are used.

Positioning movements:
Not all positioning movements are done on this Free movement level, as for
small distances this is not needed. The following movement types are applied
- DeskProto tries if type 1 can be used, if not possible type 2, if not possible
type 3:

1. Direct movement.
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The cutter moves in a straight line between startpoint and endpoint of the
positioning movement.
This happens when:
- the distance is less than 1.9 times the Toolpath distance ánd no
geometry with a higher Z-level is present on the path.
As toolpath distance is used (also for type 2 as described below): for
Geometry, Bitmap and projected Vector the Precision value, for normal
Vector the Pocketing Stepover distance (or its default, being 50% of the
diameter of the cutter tip).
or:
- the distance is less than the cutter-tip-diameter ánd the toolpath is at
constant Z ánd no geometry with a higher Z-level is present on the path.
In both cases as tip value is used: for conic cutters the tip diameter, for other
cutters the flute diameter, in case no flute is present the shaft diameter. So for
conic cutters with a sharp tip this diameter is 0.0 and thus for such cutter no
direct movements are allowed here.

2. Lowered Z-height.
The cutter rises a bit, moves in a horizontal line and then goes down to the
endpoint, at normal Feedrate. The Z-height is Z-Free mm/inch above the
highest point of the geometry below this line (this does not work for a
bitmap relief).
This happens when:
- the distance is less than 1.9 times the Toolpath distance (so when in
type 1 geometry with a higher Z-level was detected on the path) ánd the
cutting direction is Meander.
or:
- the distance is less than the cutter-shaft-diameter ánd the cutting
direction is Meander.
or:
- the distance is less than 10 times the smallest of Toolpath distance,
Cutter tip diameter ánd the cutting direction is Meander.
or:
- in the Operation parameters the option "Always stay low" has been
checked ánd the cutting direction is Meander.
Exception: "Always stay low" is not (yet) possible when roughing layers are
applied, as then for some strategies the lowered positioning movement might
travel through un-machined material.
For Vector operations without geometry checking Always stay low will only
change the Feedrate, not the Z-height.
The condition cutting direction is Meander does not apply for Vector
toolpaths.
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3. Free movement height.
The cutter rises to Free movement height for a positioning move at Rapid
speed.
The Free movement height is Z-free mm/inch above the top of the operation
area or, if that is higher, Z-free mm/inch above the highest point of the part
geometry that the cutter travels over. The first point and the last point of a
toolpath are at Z-Free mm/inch above the top of the Material block.
This happens in all other situations.

One last remark about the Free Movement height, for advanced users. While
in this dialog the user-interface offers the option Always stay low, in
addition a hidden option is present, called Never stay low. This option
cannot be checked in the user-interface, in order to use it you need to change
this:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\7.1\Custom\NeverStayLow
For MacOS change line "7·1.Custom.NeverStayLow" in file DeskProto.plist 
For Linux change line "Custom\NeverStayLow" in file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !

When for this value "true" is found, DeskProto will let the cutter rise to Free
movement height for every positioning movement. So also when proceeding
to the next toolpath. This hidden option is used for a few applications where
roughing is done by a saw (saw-blade, chain-saw), as that cannot move
sideways.
When the string is "false" (or in fact any other text) nothing will happen.

The Dynamic Feedrate control is an advanced option of DeskProto: even
many so-called high-end CAM software packages do not offer this type of
functionality. It means that DeskProto is able to reduce the feedrate when
needed, thus making it possible to select a high overall feedrate without the
danger of breaking your tool at a critical point in the process. Two separate
options are offered. In both cases you can enter a percentage for the
maximum feedrate reduction applied; and in both cases DeskProto will
choose in-between feedrates whenever possible, thus always running at
optimum feedrate. Note that both options can be combined, in which case for
certain movements both reductions will apply, resulting in a very low
feedrate.
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With the Feedrate for plunge-movements it is possible to decrease the
feedrate when the cutter moves downwards. This may be needed when
machining in metals, as fast plunge movements may damage the cutter (many
cutters have problems with drilling). It is expressed as a percentage of the
normal feedrate for this operation. 
The rate you enter here will be used for movements that go down along an
angle that is more than (steeper than) 30 degrees. 
For downward movements along an angle less than 30 degrees the reduction
will be smaller: DeskProto will apply the rate as specified + 20.  So when
you have set the plunge rate to 40 %, these movements will be reduced to 60
% of the normal feedrate.

It’s also possible to decrease the Feedrate for high chip loads, which
happens when the cutter has to remove much material. Due to DeskProto’s
parallel toolpaths approach, normally the cutter only has to remove a small
slice of material: a thickness of only the distance between two toolpaths (the
stepover) is removed. However, in certain cases the cutter has to remove
material over the full flute diameter, which is a much higher chip load. For
instance for the first toolpath (as often the block will be a bit larger than
needed); also when for the first time entering a pocket in the model (so when
the tool suddenly has to machine much lower than during the previous
toolpath, as shown in the small image). The chip load is even higher in such
cases as the chips cannot easily spread out but will be stuck in the groove
that is machined. 

In these cases the feedrate will be reduced, the actual reduction depending on
how much deeper the tool has to cut compared to the previous toolpath at
that position. Reduction is applied according to the following rule, where D is
the cutter’s flute diameter and Rate is the percentage that was entered. The
column "Example" shows the resulting actual reductions in case a value of 20
% resp 70 % has been entered. 

Difference in depth: Reduction percentage: Example:

For rates below 60 %:
Until 0.1*D 100 % 100 %
0.1*D - D Rate + ½ * (Rate)  30 %
D - 2D Rate + ¼ * (Rate)  25 %
more than 2D Rate  20 %

For rates of 60 % or higher:
Until 0.1*D 100 % 100 %
0.1*D - D Rate + 2/3 * (100-Rate)  90 %
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D - 2D Rate + 1/3 * (100-Rate)  80 %
more than 2D Rate  70 %

So (explanation of the table above): reduction is applied only in case the
cutter machines deeper than in the previous toolpath, with a margin of 
0.1*D (10 % of the cutter diameter D). When between 0.1*D and D deeper
the first reduction step is applied, between D and 2D the second, and when
the difference is more than 2D the full reduction percentage is applied. In the
toolpath drawing on screen, the paths at reduced feedrate will be drawn in a
slightly different color (purple instead of red).

The option Reduced feedrate for high chiploads is not available for all
strategies.
And these Dynamic Feedrate options are of course only possible on
machines that can set the Feedrate from the PC, which is determined by the
Postprocessor.

The Number of Reduced Initial Paths.
As mentioned above this option will also reduce the feedrate for the first
toolpath of an operation. When machining a flexible material (for instance
foam) it may be needed to reduce the feedrate for more than just this one first
toolpath. This has been implemented a "hidden feature", using a setting called
NumReducedInitialPaths, which sets the number of initial toolpaths to be
reduced. The setting will work only for strategies Parallel, Crosswise and
Block.

It can be switched on by editing this setting and giving it a value from 1
(default ) to 9:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\7.1\Custom\NumReducedInitialPaths
For MacOS change line "7·1.Custom.NumReducedInitialPaths" in file
DeskProto.plist 
For Linux change line "Custom\NumReducedInitialPaths" in file
DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !

DeskProto is able to Optimize the toolpaths using a Sorting algorithm. It
will then ignore the sequence as defined by the Strategy, and instead try to
complete series of tool-movements that are located close to one another. For
instance when machining the Picture frame sample geometry using strategy
'Parallel to X' and skipping the empty inside of the frame, the cutter would
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normally need to make positioning movements from the left to the right side
of the frame all the time. Sorting will make DeskProto first complete one side,
and only then start with the other side: preventing many positioning
movements. Sorting can especially save much time in case many roughing
layers are applied.

Background information about the sorting algorithm that is used, written by
the programmer: 
In DeskProto each toolpath is a series of small lines (linear interpolations, or
G1 movements), where each movement is a straight line between two points.
A series of connected movements (in fact a polyline) is called a chain. A chain
ends when a positioning movement (go up, position, go down) is needed.
The third concept that is used is the tour: a tour is one complete path for the
chosen strategy, so when not interrupted for some reason. For strategy
parallel a tour is one complete path from left to right, for block one complete
path around all four sides, etc. Subsequent tours are more or less parallel to
one another.
Sorting compares the start point and endpoint of each chain with all chains on
the next tour. If on that next tour a adjacent chain (so both start points and
end points close) can be found that is closer that the next chain on the same
tour, then DeskProto will jump to the chain on the next tour.

For the waterline strategy the situation is more complex. Here DeskProto
uses the bounding box of each chain. If the bounding box of a chain does not
overlap any other bounding box (on the same Z-level) then it is an isolated
chain. After machining such isolated chain DeskProto will jump to an isolated
chain on the next Z-level (and on the same location). So when machining a city
with church towers, sorting will make DeskProto complete the towers one by
one, instead of finishing a complete Z-level before starting on the next Z-level.

For the Contour-only strategy sorting can change the sequence of the
contours - of course only in case more than two separate contours are
present.
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Advanced parameters

Ambient skipping concerns the ambient area. Basically DeskProto always
machines a complete rectangular area, due to its parallel toolpaths approach.
The area where no geometry is present is called the Ambient area. In case the
model only takes up a small part of the area, this might lead to unneeded extra
chips and unneeded extra machining time. Also: when all material around the
model already has been removed in a previous roughing operation there is no
need to again machine the ambient area when finishing.
In such situations you can optimize the toolpath by using the Ambient
skipping option. 
· By default this option is set to Machine all: the complete area will be

machined.
· Skip hor. ambient means that all extra horizontal movements on ambient

level, from the model to the edge of the block and back, will be skipped.
The tool will still go down to ambient level around the model.  You can for
instance use this for finishing, when all ambient material has already been
removed by the roughing operation.

· Skip Hor. + Ver. ambient means that both horizontal movements on
ambient level and the vertical movements towards ambient level will be
skipped.  For ballnose cutters then still a groove round the part will be
visible: when only a small part of the cutter is above the model the tip of
the ball will have a lower Z-value than the part geometry at that point.
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· Skip Total ambient means that the center of the cutter will remain above
the geometry: all positions with the center of the cutter above ambient area
will be skipped.

The icon images on this tab page illustrate the differences between these four
skipping options.
For this skipping feature DeskProto will use as ambient the area where no
geometry is present on the minimum Z-level of the operation area. This may
differ from the Ambient area as used in the Part parameters.

An extra option that can be checked here is called Ignore enclosed ambient.
When checked, only the ambient around (so on the outside of) the part will
be skipped. The enclosed ambient area, like for instance within holes in the
model, then will be machined.

Start / End offers the option to add extra commands to the NC program
before the operation's toolpath starts and/or after it has ended. These
commands can be movement commands and/or user defined commands. They
can be used for instance to make the cutter move to a safe position before
rotating the 4th axis, or to insert a comment line that mentions the name of
the next cutter to be loaded. Button Settings... will open the Operation
Start/End settings dialog.

The algorithm used by DeskProto to calculate toolpaths does not really
support true Vertical surfaces. DeskProto calculates its toolpaths based on
a Z-Grid, connecting points of the grid to form the toolpath. For each XY
position in the grid only one Z value is available, which means that vertical
movements are no possible: that would require two points with the same XY
and a different Z. Each tool-movement will thus contain both a horizontal and
a vertical component, the horizontal component being the stepsize along the
toolpath. As result a vertical surface in the geometry may be machined having
a small angle in the resulting part. 
BTW this is not true for all strategies: the above does not apply when using
waterline toolpaths

In case you need your model to have true vertical surfaces (and you do not
want to use waterlines) you can achieve that by using and fine-tuning this
option. You can let DeskProto assume a vertical surface in case the ‘toolpath-
line’ is steeper than a certain angle. The angle is defined by the Ratio between
the height and horizontal distance (stepsize) of one movement in the
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toolpath, and in the edit box you can set the Height/step ratio to be used.
See the illustration and examples below.

For every movement DeskProto will check this ratio, and for a movement
that exceeds the ratio (so when the movement is steeper), DeskProto will
insert an intermediate movement: the movement will be split into a horizontal
and a vertical component, to be executed sequentially. The result will be a
vertical surface in the model, which otherwise would have been angled. 

Example:  Vertical surface ratio = 8
The image below shows a geometry with a vertical wall on the left and a
sloped wall on the right. The Stepsize has been set to a value that is 1/8th of
the total height of the geometry. You can see 2 toolpaths: one drawn in black,
one in red. The black one is the one that is first calculated. When you then
check the vertical surface ratio option and set it to 8, the toolpath will be
changed to the red one. So on the left side the toolpath will have been
corrected whereas on the right it will not, because on the left the height/step
ratio is 8/1 whereas on the right the height/step ratio is 8/2 = 4/1. In the
drawing these two ratio's are shown as purple triangles. On the left
DeskProto assumes a vertical surface and changes the toolpath, on the right
side not. For a vertical surface DeskProto will add one cutter movement at
this point, splitting the original angled movement into a vertical and a
horizontal part. These two movements will be output in a sequence that
leaves extra material on the part.

The implementation of the Vertical Surface setting is different for tab page
Roughing (image on the left) and tab page Advanced (image on the right):
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In the Advanced implementation the extra position will be added only for the
first movement (or the last for an upward toolpath), meaning that this will
only happen at the transition point between a "horizontally oriented" section
of the path and a "vertically oriented" section. See the illustration above right,
showing the result for a height/step ratio of 1.
In the Roughing implementation a much simpler version of this algorithm is
applied: with a fixed ratio of 1, and for all movements (so for all lines of 45
degrees or steeper): the illustration above, left. The result will be a staircase
shaped toolpath and a lower surface quality, so select this only when needed.

For parts without vertical surfaces this functionality is not needed, so for
such models choose Do not check for vertical surfaces.

It may be needed to experiment a bit with this option in order to find the best
ratio for your geometry.  Take care when creating parts designed with a draft
angle: in case this option is used the result might be that all draft surfaces will
be made vertical !

Example 2: now with numbers.
Assume that your part contains a vertical surface of 15 mm high, and that
you have set the Stepsize to be 1 mm. Now a toolpath over this surface has
been generated that includes a horizontal component of 1 mm (the stepsize),
however that you want to be really vertical. The default height/step ratio of
20 then means that when this tool movement goes up or down over more
than 20 mm it will be split up into two separate movements (horizontal and
vertical). As your desired vertical wall is only 15 mm high you need to set the
ratio to (say) 14 to make DeskProto change these toolpaths.
This will work for any Stepsize: when you have for instance selected 0.0262
inch, then the height/step ratio of 20 means that when the tool movement will
be split when it goes up or down over more than 20 x 0.0262 = 0.524 inch.
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Note that this vertical surfaces check does not work for conical cutters as the
steepness of the toolpath is analyzed: for conical cutters the toolpath never
can be steeper than the Angle of the cutter. 

The Collet collision check is a very useful option for high models,
especially with high vertical or steep surfaces. The problem with such models
is that in case the vertical wall is higher than the free length of the tool, the
milling machine’s collet will damage the model (DeskProto only compensates
for the geometry of the cutter, not for the machine-parts that hold the cutter).
Checking this option means that DeskProto will let the tool move away from
the model in such case, preventing the collet to collide with the model.
Obviously the resulting model will no longer be correct, as the material that
cannot be reached by the cutter will be left on the bottom of the vertical wall.
However this is much better than letting the collet damage the top of the
model, as the excess material can later be removed with a different cutter or
by hand. 
The diameter of the collet can be defined at the Machine parameters dialog.
Note that when using this option the border area will be enlarged, to enable
the complete collet to move down on all sides of the model.
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Tilt option parameters

The Tilt Option tab is visible only in case in the Part parameters the option
"Use rotation axis tilt option" has been checked (and in case the machine
supports this type of axis). It is meant for a special type of 5th axis: the
manually controlled B-axis as present on some small wax milling machines for
jewelers. Like on the Roland JWX-10 "Jewela" machine, as shown in the
illustration below:
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In the bottom-left corner of this photo you can (just) see a rotation knob:
after unlocking the rotation mechanism you can use this knob to manually tilt
the complete rotation axis (A-axis) unit.  This machine supports locking on
fixed intervals of 15 degrees.
As this manual rotation is round an axis parallel to Y, this rotation is called a
B-axis. The total number of axes then is 5 (X, Y, Z, A and B), so this is in
fact a (very primitive) 5-axis machine.

The Tilt Angle that you can enter here is the rotation value that will be used
for this Operation. As you can see in the illustration, this rotation offers you
the possibility to machine in places where the cutter normally cannot reach:
for instance the inside of a ring model.
In addition to these 15 degree intervals you can also enter a Custom rotation
value here.

Note that the position of the part after this rotation depends on the distance
between the part and the actual B-axis (so the axis of rotation). The larger this
distance, the more Z-movement while rotating. This distance can be set on
the Zero-point tab of the Part parameters, as at angle 0 this distance is in fact
the X-translation. You will see that this Zero-point tab looks differently
when this Tilt option has been selected.
Setting the correct X-translation here is important: only with a correct
translation all resulting toolpaths from operations with different tilt angles
will be correctly positioned (all working with the same Workpiece zero
point).

The Tilt option is available only for Geometry operations, so not for Vector
and Bitmap.

4.3.9 Bitmap Operation Parameters

DeskProto features three different types of Operations: this dialog is for the
Bitmap Operation -- in addition also dialogs for a  Vector Operation and for a
Geometry Operation are available.

The Bitmap Operation parameters are identical to the Geometry Operation
parameters (except for the Tilt option: that is not available for bitmap). The
Bitmap Operation applies them on the Bitmap relief, the Geometry
Operation applies them on the Geometry. 
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So for information on any of the Bitmap tab pages, jump to these
Geometry operation Help pages:
General
Strategy
Roughing
Area
Borders
Movement
Advanced

This dialog can be reached via the Parameters menu, third option.
Or you can double-click on an bitmap operation line in the project tree (one
of the third level items).
Or right-click on a bitmap operation line and select Operation Parameters in
the context-menu.

This same dialog is used for the Default Bitmap Operation parameters, only
with an extra button Restore DeskProto defaults to reset the original
default parameters.

4.3.10 Select Curves

Purpose of this dialog is to select the vector curves to be used for this
operation, or to edit that selection. 
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It is present in three different versions: once for Profiling, once for
Pocketing and once for Drilling. All three versions offer the same
functionality, except for the options in the "Settings" field. The above image
shows the version for Profiling, the settings for the other versions are shown
below.

The Select Curves dialog can be reached by pressing button "Select..." on
respectively the Profiling tab, the Pocketing tab and the Drilling tab of the
Vector Operation parameters.

A top view drawing is present (no other views), in which all loaded curves
will be drawn in gray. 

Button to open dialog Items visible for Set Graphically, in which
you can select which items should and should not be included in this drawing.
It will be clear that item "Vector curves" now cannot be switched off.

Button Toolpaths will show (and if needed first calculate) the
toolpaths in this top-view drawing. Pressing the button again will remove the
toolpaths from the drawing. This is of course possible only after one or more
curves have been selected.
The use of buttons Previous view and Next view will be known from the
Toolbar.

The leftmost button on the second row is the Select button. It is
one of the five buttons to set the current Mouse function. Four of these are
known from the Toolbar, this leftmost button is the most important button
in this dialog. When it is active you can select a curve by pointing the cursor
at it using the mouse: when pointing correctly the curve will turn purple, for
"selectable". You then can select it by clicking: its color will then change
from gray to light blue, for "selected".
To add more curves to the selecting you need to keep the Shift key (on the
keyboard) pressed (if not a next click will undo the previous selection). 
Undoing the selection can be done by clicking on the white background
(unless the Shift key is pressed).

Button Calculate toolpaths will calculate and show toolpaths for the
selected curves.



Dialogs

Page 213

DeskProto Reference

Below this button DeskProto will show how many curves have been
selected.

Not all curves can be selected:
- Profiling will not accept single points
- Pocketing will accept only closed curves
- Drilling will accept only single points, +-signs sized equal to the cutter
diameter and circles that equal the cutter diameter.
Curves that are not acceptable will be drawn in light gray, for "can not be
selected".
Vertical lines in the vector data (all points have the same X and Y, and
different Z values) cannot be selected in any of these three toolpath types.

A very handy tool is available under tab CAD Layers. Here all layers in the
available Vector data are listed (if any), with a light bulb icon that can be used
so show or hide the curves in that layer.
Many DXF files contain layers, meant to make it easier to access the data by
viewing at it layer by layer. Like in this DeskProto sample file
2D_DpBeerTray.dxf : one layer contains all contours, the second layer
contains all text.  Viewing the curves in this dialog per layer makes it very
easy to select the correct curves, as curves that need the same settings
typically will have been grouped in one layer.
Note that these CAD layers are completely unrelated to the Roughing layers
that DeskProto uses when roughing.
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Under tab Settings you can set the most important parameters for that
toolpath type: the above image from left to right shows the settings for
Profiling, Pocketing and Drilling. These are the same as present in the Vector
Operation parameters, making them also available in this dialog will allow
you to quickly see the resulting toolpaths for any setting.

4.3.11 Set Profiling tabs

When machining a 2D vector profile in sheet material you can set the depth
of the toolpath equal to the material thickness, making a cut that goes
completely through the sheet. When cutting a closed profile this will result in
a separated part: the material inside the profile no longer is connected to the
rest of the sheet.
When the material is clamped only at it's corners, that separate part will be
completely loose, may go wild, and can be damaged and/or cause damage.
Which is of course an unwanted situation.
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DeskProto offers Profiling tabs to solve this problem. Such tab keeps both
sides of the toolpath connected by raising the cutter for a small section of the
toolpath, leaving a small bridge of material that later can be manually
removed. The two images above clearly illustrate how this works: left the
toolpath, right a simulation.

This tab page is about Vector tabs, made by changing the machining depth in
a 2D toolpath. Not to be confused with Geometry support tabs, made by
adding small blocks to the geometry. Vector support tabs are available only
for vector curves without Z-values (2D curves). So they also cannot be used
when a 2D curves is projected on a 3D geometry, or when for a 2D vector file
the option "Use Z-values" has been checked in the project parameters.

The dialog Set Profiling Tabs allows you to set the number of tabs, the
location of each tab and the tab size. You can open this dialog on the Profiling
page of the Vector Operation Parameters.  The drawing will show a top view
of all vector curves, with the selected curves drawn in black. Profiling tabs
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can be set only on curves that have been selected for profiling, in the same
operation. The location of a tab is shown by a blue dot, see the screenshot
above.

The buttons in the top right corner offer the following options:

Button to open dialog Items visible for Set Graphically, in which
you can select which items should and should not be included in this drawing.
It will be clear that item "Vector curves" now cannot be switched off.

Button Toolpaths will show (and if needed first calculate) the
toolpaths in this top-view drawing. Pressing the button again will again
remove the toolpaths from the drawing.

Button Add tab will be active as default when you open this dialog.
It sets the mouse function to adding tabs: move the cursor over the drawing
to highlight one of the black profile curves (it will become violet) and left-
click: on that location a blue dot will be added on the profile.

Button Delete tab sets the mouse function to deleting tabs: move
the cursor over the drawing to highlight one of the existing blue circles, then
left-click in order to remove it.

Button Move tab sets the mouse function to Moving tabs: move
the cursor over the drawing to highlight one of the existing blue circles, then
left-click: while keeping the mouse button pressed you can move the blue
dot. Moving is possible only along the profile curve.
The meaning of all other buttons is the same as on the main screen, so needs
not explanation here.

Other options on the right side of this dialog:

Tab length
The length of the tab is the distance along the curve along which some
material will be left. That is not the same as the length of the elevated
toolpath fragment: that needs to be increased by the cutter radius on both
ends.
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You can set the tab length either as a Percentage of the cutter diameter (so it
will work for any size cutter and any size part), or as a Fixed distance in mm
or inch.  

Tab height
The height of the tab is the thickness of the remaining material. Easiest is to
define this thickness as a Percentage of the sheet thickness (so of the
material block height), second option to define it as a Fixed value. A
thickness of 0.0 (or 0%) is not permitted, and the tab may not be higher than
the material block (so max percentage is 100%).

The above options have shown how to manually set support tabs. It is also
possible to make DeskProto set tabs automatically, using the following
parameters:

Auto positioning distance
The distance between two tabs: DeskProto will automatically set tabs along
each selected profile using this distance. Here again you can either use a
percentage (of the cuter diameter) or a fixed value.

Auto positioning distance overrides
In some cases one auto positioning distance is not enough, for instance when
the operation contains both long profiles and short profiles. DeskProto
allows you to set a Minimum number of tabs per profile to make sure that
even the shortest profile gets (for instance) two tabs, and/or to set a
Maximum number to prevent a long profile to get to many tabs.

The defaults for the above parameters can be set in the Default Vector
Operation parameters (Options menu): on tab Profiling a button "Set..." is
present to set the default values for support tabs. That button will open the
Default Profiling tabs dialog.

Generate automatically
This button will make DeskProto remove all current tabs and set a complete
series of tabs based on the parameters that you selected.
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4.3.12 Default Profiling tabs

The use of Profiling tabs is explained on the help page for dialog Set Profiling
tabs. 
In that dialog they can be set manually or they can be generated automatically
using the auto positioning parameters.

It is also possible to set Default profiling tabs (on the Profiling page of the
Vector operation parameters). To generate default tabs DeskProto will also
use a set of tab parameters. This dialog Default Profiling tabs allows you to
set the parameters for these default support tabs.
It can be accessed via the Default Vector Operation parameters

The parameters are the same as in dialog Set Profiling tabs and you can find
all relevant information on that Help page.

These same default parameters are the default values when opening dialog Set
Profiling tabs.

4.3.13 Surface Sampling Refinement

The DeskProto toolpath calculations for Geometry data  are based on a Z-
grid, and the size of the grid cells sets the precision of the toolpaths. For
every cell in the grid the highest Z-value of all the geometry within that cell
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will be stored: the surface is sampled. In other words the DeskProto
algorithm is based on Surface Sampling.

In the Geometry Operation parameters you enter the Precision as “Distance
between toolpaths” and “Stepsize along toolpath”. The smallest of the two
will be used as Grid-size (cell size) of the Z-grid. While in most cases this
works OK, sometimes it is needed to overrule this default and use a smaller
Grid-size. This is called subsampling or sampling refinement, as per toolpath
point more than one geometry position will be sampled. This dialog can be
used to define the Refinement factor.

You can reach this dialog by using the button Settings on the Strategy tab of
the Operation parameter dialog (not available for all strategies).

The Surface Sampling Refinement dialog allows you to fine-tune the grid-size
or calculation precision. The higher the Refinement Factor, the more accurate
the toolpaths and the longer the calculation time (quadratic). A refinement
factor 1 will result in a Z-grid with a grid-size that equals the settings for
Distance between toolpaths and Stepsize along toolpath. A Factor 2 will
double the Z-grid resolution for both X and Y, so will subdivide each grid cell
into 4 smaller cells, etc.

Note 1: This setting is in fact only meant for advanced users, to be applied in
special circumstances only !!
Note that higher factors will mean much longer calculation times !

Note 2: The default factor as said is 1 (None). However, for strategies
Waterline and Contour Only the default factor is 3 as this is needed to
achieve smooth toolpaths. This explains why the calculation times are longer
for those strategies.
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4.3.14 Set Freeform Area

A Freeform area is meant to save machining time by exactly defining the area
that needs to be machined. This area can be defined in this dialog, by creating
a closed (freeform) contour line in the Top view of the part. In the image
above one of the visible items is a orange rectangle: this shows the Material
Block. The Freeform area needs to be completely inside this rectangle. For
this contour you can also set a Min and a Max Z-value, the result is called a
Freeform area. You can reach this dialog by using the button “Set Freeform”
on the Area tab of the Operation parameters dialog.

On the right side of the drawing four rows of buttons are present.

The first button will open dialog Items visible for Set Graphically,
in which you can select which items should and should not be included in this
drawing.
The use of the other buttons on the first row will be known from the
Toolbar.
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The four buttons on the second row will also be known from the Toolbar. 
Mouse rotation is not present: this dialog only used the six main views.
Together with the third and fourth row these are the mouse function buttons,
of which just one is active (pressed).

The eight buttons on the third row are new, these are the drawing tools used
to graphically draw and/or change the area. These are mouse function buttons
as well: of these mouse function buttons (13 in total) only one is active at
any time. You will see that the shape of the cursor changes when you select a
different mouse function button.

Adjust Boundary of a Freeform contour: you can move the points and
the sides of the contour by dragging with the mouse. Watch the cursor
to see if you will drag a point or a line.

Add new point to Freeform contour: click with your mouse to add a
point. The side of the polyline will be split up into two new sides.

Delete point from Freeform contour: click with your mouse to delete a
point. Watch the cursor when moving the mouse: when a minus sign
shows you are on target.

Draw an Ellipse as new  Freeform contour: click the left mouse
button, move the mouse and release. The ellipse (can be a circle too)
that is drawn is in fact a polyline. When you press the shift button
during this input DeskProto will lock horizontal and vertical 1:1,
forcing a circle.
Draw a Rectangle as new Freeform contour: click the left mouse
button, move the mouse and release. This function is in fact also
present in the rectangular area dialog. When you press the shift button
during this input DeskProto will lock horizontal and vertical 1:1,
forcing a square.
Draw a Polyline as new  Freeform contour: each mouse click will add
one point. The polyline is always closed. End the function with a right
mouse-click.

Delete a Freeform contour. 

Move a Freeform contour: simply pick and drag the complete contour
line. 
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These buttons are only active in the Top view and the Bottom view. In the
other views only the Min Z and the Max Z level can be graphically set. You
can also set the area’s Z-values by entering them in the Z edit boxes. The
boundaries of the current part are shown to assist you, so are the coordinate
values of the current mouse position.

Button Select contour from project is activated only when in the project
one or more Vector files have been loaded, and when at least one closed
vector curve is present. When you check this option you will see that the
vector curves in this project are added to the drawing, drawn in gray. Light
gray for open curves (cannot be used here), and dark gray for closed curves.
Position the cursor on such closed curve and it will turn purple, click to select
and it becomes black. Selecting more than one curve is possible by keeping
the Shift key (on the keyboard) pressed while selecting.
This Select button is the thirteenth mouse function button.

The buttons on the fifth row are Undo and Redo. The freeform area dialog is
the only place in DeskProto that offers Undo functionality, as while drawing
this functionality is more needed than when working with settings in dialogs. 

Undo the last action using any of the drawing buttons. 

Redo the last action that was undone

Nine levels of Undo are supported plus one level of Redo, so a total of 10
situations is stored.

The freeform area is defined by its contour, which is a 2D vector curve. Using
the buttons described above your can draw a new contour. Other options are
to use an existing curve and to make DeskProto generate a curve.

This contour line to define the freeform area can be imported from a 2D DXF
file. The button Import from File … will open a standard File Open dialog
to browse the correct file. This can be very handy in case you can export
your 3D geometry and a 2D contour from the same CAD program.

A very powerful option is offered by button Generate contour: DeskProto
then will automatically generate a freeform area contour that follows the
outside contour of the current geometry. This will also work for multiple
geometries, and for geometries that contain holes.
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The Freeform area supports multiple contours: so you can draw more than
one freeform area in this dialog. 
Nested areas are supported as well: The outer contour defines an area to be
machined, the inner contour defines an area to be skipped. And inside the
inner contour you can again draw a new outer contour, and so on. See the
illustration below.

4.3.15 Set Center
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In order to calculate toolpaths in a circular, spiral or radial toolpath a Center
point is needed. For these strategies the center point can be set in the
Operation parameters > Strategy tab > Detail settings: here you can enter the
X and Y coordinates for this center point. At that same location you can also
press the button Set in order to open this dialog to graphically set the center.
The center point may be located outside the area to be machined, even
outside the material block.

The dialog is in fact almost identical to the other dialogs for graphical input:
Set Area and Set Freeform Area.
Only the functionality is different, and is in fact very limited: 

Mouse function Set Center allows you to click a point to set the
XY coordinates for the center point. The large + sign in the drawing shows
the current location of the center point. This only works in the Top View and
in the Bottom View: in any of the other views only one of both coordinates is
changed when clicking.

The first button will open dialog Items visible for Set Graphically,
in which you can select which items should and should not be included in this
drawing. 
The use of the other buttons will be known from the Toolbar.
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4.3.16 Operation Start/End Settings

This dialog is meant for advanced users only, as you can conclude from the
warning in red text.
It enables you to add extra command lines to your NC program file, both at
the Start (so just before the calculated toolpath of this operation starts) and
at the End. For instance to let the cutter travel to some safe position after
finishing the operation. Or to let the A-axis rotate to a certain angle before
starting to machine the operation. 

You can reach this dialog by pressing the button "Settings" for start/end on
the Advanced tab of the Operation parameters dialog, for all three types of
operations (Vector, Geometry and Bitmap).

Up to seven Before Operation commands (or Start commands) can be
specified. These will be written as extra lines in the NC program file, just
before the toolpath of this operation starts. Each line is optional, and will
only be written when checked (so checking none will mean that no Start
commands are inserted) :
· User defined can be used to issue any command, like for coolant or for

some other device. Note that the line will be written exactly as defined in
this edit box: so take care what you enter ! You need to know the language
that your machine requires: this line will not be translated by the
postprocessor. A powerful option in a user defined command is the use of
placeholders, see below.
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   We advise that user defined commands are used only by advanced users !!
· Move Z-axis to adds a Z-movement command to the NC file: to the

specified position (in mm or inches) in workpiece coordinates. Note that
these lines are written to the file in the same sequence as present in the
dialog: first the Z-movement, and then the Y, the X, the A, and finally the
B movement. 

· Move Y-axis to adds a Y-movement command to the NC file: to the
specified position (in mm or inches) in workpiece coordinates.

· Move X-axis to adds a X-movement command to the NC file: to the
specified position (in mm or inches) in workpiece coordinates.

· Move A-axis to adds a command to rotate the A rotation axis to Angle
degrees.

· Move B-axis to adds a command to rotate the B rotation axis to Angle
degrees. 

· User defined 2, see the explanation given above.

The screenshot above shows a few possible uses:

- Two rotation commands are used for indexed machining: machining a part
from several sides: three-axis toolpaths for each side, with a rotation in-
between. For instance the N-sided milling wizard uses the A-axis start
command for this aim: milling from four sides will involve four operations,
each time with a 90 degree rotation in-between. It also applies a Z-axis
command, to make the cutter move upward to a safe height before the A-axis
starts rotating, as otherwise the block might hit the cutter while rotating.

- In the four edit boxes for User defined commands you can use
placeholders. These are special bits of text that you can enter, which will be
replaced with some parameter setting when the NC program file is written.
For instance the text "{TOOLNAME}" will be replaced by the name of the
cutter that is needed for this operation. 
A placeholder that forces a new line in the NC program is available as well. A
list of all available placeholders can be found at page Postprocessor
placeholders (despite the name they can also be used in this dialog).
For machines that support the use of comment lines in the NC code the
User defined fields is can of course also be used to enter comment lines.

The screenshot shows adding a comment line (this machine considers any text
between bracket as comment) with the name of the cutter to be loaded. When
the CNC-controller shows this comment on screen the operator will know
which cutter needs to be used.
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In the four "User defined" edit fields a space will be shown as a "middle
dot" ( · ), like in the example screenshot after "Load". This is done as
otherwise spaces would easily be overlooked.  When editing this field you
will again see a space.

The seven After Operation commands are the same as the Before
commands just described, only these will be written to the NC file after the
toolpath of this operation.

Note: the five Move-to commands are not available for some machines. A
machine that always needs three coordinates per command (without
specifying which is for X, Y or Z) cannot accept a line with for instance only
a Z-axis coordinate: it won't know for which axis it is meant. DeskProto
cannot simply use the current position for the other two axes, as at the start
of the toolpath it does no know the current position. For such machines all
Move commands will be grayed out.

Note: The A-axis and B-axis commands are available only when the machine
for this part has such rotation axis defined in its machine-definition, if not it
will be grayed out. So the illustration above is made with a four-axis machine
selected: the B-axis is not available.
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4.4 Libraries

4.4.1 Machine

The dimensions and speeds in the screenshot above are for a "generic"
machine, to be used for any machine that runs on ISO G-codes. When you
use this machine definition you will need to change most of this values to
match the properties of your own machine.

The Name is the name that will appear in any DeskProto dialog for selecting
a  machine. It needs not be the same as the filename: use a name that clearly
indicates which machine you mean. Each machine must have a unique name.
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The Filename will be used to store the  machine definition, using the file
extension .MCH . When editing an existing machine you can no longer change
the Filename. You can also add and remove machines by adding and removing
MCH files to/from the DeskProto Drivers folder (as set in the Preferences).

Button Notes will open the Notes dialog, in which you can enter information
that you want to store about this machine definition.

The Postprocessor you select for this machine will be used to make the
actual NC programs: see the Postprocessor library. The postprocessor is the
most important setting in the machine definition, as it determines the format
of each NC file to be written.

Most other values you enter in the Machine dialog are in fact less important 
as they will be used only to check whether the parameters entered later do
not exceed the machines' capabilities. So most of these values do not influence
the resulting toolpath (only the collet diameter does, and some of the
Advanced settings).

The Working area is used for validation, to see if all the toolpaths will fit
within the reach of the machine. Also, when drawing the working area of the
machine a box of these dimensions is drawn.

The Collet diameter as defined at the Dimensions section is used for the
Collet collision check: to prevent the collet from damaging the model.

The Feedrate and Spindle speed Min and Max values set here are used to
validate the speed settings in the operation parameters. The default values are
used when selecting a different machine for a project: the speed values for all
its operations then will be set to these defaults. In case your postprocessor
uses a feedrate command for rapid movements, that rapid feedrate is
determined by the maximum feedrate that is set here.

The Machining time correction factor is exactly what its name suggests: a
factor that is used for this machine to multiply the theoretical machining time
with, in order to get an estimated real Machining time. This factor has to be a
value larger than 1.
The Number of tools is the number of tools that this machine can store and
select automatically. Only machines that have an automatic tool-changer
should use this. This option is also used for validation only.

The Advanced settings button leads to the Advanced settings.



DeskProto Reference

Page 230

4.4.2 Advanced Machine Settings

This dialog is a part of the Machine definition of DeskProto, and can be
reached via the Advanced Settings button on the Machine definition dialog.
The advanced settings configure the availability and dimensions of the
optional A and B rotation axes.

4th axis:
The A-axis is a device that rotates the part during machining, meaning that
you can machine from all sides. Image it like a roast that is rotating above a
barbecue. Such 4th axis is a very common option on CNC milling machines.

The option Has rotation axis needs to be checked in order to make rotation
axis machining available for this machine. If not, the option "Use rotation-
axis" in the Part parameters will be grayed out, and in the Start/End
commands no A-axis commands are present.

The Distance to working table of machine is the distance between the
actual rotation axis center line and the machine table below: this value
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determines the maximum block diameter (or in fact radius) that still can be
rotated on this machine.

On some machines the rotation axis can only revolve a limited number of
times, and has to then rewind. Either because of mechanical limitations or
because of software limitations. Other machines allow you to keep rotating in
one direction: you then can check the option A-values may exceed 360
degrees. Note that the angle value that is sent to the machine will then keep
growing (for instance after 100 rotations it will be A = 36000 degrees).
When this option is not checked the values for A (when setting the area to be
machined) may not be lower than -360 degrees and not higher than 360
degrees.

Rotary machining in DeskProto in fact only uses three axes: X, A and Z: in
the NC file no Y-coordinate will be present. This means that before starting
such NC file the cutter needs to be moved to Y=0: exactly above the rotation
axis.
The option Write Y=0 in first movement command for rotary machining
adds this movement to Y=0.0 to the NC file. The default is that this option is
NOT checked, as the movement can be dangerous: it will be done at the
current Z-level, and if the Z is too low it might drive the cutter straight into
the block. So when using this option make sure that the cutter is positioned
high enough to let the cutter move over the block.

The 4th axis in DeskProto by default is an A-axis, so a rotation axis that is
parallel to the X-axis. 
However, on many desktop machines the rotation axis is parallel to Y, as that
will allow a longer rotation axis for these machines. You can use DeskProto
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on such machine by checking the option Machine with 4th axis parallel to
Y (swap X and Y coordinates in the NC file). Checking this option will
add an extra Orientator cube to your drawing:

The two orientators match the two machines as shown above. The orientator
on the left shows the situation in DeskProto, which for a standard machines
equals the situation on the machine. When the X and Y coordinates are
swapped the NC file will be conform the orientator on the right: with the
rotation axis parallel to Y. These orientators are visible only when the item
has been checked in the Items visible dialog.

Formally speaking such rotation axis parallel to Y is called a B-axis. However,
many machine suppliers still use the A coordinate value to control it (as it is
the 4th axis). When you have checked the option to Swap X and Y
coordinates DeskProto as default will keep writing A-coordinates. Checking
Use B command for this 4th axis (so also swap A and B) will make
DeskProto use B-coordinate values instead.

For the 5th axis DeskProto supports two different types.

The first type of 5th axis is a CNC controlled B-axis: so an axis identical to
the 4th axis, but then parallel to Y instead of parallel to X. You can enable
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such 5th axis in DeskProto by checking the option Has second rotation axis
(CNC-controlled B-axis). When both the 4th axis and this 5th axis are
configured the result is a five-axis milling machine. DeskProto only supports
five-axis machines where the part rotates (so not machines where the cutter
rotates). This is called a trunnion style 5-axis machine configuration.

The photo above shows such trunnion style machine: the two rotation axis
units are built on top of one another. On the photo it seems as if the small
rotation axis is parallel to Z. That can be easily fixed though: when the large
rotation axis turn 90 degrees the result will be one axis parallel to X and one
parallel to Y. In DeskProto the workpiece zero point needs to be set on the
exact location where the two rotation axes intersect.
In DeskProto this 5th axis can be used for indexed machining, using Start
commands in the Operation parameters.

The second type of 5th axis is absolutely not common: a Rotation axis tilt
option. Only a few machines support this (the Roland JWX-10 and MDX-
40). As the icon on the dialog shows: the complete 4th axis unit will be tilted,
like a draw-bridge being opened. As this rotation is around the Y-axis,
technically speaking this is a B-axis rotation. The advantage is that when
machining a ring this rotation allows you to also machine the inside of the
ring.  Note that DeskProto only supports manually controlled tilt option.
For more information and a photo see the Tilt option tab of the Operation
parameters.
If this option is not checked, the option "Use rotation-axis tilt option" in the
Part parameters will be invisible.
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One extra parameter is available for this option: the Distance to rotation
axis which sets a vertical distance between the A-axis and the B-axis (see the
illustration).  For the machines with this tilt option that we know this
distance is 0.0 however other machines might exist that need such distance.

The third advanced machine setting is an optimization for the toolpaths:
Strip curved movements at constant Z-level. This optimization makes the
NC file shorter by deleting some intermediate points on the toolpath. 
Each toolpath is built using a large number of short straight lines, the length
on each line-segment determined by the Stepsize along toolpath. A long
straight toolpath will also have been calculated as a series of segments, and
for such straight movement in fact all intermediate points can be skipped: one
long line will result in the same cutter movement. This optimization for
straight lines is done automatically in DeskProto.
This easy approach is not possible for curved toolpaths like Circular and
Spiral, as DeskProto does not support arc movements. A circular toolpath
also is built using a large number of short straight lines, however here deleting
a point slightly changes the toolpath. Still when machining a flat horizontal
surface such small changes do not matter at all. 
 
For some machines deleting points will make the movement faster and also
smoother, as the controller of that machine does not have enough calculation
power to calculate each small movement in time to keep the machine on
speed. The result will be a non-smooth, slow movement.  For such machine
you may check this option, then DeskProto will delete half of the points on
the circular toolpath. The result will be a faster and smoother movement of
the cutter.

Note that for some other machines checking this option will have a contrary
result and make the movement slower. This will happen for machines with a
very fast controller, that checks the angle between two consecutive line
segments on the toolpath and only keeps up full speed in case these segments
are almost parallel. Deleting intermediate points will increase the angle
between the remaining line segments and force the machine to slow down. So
for these machines you should not check this option.
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4.4.3 Postprocessor

The postprocessor determines the format of each NC file to be written.
Compare this with a printer driver: it translates the contents of a print file to
the language that the printer understands. Same for the postprocessor: each
machine manufacturer uses his own language for NC files (even when an ISO
standard is followed small differences are present), and the postprocessor
translates to that language.
This dialog allows you to configure a postprocessor to write exactly the
language that your machine requires.

The postprocessor dialog is divided into 7 or 8 tab pages.

General settings

The Name is the name that will appear in any DeskProto dialog for selecting
a  postprocessor. It needs not be the same as the filename: use a name that
clearly indicates which postprocessor you mean. Each postprocessor must
have a unique name.
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The Filename will be used to store the  postprocessor definition, using the
file extension .PPR . When editing an existing postprocessor you can no
longer change the Filename. You can also add and remove postprocessors by
adding and removing PPR files to/from the DeskProto Drivers folder (as set
in the Preferences).

Button Notes will open the Notes dialog, in which you can enter information
that you want to store about this postprocessor definition.

When the output file needs Line-numbering, you can switch it on the
checkbox. In this group you can define:
· Start at line - first line in the NC file with a line number
· Start command - command to be written before the actual line number

(normally an "N")
· End command - command to be written after  the actual line number

(normally empty - not used)
· Start value - the first number to be issued
· Increment - the difference between subsequent numbers (so an increment

of 5 will result in line numbers 1, 6, 11 etc).
· Leading zeroes sets the number of positions to be used for the line-

number: value 0 (default) will output the number only, like in N123, a
value of 5 will make DeskProto use 5 positions, resulting in N00123. 

· Finally the option Stop at line makes it possible to have one or more
unnumbered lines at the end of each file. For a 0 entry all lines are
numbered, for 1 the last line is without number, etc. Only un-numbered
End command lines (see next tab page) are possible, so the Stop value may
not be larger than the number of End-commands on the next tab page.

In NC-program File, setting a Maximum size is needed for some very old
milling machines, like for instance a Deckel Dialog 4. These machines need to
completely read the NC file before they can start, while at the same time they
have a very limited internal memory (say 256 Kb). For such a machine the
NC program file has to be split up into parts no larger than 200 Kb or so.
After applying this option DeskProto will automatically split the NC-
program file into a series of files, which will be named like this: name,
name#2, name#3 etc.
The Extension (file-extension) is used for every NC program file that will be
created using this postprocessor. It does not influence the contents of the file,
just the file’s name.

The values you enter at the New line decimal values group will be put
behind every line of the output file. Default these are set to the values
13,10,0,0 which will do for almost any machine. The value 13 stands for
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carriage-return, the value 10 stands for line-feed, and the values which are 0
will not be used by the postprocessor (unless followed by a non-zero value).
Do not touch these values unless you are absolutely sure what your are doing
!

The Decimal Character will be used for any real number in the NC program
files written. For instance the X-coordinate value 3½ will be output either as
3.50 (decimal point) or as 3,50 (decimal comma).

Start / End Settings

This page contains two editing windows called Start commands and End
commands. Here you can enter the lines that every NC-program must start
with, and the lines it must end with. This may include things like turning on
the spindle motor, setting the units to metric or imperial, and other global
functions. Please look at an existing postprocessor for an example. Also
looking in an existing NC program file that works OK on your machine is
helpful here. 

The screenshot above shows three start commands and two end commands
(this is just an example). The first line ("%") is the standard start line of
many G-code implementations. "G21" tells the machine to use mm as units 
(the alternative being G20 for inches), and "G90" tells to use absolute
coordinate values (the alternative being G91 for relative coordinates). 
End command "M5" tells the machine to stop the spindle, and "M30" means
end of program.

On the left side of the screenshot you will see that a "middle dot" ( · ) is
displayed between G21 and G90, instead of the space that was programmed
there. Reason is that it is often difficult to see if a line starts with a space or
not: the middle dot makes it very clear where spaces are present. When
editing this field (as shown on the right side) you will again see a space.

In both edit boxes you can use placeholders. These are special bits of text
that you can enter, which will be replaced with some parameter setting when
the NC program file is written. For instance the text "{MACHINENAME}"will
be replaced by the name of the machine that is being used. A placeholder that
forces a new line in the NC program is available as well. A list of all available
placeholders can be found at page Postprocessor placeholders (despite the
name they can also be used in this dialog).
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For machines that support the use of comment lines in the NC code the
User defined fields is can of course also be used to enter comment lines.

At the bottom of the page a large button Show example is present. When
you press that button the two large edit boxes will change in two example
panes, showing what the result will look like in the NC file. The placeholders
will be processed using the settings that DeskProto finds in the first part and
first operation of the current project. The button at the same time will change
to Hide example, that can be used to return to the two edit boxes. So the
button in fact toggles between the two situations.

Movement settings

The Tab page Movement determines the format of all movement commands
in your NC program, which will be 99.99 % of its contents.

Each movement (so each line in the NC file) is built using a Start command,
some Coordinates and an End command. To see their effect: just look at the
Example line to see what will happen when you make a change. 
The Start command (in the screenshot above "G01") determines that this is
a linear line interpolation command, the Coordinates determine the required
end position of this (linear) movement.
Most machines do not require an End command.
The option Only for first movement makes the Movement command
'modal': after being given once it stays valid until a different command is
given.  As a result the Start command will not be repeated every line.

Each of the Coordinate values for X, Y, Z (and A, B) may be configured
separately. A and B are between brackets as these are not used for three-axis
machines.
A Start command and an End command can be defined for each coordinate.
For instance a  character like X, Y or Z to determine the axis, or a comma to
separate the coordinates. Do not confuse this start command for one
coordinate with the Start command for the complete movement command.
Same for the two types of end-command on this page.
Positions gives the minimum number of character positions to be used. So if
positions is set to 7 and the output is 3.000 two spaces will be added, making
the result in this example  'X   3.000'. 
Decimals gives the number of units to be written behind the decimal point
(or comma), so this affects the precision of the output. This precision already
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has been applied when drawing the toolpaths on the DeskProto screen. As a
default for mm 3 decimals are used, and for inch 4.
The output of DeskProto is either in mm or inches (whichever you
configured). When your output should be in any other unit you can change
the Factor for the X, Y, Z coordinates. For instance a Factor 1000 will
output the coordinate in units of 1/1000 mm or inch. The factor can also be
used to reverse the direction of the axis: by entering -1.00 instead of 1.00

Last option for the coordinates is the Default: that value will be used when a
coordinate is Required (see below) however when DeskProto does not yet
know a coordinate value. A Default field may be either empty (used for most
machines), a number (which will be interpreted as coordinate value, written to
the NC file conform the specifications in the column above), or a string
enclosed with quotes (which will be literally copied to the NC file, for
instance "X6p", for Datron machines). So note that 0 and "0" will be treated
differently.

In all these edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the X, the Y, the Z, the A and the B. This
is done as otherwise spaces would easily be overlooked.  When editing this
field you will again see a space.

In both edit boxes you can use placeholders. These are special bits of text
that you can enter, which will be replaced with some parameter setting when
the NC program file is written. For instance the text "{TOOLNUMBER}"will
be replaced by the number of the cutter that is being used. A placeholder that
forces a new line in the NC program is available as well. A list of all available
placeholders can be found at page Postprocessor placeholders (despite the
name they can also be used in this dialog).

Write only if changed means that coordinate values are only written in case
changed. So when only Y has been changed DeskProto may write a command
like "G1 Y20.0", meaning that the values for X and Z will remain the same for
this movement.
Also sign positive values adds a "+" in front of every positive coordinate.
Skip trailing zeros makes the file’s size smaller, by removing any
insignificant zero in a coordinate value. For instance 3.400 becomes 3.4 and
3.000 becomes 3. Again please use the example line to see what will happen.

Using the Order/Required edit field you can change the order of the X, Y, Z,
A and B coordinates in the output. Each of these five characters should be
present in this edit box, and all exactly one time.
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In this same field you can make a coordinate value Required, by adding a +
in front of the character. So when you enter +X+Y+Z+AB this means that X,
Y, Z and A are required. This is needed for machines where the position
(sequence) on the line indicates the axis for which each coordinate is meant.
For instance "G1 X10 Z10 A 180" on such machine without the required field
would become "MOVE 10, 10, 180", which would send the Y to 10 and the Z
to 180. With the required field the result is "MOVE 10, , 10, 180" (note the
extra comma). What will be written for the missing coordinate value depends
on the setting on line Default, as just discussed.

As Distance unit you can choose between mm and inches for the coordinate
values to be converted to. Make sure that your machine uses the same units:
for some machines you need to explicitly give the command G20 (inches) or
G21 (mm). You can do so at the "Start commands' of the Start/End tab page.
This postprocessor setting is independent for the Units setting in the
DeskProto Preferences.   This makes sure that inch workers still can use a
metric machine, and the other way round.
The Angle unit is only used for rotation axis machining (degrees or radians),
so it does not apply if your machine does not have a rotation axis.

The (A) and (B) columns and the Angle units are only used in case a 4th axis /
5th axis is both present and selected. For three axis machines you can just
ignore these columns.

Rapid Settings

Rapid movements are used to save milling time by moving as fast as the
machine can travel. These are used by DeskProto for positioning moves
above the top of the material block. 
Rapid movements can be achieved either by using a special Rapid Start
command, or by first changing the feedrate and then using the normal
Movement command, at the maximum feedrate of the machine. This
maximum feedrate value can be changed at the Machine dialog.
The option Only for first movement makes the Rapid command modal:
after been given once it stays valid until a different command is given.
Here again the Example line shows what will happen. 

Feedrate settings:
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Feedrate commands will only be output if the option Use is switched on.
The option Write only if changed will be on for most machines: if not the
feedrate will be output on every movement line.

The Feedrate command is constructed using a Start-command a number and
an End-command. The result can be seen in the example line at the bottom of
this tab page.
Positions stands for the minimum number of positions that are occupied by
the value of the feedrate.
Decimals stands for the number of characters behind the point (or comma).
A Factor is needed when on the DeskProto screen and in the NC file
different units are used. For instance a Factor 1000 will output a number that
is 1000 times larger than what DeskProto shows. For instance 50000 instead
of 50 mm/sec).

In the Start-command and the End-command you can use placeholders.
These are special bits of text that you can enter, which will be replaced with
some parameter setting when the NC program file is written. For instance the
text "{F}" will be replaced by the current Feedrate. A placeholder that forces
a new line in the NC program is available as well. A list of all available
placeholders can be found at page Postprocessor placeholders (despite the
name they can also be used in this dialog).

In these two edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the F. This is done as otherwise spaces
would easily be overlooked.  When editing this field you will again see a
space.

The Method setting is self-explanatory.
The settings of Units are only used to be able to show the correct units in the
dialogs, whenever you have to enter a feedrate. DeskProto does not
"understand" them, it just copies the number that is set in the Operation
parameters to the NC program file.

The correct feedrate for rotation axis movements (so cutting movements that
also include a rotation of the A-axis) is a difficult issue. In standard G-code
the feedrate is defined only as linear speed, so a good controller should use
the linear feedrate that has been set and then calculate how fast the rotation
axis needs to rotate in order to reach the prescribed speed. That is a difficult
task though, as the length of a rotary movement depends on the distance to
the rotation axis. Unfortunately most machines cannot make such
calculation. 
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DeskProto offers two alternative methods for rotary feedrate:
Use inverse time feedrate for rotary movements - instead of the speed,
specify the time needed for the total movement. DeskProto knows the length
of the movement, so it is easy to calculate the total time to complete this
movement at the prescribed feedrate. The machine then can set the correct
speed for each of the moving axes. This is the best option: so in case your
controller supports inverse time feedrate select this option !
Use angular feedrate for rotary movements - specify the rotary feedrate
in degrees per time unit. This solves the feedrate issue for movements that
only include an rotation axis movement, however for combined movements
(rotation axis + linear axis) the problem will persist.

Only one of both options can be checked (or none). In case one of these
options is checked in extra tab page will appear in the postprocessor dialog:
"Rotary feedrate". Both options - so both extra tab pages -  will be explained
below.

The Example line shows what the result will look like, using the feedrate
found first operation of the current project.

Inverse Time Feedrate settings

This tab page will only be visible when on tab page Feedrate the option "Use
Inverse Time Feedrate for rotary movements" has been checked. It concerns
the feedrate for cutting movements that include a rotation of a rotary axis.

When setting the feedrate in linear/time units it is difficult to determine how
fast the rotation axis needs to rotate, when using angular/time units it is
difficult to determine how fast the linear axis needs to move. A good solution
is to instead define the time that may be used for the total movement.
The controller then can easily calculate how fast each of the axes needs to
move.

The Time for each movement can easily be calculated by DeskProto, as 
Distance / Linear feedrate
Important is that when roughing layers are applied the (linear) Distance to be
machined will be measured at the Maximum Z of the current roughing layer.
This is needed as the linear speed through the material at that Z-level will be
(much) higher than for the tip of the cutter.
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For historic reasons the parameter for this option is not the time but the
inverted time  (1 divided by the total time).

Inverse time is a modal command: it needs to be switched on and off.
The Switch commands can be defined here:
- the On command in standard G-code is G93.
When switched on every movement command needs to contain a Feedrate (or
rather time) value.
- the Off command in standard G-code is G94   (in fact this is the command
to set Linear feedrate).

For Units only the Time unit can be selected: either minutes or seconds.

The settings for Command and for Method are identical to those on the
Feedrate page.

The Example line shows what the result will look like, using a value of 1.

Angular Feedrate settings

This tab page will only be visible when on tab page Feedrate the option "Use
Angular Feedrate for rotary movements" has been checked. It concerns the
feedrate for cutting movements that include a rotation of a rotary axis.

Some machines require the feedrate for rotary movements (either for
movements that only rotate the A-axis or for movements that combine a
rotary move with a linear component) to be set in Angle per time units.
On this page you can set the Units to be used:
for the Angle either degree or radian
for the Time either millisecond, second, minute or hour.

After selecting this option DeskProto will convert the linear feedrate (set in
the Operation parameters) to an angular feedrate. Important is that when
roughing layers are applied the (linear) Distance to be machined will be
measured at the Maximum Z of the current roughing layer. This is needed as
the linear speed through the material at that Z-level will be (much) higher than
for the tip of the cutter.

In case your machine also support the Inverse time feedrate (see above) that
method is preferred, as the Angular feedrate method is not accurate for
movements that combine a rotary and a linear component in one movement.
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The settings for Command and for Method are identical to those on the
Feedrate page.

The Example line shows what the result will look like, using a value of 1.

Spindle speed settings

Spindle commands will only be output if the option Use is switched on.

The Spindlespeed command is constructed using a Start-command a number
and an End-command. The result can be seen in the example line at the
bottom of this tab page.
Positions stands for the minimum number of positions that are occupied by
the value of the feedrate.
Decimals stands for the number of characters behind the point (or comma).
A Factor is needed when on the DeskProto screen and in the NC file
different units are used. For instance a Factor 1000 will output a number that
is 1000 times larger than what DeskProto shows. For instance 50000 instead
of 50 rpm)

In the Start-command and the End-command you can use placeholders.
These are special bits of text that you can enter, which will be replaced with
some parameter setting when the NC program file is written. For instance the
text "{S}" will be replaced by the current Spindlespeed. A placeholder that
forces a new line in the NC program is available as well. A list of all available
placeholders can be found at page Postprocessor placeholders (despite the
name they can also be used in this dialog).

In these two edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the S and the M3. This is done as
otherwise spaces would easily be overlooked.  When editing this field you
will again see a space.

The Method setting is self-explanatory.

The Units to be used cannot be set: for the Spindle speed the unit always is
RPM  (Rounds per Minute, of Revolutions per Minute).

The option Set Spindlespeed to 0 for rapid positioning movements is
new in DeskProto V7.1.  It has been added for users of a laser cutter: on
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such machine the laser needs to be switched off during positioning
movements  (on a CNC milling machine it is sufficient to travel to a higher Z
position). Many laser cutters "listen" to the S command, and will switch the
laser off when the speed is set to 0.  Such positioning movements are done at
free movement height, after which DeskProto again will move down to
machining depth. In this downward movement the spindle already has been
switched on, which on a laser cutter results in excessive burning. So for laser
cutting it is advised to set Machining depth and Free movement height equal:
both at Z = 0.0

The Example line shows what the result will look like, using the spindle
speed found first operation of the current project.

Toolchange settings

DeskProto will create one NC program file for one part. However, for every
operation a different cutter can be used, so in case you are using different
cutters in one part (which would mean in one NC program) you have to
define what should happen at a tool change. Select one of the three options. 

Use change-command in NC program can be used in case the milling
machine is equipped with an automatic tool change system (ATC =
Automatic Tool Changer). To define the actual command you can use one,
two or three lines, as some controllers require separate lines to select the next
cutter and to actually load it. For each of these lines you can select whether
or not the Tool Nr has to be present on the line. The Example line on the
bottom of this dialog will show the result. 

In the illustration above two lines are used, each mentioning the tool number
(this is just an example command: actual commands will differ per machine).
The first line ("T1 M06") is pretty standard G-code: T for the tool number
to be loaded, and M6 to start the ATC operation. Note the space just before
the “M6” (spaces are shown as "high dots"). For many G-code machines this
first line will be sufficient. On the second line "G43 H1"sets the tool length
compensation for this next cutter, which for this machine apparently is not
done automatically. "Z1.0" after G43 moves the cutter to Z=1.0 for a visual
check of the tool compensation, and "M08" switches the Coolant on. As you
can see you can configure the postprocessor to meet your own preferences.

In all edit fields you can use placeholders. These are special bits of text that
you can enter, which will be replaced with some parameter setting when the
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NC program file is written. For instance the text "{TOOLNUMBER}" will be
replaced by the tool number current cutter. A placeholder that forces a new
line in the NC program is available as well, so if needed you can use more
than three lines. A list of all available placeholders can be found at page
Postprocessor placeholders (despite the name they can also be used in this
dialog).

In all these edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the M06. This is done as otherwise spaces
would easily be overlooked.  When editing this field you will again see a
space.

Note:
For this method be sure that the ‘number of tools’ of the machine is set
correctly. You can do that in the Machine dialog. Also be sure that the cutters
that you use in DeskProto have the correct "Number in machine" parameter.
You can set that in the Cutter dialog. You also have to check if the correct
cutter is indeed loaded on this position of the machine’s tool changer:
DeskProto just loads Tool No “N” without knowing if it is indeed the right
cutter.

Use pause-command in NC program lets you change the cutter manually,
however within the same NC program. The Pause command will stop the
machine for this purpose. You must define the pause command in the pause
field. For most machines such command is not available though. It needs to be
a special Pause for toolchange command: a standard Pause will only wait for
the prescribed time (which is dangerous when changing a tool) and will not
allow tool length compensation (needed because the new cutter will have a
different length).

Use new NC program will cause a next NC program to be created. If your
machine does not support a tool change or if you do not know, it is best to
choose new NC program file. After ending the first file you can then change
the cutter, correct the zero position for the length of the new cutter, and start
the second NC program file.
When writing such multiple NC program file, names for the subsequent files
will be automatically generated by DeskProto. In case you chose the name
Test.nc and the two operations were called Roughing and Finishing, then the
first file will be called Test#1_Roughing.nc and the second file
Test#2_Finishing.nc 
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Note:
Use new NC program is the safest, and thus it is the DeskProto default for
this option

The Example line shows what the result will look like, using the tool number
found first operation of the current project.

4.4.4 Cutter

The Name is the name that will appear in any DeskProto dialog for selecting
a  cutter. It needs not be the same as the filename: use a name that clearly
indicates which cutter you mean. Show in this Name whether you mean
radius or diameter for any number (you will forget if  'Ball6' means R6 or
D6). Each cutter must have a unique name.
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The Filename will be used to store the  cutter definition, using the file
extension .CTR . When editing an existing cutter you can no longer change the
Filename. You can also add and remove cutters by adding and removing CTR
files to/from the DeskProto Drivers folder (as set in the Preferences).

Button Notes will open the Notes dialog, in which you can enter information
that you want to store about this cutter definition.

DeskProto offers six Types of cutter, that are variants of three basic types:
flat (square cutter), conic (sharp point), and ball (ballnose cutter). Both conic
and ball can be given a flat tool-tip, conic can be given a ballnose tooltip as
well. For that last type (Conic with ball tip) check the image on the bottom
of this page.
Depending on the type that you select, some of the Dimensions will be
disabled. For example a flat cutter does not have a cutting angle.

For each type you can check the option Multiple diameter, to define a tool
of which the shaft (the part that fits in the collet chuck) is thicker than the
flute (the part that actually cuts). This is a commonly used model for small
cutters. When correctly defined, DeskProto will make sure that the thick
shaft does not damage your model at vertical surfaces.

Just look at the drawing in the Preview to see the cutter that you have
defined.
The image below gives an explanation of most terms used for the
Dimensions.
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The Free length is the length of the part of the tool below the collet. So this
is not the total length of the cutter. The free length is not constant, as it
depends on how far you insert the cutter in the collet. DeskProto uses this
parameter only for the collet collision check. In the Preview image the free
length is shown by a horizontal black line.

The meaning of Shaft diameter will be clear. For single diameter tools the
Flute diameter is identical to this value. In order to support 1/8 inch (3.175
mm) cutters with a DeskProto set on metric, all dimensions in this dialog can
be set with 3 decimals accuracy

The Slope Angle is available only for multiple diameter cutters. It defines
the transition between the thick shaft and the thinner flute, which for most of
these cutters has a conical shape.

The Flute length is only available for multiple diameter tools, as it is the
length of the small diameter part which is called the flute of the cutter.

The Flute diameter (or flute diameter) is the nominal diameter of the cutter,
used for the calculations (do not confuse Diameter with Radius!). It is only
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available for multiple diameter tools, as otherwise it is the same as the shaft
diameter.

The Cutting length is the length of that part of the tool that actually cuts: it
will be used to calculate Layers as the tool may not  sink into the material
deeper than this value. In case you do not select Roughing then DeskProto
will automatically do so for the first Operation. In the Preview image the
cutting length is shown by a red color.

The Tip diameter is the diameter of the flat tip for cutter types with a flat
tip, and the diameter of the flat ballnose tip for Ball/Conic cutters. So for
instance a Ball/Flat cutter with diameter 6 and tip 4 will have a radius 1 left
(this type of cutter sometimes is called bull nose).
A special cutter type can be defined by choosing “Ball with flat tip” and
setting the Tip diameter larger than the Flute diameter (which normally is
nonsense). This creates a special cutter type “Curved  tip” as a result. The
preview drawing shows what will happen.

The Cutting angle is for conic cutters only: it is the angle between the
cutting edge and the center-line of the tool (so the ‘grinding angle’). Do not
confuse this with the ‘included angle’ that is also used. You can also use this
parameter to define special tapered cutters having a draft angle of say 3
degrees.
Here as well: just try and look what happens in the Preview.

The Preview shows you the currently defined cutter-definition in a drawing,
which is a very convenient help when setting the parameters in this dialog. A
preview can of course only be drawn when a correct set of dimensions have
been entered first (for invalid setting a red cross will be drawn). The area in
dark red shows the cutting length, the horizontal line at top indicates the
collet and thus shows the free length.

The Number in machine indicates on which position of the Automatic Tool
Changer this cutter needs to be loaded. So this is used only when your
machine supports automatic toolchange. The number will be used for any
toolchange command written in the NC-program file.
Important:
This number can be different for each machine and even for each situation, as
the operator has to load the correct cutter in the correct location.
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The Maximum spindlespeed is used only for validation of your projects
(some larger cutters may not rotate at high rpm as these are insufficiently
balanced).

The option Automatically set speeds when selecting this cutter may be
very handy when you have standard milling conditions. For instance when
you always machine in wax (jewelry wax models) you may want to always
use the same low feedrate and high spindle speed for a certain thin cutter. 
Then you can define these two speeds here, and in the Operation parameters
DeskProto will automatically set these values for Feedrate and
Spindlespeed when this cutter is selected.

Note that for the Feedrate DeskProto will just copy the number that you
enter in this dialog to the NC file, without understanding it's units. So when
enter "10" and use this cutter on a m/min machine the feedrate will be 10
m/min, on a mm/sec machine it will be 10 mm/sec. A large difference ! 
DeskProto could show the units used by your current machine, however that
would give a false sense of security as they would be valid for that machine
only.

For cutter type Conic with ball tip an extra remark is needed, to exactly
explain the dimensions of this cutter type. We have found that cutter
manufacturers use two different methods to define the tip diameter. See the
image above, drawn for a conical cutter with a tip diameter of 2 mm.
· on the left side the widest part of the ball before the taper begins is used as

tip diameter.
· on the right side the diameter of the (half) sphere is used as tip diameter
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DeskProto uses the first definition (left side of the image): the diameter of the
sphere is a (tiny) bit larger than the "tip diameter". The smaller the cutting
angle, the smaller the difference.

4.4.5 Driver Notes

In each of the three dialogs to edit a DeskProto driver (Cutter, Machine and
Postprocessor) you can find the button Notes, that will open this dialog.
The Notes that you enter here will be stored as comment lines at the start of
the Driver file that you care editing.

These notes will not be used by DeskProto, they are just for your own
convenience. You can for instance store for a certain cutter type where and/or
when you have bought it. Or any other detail about this driver that is not
relevant for DeskProto but that you still want to remember.
You can also use this space for notes to store a "revision history" for the file:
when has it been changed, by whom and why.

In the driver file (*.ctr, *.mch or *.ppr) each of the lines will be preceded by a
semicolon, which marks them as comment lines.
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4.5 OpenGL warnings

4.5.1 OpenGL driver: version

DeskProto uses a graphics language called OpenGL to display graphics
information (a drawing) in its View Window.  This language has been defined
long time ago, and over the years already many new Versions have been
defined, each time adding extra functionality to the language. DeskProto needs
OpenGL Version 2.1 or newer, when your driver version is too low this
warning will be shown when the program is started.

Apart from these differences between various versions the OpenGL language
supports "Extensions": extra functionality that is not required and thus may
and may not be present. A few features are present in DeskProto that depend
on such extension: if not present the function cannot be executed, and the two
lines starting with "Unable to" will be added to this warning dialog. This
concerns the following features:
- Print Image (File menu)
- Generate Contour (Set freeform area).

When this warning is given you can continue using DeskProto, however at
some points the graphic behavior will be below standard. The advise is to
download and install a new driver for your graphics card. You then need to
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find out the brand and type of your graphics card, visit the website of the
card manufacturer and there look for a driver for your type card. In most
cases you can download drivers in a section called Support or Download.
When your PC and your Windows version are very old this may no loner be
possible.

In case you have a choice, select the driver that supports OpenGL.
Like for all AMD Graphics cards (formerly ATI), where you can choose
between downloading
1- the Catalyst Software Suite
2- the WDM Integrated Driver
Here you need to select the Catalyst suite, as the obsolete WDM driver
(Windows Driver Model) does not support OpenGL. Windows then will fall
back on its old software renderer (OpenGL V1.0) to create the graphics,
which misses some features and will also make DeskProto very slow.

Important to know is that using the button "Update Driver" in the Windows
Device Manager does not always find the latest driver ! So you need to check
the card manufacturer's website.

A big advantage of OpenGL is that it makes hardware implementation
possible: let specialized hardware on the card do graphics calculations,
making it much faster than using software. The more expensive your graphics
card, the more can be done by hardware, and the faster all graphics will be
displayed.
An important feature is the Retained mode rendering, as mentioned in the
warning text. This means that the complete 3D scene is stored in the card's
graphics memory, using a 'vertex buffer'. So in order to change the
viewpoint, the software only needs to send the new camera position to the
card, the rest will all be done in hardware. You can imagine that this is much
quicker than again sending the complete scene to the graphics card for each
change (which is called Immediate mode).
Vertex buffers are available from OpenGL V 1.5

A few OpenGL related settings can be found in the Preferences. In case of a
limited driver not all functions will be available.
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4.5.2 OpenGL driver: extensions

DeskProto uses a graphics language called OpenGL to display graphics
information (a drawing) in its View Window.  This language has been defined
long time ago, and over the years already many new Versions have been
defined, each time adding extra functionality to the language. DeskProto needs
OpenGL V2.1 or newer.

Apart from these differences between various versions the OpenGL language
supports "Extensions": extra functionality that is not required and thus may
and may not be present.

A few features are present in DeskProto that depend on such extension: if
not present the function cannot be executed and this warning dialog will be
shown. This concerns the following features:
- Print Image (File menu)
- Generate Contour (Set freeform area).

A similar warning will be shown when one of these functions is called,
without the list of limitations.

Some other features will simply be disabled (grayed out) when the required
extension is missing.
For instance Anti-aliasing (Advanced Preferences).
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For Windows and for Linux is may be possible to solve this by downloading
and installing a new driver for your graphics card. You then need to find out
the brand and type of your graphics card, visit the website of the card
manufacturer and there look for a driver for your type card. In most cases
you can download drivers in a section called Support or Download. When
your PC and your Windows version are very old this may no loner be
possible.

For Apple the situation is different: MacOS  simply does not support the
extensions that are needed, so installing an upgrade will not ix this.
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4.6 Initial Personal Settings

This dialog will be shown only once: when DeskProto is started for the first
time after it has been installed.

You have to select the Machine that will be used as the machine for every
new project. Click on the arrow to show the list that you can choose from.
When your machine is not listed: read further below.
DeskProto asks you to select a Machine, so not (like many other CAM
programs) a Postprocessor. In DeskProto the postprocessor is one of the
settings in the machine definition: when selecting a machine you also select a
postprocessor. Advantage of this construction is that several machines can
share the same postprocessor.
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The second question asks to set the Measurement unit you want to use
within DeskProto: mm or inch. All user-interaction will show this unit, and
all CAD-data files will be loaded using this unit (because in most of the
CAD-files the units used are not specified).

Third question is about the Default project that you want to configure.
DeskProto offers three different types of machining: 
- Vector: load a 2D drawing file and make the cutter follow the curves in a
drawing
- Geometry: load a 3D geometry file and generate toolpaths to create that
shape
- Bitmap: load a bitmap image, convert it to a 3D relief can generate toolpaths
to machine it.
Selecting an option here tells DeskProto which type of project to open as
default New project. The other two types remain available. Select the type of
project that you expect to be using most.
This default type can be changed later by editing the Default Part (Options
menu) and changing the type of operation that is present.

What to do when your machine is not listed ?
This is a very common situation (as the number of machine manufacturers
and the models that they produce is almost infinite), and in most cases it is
easy to solve. Please follow the three instructions given below.

1. Look if you can find a different model made by the same machine builder.
In most cases a machine builder uses the same NC file format for all
machines, so you may expect that the resulting NC files will be OK for your
machine as well. Try to run an NC file, and if positive proceed to "Add a
machine" below.
Important: when you look for your machine in the alphabetical list you also
need to look under the Manufacturer's name. For instance the Magic7
machine is listed as "REDT - MAGIC-7", and the High-Z machines are listed
as "Heiz High-Z"

2. Look if you can find a generic machine definition for the controller or
the control software that you use. Like for the Mach3 control software one
of the machines called "Mach3/Mach4 based machine", or for the EdingCNC
controller the machine called "EdingCNC based machine". Try to run an NC
file, and if positive proceed to "Add a machine" below.
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3. Most machines will run on NC files written in standard G-codes. G-code
is the official standard for NC files, defined by ISO (the International
Standards Organization). Unfortunately each machine builder has developed
his own flavor of this standard, and not all G-code files are compatible. Still
when your machine runs on G-code, you have a good chance that it will work
when you select the machine called "ISO plain G-codes".  Try to run an NC
file, and if positive proceed to "Add a machine" below.

In case the above three options do not work and you have problems
configuring a machine definition and a postprocessor, feel free to send us an
email: we can assist ! We are always happy when we can add a machine to
the list this way.

Add a machine. When your test is positive then you can add your own
machine to the list as follows:
Options > Library of machines > OK on warning > Select the machine that
you tested with and press button Copy. Now in the Machine dialog give the
new copy a proper name and filename. Make sure that you do not change the
selected postprocessor. Enter the correct dimensions and speeds, if needed
add a rotation axis in the Advanced machine settings. For more information
use the Help button of the Machine dialog.

When your machine has an optional rotation axis it is possible that the
machine-definition in DeskProto does not have that option checked. It is easy
to add it in the machine definition (see the previous paragraph), on the
Advanced settings page.

The default Machine is stored in the Default Project, and can be changed later
by choosing the option Default Project Parameters from the Options menu.
The measurement unit will be saved in the Preferences. You can later change
this setting in the Preferences dialog (Options menu).
The default project type as said can be changed by editing the Default Part
(Options menu) and there changing the type of operation that is present.

These initial settings will be stored per user of the computer, so any new user
will see this dialog when he/she starts DeskProto for the first time.
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4.7 Edition select

DeskProto is offered to you as Freemium software:
you are welcome to use the basic functionality DeskProto free of charge, the
advanced features are available as premium extras.

Four different Editions are available:
· Free Edition
· Entry Edition
· Expert  Edition
· Multi-Axis Edition
of which the first is free while for the other three you need to buy a license.
The Free edition also allows you to Trial (evaluate) the higher editions: when
running in trial mode the resulting toolpath will leave a Trial cross
(watermark) on each part that is machined.
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The Free Edition is available for anyone: free of charge, without any
obligations attached. It's functionality is limited, still it offers all you need for
basic CNC machining: Profiling toolpaths based on Vector Data, Parallel
toolpaths over Geometry Data, and machining reliefs based on Bitmap data.
In the Free edition a project may contain maximum one part and one
operation.
Many parameters as described in the Help file are not available in the Free
Edition. Still the most important parameters are there, and for many users
this free CAM program will be all they need.

The Entry Edition is the lowcost version of DeskProto, offering limited
options, at a very low price.
Compared to the Free edition a few important extra options are present:
Pocketing and Drilling for Vector operations, and Roughing for all three
operation types. Projects also may contain any number of parts and
operations.

The Expert Edition includes all parameters, except for the rotation axis
options. So the fourth axis and the fifth axis are not available in this edition.

The Multi-Axis Edition is the most complete version: all parameters are
present, and so are the A-axis and B-axes rotation axes.

More information about higher editions can be found in the Upgrade dialog. 
An edition comparison table can be found on www.deskproto.com 

A license for a higher edition can be activated in the Activate dialog.
After activating your license this Edition select dialog will no longer be
displayed.

https://www.deskproto.com
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4.8 Start Screen

The DeskProto Start Screen shown above is a help to quickly start the task
that you need.
You can open the Start Screen via the File menu  (File >> Show Start Screen).

Shortcut:

Keys: Ctrl+B  (Windows, Linux)  +B  (MacOS).  
B stands for "Begin", as the S already is being used.
 
It will first show the Edition that your are running, 
next your Name and Location (as owner of the license),
and the type of License, with the restrictions that apply (of any).

Three groups of tasks are presented:
· Start a new project
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· Open an existing project 
· Other tasks
Each line in these three lists is a link that will directly start that task.

Starting a New project can be done either using the Wizard interface or the
Dialog based interface. 
Default choice for this dialog is to start a New project using the Wizard: that
is what will happen when you simply press the Enter key (indicated by the
icon at this line). This is the most convenient option for novice users.
The difference between Vector/Geometry/Bitmap projects is explained on
page New project. 

The DeskProto Setup has installed a number of Sample projects and
Sample geometries on your PC. Including some great geometries like the
DeskProto picture frame: see the lessons in the DeskProto Tutorial book.
Conform Microsoft's specifications the Samples have been installed in the
\ProgramData\ folder, which may not be easy to find as it is a hidden folder
and its location is different per Windows version. Sorry about that,
unfortunately for standard users other locations are not permitted by
Microsoft. Also when using MacOS or Linux the Samples folder may not be
easy to find for you.
Using the checkbox Use samples folder you will always be able to find the
sample geometries.

Recent projects will be available only when you have used DeskProto V7
before. In this dialog only the latest 5 projects will be shown.  Command
Open project will allow you to open any project file by browsing one.

In the Other tasks section, Open sample project makes it easy to find the
sample projects.
The other three 'other tasks' require an Internet connection, as they will start
your browser and open a web page.

The checkbox Show this start screen on startup makes this screen
automatically appear at each start of DeskProto. After having de-selected this
option, you can still access the Start Screen using the command Show Start
screen in the File menu.
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4.9 Viewpoint

The View menu command Viewpoint -> Custom...  displays the Viewpoint
dialog, in which you can change the settings of the active view, which are the
settings for rotation, panning and zooming. In fact this is setting the Camera
position.

Shortcuts:

Toolbar:
Mouse: Right-click in a view, and select the Viewpoint item in the shown
context-menu.

In this dialog you can change the point of view from which you look at the
curves, the geometry, z-grid, toolpath etc. You can set the values exactly,
using the keyboard. The rotations are executed in the order X, Y, Z. The
effect is the same as when using mouse rotation, pan and zoom or when using
the thumbwheels.
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Note:
These values do not change the toolpaths, they only change the Camera
position. To rotate/pan/scale the part to be machined you should go to the
Transform tab page of the Part Parameters dialog.
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4.10 Views Layout

In this dialog you can change the Layout of the View Window: the way it is
filled with Views. It is possible to show 1, 2, 3 or 4 Views at the same time,
as shown in the dialog. Each of these Views can have different settings for
Viewpoint and for Items visible. All these settings will be stored in the
project file.

The two layouts at the right automatically set the viewpoint for all views.
Those are the ones with the characters T, F, R and the term DEF, where ‘T’
stands for Top view, ‘F’ stands for Front view, ‘R’ stands for Right view
and ‘DEF’. stands for Default view.
Such a layout is very handy to get a quick impression of what a new part
looks like.

Shortcuts:

Toolbar:

Note:
In a Layout with more than one view, one of the views will be the current
(active) view. You can make a view current by clicking your left mouse-
button inside the view: observe the blue line that appears around the active
view. The thumb-wheels, view buttons and view commands apply only on
the current view.
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4.11 Items Visible

In this dialog you can select which items will be included in the View
Window.

Shortcuts:

Toolbar:
Mouse: Double-click in a view, or Right-click and select "Items visible" in
the shown context-menu.

Four groups of items are present: General items, types of CAD-data, items
about the complete Part and items that are different for each Operation. In
front of each item you find a checkbox: checked means Visible, not checked
means not visible.

Three General items are present: 
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The Title will be displayed on the screen and on the printed view, in the top
left corner of the View. You can type a title in the edit box shown, if that is
empty checking Title does not make a difference.

The View Orientator is the coordinate system icon (green cube with axes)
displayed in the bottom left corner of each view. It helps you to understand
from which direction you are looking at the geometry. This green cube does
NOT indicate the zero point.
For machines with a 4th axis parallel to Y (option Swap X and Y coordinates
in the NC file checked in the Advanced Machine settings) two View
orientators are drawn.

The Working Area can be drawn, which is the working area of the machine
selected for this project. Of course DeskProto does not know where you will
set the workpiece zero point on the machine, so it will draw the part exactly
in the middle of the working area. This will give a good indication how the
part relates to the machine. The working area for your machine can be set in
the Machine dialog.

The second group shows all CAD-data items:

The Vector curves are all curves that are loaded as
Vector data. The curves are drawn in gray, only
when a curves has been selected in one or more
vector operations it will be drawn in black.

Vector curves in DeskProto are all polylines: the
curve is built as a series of straight line segments.
The sub-option Show points will indicate the end
of each of these straight lines with a small point in
the drawing. As you can see in the letter D (image
on the left) no points are present on straight lines.
In a Rendered geometry drawing all triangles of the
geometry definition are made "solid" with color.
This offers a good understanding of your geometry,
so it is the default way to draw all Geometry data.

The sub-option Show downward faces will assign a
different color to any triangles that are facing down
(in other words: of which the normal has a negative
Z-component). This option makes it very easy to
check for Undercuts (areas where the cutter cannot
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reach), and to optimally rotate your geometry to
reduce undercuts.
In a Wireframe geometry the triangles of the
geometry are drawn with lines.
it is possible that you can’t see the geometry very
well because all the lines are confusing.

In such case the sub-option Remove hidden lines
can be useful. This removes the lines of triangles
that are hidden (obscured by other triangles).

In a Points geometry only the three vertices (corner
points) of each triangle are drawn.

Bitmap concerns the Bitmap image that has been
loaded. For large bitmaps DeskProto will display a
simplified version (256x256 pixels) of the bitmap, in
order to speed up drawing. 

The sub-option Translucent draws the bitmap
image in a translucent way, maintaining visibility of
the items behind the bitmap that otherwise would
remain hidden.

The CAD zero-point draws a gray orientator cube
with three axes (as shown on the left) on the point
where in the original CAD-data the zero point is
located.

 

The group that includes the Parts-related items is the smallest:

The Material block is drawn in orange lines. For standard three-
axis machining this is a rectangular block, for rotation axis
machining the block may also be a cylinder.
The sub-option Translucent draws the surfaces of the material
block in a translucent color (the same orange/brown as used for
the lines). This will show the block more clearly, maintaining
visibility of the CAD-data inside.
The Workpiece zero-point orientator again is a small cube with
three axes, this time drawn in dark blue and showing the position
of the zero point on the machine. The position of the Workpiece
zero point can be changed on the Zero point tab of the Part
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Parameters. Default position (as shown left) is on the
front/left/top corner of the material block.
The S imulation checkbox allows you to add a Simulation of this
Part, which will clearly show what the resulting model will look
like. Checking this box will display the complete block of
material and show the Simulated Operations dialog.  Here all
operations for this part are shown, and you can choose the
operations to be processed in the simulation.

The last group shows the items that are different per Operation. So the
selection of items in this group may be different per Operation.  It is for
instance possible to show the toolpaths of Operation Roughing and not show
them for Operation Finishing, while both operations are visible.

In the list of Operations you can change the  visibility of each Operation by
clicking on the lamp icons (just as in the Project tree). Yellow (lamp on)
means visible, gray (lamp off) means invisible.
In the list you can also Select one or more Operations: making the line blue
(meaning selected) by clicking on it. Two or more operations can be selected
by keeping the Control or the Shift button depressed when clicking. The
Operation Items that you will check and uncheck will apply ONLY to the
selected operations.

When you have selected two operations and some item is checked for one and
not checked for the other, the checkbox will show a small black square instead
of a V, like in the illustration above for the Toolpaths.

When you check the Z-Grids checkbox the Z-grids
of the visible operations will be shown. The Z-grid
is an intermediate representation of the geometry
that DeskProto uses for it's toolpath calculations.
The Z-grid will be drawn in lines.
The same Z-Grid will be show for option Rendered
Z-Grids. Now the Z-grid is drawn as a rendering, so
you can clearly see that it is a 3D bar graph
representation of the geometry.

When you check the Toolpaths checkbox the
Toolpaths of the visible operations will be shown.
The toolpath that is drawn is the same toolpath that
will be sent to the machine: if there are any
problems it should be possible to detect them now.
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Toolpaths in DeskProto are all polylines: the path is
built as a series of linear interpolations ("G1
movements"). The sub-option Show points will
indicate the end of each of these straight movements
with a small point in the drawing. 
When checked the Operation areas will be shown:
the rectangular bounding box of the operation in light
green lines. The sub-option Translucent draws the
sides of the area in a translucent green color. This
will show the area block more clearly, maintaining
visibility of the geometry inside.

The colors that are used for the various items in the example drawings above
are the DeskProto default colors. These can be changed in the Colors tab of
the DeskProto Preferences.
For all line drawings default fog may be applied to simulate depth, which can
be set on that same location.
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4.12 Part Information

Depending on which types of CAD data have been loaded in the project, one
up to four tab pages are shown.
Each tab shows the Boundaries and the Dimensions ("Delta") , either for the
complete part or for that type of CAD data.

Shortcuts:

Toolbar:

All coordinate values and sizes are shown for the Part that results when the
Part parameters have been applied (scaling, rotating, etc): these values are
valid for the NC program file to be written and on your milling machine. 
When checkbox Use translated coordinates has been checked the final Part
translation (as set on tab page Zero-point) will be applied.

You can find the Min and Max values as present in the original CAD-data
using button File info in the Project parameters.

Material:
The dimensions of the material block that has been defined for this part. This
is important information for you, as these are the dimensions of the Block of
material that you have to prepare.
Vector:
The bounding box of all Vector curves that have been loaded. For the Z the
machining depth is used that has been set in the Vector operations for this
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part. The deformation caused when projected on a 3D geometry is not
shown.
Geometry:
The bounding box of all Geometry data that has been loaded.
Bitmap:
The bounding box of the Bitmap relief that will be created. For the Z the
relief depth is used that has been set in the Part parameters The deformation
caused when projected on a 3D geometry is not shown.

In all TAB pages coordinates are given for Min, Max and Delta. The min
and max part values are handy when setting the workpiece zero point on the
machine, the delta values (dimensions) can be used to prepare the  block of
material to be machined. 
This dialog can stay open while you are working with the project.

For rotation axis projects with a cylindrical block of material the Material
tab of this dialog shows values for X and D (instead of X, Y, Z).  Here D is
the diameter of the block (only shown in the Delta column). 
In case a tube shaped block has been defined the material tab shows a third
line, with R values (Radius): the delta between Rmin and Rmax is the material
thickness of the tube.

The dialog can be viewed in two ways; as a small dialog box with tab pages
(shown above), or as a large dialog box with all the information visible at the
same time (shown below). You can switch easily between those two types of
dialogs by pressing the button at the bottom on the right side (the small black
arrow).
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4.13 Estimated Machine Time

With this option you get a rough estimation of the machining time that it will
take to create your part. Be advised that this indeed is a very rough
estimation, as the actual time will be influenced by many factors.

Theoretically speaking it is easy to calculate the exact machining time:
DeskProto knows both the length of the toolpath and the feedrate (machining
speed), so length divided by feedrate results in a theoretical machining time. 
However, the real machining time is influenced by many factors:
· How long does the machine’s controller need to calculate for one linear

interpolation (calculating the separate speeds for each axis, a calculation
that is needed for every movement) ?

· Does the machine keep up its speed (look-ahead buffer), or does it stop or
slow-down in-between each two movements ?

· How fast can the machine accelerate and decelerate ? (especially important
when stopping or slowing down after every movement).

· How fast is the data transfer from computer to machine ? (if you are using
a 9600 baud serial line this factor will seriously slow down the process).

· Does the toolpath consist of small movements or long straight lines ? (in
the first case it will in fact not even reach the desired feedrate as the
distance is too short to accelerate to full speed).

So the resulting real machining time cannot even be correctly predicted for
one particular machine, as it will vary considerably depending on the
characteristics of the toolpath. 
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DeskProto will convert the Theoretical machining time to an estimated Real
Machining Time by multiplying by a machine dependent correction factor.
As previously noted, this results in a rough estimation since the actual time is
also dependent on the toolpath characteristics. The correction factor can be
set at the Machine dialog (Library of Machines). In order to fine-tune you
can time a few toolpaths and correct this factor accordingly.

This dialog will automatically pop up immediately when a toolpath has been
calculated.
In case you do not like that: remove the checkbox before "Always show this
dialog after calculating toolpaths".
You can make this dialog (re-)appear by selecting Estimate machining time in
the Create menu.
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4.14 Simulated Operations

This dialog is visible when a Simulation is visible on screen
Removing this dialog (red cross or button Hide) will make the Simulation
invisible.

You can open this simulation dialog by:
- pressing the Simulation button on the Toolbar (after which you can see that
it is pressed)
- using the Show Simulation command in the Create menu. 
- switching the simulation on in the Items visible dialog. 
DeskProto will calculate a simulation in 3D, so you can rotate, pan and zoom
it just like any other item on screen.

A simulation is made for one complete part. This Simulated Operations
dialog will pop up in which you can select which operations should be
included in the simulation. When no operations are included the simulation
shows the complete block of material. After checking an operation to be
included you will need to start a calculation to see the result. Removing an
operation from the selection causes the complete simulation to be reset.

Option Check all / none offers an easy way to include resp remove all
operations in one click. When  some operations have been selected and some
have not, this checkbox shows a small black square, like shown in the image
above.
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You can set the Simulation parameters in the Part parameters dialog.

Closing the Simulated Operations dialog, again pressing the Simulation button
and switching the simulation off in the Items visible dialog will all make the
simulation disappear from the view.

Note that the simulation calculation algorithms for 3-axis toolpaths and for
rotation axis toolpaths are completely different. 
· The XYZ algorithm (3-axis toolpaths) uses a grid on the XY plane with a

Z-height for each grid-cell: the grid-based simulation.
· For the XZA simulation (rotation axis toolpaths) this is not possible,

this calculation is based on voxels (small "3D pixels") that either are filled
with material or not: the voxel-based algorithm. 

The voxel-based algorithm is much more complicated, and so calculation time
will be higher.  The quality of the resulting image also is higher for the grid-
based simulation. 
One more difference is that the voxel-based simulation removes material only
where the cutter can actually cut, defined by its cutting length. For a finishing
operation this might be completely within the block: creating an invisible
cavity in the block, So for a voxel-based simulation it is important to simulate
the operations in the correct sequence: first roughing, then finishing.
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4.15 Machine Check

This dialog will be shown by command Send NC-program file to machine and
Send toolpaths to machine, both in menu Create (the first in group Extra).

When a different image has been configured for button "Send toolpaths to
machine" (see the Preferences) that image will be used in this dialog as well.

The dialog asks if the machine is ready: material loaded, cutter loaded, zero
point correctly set, machine ready to receive data. 
After pressing Send DeskProto will start sending, and the machine may start
cutting immediately.
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4.16 NC-Program File Number

This dialog pops up when you write an NC-Program file, and when you have
used the placeholder {PROGNUMBER} in the Start commands of the
postprocessor that is used.

It is meant for machines that require each NC-program to have a unique
Program Number. Here you can enter the program number to be used in this
NC file. On other machines adding this number may generate an error on the
machine. Consult your machine's manual to find if this is needed for your
machine.

The number of positions sets how many positions will be used: in most cases
this needs to be 4 or 5. This information should also be given in your
machine's manual. The file number may of course not be larger than possible
for this number of positions.  When a program number is lower DeskProto
will automatically add preceding zeroes. Finally: after writing an NC file
DeskProto will automatically increment this number for the next file to be
written.
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4.17 File not found warning

When opening a project file, the CAD file(s) that was (were) used will be
opened again: the DPJ file does not store the data but only links to the
Vector/Geometry/Bitmap files. These files must thus be found at the same
place as where they were when the project file was saved. 

If the CAD file cannot be found (for instance when the DPJ file was copied
from a different computer system) then DeskProto will check if a CAD file
with the correct name can be found in the current folder (same as the DPJ
file) or in the default Data directory. If yes, DeskProto will ask you if it can
use that file instead, using a dialog as shown above.
You then can choose to either use that file at the alternative location,  or
browse to use a file on some other location.

The option Apply to all files is useful in case your project file contains more
references to external files (Vector, Geometry and/or Bitmap). This option
makes it possible to use the new location for all file references in the project.
If the option is not checked then this same dialog may be shown a number of
times, once for every CAD file that could not be found.
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If the file cannot be found on any of these alternative locations this warning-
message will be displayed instead:

Here as well you can Browse to find the file on some other location. 

After pressing the Cancel button the project will continue loading, without
the missing CAD file(s).



DeskProto Reference

Page 284

4.18 Preferences

This is a dialog in which you can edit DeskProto's preferences. The dialog
consists of 5 Tab pages. In Windows and in Linux this dialog can be found in
the Options menu, in MacOS in the DeskProto menu.

In Windows these preferences are stored in the Registry, in MacOS in file
~/Library/Preferences/com.delft-spline-systems.DeskProto.plist, in Linux in
file ~/.config/Delft Spline Systems/DeskProto.conf 
Each user has his/her own preferences stored there.

General tab page

The File-locations listed here are the directories (folders) where DeskProto
looks for the specified file types. These directories can be changed by typing
the new directory’s complete path-specification (i.e.: C:\DeskProto\ ) or by
using the Browse button. 

Data is the location where DeskProto will initiate the Load and Save dialog
boxes for projects and for CAD data. The default setting for this option is the
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Documents (or My Documents) folder. This is a standard location in all tree
operating systems:
Windows: Documents
MacOS: ~/Documents/
Linux: ~/Documents/

In this default location no sample files and projects are present: quickest
way to find the sample files is via the DeskProto Start Screen (check "Use
samples folder" on this screen). The Sample file location is:
Windows: C:\ProgramData\DeskProto 7.1\Samples\
MacOS: ~/Library/Application Support/Delft Spline
Systems/DeskProto/7.1/Samples/
Linux:  ~/.local/share/Delft Spline Systems/DeskProto/7.1/Samples/

While working with DeskProto this Data folder (the "current directory")
may change: when loading from of saving to a different folder that folder will
become the current directory. For instance after loading CAD-data from
folder C:\Test, the default folder for loading more CAD-data or saving the
project file will also have become C:\Test.  This is very convenient, as it
makes it easy to save all files for one particular project in one folder.

The Data directory comes with the extra option Fill with last used folder
on exit, making DeskProto remember which folder you were working in the
last time you used DeskProto. 

Drivers is the location from which DeskProto will load all driver files
(machines, postprocessors and cutters). Any valid new driver files that you
copy to this folder will be automatically available after (re)starting
DeskProto. Changing this location will make DeskProto unload all drivers
(not delete them from disk though) and load drivers from the new location (if
available). Because the open project uses drivers from that library, the open
project will be closed before making this change. A new empty project will be
created after the new library has been loaded or created at the new location.
Be careful though: DeskProto will not function correctly when it cannot find
it's drivers.

Windows: C:\ProgramData\DeskProto 7.1\Drivers\
MacOS: ~/Library/Application Support/Delft Spline
Systems/DeskProto/7.1/Drivers/
Linux:  ~/.local/share/Delft Spline Systems/DeskProto/7.1/Drivers/
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In Windows the default location for this type of files is in the C:
\ProgramData\  folder  (as folders in \Program Files\ can be accessed only by
users with administrative privileges). For some reason Microsoft has made it
a hidden folder: to make it visible in File Explorer ('My Computer”) select
Organize >> Folder Options, tab page View and select the option “Show
hidden files, folders and drives”.
In Windows XP this folder is called: C:\Documents and Settings\All
Users\Application Data\
To make it visible in WinXP Explorer open Tools >> Folder Options >> tab
View and select the option “Show hidden files and directories”.

As this is a rather confusing situation it may be difficult to restore the
DeskProto default after a change. So we have added the button Use
DeskProto defaults to make resetting the file locations easy.

Using the option Measurement unit you can choose between  metric (mm)
and  imperial (inches) for your DeskProto configuration. This setting will be
applied in the user-interface and when loading and saving CAD-data: most
CAD files do not state the units used and DeskProto has to assume that they
are in the same unit as the one you define here. 

Note: also check your milling machine’s documentation to see which units
are needed for the machine, as that setting is independent from this
preferences setting. Some machines expect NC files in mm, some will expect
files to be in inches. Make sure to configure your postprocessor to use the
correct units: this is completely independent of the choice that you make in
these Preferences. 
A few places that you can check in case of problems:
This setting Measurement unit, in Options> Preferences> General tab, mm or
inch.
The Distance unit in Options> Postproc> Movement tab, mm or inch.
The Feedrate units in Options> Postproc> Feedrate tab (many more options)
When your machine uses G-codes you can also check the Start commands of
your Postprocessor: 
If working in mm:  use "G21 or G71 mm" to set the machine to use mm.
If working in inch:  use "G20 or G70 inch" to set the machine to use inches.

Other Available languages than English are only present in case you have
run a translated DeskProto Setup. This setup will create a Translations sub-
folder in the DeskProto installation folder, with a sub-folder for that language,
and it will copy translation files for a certain language to that folder. The
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name of the sub-folder is the two-letter codes for that language (conform ISO
639).

DeskProto currently supports the following languages:
de Deutsch German
en English English (this is the default, no Translations folder needed)
es Español Spanish
fr Français French
it Italiano Italian
nl NederlandsDutch
pl Polski Polish
ru Русский Russian
zh   Chinese
ja    Japanese

For each language "nn" at least the following file is required:
DeskProto_nn.qm, containing the  translated resources. 
For instance "nl" for Dutch needs the file DeskProto_nl.qm
Complete file specification:  C:\Program Files\DeskProto
7.1\Translations\nl\DeskProto_nl.qm

In addition the following translated files are optional:
- translations for the standard Windows buttons and dialogs, in file
qtbase_nl.qm
- a translated Help file, in files DeskProto_nl.qhc and DeskProto_nl.qch
- translations for the custom wizards, in file DeskProto_Wizards_nl.qm
If such optional file is not present (or incomplete) the missing texts will be
displayed in English.

The cutter files that are installed with DeskProto V7 already contain proper
names (translations) for all these languages. This is different from the
situation in DeskProto V6.1 and older, where for each language a completely
different series of cutter files was used.

The translated Setup will also copy translated versions of the license
agreement and the Readme file:
License_nl.rtf and Readme_nl.rtf
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Colors tab page

The tab page Colors makes it possible to customize all colors used in the
DeskProto view window: all color fields are buttons that you can click on,
which will open the Select Color dialog. As you can see different operations
can be assigned different colors. In case of many operations: the colors for
operation No. 1 will also be used for No. 5, 9, 13 etc. 

Checking the option Use fog applies fog to all drawings that use lines. This
technique (also called 'depth cueing') improves the perception of depth on
your two-dimensional screen by making distant lines more vague (as if
obscured by a light fog). 
On Black and White printers this may cause the lines to be printed like
dotted lines, resulting in a blurry print. Therefore you might want to
temporarily switch off the fog when printing. On computers with a video
card which does not support OpenGL this option may have no effect.

In case you have made a giant mess of your color settings you can press Use
DeskProto defaults to restore the default settings of DeskProto for all
colors (these 'hard defaults' are stored internally in DeskProto and can not be
changed).
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NC Output tab page

These preferences are meant to configure the NC-output, so are meant for
exporting the toolpaths to NC files or other destinations.

With the first preference you can fine-tune the Output path for Write NC-
Program. Normally DeskProto exports the NC files to the same folder from
where the project and/or the geometry file were opened (the 'current'
directory). This is when the option Use data path is checked.
After unchecking this option you can type or Browse a fixed directory to be
used for writing the NC files to. This is handy in case you want all NC files
to be stored on the same place (for instance a folder on the PC next to the
milling machine, or a USB stick that will later be plugged into the machine).

The second preference, Destination, refers to the commands Send Toolpaths
to Machine in the Create menu and Send NC-program File to Machine in
Create > Extra.  By default these two commands are disabled, here you can
enable them by determining which process has to be started after giving the
command. 
This feature is not available in MacOS and in Linux: only in Windows. Sorry
about that. 
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Send to
This combo box shows four types of choices: Printer Driver, a Hardware
Output port, an External program or None. Each option comes with it's own
sub-settings:

1- In case you configure None, the commands Send toolpaths to Machine
and Send NC-program To Machine will not be available (grayed out), and the
toolbar button "Send toolpaths to machine" is not present.
No sub-settings are available. This is the default situation.

2- Selecting a Hardware Port (either serial COM.. or parallel LPT..) means
that the NC-program will simply be copied to that port after the command is
given. This can be for example LPT1, or COM2. The button  "Send toolpaths
to machine" will show a machine icon (see Note 1 below), and the tooltip for
that button will show the configured destination.
For a Centronics Printer port (LPT1 or LPT2) no settings are needed. In case
of a COM-port you need to configure this port according to the
specifications of the milling machine. Use the button Setup for the standard
Windows COM port settings dialog (setting values like ‘Baud Rate’, ‘Data
Bits’, ‘Parity’, ‘Stop Bits’ & ‘Flow Control’).

3- Selecting Printer Driver can be used for machines that are accessed via
their own printer drivers (for instance most Roland machines). This also
works for USB machines that cannot be accessed via a Port. The button 
"Send toolpaths to machine" will show a machine icon (see Note 1 below),
and the tooltip for that button will show the configured destination.
Here you have to select the correct Machine name from the list of available
printers (or rather of all printer drivers that have been installed on your PC).
Take care not to select a ‘normal’ printer as this may result in hundreds of
pages to be printed on paper.
After sending the NC-file to the machine this way, the job status can be
followed using the standard Windows Printer Properties tools. On some PC's
it may be needed to select “Print directly to printer” in the Advanced Printer
properties of the selected printer driver.

4- After selecting the option External program, you can use the Browse
button to define which program has to be used. The button  "Send toolpaths
to machine" will show the desktop icon of that program (see Note 1 below),
and the tooltip for that button will show the configured destination.
Here you can browse to any program file (EXE of COM) on your computer.
After the command Send NC Program to machine, DeskProto will start this
program, with the name of the NC-program file to be used as command line
parameter. 
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The idea is to configure the control software of your CNC milling machine
here. This works for many programs, for instance:
- Kay  (configure "C:\Galaad\KAY.EXE", or "C:\Program Files (x86)
\Galaad\KAY.EXE").
- PlanetCNC  (configure "C:\Program Files\PlanetCNC\PlanetCNC64.exe",
or PlanetCNC32.exe on 32bit windows).
- WinPC-NC  (version 3.01 or newer, configure "C:
\WinPCNC_USB\WinPCNC.EXE").
However, it does not work for all control software, for instance not for
Mach3: the control software must support the use of a command line
parameter with the name of an NC file, and Mach3 does not.
In fact you can select any program, for instance a milling simulation software,
or (for the diehards) a plain text editor like Notepad, allowing you to change
the NC-program that DeskProto has just created.

Note 1:
It is possible to configure a custom icon to be shown on button "Send
toolpaths to machine" . That is ideal for machine builders that give (or sell) a
DeskProto license with their machine: they can make DeskProto show their
very own logo !! Configuration is easy: copy an image file called machine.png
to the folder that also contains DeskProto.exe (normally C:\Program
Files\DeskProto 7.1\ ) and that image will be shown on the button. Scaled
down to the proper size (default 32x32 pixels).
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Wizard tab page

The tab page Wizard contains a preference that you can set for the Two-
Sided Milling Wizard: the size of the material block. This tab page is not
available in the Free edition and the Entry Edition. Two options are available:

· Floating size. The block size needed of course depends on the size of the
part that you want to create. DeskProto offers a flexible solution here,
called Floating size: around the part (including the support tabs) a frame is
added of a certain width. In the edit boxes for X and Y you can enter which
 frame size to use. This is the default choice for this option.

· Fixed size is useful in case all your parts have almost the same size: you
then can use standard blocks of a certain size, to be defined in the X and Y
edit box.

Only the X and Y block size can be set here, the Z dimension is set in the
wizard.
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Advanced tab page

This tab page of the Preferences contains four or five different sub-pages,
which you can select by making it active (blue background) in the list on the
left. Four sub-pages are always shown: Graphics, User Interface, Mouse
and Settings;  page SpaceMouse is available only when DeskProto finds a
SpaceMouse attached to the PC. Help for all four sub-pages is given below.

First the Graphics preferences will be explained, shown in the picture above.

Dynamic drawing
Dynamic drawing is the drawing that is done while the left mouse button is
pressed inside the view window or while using the thumb-wheels: you see
the image change while moving the cursor. Choosing the option Draw
limited number of entities will decrease the number of entities that is
dynamically drawn, and so will increase the speed with which you can move
the geometry and other items (the term entities used here stands for points,
lines and facets). If several Items are drawn, the maximum number that you
enter is split up over all visible items. In case you set the number of entities
to zero only the bounding box of the geometry will be displayed during
dynamic drawing.
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The optimum number of entities depends on the capabilities of your graphics
card: an OpenGL card featuring hardware rotation etc. can handle a large
number of entities at high speed. For a simple graphics card the number must
be set lower to achieve real time results.

Graphics options are in fact OpenGL options:

Drawings on the screen are displayed using pixels, for instance a line is drawn
as a series of black pixels on a white screen. As the pixels on your monitor
are located in a rectangular grid, a curved line will be displayed as a staircase.
Anti-Aliasing is a technique to make this staircase effect less visible, by
adding pixels with an intermediate color value: in the example just mentioned
this will be in various grades of gray. This shade of gray to be used for a pixel
is calculated using multi-sampling: each pixel is divided into multiple sub-
pixels, for each sub-pixel a gray value is calculated, and the average resulting
gray value is used for the pixel to be displayed. 

The more samples are used, the better the resulting quality, however the more
calculation time is needed. You can set this Sample rate as a detail setting:
the combo box will show only the rates supported by your graphics card. We
advise a rate of four: higher rates will cost much time where the improvement
in quality will be marginal.
In case your graphics card does not support anti-aliasing at all, this option
will have been grayed out.

The option Use buffering when rendering the simulation is meant to
optimize the drawing speed for your typical simulations.
A simulation in DeskProto is calculated and drawn as a large set of small
triangles (defining it's outer surface). This is the same type of entity as used
to draw the geometry. Only the number of triangles in most cases is higher
for a simulation, which may make the drawing process slow.

Using Buffering means that all triangles are stored in RAM as a sort of
"geometry model", and for drawing are sent to the 3D video memory of the
graphics card as 3D data (a 'buffer'). Changing the view then will be
completely handled by the graphics card: DeskProto only needs to send the
new camera position, the graphics card will do the rest. This is what
DeskProto does when displaying geometry data, and for a simulation the
default status of this option is to have it checked. On most current PCs that
works fine.
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The drawback of buffering is that it requires more graphics memory (video
RAM). When more memory is needed than available (either RAM or video
memory), Windows will need to swap to hard disk. And that will make this
nice method even slower than the un-buffered method. So when drawing a
complex simulation (on the screen of your old PC) is very slow you can try if
is helps to uncheck this buffering option.

Without buffering the color values for all triangles are generated for the
current view settings and are sent to the card as 2D data. The graphics card
just displays the resulting 2D image, and does not keep 3D data in it's video
memory. This will of course cost time: for each new view all triangles have to
again be generated and sent over to the graphics card.

One more graphics option is available: the line width (default 1 pixel) can be
changed for all lines in the drawing (curves, blocks, toolpaths). This has been
implemented as "hidden feature". Setting DrawingLineWidth may have a
value from 1 (default ) to 99. Changing this value needs to be done before
DeskProto is started.

You can access this setting as follows:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto7.1\Preferences\Advanced\Graphics\DrawingLineWidth
For MacOS change line
"7·1.Preferences.Advanced.Graphics.DrawingLineWidth" in file
DeskProto.plist 
For Linux change line "Preferences\Advanced\Graphics\DrawingLineWidth"
in file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !
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The picture above shows the User Interface sub-page of the Advanced
Preferences.
The user interface displays both text and graphics, this setting concerns the
size of these items. The toolbar buttons for instance are drawn as 32x32 pixel
images (the 'large' buttons), all texts and all images in the dialogs have a fixed
sizes as well. At least, on a 'standard' display. 

On high-res displays the fixed size as just mentioned will be too small for an
easy readability. For instance on "4K displays" (with a horizontal resolution
of around 4,000 pixels) of a desktop size the text and the buttons would be
unreadable. On such display DeskProto will automatically make the user
interface larger (use more pixels).
This is determined by the screen's DPI (how many pixels per inch).
DeskProto considers a DPI value of 96 to be standard. If the screen's DPI is
larger, an automatic scaling factor of [ the actual DP / 96 ] will be applied
on the number of pixels used for each element, making the actual dimensions
of each user interface detail in mm or inch roughly the same as on a standard
screen.

This option Extra scaling makes it possible to adjust this automatic scaling
factor: the automatic factor will be multiplied by the extra factor. So if the
automatic scaling is factor is 2, you can for instance set the extra factor on 1.5
to configure the total scaling factor to be 3. This will help in case you have
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trouble reading from the screen.  Or when you feel that all user interface items
are too large you can set the extra factor on 0.5 to configure a total scaling
factor of 1.

You can also use this Extra scaling on a standard screen, to make the user
interface larger.
The total scaling factor may not be lower than 1, so on a standard screen (96
DPI) an extra factor below 1.0 is not possible.

The button Use DeskProto Defaults resets the extra scaling factor to 1.

The picture above shows the Mouse sub-page of the Advanced Preferences.

The only Mouse setting that you can configure is the Mouse wheel zoom:
rotating the mouse-wheel (scrolling) when the cursor is in the View window
will make DeskProto zoom in or zoom out.

The Zooming speed sets the zoom percentage for each rotation step of the
mouse's scroll-wheel. 
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Scrolling from back to front will zoom in: your finger movement pulls the
part on screen closer.  Scrolling from front to back will zoom out: your finger
movement pushes the part away.
The option Reverse scrolling direction reverses this situation.

The picture above shows the SpaceMouse sub-page of the Advanced
Preferences.
It will be visible only in case a SpaceMouse is connected to the PC.

These settings are meant for the 3Dconnexion SpaceMouse series of products
(formerly called Logitech SpaceMouse, now offered by Logitech daughter
company 3Dconnexion). The sub-page will be present only when on program
start DeskProto detects that such SpaceMouse is present on your computer.
 The product is also called 3D Mouse and SpaceNavigator.
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The image above shows the most basic version. The device stands on your
desk, the handle (rubber knob) on top is pressure-sensitive in six directions: 
front-to-back, left-to-right, up-and-down, pitch rotate, roll rotate, yaw rotate.
 Applying pressure in one of more of these directions will make the 3D part
on screen move and rotate in these directions. Which is a great help for CAD
designers.

This use of a SpaceMouse in fact is so straightforward and intuitive that no
settings seem to be required. Still DeskProto offers a few.

Functions:
Of the six degrees of freedom just described three are linear movements and
three are rotations.
Un-checking  Pan/Zoom disables the linear movement commands
Un-checking Rotate disables the rotation commands.
When you un-check both only the buttons will work - which does not seem
to make sense though.

Speed:
Just as for the scroll-wheel on the normal mouse you can set how fast the
movement of the part should be, here in response to the pressure applied to
the mouse's handle.

Buttons:
Each SpaceMouse features (at least) two buttons: for the basic model button
1 is the Left button and button 2 the Right button. For each button you can
select the action that needs to be done when it is pressed. Each SpaceMouse
model has a different number of buttons: of course you can't use more than
your SpaceMouse offers.
If nothing is visible in this box press button "Use DeskProto defaults" to fill
it.
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DeskProto sets defaults actions for twelve buttons:
1. Menu -> Items visible dialog
2. Fit -> Zoom all
3. Top -> Top view
4. Left -> Left view
5. Right -> Right view
6. Front -> Front view
7. Bottom -> Bottom view
8. Back -> Back view
9. Roll cw -> Rotate image 90 degrees clockwise
10. Roll ccw -> Rotate image 90 degrees counter-clockwise
11. Iso 1 -> Isometric view
12. Iso 2 -> Default view

You can change any of these button definitions by selecting a different action
from the pull-down list for that button. The pull-down list contains 22
actions that you can choose from. In this list the movement directions Tilt,
Spin and Roll are used: see the image above for an explanation. After changing
one or more button definitions you can use button "Use DeskProto Defaults"
to reset to the 12 actions shown above.

In case you are not sure which button corresponds to which number you
can simply press that button with this Preferences page opened: in the dialog
shown above DeskProto will then make the number for that button red. In
the screenshot above you can see that the "2" is displayed in red.

To understand the function of button Override 3DxWare, it is important to
know is that DeskProto does not use 3Dconnextion's software development
kit (3DxWare), and also does not use the 3DxWare driver that 3Dconnexion
ships with this device. Reason is that this software is not compatible with
the QT toolkit that DeskProto also uses.
Disabling the official 3DxWare driver (only for application DeskProto.exe) is
achieved by copying file
C:\Program Files\DeskProto 7.1\SpaceMouse\Win.xml   to
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C:
\Users\Name\AppData\Roaming\3Dconnexion\3DxWare\Cfg\DeskProto.xml  
(where Name is the name of the user).
This copy action is done automatically, by the DeskProto Setup.

However, in the 3DxWare driver (3Dconnection Properties) a user can create
a configuration for application DeskProto, which will over-write the one that
was copied during Setup. When that happens both drivers will be active at
the same time, resulting in zooming activity during all rotation commands: the
view will rotate and zoom at the same time, while it only should rotate.
Button Override 3DxWare makes it possible to fix this problem: it will
again copy the DeskProto version of the XML file, as described above. This
disabling of the driver will only be effective for DeskProto.

This fix does not work correctly for old 3DxWare drivers (it did not work
with a V4 driver), so if it does not work for you then you may need to
upgrade your driver (it worked OK with a V10 driver).

Button Use DeskProto Defaults allows you to reset all setting on this page
to the original DeskProto defaults.
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The picture above shows the Settings sub-page of the Advanced
Preferences.
 
In DeskProto many warning messages contain a checkbox called "Always
show this message".
These are optional warnings: when you remove the mark from the checkbox
and press OK, the warning will no longer be issued each time the same
situation occurs. However what to do when you want the warning restored ?
Using button Restore the 'always show' settings  you can restore all
warnings (so it will again set the mark in all these checkboxes).

All DeskProto defaults and preferences are of course stored.
For Windows this is done in the Registry, conform the specifications for
Windows applications as made by Microsoft.
For MacOS the defaults and the preferences are stored in file
~/Library/Preferences/com.delft-spline-systems.DeskProto.plist
For Linux the defaults and the preferences are stored in file ~/.config/Delft
Spline Systems/DeskProto.conf
This makes it difficult to extract these settings, for instance for backup
purposes, or in order to give DeskProto exactly the same workspace on a
number of PC’s.

This is where the options Export settings and Import settings come in:
these tool allow you to export DeskProto’s Registry settings to a file, and
also to import all these settings from a file that has been created previously or
on a different PC. The use of these commands is straightforward: button
Export settings will export an xml file, button Import settings will import
one. The file format used is an XML file, default filename for export is
deskproto_7-1_settings.xml

The resulting V7.1 XML files can be used for all three operating systems
(Linux, MacOS, Windows). In DeskProto V7.0 the Windows version used a
different format for this XML file. DeskProto V7.1 can import that old
format, however DeskProto 7.0 cannot import an XML file that was written
by DeskProto V7.1.

The export option will write the current settings, so for the current version of
DeskProto.
The import option accepts XML files, written by V6.1 en V7.0.  DeskProto
V6.0 and older versions will write a .REG file when exporting the settings:
DeskProto V7.1 cannot read such .REG file.
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Note: the File locations (Data location, Drivers location, NC-File location)
will not be included in this Settings file. Reason is that these will be different
per user: like 
C:\Documents and Settings\Jones\My Documents\
and 
C:\Documents and Settings\Smith\My Documents\



DeskProto Reference

Page 304

4.19 Activate license

In Windows and in Linux this dialog can be found in the Help menu, in
MacOS in the DeskProto menu.

The Free Edition of DeskProto can and may be used without buying a
license.
Users who need more functionality can buy a license to activate (unlock) one
of the higher Editions: Entry, Expert or Multi-Axis. One of the options in
the Free edition is to evaluate (trial) these higher Editions - when trialling a
watermark (the "Trial cross") will be visible in all machined parts.

In all cases you need to first download the DeskProto Setup file from our
website www.deskproto.com and instal DeskProto on your computer. This
Setup file is the same for all Editions of DeskProto.

A free DeskProto license is given to any user: you are welcome to use the
Free Edition of DeskProto free of charge.

http://www.deskproto.com
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A paid DeskProto license can be bought either via a reseller or via our
webshop. After buying you will receive the license (a PDF file) containing
two strings: a Name and a Key.
The Name contains the name of the buyer (either a person or a company)
and his/her/its location (city, village): information that will be clearly shown
at each program start.
The Key is a code of 340 characters, containing information all license
information. Each Key is valid only for the Name on that same license.

The Activate dialog is meant to activate a DeskProto license and unlock the
extra functionality for the Edition that you have bought. Both the complete
Name-string and the 340 character Key have to be entered exactly as given,
including case (upper or lower), spaces, commas, points, etc. Any small
difference will make DeskProto refuse to activate. So use Copy/Paste to enter
this information in this dialog.
After filling both fields you can use the Activate button to make DeskProto
activate the license.

Make sure to carefully save and backup the license: you will
again need Name and Key when (for instance) you buy a new
computer.

A registered version of DeskProto will clearly show the Name of it's owner:
in case that is not you then you are running an illegal copy!

After Activating it is also possible to Deactivate, allowing you to again
convert the program from paid license to free license. Needed for instance
when you sell your computer.
You may Activate and Deactivate as many times as you like: information
about the previous licenses will simply be deleted. 
Activating a new license is also possible without Deactivation first.

Both for Activating and for Deactivating administrative privileges are
required (Windows).

In Windows the license activation affects all users of that PC, in MacOS  and
in Linux the activation information can be accessed only by the current user:
every next user will also need to activate the license on that same computer.
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4.20 Migrate Settings

DeskProto stores many of the user's defaults and preferences in the storage
facility that your operating system offers.
for Windows this is the Registry, conform Microsoft's guidelines. 
for MacOS this is a .PLIST file in the Library
(~/Library/Preferences/com.delft-spline-systems.DeskProto.plist) 
for Linux this is a CONF file (~/.config/Delft Spline Systems/DeskProto.conf)
The settings are stored per DeskProto version, so settings for V7.0 and V7.1
are completely independent.

When you have installed a higher DeskProto version on a PC where an older
version is present, the above dialog will be shown: you can choose whether or
not you want to keep using the settings of your old DeskProto, so whether
or not to migrate them to the new version. For instance you have installed a
new DeskProto V 7.1 on a PC where a DeskProto V 7.0 was already present,
like in the image above (for you it may show a different old version). This
concerns all settings that you made in the Preferences and in the default
Project, default Part and default Operation(s). The exact text in the dialog
may be a bit different for you: it depends on which previous version of
DeskProto has been found)
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When you have reinstalled the same version (for instance a new DeskProto V
7.1 over an existing DeskProto V 7.1)  the Keep Settings dialog will be
shown.

When you answer Migrate old settings, DeskProto will read these settings
of the old DeskProto and save them as settings for the new version. This will
be done as far as possible: not all settings are compatible between different
versions.
In order to let DeskProto V7.1 use the old defaults a few driver files will be
copied as well: for the default machine and postprocessor, and for the default
cutter(s). Be warned: in case already present in the V7.1 drivers folder, this
will replace V7.1 driver files with the same name!  The V7.1 driver will be
renamed to name.bak1 (or name.bak2, etc)
Other machines, postprocessors and cutters that you (may) have added are
not migrated.

The Language setting will not be migrated as the language might not be
available in the new DeskProto. If needed you can manually change that in
the Preferences.
When DeskProto finds an activated license for DeskProto V7.0 that
activation will automatically be used for Version 7.1 too.

When you answer No thank you, nothing will happen, and the new
DeskProto will start with system default values.

Manually migrating is possible as well:

In DeskProto every Machine, Postprocessor and Cutter has it's own Driver
file: name.mch for a machine, name.ppr for a postprocessor and name.ctr for
a cutter. These files are stored in the DeskProto Drivers directory.
You can simply copy these files from the old Drivers folder to the V7.1
Drivers folder. Do not copy all files, as that may remove improvements were
made in DeskProto V7.1. When you sort the old drivers on date it is easy to
see which drivers you have added and/or changed.

Migrating the settings (preferences and defaults) is possible via the
Preferences, tab Advanced. Under Settings you can find buttons Export
settings... and Import settings....  In the old DeskProto you can export all
settings to a file (XML file), and in the new DeskProto you can import that
file. This will only work to migrating settings from DeskProto V6.1 and V7.0:
in older DeskProto versions the Export option will write a .REG file.
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4.21 Keep settings

DeskProto stores many of the user's defaults and preferences in the storage
facility that your operating system offers. When you again install DeskProto
you can choose whether or not you want to keep using these settings.

Two different situations are possible:
1. You have reinstalled the same version (for instance you have installed a
new DeskProto V 7.1  over an existing DeskProto V 7.1). Then this Keep
Settings dialog will be shown, further see below.
2. You have reinstalled a newer version of DeskProto next to an old one. For
instance you have installed a new DeskProto V 7.1 on a PC where a
DeskProto V 7.0 was already present.
Then DeskProto the Migrate Settings dialog will be shown.

This Keep Setting dialog offers you two options:

- when you answer Keep settings, nothing will happen: 
DeskProto will keep using the settings as they were.

- when you answer Reset settings, DeskProto will delete the old settings
and replace them by the DeskProto system defaults.
So when you have made a giant mess of your settings this is an easy way to
delete them all.
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4.22 Newer Drivers warning

This warning is given at program start, when DeskProto has detected that one
of the Driver files (each file contains a definition for a Cutter, a Postprocessor
or a Machine) has been created by a newer version of DeskProto.
For instance: your DeskProto V7.1 opens a cutter file that was created by a
DeskProto V8.0 (which when this document is written does not yet exist).

This newer version of DeskProto may of course offer new features (not yet
known at the time when this Help information is written).
And so this (these) driver file(s) may contain settings that you current
DeskProto will not understand. In most cases this is no problem: your
current DeskProto will simply ignore a feature that it does not recognize.

Take care though: new functionality may also be added to an existing feature. 
An example: DeskProto V7.1 supports "placeholders", allowing you to add
information like program number, part size, date, etc to the NC file. These
placeholders were not yet available DeskProto V7.0.  Using a V7.1
postprocessor with placeholders in V7.0 makes the resulting NC file useless.

This warning will be shown each time that you start DeskProto, unless you
select Yes:
in that case these drivers files will have saved again, now as DeskProto V7.1
files. Any features in the file that are not compatible with DeskProto V7.1
will be deleted.



DeskProto Reference

Page 310



Concepts

Page 311

DeskProto Reference

V Concepts

5.1 CAD Data

Vector data Geometry data Bitmap data

DeskProto offers CAM (Computer Aided Manufacturing): the ability to
calculate CNC toolpaths for a part that you have designed. The first step is
this process in all cases is loading some CAD-data, as DeskProto does not
offer CAD (Computer Aided Design) functionality. Three different types of
CAD-data are supported:
· Vector data One or more curves: points in space connected

with straight line segments (or arcs).
· Geometry data A collection of small triangles that describe the outer

surface of a 3D shape.
· Bitmap data A grid of colored pixels on a flat plane, forming

a 2D image.

The images above for Geometry data and Bitmap data are identical, because
on a 2D screen or page we can only show bitmap images (also for 3D CAD
data). Bitmap data for DeskProto normally will be a digital photo, a company
logo or similar. We used this image to show the difference between 2D data
and 3D data:
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Vector data Geometry data Bitmap data

When looking at the CAD-data from a different viewpoint the difference
between the Geometry data (3D) and the Bitmap data (2D is clear: a real 3D
bottle versus a flat drawing of the bottle on paper.
Vector data for DeskProto in most cases will also be a 2D drawing, however
DeskProto will also accept 3D curves as Vector data.

Vector data Geometry data Bitmap data

The images above clear show the difference between these three types of
CAD-data.
Both for Vector data (points connected by straight lines) and Geometry data
(collection of triangle surfaces) you can zoom in without loosing detail. For
Bitmap data this is different: when zooming in the pixels will became large
squares, and what seemed a smooth curve becomes a staircase.

For each type of CAD data DeskProto offers a (slightly) different work-
flow:
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· a Vector project uses Vector operations, and offers Vector settings in the
Part parameters

· a Geometry project uses Geometry operations, and offers Geometry
settings in the Part parameters

· a Bitmap project uses Bitmap operations, and offers Bitmap settings in
the Part parameters

The wizard interface also offers different wizards for each type of CAD-data.

A very powerful feature in DeskProto is that it can combine these types of
CAD data in one project:
combine a Geometry with Vector curves and /or with a bitmap. It is even
possible to project the Vector curves and the bitmap onto the 3D geometry.  
In the illustration above the Coat-Of-Arms relief Geometry data (a free
download from the DeskProto website) was combined with 2D Vector data
for the word "DeskProto" and an image of the clock as Bitmap data.  You can
of course use your own data for the text on the ribbon and the image on the
shield.
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5.2 Vector Data

DeskProto can load three types of CAD data: Vector data, Geometry data
and Bitmap data.

Vector data consists of curves: points in space that are connected with
straight line segments, in most cases a 2D line-drawing. DeskProto will use
the curves in the drawing to generate the toolpaths. Ideal for 2D jobs, like
milling 2D shapes out of sheet material, or engraving on a flat surface.
In order to create Vector toolpaths you need to use a Vector Operation in
your project.

How to load a Vector file
Vector data files can be loaded in several ways:
· File menu command Load Vector file
· Toolbar button Load Vector file
· Button Add... on the Vector tab of the Project parameters
· The Wizard Basic Vector machining.
It is possible to load more than one Vector file, using the same command: 
after you have loaded a vector file the Load Vector file command will change
to Add Vector file. 

How to save Vector data
Vector data can be exported in two ways (for export only DXF is
supported):
· File menu command Save Vector data as...
· Button Save as... on the Vector tab of the Project parameters
The first option save all Vector data to one file (also when various Vector
files had been loaded), the second only that data of the selected vector file.
When saving the Vector data you may select which of the Part
transformations you want to apply for the exported file. You can do so in the
Save Vector Options dialog.

When reading vector curves DeskProto will check whether or not a curve is
closed: it is closed when the end-point is identical to the start-point. Or in
fact almost identical, as DeskProto applies a tolerance: when the difference is
less than 0.001 mm the points are considered to be equal. The same tolerance
is used when separate open curves can be combined to one long curve (also
see the option 'Preserve curve direction' in the Project parameters.
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The vector calculation algorithm that DeskProto uses only works for
polylines. So when opening a vector file that contains arcs, circles, ellipses,
splines or other curves each of these curves will be converted to a polyline.
The  size of each straight line-segment in the polyline depends on the radius
of the arc. If you are interested, the exact formula for arcs is:
stepsize = 2 * acos( (radius-0.001)/ radius )

As a nice extra feature DeskProto also supports 3D Vector files. The
entities mentioned above normally do not contain any Z-coordinates: you
will set the Z-values in the Vector Operation parameters. A 3D Polyline
however does contain Z-values, and DeskProto can import these. The
toolpath then will follow this 3D Polyline, and the Z-values as entered in the
Vector Operation parameters will be taken relatively to the Z as defined in
the file.
When you open a DXF file containing Z-coordinates then DeskProto will
report that is has detected Z-values in the file, and will ask you if you want
to use them. After Yes the Vector operation will produce a 3D toolpath, after
No the Z-values will be ignored. This setting "Use Z-values" can also be
found on the Vector tab of the Project parameters.
This option can also be checked for vector files that do not contain Z-values:
DeskProto then will use Z=0 for all points on the vector curves. This will
influence the result when both vector files and geometry files are loaded as
the CAD-data zero level of the geometry file is used, which in most cases will
not be the top of the block.

Text in a vector drawing that is stored as a series of ASCII character with a
font definition cannot be read by DeskProto.

Vector File types
For Vector data DeskProto supports three file types: 
· DXF the most widely used exchange format for engineering
· AI the most widely used format for graphics design (vector graphics

only)
· EPS open source format, supports both vector and bitmap graphics
· SVG open source format meant for internet, supports vector, bitmap,

interactivity and animation.
For all four file-types DeskProto supports (so can read) only a small subset
of all entities that can be present in the file, see the lists below.
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DXF
The acronym stands for AutoCAD Drawing eXchange File. 
It can contain many different entities, both 2D and 3D, DeskProto supports
a small subset only. 

Supported DXF entities for Vector data in DeskProto:
POINT
A point in the DXF file can only be selected for a drilling operation on that
location.
LINE
A line contains a begin- and end-point, and will result in a tool movement
from begin to end (linear interpolation).
POLYLINE and LW POLYLINE
A polyline is in fact a series of lines connected to each other. This is more
efficient (endpoint line 1 = startpoint line 2) and gives more control over the
toolpath sequence. A polyline may contain arc segments as well.
ARC
An arc entity contains the centerpoint coordinates, the radius of the arc, and
angles for start and stop. Currently DeskProto will convert the arc to a
polyline (many small line segments), as the toolpath part (postprocessor)
does not yet support arcs.
CIRCLE and ELLIPSE
Same as the Arc: stored in DXF as Centerpoint(s) and radius, converted by
DeskProto to polylines.
SPLINE
A spline curve (Bezier, B-spine or NURBS). DeskProto will convert the
spline to a polyline when importing.

DeskProto will also import CAD-layer information (if present). When
selecting curves you can make each layer visible or invisible.

Internally DeskProto only uses polylines for vector data, so all entities will
be converted to polylines (see the information above). When saving vector
data in a DXF file it will thus contain only polylines.

Note that DeskProto also supports Geometry data in DXF files.

AI and EPS  (Postscript)

These acronyms stand for Encapsulated PostScript (a file exchange format)
and Adobe Illustrator (native format of the most widely used graphics design



Concepts

Page 317

DeskProto Reference

program). Both are in fact variations on the PostScript format, and for both
files DeskProto supports the same subset of entities.
Since Adobe Illustrator Version 9 a completely different format for AI has
been used. So AI files need to be saved/exported for AI8 to make them
readable for DeskProto. Loading an AI file in the new format will result in the
error "The version of this file type is not supported".

Supported Postscript entities for Vector data in DeskProto:
POINT
A point in the Postscript file will result in a drilling operation on that
location.
LINETO
A line in Postscript contains only an end-point, and will result in a tool
movement from the current position to that end (linear interpolation).
CURVETO,  CURVETO_USESTART,  CURVETO_USEEND
Also a tool movement to the defined end-point, however now a Bezier curve.
Used much in font definitions.
MOVETO
As the above commands specify the end-point but not the start-point, a
method needs to be supplied to move to a new start-point without drawing
(milling) a line. The Moveto command makes such positioning move.

DeskProto will also import CAD-layer information (if present). When
selecting curves you can make each layer visible or invisible.

Postscript also may contain many other entities, like colors and bitmaps,
which will be skipped by DeskProto.

SVG
The acronym stands for Scalable Vector Graphics, an open standard
developed by the World Wide Web Consortium (W3C).
It can contain many different entities, DeskProto supports a small subset
only. 

Supported SVG entities for Vector data in DeskProto:
line
rect
circle
ellipse
polyline
polygon
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elliptical_arc
cubic_bezier
quadratic_bezier 

Internally DeskProto only uses polylines for vector data, so all entities will
be converted to polylines (see the information above). When saving vector
data in an SVG file it will thus contain only polylines.

When the size in SVG file is only in pixels (no real life dimensions)
DeskProto assumes 4 pixels per mm (101.6 dpi), as that comes close to mes
screen resolutions.
In the SVG format the zero point is in the upper left corner of the screen,
with the positive Y direction going downwards. In DeskProto (and on the
machine) the positive Y direction goes upwards, so DeskProto needs to
mirror all Y values.

Viewing the Vector data
After loading, you can see the Vector data on your graphics screen. 
In case you do not see the curves, check if item “Vector curves” is checked in
the Items visible dialog. Here you can also find the option to show all points
in each vector curve.



Concepts

Page 319

DeskProto Reference

5.3 Geometry Data

DeskProto can load three types of CAD data: Vector data, Geometry data
and Bitmap data.

For Geometries DeskProto only recognizes surface data defined with
triangles: the outer surface of the geometry described using a (large) number
of triangles. This type of geometry is also called Polygon data or mesh data,
and any 3D shape can be defined this way. DeskProto will generate the
toolpaths by projecting a flat toolpaths pattern over the 3D geometry.
It is not the most efficient way of storing 3D data, still it has the large
advantage that it always works: the definition is so basic that no
incompatibilities between systems exist. This same format is also used for
3D printing, and because of that it can generated by any 3D CAD system

In order to create Geometry toolpaths you need to use a Geometry
Operation in your project.

How to load a Geometry file
Geometry data files can be loaded in several ways:
· File menu command Load Geometry file
· Toolbar button Load Geometry file
· Button Add... on the Geometry tab of the Project parameters
· The Wizard Basic Geometry machining and other wizards.
It is possible to load more than one Geometry file, using the same command: 
after you have loaded a geometry the Load Geometry file command will
change to Add Geometry file. 

How to save Geometry data
Geometry data can be exported in two ways:
· File menu command Save Geometry data as...
· Button Save as... on the Geometry tab of the Project parameters
The first option save all Geometry data to one file (also when various
geometry files had been loaded), the second only that data of the selected
geometry file.
You can select any of the supported Geometry file types.
When saving the Geometry data you may select which of the Part
transformations you want to apply for the exported file. You can do so in the
Save Geometry Options dialog.
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Geometry File types
DeskProto supports three geometry file types: STL, DXF and VRML. The
only type that is fully supported is STL, as that file can only contain
triangles. The other types may also contain other shapes (entities), which are
not supported. 
For loading geometry we advise to use STL files, as both DXF and VRML in
practice may give problems.

Two other file types that are often used to transfer geometry data are not
supported by DeskProto: IGES  and STEP. These formats store the data in a
much more complex way, making many types of conversion errors possible

STL
File format created for the first 3D printer ever: the STereoLithography
system. This does well explain the acronym, though some claim that it stands
for S tandard Triangle Language, or for S tandard Tesselation Language..
An STL file may be a binary file or an ASCII file, the only difference being
the storage method: the contents of both files (the series of triangles) is
identical. DeskProto can read and write both binary and ASCII STL files.

The original StereoLithography system had more severe requirements for the
STL file than DeskProto. It accepted only positive coordinate values, and a
complete and true solid needed be present as geometry (no gaps and/or
orphan surfaces). Currently negative coordinates no longer are a problem,
however for 3D printers small gaps (say 0.001 mm between two triangles)
still are lethal.  DeskProto does not care about all these errors.
 
In an STL file for every triangle also a normal-vector is saved, in order to
define the inside and the outside of the part. The direction of each normal
should point outwards. When the option 'Skip Backfaces' in the Project
parameters has been checked the backsides of the triangles will not be
considered: drawn in black, and skipped in the toolpath calculations.

This normal vector contains in fact double information, as the order in which
the three points are stored can also be used to define inside and outside: in an
STL file the vertices are listed in counterclockwise order when looking at the
object from the outside.

DXF
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AutoCAD Drawing eXchange File. A DXF file can contain many different
entities, both 2D and 3D.
DeskProto only supports a specific type of geometry in the DXF file:
geometry in small triangles (facets). In DXF these supported entities are
called 3D Face and Polyface Mesh. All other entities in the DXF file will be
ignored by DeskProto:
3D-Face
With 3D-faces for every triangle 3 points are stored. No normal-vector is
stored, the three points are stored in counter-clockwise order.
Polyface Mesh
With polyface meshes first a long list of points is stored, and then for every
triangle 3 indexes that each lead to a point in that list. In this way all the
points only have to be saved once, thus saving disk-space.

Other entities in the DXF file will be skipped when importing the file. In
practice many DXF-files will only contain other entities, and thus can not be
read by DeskProto.

Note that DeskProto also supports DXF files for Vector data, and then will
accept a different set of entities.

VRML
Virtual Reality Modeling Language file. Not widely used.
The standard for VRML files is almost completely covered by DeskProto,
both for VRML Version 1 and Version 2. DeskProto does not support the
entities Sphere, Cone and Cylinder, and the concept of Custom Node Type
definitions. 
VRML files have the file extension .WRL (short for "world").

Corrupt geometries
Unfortunately not all 3D CAD systems will export perfect geometry files,
which may result in geometries that do not look right on the DeskProto
screen. Note that with an up-to-date CAD program this is not likely to
happen: most current CAD systems have a correct STL export function.

A known problem with the STL files of some surface modeling CAD
programs is incorrect normal-vectors. The normal-vector of a triangle defines
which side of the triangle is the outside, so incorrect normals result in a
geometry with the backfaces on the outside, drawn in black. This can be
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solved by switching the option Flip normals on in the Project Parameters
dialog. 
You can also save your geometry with these flipped normals: choose the Save
Geometry As option in the File menu. 
STL-files contain normal-vectors.
DXF files do not contain normals, when importing a DXF file DeskProto
calculates the normal based on the three points of the triangle being stored in
a counter-clockwise order.

When some of the normals are OK and some are incorrect, then only some of
the triangles are drawn in black.. This can also be solved by DeskProto. You
have to uncheck the option Skip backfaces with calculations in the Project
Parameters dialog. This causes all the triangles to be treated as if they don’t
have backfaces but 2 frontfaces so they will be rendered from both sides, and
both sides will be used for toolpath calculations as well.

Obviously files can be corrupt in many more ways. DeskProto is very
tolerant here: it will just accept files containing cracks, holes, orphan surfaces
and many more inconsistencies. Files that would be rejected by any other
RP-system.

Viewing the Geometry data
After loading, you can see the Geometry data on your graphics screen. As a
wireframe, as a wireframe with hidden lines removed, as a rendered geometry
or as points. To determine how to view the geometry you can check or
uncheck the items in the Items visible dialog.
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5.4 Bitmap Data

DeskProto can load three types of CAD data: Vector data, Geometry data
and Bitmap data.

A Bitmap file contains a 2D picture by storing the color value of each pixel
on the screen. So a line is stored as a series of black pixels on a white
background. This in contrast to a vector file, where the line is stored using the
coordinates of both the start point and the end point of the line. As many
different colors can be used for each pixel, in a bitmap complex pictures are
possible. Digital photos for instance are stored in bitmap files.
DeskProto needs an image in gray values, so it will automatically convert
color pictures to Black&White (B&W) when loading. In case you are
interested: the conversion formula is  gray-value = 0.30 * red + 0.59 * green
+ 0.11 * blue.

A bitmap file is a 2D file: a pixel only has an X-coordinate and a Y-
coordinate, plus of course a color (gray value). DeskProto will convert this
2D file to a 3D geometry by translating the gray value to a Z-value, resulting
in XYZ information for each pixel. The result is a 3D Relief. This is called
Gray scale to Z-height conversion, or Bitmap to Relief conversion 

The B&W 'colors' range between black and white, where pure black and pure
white define the extreme Z-values to be used. These two extreme Z-values
can be set in the Part parameters, tab Z Settings. Internally DeskProto
converts the bitmap into a Z-grid, that can be used for toolpath calculations.

In order to create Bitmap toolpaths you need to use a Bitmap Operation in
your project.
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The two pictures above show the original bitmap image of a shell left, and a
simulation of the resulting 3D Relief. Minimum Z has been assigned to black,
and Maximum Z to white. DeskProto does not display the resulting Bitmap
geometry, you can only see it by displaying the Z-grid, the Toolpaths or the
Simulation.
Important to know is that for large bitmaps DeskProto will display a
simplified version (256x256 pixels) of the bitmap, in order to speed up
drawing. The actual toolpath calculations will nevertheless be done with the
original bitmap data.

How to load a Bitmap File
Geometry data files can be loaded in several ways:
· File menu command Load Bitmap file
· Toolbar button Load Bitmap file
· Button Browse on the Bitmap tab of the Project parameters
· The Wizard Basic Bitmap machining and other wizards.
You can only load one bitmap file per project. 

How to save Bitmap data
Geometry data can be exported in two ways:
· File menu command Save Bitmap data as...
· Button Save as... on the Bitmap tab of the Project parameters
You can select any of the supported Bitmap file types, except GIF..

Bitmap File types
DeskProto supports the five most popular file types for bitmap files:

BMP File format defined by Microsoft for BitMaP files. Not
very efficient (large files), widely accepted.

GIF the Graphic Interchange Format is an efficient format
without data loss, though only max 256 colors are
possible.

JPG or JPEG File format defined by the ISO (International
Standards Org) Joint Photographic Experts Group.
Various levels of compression are possible, all resulting in
some loss of information.

PNG the Portable Network Graphics is the best bitmap format:
with compression, no data loss, not patented (like GIF).
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Designed for Internet use.

TIFF Tagged Image File Format, originally made by Aldus, since
2009 controlled by Adobe. TIFF files tend to be very
large.

Grid complications: the Moiré effect.
In a DeskProto bitmap operation two grids are used: the bitmap is a grid, and
for calculating the toolpath the Z-grid is used. Be warned: combining two
grids that are not equally spaced may lead to ripples in the resulting relief,
caused by a Moiré effect.

The bitmap grid is the grid of pixels, the size of each grid cell in mm being set
on tab XY Transform of the Bitmap parameters.
The Z-grid is the rectangular grid of XY positions, with a Z-value calculated
for each position, the size of each grid-cell in mm set by the Precision.
The Z-grid will be filled with Z-values that are calculated in the Bitmap grid.

In most cases the dimensions of these different grid cells will not be not
equal, so this conversion cannot be done one to one. 
For instance: imagine a bitmap with a pixel size of 0.9 mm and a Z-grid with a
cell size of 1 mm. Most Z-grid cells then are filled with the Z-value of just
one single bitmap cell, however every 10th cell will be filled with Z-values
from two bitmap cells. And this may cause a visible ripple in the relief. Such
ripples are called the Moiré effect.

In order to prevent such Moiré problems you can select a pixel size that is
dependent from the precision. This can be accomplished using one of the two
options “Calculate from precision...”. The edit fields for Custom will show
the resulting relief size. Note that when you later change the precision this
will automatically also change the size of the resulting relief.

Viewing the Bitmap File data
After loading, you can see the Bitmap image on your graphics screen. 
In case you do not see a bitmap, check if item “Bitmap” is checked in the
Items visible dialog. Per default the bitmap is drawn translucent, making it
possible to see items behind the bitmap. In the Items visible dialog that
translucency can be switched off.
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5.5 Project

A project is the object that you open when you work with DeskProto, it can
be compared with a document in applications like MS Word. Unlike Word,
where you can open several documents at the same time, in DeskProto you
can have only one project opened. A project can be saved and opened in the
File Menu, as a DeskProto ProJect file with the file-extension DPJ.

Project Structure
The information in a project is structured: in addition to some general
information three groups are present:
· General information
· CAD files
· Parts
· Operations

Most important general information is the Machine (CNC milling machine)
that you want to use for this project. You can select a different machine in
the Project Parameters dialog. Other general information includes the type of
user interface that you used (Wizard-based or Dialog-based) and the Edition
of DeskProto that was used.

Each project can include one or more CAD files. Three types of CAD data
are supported: Vector data, Geometry data and Bitmap data.
(in the DPJ file only links to the CAD files are stored, not the actual CAD
data). In case a project does not have link to a CAD file it is called a template
project.

The Part is what you are going to machine. A project can contain more than
one part (zero parts is not possible), as for one model several parts may be
needed. For instance the left halve and the right halve of a hand drill. The part
definition consists of a number of parameters, like scaling values (relative to
the original geometry), rotation values etc. Each type of CAD data comes
with slightly different set of part parameters: the Vector settings, the
Geometry settings and the Bitmap settings. 
In fact the Part parameters define what to machine.

An Operation defines how the material will be machined. Three different
types of operation are available: Vector operations, Geometry Operations
and Bitmap operations. Each part contains one or more operations (no upper
limit, zero operations is not possible). It is called operation because it defines
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one actual machining operation. This definition also consists of a number of
parameters, like cutter, milling direction, precision values, feedrate etc. Most
times you will use more than one operation for one part. For example you
may want to quickly remove most of the material (roughing) before you want
to mill precisely (finishing).
In fact the Operation parameters define how to machine it.

In DeskProto the structure of the project is shown in the Project tree, which
is placed on the left of the screen and looks like this:

Project Types
You can create a new project by choosing the New Project option in the File
menu. You will see three sub-options for the three types of project that
DeskProto supports:
· New Vector project will create a project with a Vector operation
· New Geometry project will create a project with a Geometry operation
· New Bitmap project will create a project with a Bitmap operation
So the difference is small: the type of operation that is present defines the
project type. You can easily add and remove other operations, of any type.
When you create a new project the currently opened project file will be
closed. In case you start DeskProto a new project will be created
automatically. 
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Default project
When a new project is created, all parameters are copied from the Default
Project, the Default Part and a Default Operation. This default operation can
either be Vector, Geometry or Bitmap. The three operation types each have
their own set of default settings: the default Vector operation, default
Geometry operation, the default Bitmap operation.
All these settings are saved on your PC, every user has a separate set of
defaults. You can use these defaults to enter parameters that you want to use
as a standard, for instance the machine that you always use. A default CAD
file cannot be set though, and the default project can only contain one Part.
One of the settings of the default Part is which type of operation needs to be
loaded (Vector/Geometry/Bitmap). This defines whether the default for a
New project (in the file menu) is a Vector project, a Geometry project or a
Bitmap project.
Editing the parameters of the default Project/Part/Operation can be done in
the Options menu.

How to open a project
You can open a project by choosing the Open... option of the File menu.
When you open a project the currently opened file will be closed.
The current folder when you first open the Open File dialog is the file
location ‘Data’, which can be changed at the General tab page of the
Preferences dialog. After that DeskProto will remember the folder you are
working is (the current folder) and will keep using that.

How to save a project
You can save a project by choosing the Save option of the File menu. Using
this option it will be saved under the same name you have saved it before. If
you want to save it with another name, choose the option Save As... under
the File menu.
The same current folder as just explained for Open project will be used here
as well.

The DPJ file
The project information is stored in a DeskProto ProJect file (file extension
.DPJ), containing all Parameter settings and also all View settings. Note that
the project file does not contain any CAD data, only links to the CAD file(s).

Two different types of DPJ files are used:
1 - a project file with only the settings (default)
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2 - a project file with both the settings and the calculated toolpaths.
Both files have the same file extension .DPJ

The second type (with toolpaths) can be used in case the toolpath
calculations take very long. 
You can choose between both types in the "Save as type" field of the Save
As dialog.
When opening a project file it is not needed to distinguish between both
types of DPJ file.
In fact the toolpaths will be stored in a separate file: the DeskProto Toolpath
file (file extension .DPT), which will be much larger than the (small) DPJ file.
For a project file called test.dpj  the toolpath filename will be test.dpt
The difference between such Toolpaths file and an NC program file is that
the first is in a machine-independent format.

A DPJ file without CAD data is called a template file: when opening
DeskProto will ask for a CAD file to be loaded.
The sample DPJ files do not include a line to define the machine to be used:
DeskProto will then use the default machine that you have set.
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5.6 Part

A part is what you will machine using one setup (a block being fixtured on
the machine). For some products that is all that is needed, for other products
more parts may be needed: for instance the left side and the right side of a
hand drilling machine, to be glued together later. In case you machine one
block of material from two (or more) sides, DeskProto will see each side as a
separate Part.

The description of a part consists of a number of parameters, like scaling
values (applied to the original CAD data), rotation values and the size of the
material block to be used. These parameters depend on which type of CAD
data has been loaded: the Vector settings, the Geometry settings and the
Bitmap settings are slightly different. For a complete list of parameters see
Part Parameters dialog. To edit a part go to the Parameters menu and select
the item Part Parameters. This opens the Part Parameters dialog.
A much quicker way to open the Part parameters dialog is double-clicking on
the part's name in the Tree.

How the part should be machined is defined in its Operations. A part can
contain one or more operations: Vector operations, Geometry operations
and/or Bitmap operations.

Current part
In case your project contains more than one part you need to make a part
current in order to see it on the graphics screen. There is always one part
that’s current: no more, no less. The light-bulb icon in the project-tree shows
which part is current: for only part the light burns (yellow) - for all other
parts (if any) the light is off (gray).
You can make a part current by clicking on the gray light-bulb icon for that
particular part. Clicking on a yellow light-bulb does not have any effect. You
can also make a part current by right-clicking on a part in the project-tree and
then mark the option ‘Make Current’ in the context-menu that will be shown.

Default part
When a new project is created it will contain one part. The parameters of that
part are copied from the default part. The default settings are saved on the
computer; each computer user has his/her own set of defaults.
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You can use the default part to enter the settings that you want to use as a
standard. For instance when your geometry always needs to be rotated 90
degr round Z, or when you always need the Zero point to be at the bottom of
the block. You can also set the number of operations, for instance a Roughing
operation and a Finishing operation (in that case you will have two default
operations).

Important is the type of Operation that you use in your default part: 
· when the first operation is a Vector operation your default project will be

a Vector project
· when the first operation is a Geometry operation your default project will

be a Geometry project
· when the first operation is a Bitmap operation your default project will be

a Bitmap project

To edit the parameters of the default part, go to the Options menu and select
the option Default Part Parameters. This opens the Part Parameters dialog.
The parameters of the default part are also used when you add a new part to
the project.
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5.7 Vector Operation

An operation gives a description of how the material should be machined.
DeskProto features three different operation types: 
· this Vector operation is meant to create toolpaths for Vector data
· a Geometry operation is meant to create toolpaths for Geometry data
· a Bitmap operation is meant to create toolpaths for Bitmap data.

The description of a Vector operation consists of a number of parameters,
like cutter, type of toolpath (Profiling, Pocketing, Drilling), milling direction,
precision values, feedrate etc. For a complete list of parameters see Vector
Operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item Operation
Parameters. When more than one operation is present a dialog will open to
select which Operation to edit. After selecting a Vector operation, DeskProto
will show the Vector Operation Parameters dialog. Of course a Vector
Operation must already be present in order to select one.
A much quicker way to open the Vector Operation parameters dialog is
double-clicking on the operation's name in the Project Tree.

Visible operations
To view the data or the toolpaths of a particular Vector operation you need
to make it visible. Of all operations of the current part 0, 1 or more
operations may be visible at the same time. The light-bulb icon in the Project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (gray) means invisible.
You can make an operation visible by clicking on the gray light-bulb icon for
that particular operation, and make it invisible by clicking on it's yellow lamp
icon. You can also make an operation visible by right-clicking on an operation
in the project-tree and then mark the option ‘Visible’ in the context-menu
that will be shown. Another way to make an operation visible is to click on a
lamp icon in the operation-list of the Items visible dialog. To actually see one
of the items (curves, toolpaths) of the Vector operation you have made
visible, the item needs to be checked as well in this dialog.

Default Vector operation
When a new Vector operation is created, the parameters of the new operation
are copied from the default Vector operation. The default settings are saved
on the computer; each computer user has his/her own set of defaults.
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DeskProto also contains a default project and a default part. When the default
part contains a Vector operation (as first operation) the default project is a
Vector project. 
You can use the default Vector operation(s) to enter milling parameters that
you want to use as a standard. For instance a specific tool and/or machining
depth.

To edit the parameters of the default Vector operation, go to the Options
menu and select the option Default Vector operation Parameters. This will
open the Vector operation Parameters dialog.
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5.8 Geometry Operation

An operation gives a description of how the material should be machined.
DeskProto features three different operation types: 
· a Vector operation is meant to create toolpaths for Vector data
· this Geometry operation is meant to create toolpaths for Geometry data
· a Bitmap operation is meant to create toolpaths for Bitmap data.

The description of an operation consists of a number of parameters, like
cutter, strategy, precision values, feedrate etc. For a complete list of
parameters see Geometry operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item Operation
Parameters. When more than one operation is present a dialog will open to
select which Operation to edit. After selecting a Geometry operation,
DeskProto will show the Geometry Operation Parameters dialog. Of course a
Geometry operation must already be present in order to select one.
A much quicker way to open the Geometry operation parameters dialog is
double-clicking on the operation's name in the Project Tree.

Visible operations
To view the data or the toolpaths of a particular Geometry operation you
need to make it visible. Of all operations of the current part 0, 1 or more
operations may be visible at the same time. The light-bulb icon in the Project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (gray) means invisible.
You can make an operation visible by clicking on the gray light-bulb icon for
that particular operation, and make it invisible by clicking on it's yellow lamp
icon. You can also make an operation visible by right-clicking on an operation
in the project-tree and then mark the option ‘Visible’ in the context-menu
that will be shown. Another way to make an operation visible is to click on a
lamp icon in the operation-list of the Items visible dialog. To actually see one
of the items (Z-grids, toolpaths) of the Geometry operation you have made
visible, the item needs to be checked as well in this dialog.

Default operation
When a new Geometry operation is created, the parameters of the new
operation are copied from the default Geometry operation. The default
settings are saved on the computer; each computer user has his/her own set of
defaults.



Concepts

Page 335

DeskProto Reference

DeskProto also contains a default project and a default part. When the default
part contains a Geometry operation (as first operation) the default project is
a Geometry project. 
You can use the default Geometry operation(s) to enter milling parameters
that you want to use as a standard. For instance a specific tool and/or
strategy.

To edit the parameters of the default Geometry operation, go to the Options
menu and select the option Default Geometry operation Parameters. This
will open the Geometry operation Parameters dialog.
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5.9 Bitmap Operation

An operation gives a description of how the material should be machined.
DeskProto features three different operation types: 
· a Vector operation is meant to create toolpaths for Vector data
· a Geometry operation is meant to create toolpaths for Geometry data
· this Bitmap operation is meant to create toolpaths for Bitmap data.

The description of a Bitmap operation consists of a number of parameters,
like cutter, strategy, milling direction, precision values, feedrate etc. For a
complete list of parameters see Bitmap Operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item Operation
Parameters. When more than one operation is present a dialog will open to
select which Operation to edit. After selecting a Bitmap operation,
DeskProto will show the Bitmap Operation Parameters dialog. Of course a
Bitmap Operation must already be present in order to select one.
A much quicker way to open the Bitmap Operation parameters dialog is
double-clicking on the operation's name in the Project Tree.

Visible operations
To view the data or the toolpaths of a particular Bitmap operation you need
to make it visible. Of all operations of the current part 0, 1 or more
operations may be visible at the same time. The light-bulb icon in the Project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (gray) means invisible.
You can make an operation visible by clicking on the gray light-bulb icon for
that particular operation, and make it invisible by clicking on it's yellow lamp
icon. You can also make an operation visible by right-clicking on an operation
in the project-tree and then mark the option ‘Visible’ in the context-menu
that will be shown. Another way to make an operation visible is to click on a
lamp icon in the operation-list of the Items visible dialog. To actually see one
of the items (bitmap, toolpaths) of the Bitmap operation you have made
visible, the item needs to be checked as well in this dialog.

Default Bitmap operation
When a new Bitmap operation is created, the parameters of the new
operation are copied from the default Bitmap operation. The default settings
are saved on the computer; each computer user has his/her own set of
defaults.
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DeskProto also contains a default project and a default part. When the default
part contains a Bitmap operation (as first operation) the default project is a
Bitmap project. 
You can use the default Bitmap operation(s) to enter milling parameters that
you want to use as a standard. For instance a specific tool and/or strategy.

To edit the parameters of the default Bitmap operation, go to the Options
menu and select the option Default Bitmap operation Parameters. This will
open the Bitmap operation Parameters dialog.
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5.10 Z-Grid

The Z-grid is an intermediate result, in-between the CAD-data and a
toolpath. It is used for Geometry data and for Bitmap data: Vector data is
processed without a Z-grid. The Z-grid is a sort of height-map of the
geometry (or of the bitmap relief): a 3D bar graph, with a Z-value for each
XY position. The size of the grid-cells is set by the toolpath distance and the
stepsize along the toolpath. Normally you should not be bothered by this
representation of the geometry, however it might be useful to see what is
really happening. For instance in case a hole in the geometry was missing in
the toolpath, you could check the Z-grid. In case present there, the cause will
be that the cutter is too large to fit in the hole. In case not present in the Z-
grid, some error is present is the geometry file. Besides that it can also give an
idea of how the final result will look: a rough simulation of the part to be
created. Especially when you view it as a rendered Z-grid.

Here’s an image with a Z-grid and the rendered one (Note that a rendered Z-
grid for an accurate toolpath needs some time to be drawn on your screen). 

The pictures show a line-drawing and a rendered Z-grid, you can display
these by checking them in the Items visible dialog. The grid-structure is
clearly visible. Note that any undercuts present that are present have become
solid: just one Z-value for each grid-cell. Especially for inverse milling this
rendered Z-grid is useful as a preview to show what will be created. Also
note the strong staircase effect that is visible. In the actual model the stairs
will be partially smoothed away due to the size of the cutter (as it cannot
create sharp inner corners).

When creating the Z-grid DeskProto calculates a large number of points on
the surface of the geometry, finds the correct grid-cell for each point (based
on X and Y) and fills that grid cell with the Z-value. For each cell only the
highest grid value will be stored. This explains some characteristics of the
DeskProto toolpath: undercuts are not possible, and the resulting part always
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will be a bit larger than the CAD model. How much larger depends on the
Precision values.

When projecting vector curves or a bitmap on the geometry DeskProto will
use a Z-grid to determine the correct Z-value for each point in the toolpath.

Each operation has it's own Z-grid.

How to calculate and show a Z-grid
You can show a Z-grid by selecting the option Calculate Z-grids under the
Create - Extra menu. Another way is checking Z-Grids or Rendered Z-Grids
in the Items visible dialog.
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5.11 Toolpath

The Toolpath is the path that the cutter will follow to create a part on the
milling machine. More specific, it is the series of positions for the tip of the
cutting tool (XY of the center of the tool, Z of the lowest point of the tool).
The start of the toolpath is drawn as a small red cone pointing downward, the
end by a similar cone pointing upward. These cones are NOT the workpiece
zero point: in the Items visible dialog an option is present to display a blue
orientator at the workpiece zero point.

The toolpath is a very important representation for a visual check before
starting the milling machine: any errors should best be found before milling.
Here’s an image of a toolpath.

Most lines are drawn as solid lines (default in red), indicating a normal speed
(Feedrate). 
Lines drawn in purple indicate that the feedrate is reduced by DeskProto's 
Dynamic Feedrate Control.
Some lines are dashed in gray, indicating that they are Rapid movements
(moving as fast as possible). 
The toolpath depends on the settings made in the Operation Parameters
dialog. 
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After calculating a toolpath using the command Calculate toolpaths the
toolpath will automatically be switched on in the scene (made visible in the
Items visible dialog). To send this toolpath to the machine it should first be
post-processed to an NC-program, which is done using the command Write
NC-program file. How it will be post-processed is determined by the
postprocessor which is linked to the milling machine you use.

How to calculate toolpaths
You can let the toolpaths be calculated by selecting the option Calculate
Toolpaths under the Create - Extra menu. 

As a shortcut this convenient button is present on the Toolbar. 
Another way is checking the Toolpaths checkbox in the Items visible dialog.
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5.12 Simulation

The NC program file is in fact the final result of DeskProto: sending it to the
machine will produce the desired part. It may be useful though to preview
this resulting model on screen, in a machining Simulation.

The Simulation is a 3D model, displayed on the screen that shows you what
the resulting part will look like. This can be used to check things like the
resulting surface smoothness, error movements (if any) that damage the part,
rest material where the cutter cannot reach, etc. DeskProto will calculate a
simulation in 3D, so you can rotate, pan and zoom it just like any other item
on screen. The calculation is done using only the toolpath data, so without
use of the underlying CAD data.

The simulation is for one Part: all available operations can be included. The
illustration above shows three operations:
· a Geometry operation for roughing, where the ballnose toolpaths (or rather

the "cusps" in-between) are clearly visible: the green part on the right.
· a Geometry operation for finishing, showing a very smooth resulting

surface: only the left half has been finished.
· a Vector operation with a DeskProto logo, 0.5 mm deep, projected onto

the bottle surface: only visible on the finished side.

In a simulation an operation cannot simply be made invisible (like for
instance for the toolpaths):
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just as in real life for a simulation removing material is possible while undoing
such removal is not.
Because of that the Operation's visibility settings cannot be used here, and a
Simulation comes with the Simulated Operations dialog to select which
operations need to be included.
Only after pressing Calculate the simulation will be updated (if needed after
resetting it first).

DeskProto uses in fact two completely different calculation algorithms: one
for 3-axis toolpaths (XYZ) and one for rotation axis toolpaths (XZA):
· the XYZ algorithm uses a grid-based calculation: a grid on the XY plane

with a Z-height for each grid-cell. 
· the XZA simulation uses a voxel-based algorithm: a calculation based on

voxels (small "3D pixels") that either are filled with material or not. 
The voxel-based algorithm is much more complicated, and so calculation time
will be higher.  The quality of the resulting image is higher for the grid-based
simulation. That algorithm however simply does not work for rotary
machining.

You can set the Level of detail of the simulation on the Simulation tab of the
Part parameters. For the grid-based simulations this sets the number of grid-
cells to be used (the size of the grid), for the voxel-based simulation the
number of voxels.

For Geometry projects the DeskProto grid-based simulation allows you to
compare the simulation with the original geometry, and indicate any
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differences with a color. Rest material in green, too much material removed in
red. On the Simulation tab of the Part parameters the user can select whether
or not to use these colors, and also the tolerance to be used. 
In the simulation screenshot above you can for instance see that a skin has
been applied when roughing  (green rest-material), and that the cutter is too
thick for the small inner radius at the neck of the bottle (green rest-material
just below the cap). The red color in the DeskProto logo is logical, as the logo
is not a part of the geometry and thus DeskProto concludes that too much
material has been removed. The red will only be visible in case the geometry
is switched off in the Items visible dialog.

How to calculate and show a simulation
You can show a Simulation by selecting the option Calculate Simulation in
the Create menu. 

As a shortcut this convenient button is present on the Toolbar. 
Another way is checking Simulation in the Items visible dialog.
The speed of drawing a simulation can be optimized using the Graphics
options in the Advanced Preferences.
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5.13 NC-program

NC stands for Numerical Control (we will also use the acronym CNC, which
stands for Computerized Numerical Control). An NC-file contains an NC
program: a series of instructions for a CNC milling machine to execute. It
needs to be sent to a machine (or rather to the machine's control software) to
make that machine execute the NC program. Each file contains commands for
a specific machine (or machine-type). 

An NC-program is machine-dependent: its format will be different per
machine, as each machine (or rather each controller) will "speak a different
language". The format that DeskProto uses to write the NC-file is determined
by the Postprocessor that is configured for that machine. In the Project
parameters you can select which machine will be used.
Almost any NC program file is in plain ASCII: you can read and edit it using
a plain text editor like Notepad. DeskProto can only work with ASCII NC
files.

How to create an NC-program
The toolpaths calculated by DeskProto can be saved to an NC-program
choosing the option Write NC-program from the Create - Extra menu.

As a shortcut a convenient button is present on the Toolbar.

DeskProto will try to combine the toolpaths of all Operations of one Part
into one combined NC program file.
Or, if Chaining has been applied, even toolpaths of Operations in several
Parts can be combined.

NC Files list
DeskProto will show you a list of all NC files that have been written for the
current project. This is shown in the NC Files window, below the Project
Tree. If this window is not visible you can check it in the View menu.

Sending NC-program to machine
For some machines it’s possible to send an NC-program to the machine from
within DeskProto (only a few machines support this). How to do this see the
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option Send NC-program To Machine from the Create menu. For all other
machines you need to open the NC file in the machine's control software.
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5.14 Libraries

Three different libraries are present in DeskProto: one for machines, one for
postprocessors and one for cutters.
Each library is displayed in a dialog like this:

A library is just a collection of definitions. You can either Add, Remove,
Copy or Edit an item. The definitions are saved to disk in the Drivers folder,
which can be set at the General tab page of the Preferences dialog box. They
are saved to disk when you click the OK-button of the library-dialog, one file
for each driver.

When you add or copy an item, you can set all the values including the
filename. When you edit an item you can set all values except the filename. If
you want to change the filename of a cutter, postprocessor or machine you
can use your operating system to do so (for instance using Windows
Explorer). You need to do this when DeskProto is not running (so close
DeskProto first) because otherwise the old filename will be saved again when
closing the library. The file with the new name will be automatically loaded
when you restart DeskProto.

See Library Of Machines, Library Of Postprocessors and Library Of Cutters.
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All these definitions are stored in files (machines in .mch files,
postprocessors in .ppr files and cutters in .ctr files), to be stored in the
Drivers directory of DeskProto. Button Open location will open that folder
in Explorer/Finder/FileManager. All these files are plain ASCII text files, that
can also be edited using a plain text editor.
For editing no help information is present, so only do this if you are sure
what you are doing.
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5.15 Postprocessor placeholders

The option to use Placeholders is a very powerful feature in DeskProto. A
placeholder is a bit of text that you enter, to be included in the NC files that
you create, which (when the NC file is written) will be replaced by the
current value of some parameter.
An example: you can enter {DATE} , which in the NC file will be replaced
by the current date.

In DeskProto placeholders are enclosed in curly braces (curly brackets). They
can be used in the Postprocessor definition and in the operation Start/End
commands

Some of the placeholders can be used in the actual G-code, like Feedrate and
Spindlespeed. Other placeholders can only be used in comment lines: these
can of course be used only if your machine or your control software supports
comment lines (for instance lines that start with a semicolon, or all code
between parentheses). Consult your machine's manual to find out.

This is the list of placeholders that can be used in DeskProto V7.1:

Project information:

{PROJPATH} The complete file specification of the project file
(.dpj), including disk and path

{PROJNAME} Name of the project

{MACHINENAME} Name of the machine that has been selected for this
project

{POSTPROCNAME} Name of the postprocessor that is used (so that is
configured for this machine)

Part information:

{PARTNAME} Name of the current part

{BLOCKXSIZE} Size of the material block along X. Sizes are given in
the units as defined in the Preferences.

{BLOCKYSIZE} Size of the material block along y

{BLOCKZSIZE} Size of the material block along Z
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{BLOCKDSIZE} Diameter of a cylinder shaped block (only for parts
with rotation axis toolpaths: no output for 3-axis
parts).

{BLOCKRSIZE} Rmax minus Rmin, for a cylinder shaped block. For
a tube this is the material thickness., for a solid
cylinder the Radius (only for parts with rotation axis
toolpaths: no output for 3-axis parts).

Operation information:

{OPERNAME} Name of the operation to which the current toolpath
belongs

{TOOLNUMBER} Number of the current cutter (as set in the cutter
definition)

{TOOLNAME} Name of the current cutter

{F} Feedrate - only the number if written, without the
Feedrate command (like "F")

{S} Spindlespeed - only the number if written, without
the Spindle command (like "S")

Other relevant information:

{N} Newline: forces DeskProto to continue on a new line

{DATETIME} Date and time, for instance "2021-02-12 14:07"

{DATE} Date, for instance "2021-02-12"

{TIME} Time, for instance "14:07"

{PROGNUMBER} Number of the NC program: some controllers require
a unique program number as identification.

{{}   or   {}} This is the trick if you need a curly bracket to
appear in your NC file.

The application of the above placeholders will be clear, except perhaps for
the last one: DeskProto can't know which program number you want to use
so cannot replace this placeholder on the fly.
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So when you have used the placeholder {PROGNUMBER} in your project and
then write an NC file, the NC-Program File Number dialog will pop up,
asking you to enter the program number that you want to use for this NC
program. In most case this number need to be preceded by a capital "O": do
not forget to write that just before the placeholder.

The PROGNUMBER placeholder needs to be placed in the Start commands
of the postprocessor, as this program number is needed at the start of the
program.  When you use this placeholder in the Operation Start/End
commands the NC Program File Number dialog will not pop up.

Example:
So the Start commands of your G-code postprocessor can for instance be:

%
O{PROGNUMBER}
; NC program written by DeskProto on {DATE},
; for machine "{MACHINENAME}".
; Start with cutter "{TOOLNAME}".

The resulting G-code then would start with something like

%
O1234
; NC program written by DeskProto on 2021-02-12,
; for machine "ISO plain G-codes - mm".
; Start with cutter "Ball nose, radius 3 = diameter 6
mm".

Upwards compatibility.
These placeholders are new in DeskProto V7.1
Previous DeskProto versions offered only two optional placeholders in the
postprocessor, using a different format:
- the string “^\N” started a new line, 
- the string “^\V” would again output the parameters value of that tab page
(for instance the Spindlespeed).

These old placeholders are no longer supported in DeskProto V7.1  When
opening an old postprocessor file DeskProto will automatically convert these
to the new placeholders.
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For instance a Start command “ S ^\V^\N R” on the Spindle tab page will
be converted to " S {S}{N} R". The postprocessor file will be saved in
the V7.1 format only when other changes have been entered.
A postprocessor file in the new V7.1 format can no longer be used in older
DeskProto versions.

The conversion and compatibility just described also applies to DPJ files
(DeskProto project files) that use “^\N” in the Operation Start/End
commands.
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5.16 Two-sided machining

This page is about Geometry machining (does not apply to Vector and
Bitmap). 
Some models can be completely machined from one side, like DeskProto's 
DpPictureFrame sample geometry.
For other models, like the perfume bottle sample geometry, machining from
one side is not sufficient.
A complete bottle can be created in three ways:

1. Machine two separate halves and glue these to one another to make a
complete model. This is the easiest way, which works great for many
types of models. For instance for an electric hand-drill or similar tool. 

2. Use a rotation axis to rotate the model during machining. This is called
rotation axis machining.

3. Machine the model from two sides, so flip the block upside-down
halfway through process. This flipping can be done either manually or
automatically by a rotation axis. 

This help page concerns the third method: Two-Sided machining, using the
manual flip. For the automatic flip see the page on indexed machining.

Machining from two sides comes with some extra issues:
- how to hold the part after turning it upside down
- how to make sure that both sides are perfectly aligned
- how to correctly set the WorkPiece zero point for the second side, making it
match the first side.

The advanced geometry wizard "Two sides, manual flip" will help you to
create a complete model in one piece, by machining it from two sides. The
total block of material to be used is larger than the model, leaving a frame
around the model. This frame permits you (after machining the first side) to
again clamp the model in order to machine the second side as well (turned
upside down). See the illustration below, where the yellow part is the block,
or in fact what has remained after milling (top view).
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Obviously the model needs to remain connected to the block when the second
side is machined. This is done by the so called Support Tabs: four small
rectangular blocks that function as bridges to connect the model to the
remaining part of the block (the frame). In the illustration above the four red
rectangles are the Support Tabs.
DeskProto will lock the Operation’s Area to be machined to the geometry
plus the Support Tabs by setting it to Custom, and DeskProto will switch
off the Borders to prevent the tool from cutting the outside surface of each
support tab (as that would disconnect the part from the main block).

DeskProto will set the width and depth (X and Y) of the material block. For
X both left and right 25 mm (or 1 inch) is added, permitting you to clamp
down the block on the machining table at that spot. For Y both front and
back 10 mm (or ½ inch) is added, resulting in a block that is sufficiently
stable when machining. These dimensions need not be very accurate. A bit
oversize is advised for the actual block, making sure that you can machine a
reference plane later in the process.

In contrast, the height of the block (Z) needs to be very accurate as otherwise
the second side will not be correctly positioned relative to the first. In
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practice you can easily satisfy this requirement, as you can buy most
materials in slabs at an exact thickness. Of these slabs both sides are exactly
parallel to one another as well. 
The size of the total material block is defined in the Part parameters.

Note that DeskProto can be configured for two different block types:
floating size and fixed size. The first type is default, and determines the
block size by adding a certain frame thickness on all four sides, as explained
above. The second type uses, as its name indicates, a fixed block size. This is
handy when you have similar products and a stock of equally sized blocks. In
this case it is possible that the part does not fit in the block (some minimum
margin is needed as a frame): in such cases a warning message will be issued
and you need to scale down the part. The choice between both types of
block, and the actual dimensions, can be set in the Preferences dialog.

DeskProto makes it easy for you to correctly position the two sides relative
to one another. Or in other words: to set the correct workpiece zero point to
make the second side exactly fit on the first.  For this aim DeskProto uses
two rulers (stop-bars) that are exactly parallel to the machine’s axes, and that
have a known position. See the illustration below: the long ‘horizontal’ bar is
parallel to X, at a known Y position, the short ‘vertical’ bar has a known X-
position (being parallel is less important here). The workpiece zero point for
both NC program files has to be set at the exact point where both rulers meet,
with the Z=0 set with the tip of the tool touching the top of the block. This
zero point remains the same after turning the block upside down for the
second side. Also see the illustration below.

After machining the first side, you have to machine two reference planes, on
the block’s back and left side: see the light-blue line in the illustration. The
reference plane on the left is on position X = 0 and needs not be along the
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complete side (which would not be possible because of a clamp). The
reference plane on the back is on a Y-position as specified in the Report file,
and needs to be machined along the complete back. After turning upside-
down these two reference planes will exactly touch the rulers, making sure
that the block is exactly lined up with the machine, and exactly at the correct
position.

Note: 
The Ruler /Reference plane method just described is just one method: more
methods are available to correctly position the block after turning upside-
down. For instance using reference pins on the machining table, combined
with matching holes in the block that exactly fit these positioning pins. This
is easiest when you set the zero point exactly centered between the pins (two
or four). In DeskProto "Make center of material zero" is a pre-defined option
for the zero point X and Y (needs to be set after completing this wizard).
The Two-Sided Milling Wizard can be used with any of these positioning
methods, as long as they result in the block having the same position before
and after turning upside-down.

The Report file just mentioned will be generated upon pressing button
Write report file on the last page of the wizard. It gives all information
needed for the actual machining process. The file is opened in Notepad,
making it easy to print the file and/or to save it. Default filename is
Wizardlog.txt: do save it using a different name to prevent it from being
written over by a next wizard.

Of course you are free to still fine-tune the results of the wizard before
starting on the machine. You can still change any parameter after finishing the
wizard: also parameters that have not been set by the wizard. You may also
add operations, for instance some extra finishing with a small tool for some
specific detail. In case of using an extra operation make sure to create the new
operations by Copying an operation set by the Wizard, not by just Adding a
(default) operation. That way all settings made by the wizard will be copied
as well.
After changing any parameter you will have to again save the NC program file
that was written by the wizard.

A wealth of information on two-sided machining is available in the DeskProto
Tutorial book (can also be downloaded as PDF): Lesson 6 is about two-sided
machining, and shows you how to machine a nice sample geometry: a
cellphone's front cover. This STL file is a free download on
www.deskproto.com  Tutorial videos are available as well.

http://www.deskproto.com
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5.17 Rotation axis machining

A rotation axis or 4th axis on a CNC milling machine can be applied in two
different ways:
- the part can be rotated during machining (continuous rotation)
- the part can be machined from one side (three axis machining), then rotated
and machined from a second side, etc. This is called indexed machining.

DeskProto supports both methods, obviously only in the Multi-Axis edition
of DeskProto. Rotation axis machining is possible only for Geometries.

This page is about the first method, which is in fact 'real' Rotation axis
machining. It can be switched on by checking the box "Use rotation axis" in
the Part parameters. That option is of course available only when the
machine that you selected for your project has a rotation axis set in it's
machine definition.

When Geometry data is present DeskProto will then set a Material block
that exactly fits the bounding box of the geometry. This block may either be
rectangular or cylinder shaped. The axis of this cylinder (so the actual axis of
rotation) will be the X-axis in the original CAD coordinates (the line for Y=0
and Z=0), so you may need the option Center geometry to center your
geometry round that X-axis.
For Geometries an easy way to create a rotary project is available: use the
Rotary machining wizard. 

As said above the rotation axis in DeskProto is parallel to the X-axis. In
case on your machine it is parallel to Y you can configure that in the
machine definition: Options > Library of machines > OK on warning > select
your machine and press Edit. One of the options in the Advanced Machine
Settings is "Machine with Y-axis parallel to Y", more information on that
help page.

In case only Vector data and/or Bitmap data is present, rotation axis
machining is possible only when a cylinder shape Material block has been
set. DeskProto will then create a cylinder that is exactly large enough to wrap
the 2D CAD data round this complete cylinder (like a paper label on a jam
jar). So for a bitmap image with Y-size 100 mm, the diameter of the generated
cylinder block will be 31.83 mm: as this cylinder's circumference is Pi * 31.83
= 100 mm.
For mixed projects the Geometry size will overrule the wrapping calculation.
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In all cases you are of course free to change the block dimensions conform
your needs.

Rotation axis machining in DeskProto in fact still is a type of three axis
machining: instead of moving X, Y and Z at the same time, now X, Z and A
will move. In a DeskProto NC program file for Rotation axis machining no Y-
coordinate value is present.
So before starting the cutter needs to be positioned along Y exactly above the
rotation axis, so at Y = 0.0.  You can make DeskProto do this automatically
by checking the option "Write Y=0 in first movement command for rotary
machining" in the Advanced Machine Settings dialog.
DeskProto does not do this by default as such movement may damage your
machine in case the current Z is too low.

A wealth of information on rotation axis machining is available in the
DeskProto Tutorial book (can also be downloaded as PDF): Lesson 5 is
about rotation axis machining a geometry, and shows you how to machine a
great sample geometry: the head of the famous Venus de Milo statue. This
STL file is a free download on www.deskproto.com  In addition nice tutorial
video's are available as well.

http://www.deskproto.com
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5.18 Indexed machining

A rotation axis or 4th axis on a CNC milling machine can be applied in two
different ways:
- the part can be rotated during machining (continuous rotation)
- the part can be machined from one side (three axis machining), then rotated
and machined from a second side, etc.

DeskProto supports both methods, obviously only in the Multi-Axis edition
of DeskProto. Indexed machining is possible only for Geometries.

This page is about the second method, called indexed machining.
DeskProto offers indexed machining in the Advanced Geometry wizard Two
or more sides, automatic rotation (also called the N-Sided Milling
wizard). In this wizard you can choose any number for N, from 2 up to 99
sides.

· The wizard will automatically generate N parts for you, and apply the
correct rotation for the geometry in each Part. The rotations are evenly
spread (360 / N), if needed you can select a higher N and then later delete
some of the parts.

· Support tabs (cylinder shaped blocks left and right), to keep the part
connected to the rotary table, are optional.

· In each part one or two operations are generated (finishing, and optionally
roughing first): the wizard will link all these operations into one large
Chain in order to write one combined NC file for the complete indexed
milling process.

· The required A-axis rotation commands for the rotation axis (in-between
the operations) are entered in the operation's Start/End commands. The
wizard will also use these commands to move the Z up to a safe height
before rotating the block. This is needed because the diagonal of a
rectangular block is larger than each of the sides.

DeskProto also supports indexed machining on five-axis milling machines
(five-axis continuous rotation is not supported). This works exactly the same
as with four axes: you create a series of parts, specify the correct rotations
for each part, and specify these same rotations in the Start commands of each
Operation. Only now both an A-axis rotation command and a B-axis rotation
command need to be specified.
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The five-axis process however is much more complex than for four axis, as
five-axis machines are available in many configurations. That is why
DeskProto cannot offer a wizard to automatically create such project for you.
A detailed instruction for five-axis indexed machining can be found in Lesson
9 of the DeskProto Tutorial book (can be downloaded as PDF). Including a
nice sample project.
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5.19 Graphically finding the rotation

Finding the correct XYZ rotation values to correctly orientate a Geometry as
required can be very difficult, especially when angles other than 90 degrees
are involved. Reason is that DeskProto uses absolute rotations: for each new
orientation DeskProto starts with the original CAD orientation, first applies
the X-rotation, next the Y-rotation and finally the Z-rotation. 

Here is a tip to easily find these three rotation values by first rotating the
geometry on screen.
Follow the following steps:

1. Set the rotation settings for the Part to [X=0, Y=0, Z=0].
(Part Parameters, tab page Transform)

2. Rotate the geometry to the required orientation (using the mouse) seen
from above (assuming the X-axis of the machine to be horizontal on the
screen, and the Y-axis of the machine to be vertical on the screen). So imagine
that your viewpoint is above the machine: you are looking downward from
the positive Z-axis.

3. Now simply copy the rotation settings from the view (View menu >>
Viewpoint >> Custom) and enter them as the rotation settings for the part
(Part Parameters, tab page Transform).

4. Finally check whether the rotations are exactly the way you want (by
looking at some default views for example).

A different feature that you can use to find the orientation that you need is
the option called Show downward faces in the Items visible dialog.
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5.20 Editions / Trial mode

DeskProto is offered to you as Freemium software:
you are welcome to use the basic functionality DeskProto free of charge, the
advanced features are available as premium extras.

Four different Editions are available:
· Free Edition
· Entry Edition
· Expert  Edition
· Multi-Axis Edition
of which the first is free while for the other three you need to buy a license.
The Free edition also allows you to Trial (evaluate) the higher editions: when
running in trial mode the resulting toolpath will leave a Trial cross
(watermark) on each part that is machined.
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The Free Edition is available for anyone: free of charge, without any
obligations attached. It's functionality is limited, still it offers all you need for
basic CNC machining: Profiling toolpaths based on Vector Data, Parallel
toolpaths over Geometry Data, and machining reliefs based on Bitmap data.
In the Free edition a project may contain maximum one part and one
operation.
Many parameters as described in the Help file are not available in the Free
Edition. Still the most important parameters are there, and for many users
this free CAM program will be all they need.

The Entry Edition is the lowcost version of DeskProto, offering limited
options, at a very low price.
Compared to the Free edition a few important extra options are present:
Pocketing and Drilling for Vector operations, and Roughing for all three
operation types. Projects also may contain any number of parts and
operations.

The Expert Edition includes all parameters, except for the rotation axis
options. So the fourth axis and the fifth axis are not available in this edition.

The Multi-Axis Edition is the most complete version: all parameters are
present, and so are the A-axis and B-axes rotation axes.

More information about higher editions can be found in the Upgrade dialog. 
An edition comparison table can be found on www.deskproto.com 

A license for a higher edition can be activated in the Activate dialog.
After activating your license this Edition select dialog will no longer be
displayed.

https://www.deskproto.com
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5.21 Trial Cross

The Free edition allows you to Trial (evaluate) the higher Editions: when
running in trial mode the resulting toolpath will leave a Trial cross
(watermark) on each part that is machined.

The effect of this Trial cross (displayed in purple) can be seen in the above
images:
For a Vector operation no toolpaths will be present in the area below this
purple cross: the toolpaths will simply be interrupted.
For a Geometry operation and a Bitmap operation all Z-positions below
this purple cross will be a lowered a bit, resulting in two "ribbons" pressed
into the surface of the part, displaying the text "DeskProto Trial version".
So in all cases you can clearly see if the resulting part will suit your needs,
however the trial cross will make really using the part impossible.

Note that the project files (DPJ files) that are saved when in trial mode do
not have a trial limitation. So you can run in trial mode to prepare a project
and then use a paid license on a different PC to calculate the NC file. For
schools this makes a very lowcost classroom license possible: one paid
educational license on the PC next to the machine, plus many free licenses
running on the student PC's.

In order to use one of the higher editions you need to buy a license.
Such license for a higher edition can be activated in the Activate dialog.
After activating your license the trial cross will no longer be applied.
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5.22 Custom Wizards

In addition to the series of predefined Wizards DeskProto also offers
Custom wizards: wizards that any user can add and/or edit. A number of
these custom wizards already has been installed, and can be started via File
menu command Start Custom wizard.

Custom wizards are not available in MacOS and in Linux: only in Windows,
sorry about that.

The Custom wizard is a very powerful option, making it possible to add
your own Wizards to DeskProto. Such wizard can make it easy to use a
special machine, or to create a special type of product. A good example are
the Wax Ring Wizards that come with DeskProto (123WaxRing, made for the
123WaxRing fixture, and HollowWaxRing, made for the 5t axis of the Roland
JWX-10 milling machine). Total 7 custom wizards haven been installed by
the DeskProto Setup, you are free to edit these wizards and/or use them as
examples for your own script wizards.
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A valid Custom Wizard consist of one DPW file (DeskProto Wizard) and a
subdirectory with the same name.
For instance the file Basic3D.dpw and the directory C:\Program
Files\DeskProto 7.1\Wizards\Basic3D\
The DPW file specifies the name of the Wizard, how many pages are
present, the page definition file for each page, version information. The page
definition files are QML files,  present in the folder just mentioned.  For
instance C:\Program Files\DeskProto
7.1\Wizards\Basic3D\WizPageLoadGeometry.qml

In this folder you may also use .QMLC files: compiled versions of the .QML
files, used as cache for a better performance (faster display) of the wizard
pages.

The wizard pages are written in QML (the Qt Modeling Language), which is
a framework for developing applications offered by the QT Company. As
DeskProto is built using the QT toolkit this is the most efficient choice for a
framework. For each custom wizard page one QML file is needed. This file
contains both the user interface (dialog design, texts, edit boxes, etc) and the
script that defines the actions to be performed. As scripting language
JavaScript is used. About QML and about JavaScript plenty of information
is available via the Internet.

So basically all you need to add a Custom wizard to DeskProto is a plain text
editor. Copy the resulting files to the location specified above, and
DeskProto will show your new wizard. For copying to that location and for
editing files at that location Windows requires administrative privileges.

For more information on scripting see the Scripts page and the DeskProto
Script Documentation: email us to receive a copy. Note that a very easy
way to create a Script wizard is to copy and rename one of the sample Script
wizards: then the correct structure  already is present.

You can also start a Custom Wizard by calling it's DPW-file as a  command
line parameter.

For software specialists: 
you can set the location of this wizard directory as follows:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\7.1\Preferences\File Locations\WizardsLocation
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For MacOS change line "7·1.Preferences.File Locations.WizardsLocation" in
file DeskProto.plist 
For Linux change line "Preferences\File%20Locations\WizardsLocation" in
file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !
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5.23 Scripts

A Script or Macro is a program: a series of commands for DeskProto that
will be executed one by one. Programs are written in a programming language:
DeskProto scripts need to be written in JScript (JavaScript, file extension
.dps). 
Other ways to automate DeskProto are Template projects and Command line
parameters.

A script can be called in DeskProto using the command Run Script...  in the
File menu.
You can also start a Script by calling it as Command line parameter.
Default folder for script files is the Scripts subdirectory of DeskProto ( C:
\Program Files\DeskProto 7.1\Scripts)

A Script is an ASCII text file with a number of lines: each line contains a
command (or part of a command) to be executed. The script can call a number
of objects (functions) that DeskProto has made available via its Scripting
Interface. Most of these objects are Properties (a variable that can be set or
read) and Methods (a function with one or more parameters).

A very simple example of a DeskProto script file is present already
(ScriptedBottle.dps):

MinDeskProtoVersion = 7.1;
MinDeskProtoRevision = 7828;
var strSamplesLocation = DPPreferences.getSamplesLocation();
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DPProject.loadGeometryFile(strSamplesLocation + "Bottle.stl");
DPActivePart.setGeometryRotation(-90.0, 0.0, 0.0);
DPActivePart.materialBlockMethod = 2;
DPProject.calculateToolpaths();
DPProject.writeNCProgram( "ScriptOutputNCfile.ext" );
DPProgram.exit();

This script will load the Bottle geometry, orientate it correctly for machining,
set the Material block (segment is the old name) to use the upper half only,
calculate the toolpaths using the default Operation parameters, save these
toolpaths in an NC program file and exit.  
The parameter of function LoadGeometry could have contained the complete
path in one string. However as the location of the Samples folder is different
per Windows version (sorry: thanks to Microsoft) this solution is better.
The parameter of function writeNCProgram does not include a path: the file
now will be save in the folder that is specified in the Preferences (tab NC
Output). The file extension defined in this parameter will overrule that
extension that is set in the postprocessor.

The available scripting objects are described in the DeskProto Script
Documentation: a series of HTML files that can be found in the directory
\DPScript\html\ on the DeskProto CD.  Open the file
\DPScript\html\index.html to start reading. If you do not have this CD then
please email us.

A special type of Script that is available in DeskProto is the Custom
Wizard. This is a very powerful option, making it possible to add you own
Wizards to DeskProto. Custom wizards can be started via Start Custom
Wizard in the File menu.

For software specialists: 
you can set the location of this scripts directory as follows:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\7.1\Preferences\File Locations\ScriptsLocation
For MacOS change line "7·1.Preferences.File Locations.ScriptsLocation" in
file DeskProto.plist 
For Linux change line "Preferences\File%20Locations\ScriptsLocation" in file
DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !
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5.24 Command Line Parameters

It is possible to run DeskProto with one or two command line parameters. 
This feature is not meant for ‘normal’ users, but rather for application
builders who need to include toolpath calculations in their application and/or
want to automate that process. So when you do not know what a command
line parameter is please ignore this paragraph.
Other ways to automate DeskProto are Template projects and Scripts.

Command line parameters for DeskProto need to be file names (valid file
specifications, including the path). When the file is not found or invalid an
error message will be shown. For the first parameter only a limited number of
file-types is possible (DeskProto uses the file-extension to decide what to do
with the file), for the second parameter any file extension is possible.
In addition two extra parameters are possible, see below

1. First parameter:

Supported file-types for the first parameter are:

DPJ
This is a DeskProto project file - the project will be automatically loaded.
For instance:
"C:\Program Files\DeskProto 7.1\deskproto.exe"  C:\torso.dpj
This project may also be a Template project.

DPW
This is a DeskProto Custom wizard file - the custom wizard will be
automatically started. For instance:
"C:\Program Files\DeskProto 7.1\deskproto.exe"  "C:\Program
Files\DeskProto 7.1\Wizards\123waxRing.dpw"

DPS
This is a DeskProto Script file - the script will be automatically started. For
instance:
"C:\Program Files\DeskProto 7.1\deskproto.exe"   "C:\Program
Files\DeskProto 7.1\Scripts\ScriptedBottle.dps"

DXF, AI, EPS, SVG
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These are CAD-files containing Vector data - the vector file will be
automatically loaded. For instance
"C:\Program Files\DeskProto 7.1\deskproto.exe" "C:
\ProgramData\DeskProto 7.1\Samples\DpBeerTray.dxf"
The default project needs to be a Vector project.
Note that DXF can contain Vector data and/or Geometry data. The default
project type decides how the file is loaded.

STL, DXF
These are CAD-files containing Geometry data - the geometry file will be
automatically loaded. For instance
"C:\Program Files\DeskProto 7.1\deskproto.exe" "C:
\User\STLdata\medaillon.stl"
The default project needs to be a Geometry project.
Note that DXF can contain Vector data and/or Geometry data. The default
project type decides how the file is loaded.

BMP, GIF, JPG, JPEG, PNG, TIF, TIFF
These are CAD-files containing Bitmap data - the bitmap file will be
automatically loaded. For instance
"C:\Program Files\DeskProto 7.1\deskproto.exe" "C:
\ProgramData\DeskProto 7.1\Samples\XYZlogo.png"
The default project needs to be a Bitmap project.

You can test command line parameters by entering these command lines in
the Search dialog of the Windows Start button.
Or you can edit the Shortcut on the desktop (click it with the right mouse-
button, in the context menu choose Properties, select Tab Shortcut): you can
add the command line parameter to field Target.
Or you can use the Windows Command window (start by entering CMD in
the Search dialog) and enter the command in MS-Dos.

2. Second parameter:

The above options start DeskProto and load data, nothing more (except of
course in scripts). Calculating toolpaths and writing the NC file still has to be
done by the user. DeskProto allows you to automate this as well. You then
need to start DeskProto with TWO command line parameters, the second
being the name of the NC file.

For instance: issue the following command:
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"C:\Program Files\DeskProto 7.1\deskproto.exe"  C:\casting.stl  C:
\casting.nc
As a result DeskProto will be started, the file casting.stl will be loaded,
toolpaths will be calculated, the NC file casting.nc will be written, and
DeskProto will be shut down automatically. The user just sees DeskProto
coming up and closing down again. The file extension of the NC-file needs not
be the one that is prescribed by the postprocessor: the name on the command
line will overwrite that.

The toolpath calculations are done using the parameters as set in the defaults.
This works great when the application involves repeating the same job with a
slightly different geometry. This is for instance used for making custom
insoles: each sole is different, however all soles can be machined using exactly
the same parameters.
An application programmer then can include DeskProto in his CAD
application without asking the end-user to work with DeskProto. Calling
DeskProto with the correct command line parameters can be done by a macro
that is called by a button in the CAD application. 

Extra parameters:

Two extra parameters are supported, which is not a file specification.  These
flags may be added on any position on the command line, and do not count as
first or second parameter.

"/nocalculationwarnings"  will make DeskProto suppress calculation
warnings.
This option is useful in case of automated processes, where it should not be
needed for the user to give input (press OK) on warnings that are normal for
that process. Only non-critical warnings are suppressed, for instance "The
selected curves of the operation go 5.00 mm outside of the material block."

"/userinteractionsuppressed"  will make DeskProto suppress all user
interaction (except for error situations). This option includes
the /nocalculationwarnings setting.

The first command line parameter may also be a DPJ file. When a DPJ file is
loaded the parameters in this file will of course be used, not the current
DeskProto defaults. This can be used when the CAD-file used has the same
name for all models.
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This option allows you to achieve full automation like mentioned above, but
now for more than one set of default settings.
For instance:
"C:\Program Files\DeskProto 7.1\deskproto.exe"  C:\TwoSided.dpj  C:
\TwoSided.nc

When you do this with a template project file DeskProto will prompt the
user to browse an STL file.
The project may not be a wizard-project, as then on opening the project the
Wizard will be started which will stop the automation. So when you created
the project using a wizard make sure to make (at least) one small change in
the dialog-based interface before saving the DPJ file.

We strongly advise to define both command line parameters including a path
specification. In case the first parameters comes with a path and the second
does not, the NC file will be written in the directory of the first (STL or DPJ)
file, as then that has become the "current folder".

The second command line parameter also works in case the project causes
DeskProto to save more than one NC program file (for instance because of a
toolchange): the standard DeskProto naming conventions will be used for the
NC files.
In case the DPJ file that is loaded contains more than one part, then for all
parts NC files will be written. Extra file names will be generated by extending
the NC filename using the standard DeskProto naming conventions for
multiple NC files.
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5.25 Template projects

Some applications concern DeskProto projects that all very much look like
each other: all settings equal, only the CAD-data are (slightly) different. In
that case you don’t want to again and again set all parameters for each next
project. 

A first possible solution is to enter all parameters as Defaults (Default Part
and Default Operation). When you then start DeskProto and load the CAD-
data (vector, geometry or bitmap) for the new project, all parameters have
already been set and you can immediately calculate the toolpaths. This even
makes it possible to fully automate DeskProto: see the paragraph on
Command Line Parameters.  

Examples where the defaults can be successfully used:
- production of custom insoles: all products are machined with exactly the
same settings, only the Geometry file is different.
- production of name-tags: again the setting are equal for all tags, only the
Vector file is different for each product.

The above solution is useful only if all your projects need these same
parameters. In case you have several types of projects, then the alternative
solution is to create a project-file without CAD-data, which is called a
Template project.  In order to create such template project you will still
need to load CAD data (vector, geometry or bitmap), as without CAD-data it
will not be possible to set any Part parameters. When you have set all
parameters that you need you can remove your CAD-data file (in the Project
parameters), and then save the project.

DeskProto will warn you that no Vector-data / Geometry-data / Bitmap-data
is present, and ask you if you want to create a template project.  When you
later open such template project, DeskProto will immediately show a File-
Open dialog to load a CAD file into the project.

In DeskProto the first operation of a part defines the type of the project:
when the first operation is a Vector operation the project is a Vector project.
Same for template projects, which means that in these three cases DeskProto
will treat a project that it opens as template project: 
- first operation is a Vector operation, however no Vector-file is present
- first operation is a Geometry operation, however no Geometry-file is
present
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- first operation is a Bitmap operation, however no Bitmap-file is present

Here some examples where template projects may be useful:
· You might want to define a template project that you can use for a certain

material. For instance when you always machine dental models your
settings are always the same. However some models are in zirconium and
some in wax, needing different settings.

· You might want to define a template project for molds, using inverse
milling.

· You might want to define a template project with one part defined as top
part, another defined as bottom part (with correct transformations), each
containing one operation for roughing, and one for finishing.

After opening a template project and loading the CAD file that you want to
use you need to take care NOT to save the project, as that will over-write
your template project. If needed to save use Save_As, and a different name.

A second way of using template project files is to always use the same name
for the CAD file. Your template project than will open this file when starting
DeskProto: you just need to make sure that you have saved the CAD-data to
be used in that CAD file before starting DeskProto.

Finally: the third option for automation that DeskProto offers is writing a
Script.
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CAD data  
geometry 311
vector 311

CAD file 282
Calculate  

toolpaths 78
Calculation precision 218
Camera position 264
Center 223
Center geometry 141
Centre 223
Chaining 136, 180
Check for update 117
Circular strategy 223
Circular toolpaths 184
Climb milling 197
Clipboard 57
Collet collision 204
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COM Port 289
Command line parameters 371
Compare wth geometry 156
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Contour only toolpath 184
Conventional milling 197
Coordinates on screen 35, 63
Copy image 57
Copyright 7
Correction factor (time) 83
Corrupt geometry 321
Crosswise toolpaths 184
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part 330
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Customizing DeskProto 54
Cutter 181

dimensions 247
multiple diameter 247
type 247
vector operation 166

Cutter-file 252
Cutting direction 169, 172

D
Deactivate license 113, 304
Default  

bitmap operation 336
bitmap operation parameters 100
geometry operation 334
geometry operation parameters98
machine 257
part 330
part parameters 96
project 328
project parameters 95
vector operation 332
vector operation parameters 97
view 101

Delft Spline Systems 18
Depth cueing (fog) 288
Direction of milling 197
Disclaimer 6
Distance between toolpaths 181
Downward faces 268
DPJ file 282, 328
DPS file 54, 368
DPT file 328
DPW file 365
Drilling 174

curve selection 211
Driver  

newer 309
Drivers  

file location 284
DXF-file  

2D 315
3D 320
freeform area 220
geometry 320
vector 315

Dynamic drawing 293
Dynamic feedrate 197

E
Edition  

entry 260, 362
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Edition  
expert 260, 362
free 260, 362
multi-axis 260, 362

Editions 115
End commands 225

postprocessor 237
Entry edition 260, 362
EPS file 315
Essentials 9
Exit 56
Expert edition 260, 362
Export  

Simulation 87
Z-grid 87

Export settings 293
External program 289

F
Feedrate 166, 181, 228

angular 240
default 247
dynamic 197
first movements 197
high chip loads 197
inverse time 240
plunge movements 197

Feedrate command 240
File  

locations 284, 289
new 37
not found 282
open 39
recent 39
save 40
save as 40

Filetypes 11
bitmap 323
DeskProto project 328
geometry 319
vector 314

Fill gaps 184
Five axis machining 225
Flip normals 133

Fog 288
Free edition 260, 362
Free movement height  

geometry 197
vector 167

Freeform area 193
Freeformed area 220

G
G00 240
G01 238
G93 242
Geometry  

add 42
corrupt 321
dimensions 273
load 42
points only 268
rendered 268
save as 42
size 64
wireframe 268

Geometry data 311, 319
Geometry file 133, 319
Geometry information 64
Geometry operation 334

default 98, 334
Geometry operation parameters 180
Geometry Settings 137
Geometry transformation 121
GIF-file 324

H
Hardware specification 11
Helix toolpath 184
Help  

topics 104
Hidden lines 268

I
IGES-file 320
Import settings 293
inch 284
Indexed machining 225, 359
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Initial Settings 257
Inverse milling 141
Inverse time feedrate 240, 242
Items visible 70, 268

J
JPG-file 324

K
Keep settings 308

L
Lamp icons 30, 65
Language setting 284
Large buttons 62
Laser cutter 167, 244
Layer thickness 190
Layout  

view 70
Liability 6
Library  

cutter 247
cutters 94
how to use 347
machine 228
machines 90
notes 252
postprocessor 235
postprocessors 92

Library, external 7
License 7
License key 113, 304
Line numbers 235
Linux 9, 105
Load  

bitmap data 43
geometry 42
vector data 41

LPT Port 289

M
Machine  

advanced settings 230
configuration 228

ready to receive 280
select 130
send toolpaths to 81

Machine-file 252
Machining  

indexed 359
rotary 357
two-sided 353

Machining level 167
Machining time 83

correction factor 228
Machining time estimation 276
MacOS 9, 11, 105
Macro 368
Material block 148, 268
Material block size 162
Maximum layering height 190
Meander milling 197
Menu bar 23
Migrate settings 306
Mirror 141
mm 284
Moiré effect 324
Mold 141
Mould 141
Mouse  

rotate/pan/zoom 72
settings 293

Mouse coordinates 35, 63
Movement command 238
Mulit-axis edition 260, 362

N
NC files window 33, 68
NC Output 289
NC-program 345

creating 345
write 80

New  
project 37

Newer driver 309
Normals 321

flip 133
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O
Offset toolpaths 184
Open  

file location 284
project 39, 328

Open GL 293
OpenGL  

driver warning 253
extension warning 255

Operation  
bitmap 336
geometry 334
number of 138
parameters 76
to be simulated 278
vector 332
visible 332, 334, 336

Operation parameters  
bitmap 210
geometry 180
vector 165

Optimization 197
Orientator 268

P
Parallel toolpaths 184
parameters  

operation 76
part 75
project 75

Part 330
current 330
default 96, 330
number of 130
parameters 75
rotation 361
size 64

Part information 273
Part parameters 137
Peck drilling 165, 174
Placeholder 349
Plotfile 314
Plunge 197

Plunge rate  
vector 179

PNG-file 324
Pocketing 172

curve selection 211
Points on curve 268
Points on toolpath 268
Polyface mesh 320
Positive coordinate values 153
Postprocessor 228

configuration 235
end commands 237
file extension 235
file size 235
placeholder 349
program number 349
start commands 237

Postprocessor-file 252
Postscript 315
Precision 181, 218
Preferences 102, 284
Print  

image 44
preview 44, 46
project 45
setup 45, 47

Printer driver 289
Problem report 111
Profiling 169

curve selection 211
Profiling tabs 214
Profilink tabs  

default 218
Program number 281, 349
Project  

default 95, 328
NC-program 345
opening 328
parameters 75
saving 328
structure 326
template 375
toolpath 340

Project file 282, 326
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Project parameters 130
Project tree 30, 65
Project vector curves 167
Properties 58
Protect vertical surfaces  

roughing 190

Q
Quick Start 105

R
Radial strategy 223
Radial toolpaths 184
Ramping 190

vector 176
Rapid movement command 240
Recent file list 39
Redo 220
Reduced feedrate 197
Register 113, 304
Relief 323
Relief height 146
Report 111
Requirements 11
Rest material 156
Retained mode graphics 293
Retraction value 174
Right-click 30, 65
Rotary machining 357
Rotate 141
Rotation 361
Rotation axis 228, 357

tilt option 138
use 138

Roughing 190
vector 176

S
Sample  

files 47, 262
projects 47, 262

Save  
bitmap data as 44
file location 284

geometry as 42
geometry transformations 123
project 40, 328
project as 40
vector data as 41
vector transformations 122

Scale 141
Screen layout 19
Script 368
Scripting 54
Send NC program to ... 85, 289
Send toolpaths to ... 81
Settings  

bitmap 137
geometry 137
initial 257
keep 308
migrate 306
vector 137

Settings, import/export 293
Show downward faces 268
Simulation 268, 342

calculating 342
compare with geometry 342
export 87
level of detail 342
settings 156
show 83
which operations 278

Skin 190
Skip backfaces 133
Smooth transitions 184
Smoothing contour 184
Sort 197
SpaceMouse 293
Specifications 11
Speed 228
Spindle speed 166, 181, 228

default 247
maximum 247

Spindle speed command 244
Spiral strategy 223
Spiral toolpaths 184
Start commands 225
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Start commands 225
postprocessor 237

Start screen 47, 262
Start/End  

geometry 204
Start/End commands  

vector 179
Status bar 35, 63
STEP-file 320
Stepover  

geometry 181
pocketing 172

Stepsize along toolpath 181
STL-file 320
Strategy 184
Support 17

problem report 111
Support tab 150, 158
Support tabs 169
Surface sampling refinement184, 218
SVG file 315

T
Tab  

geometry 150, 158
vector 169, 214
vector, default 218

Template project 375
thumbwheel 69
Thumb-wheels 28
TIFF-file 324
Tilt angle 209
Title 268
Title bar 21
Toolbar 24, 59
Toolchange command 245
Toolpath 340

calculation 340
Toolpaths  

calculate 78
calculate all 85

Trademark 6
Transformation  

geometry 121

save geometry 123
save vector data 122
vector data 119

Translate 153
bitmap 144

Translation (language) 284
Translucent 268
Tree 30, 65
Trial cross 364
Trial limitation 364
Two sided wizard (block size) 292
Two-sided machining 353

U
Units 257, 284

postprocessor 238
Update 117
Upgrade 306
Upgrading 115
Upper half of geometry 148
USB Port 289

V
Vector  

curve direction 131
drilling 174
free movement height 167
pocketing 172
profiling 169
project on 3D 167
roughing 176
Z-values 131

Vector curves 268
Vector data 311, 314

add 41
dimensions 273
load 41
save as 41
size 64

Vector data transformation 119
Vector file 131, 314
Vector operation 332

default 97, 332
Vector operation parameters 165
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Vector Settings 137
Vertical surfaces 204

roughing 190
View 72

default 101
layout 70
Subjects dialog 268

View window 28
Viewpoint 71

custom 264
dialog 264

Views layout 266
Visible items 70

main screen 268
set graphically 161

Visible operation 332, 334, 336
VRML-file 320

W
Waterline toolpaths 184
Watermark 364
Windows 9, 11, 105
Wireframe 268
Wizard  

bitmap 49, 125
choose type 49, 125
custom 52, 365
geometry 49, 125
html 52, 365
introduction 14
multiple sides 49, 125
preferences 292
rotary 49, 125
script 52, 365
two-sides 49, 125
vector 49, 125

Wizard, custom 129
Working area 228
Workpiece zero point 153

indication 268
Write  

NC program 80
Write NC 289

Z
Zero point 153
Z-grid 338

calculate 84
calculation 338
export 87

Zoom 72
Zoom speed 293
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